For Research Use Only. Not for use in diagnostic procedures.

The information in this guide is subject to change without notice.

DISCLAIMER

LIFE TECHNOLOGIES CORPORATION AND/OR ITS AFFILIATE(S) DISCLAIM ALL WARRANTIES WITH RESPECT TO THIS DOCUMENT, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. TO THE EXTENT ALLOWED BY LAW, IN NO EVENT SHALL LIFE TECHNOLOGIES AND/OR ITS AFFILIATE(S) BE LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY, OR UNDER ANY STATUTE OR ON ANY OTHER BASIS FOR SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM THIS DOCUMENT, INCLUDING BUT NOT LIMITED TO THE USE THEREOF.

LIMITED USE LABEL LICENSE No. 477: Real-Time PCR System

Notice to Purchaser: This product is licensed for use under certain patent claims owned by the University of Utah Research Foundation and licensed to BioFire Diagnostics, Inc. No right is conveyed, expressly, by implication or by estoppel under any other patent claim.

TRADEMARKS

© 2013 Life Technologies Corporation. All rights reserved. The trademarks mentioned herein are the property of Life Technologies Corporation and/or its affiliate(s) or their respective owners.

RealTime StatMiner is a registered trademark of Integromics, S.L. Cy is a registered trademark of GE Healthcare. Microsoft, Windows and Internet Explorer are registered trademarks of Microsoft Corporation. Apple, Macintosh and Safari are registered trademarks of Apple, Inc. Mozilla and Firefox are registered trademarks of Mozilla Foundation. Adobe, Reader and Acrobat are registered trademarks of Adobe Systems, Inc. AmpErase and AmpliTaq Gold are registered trademarks of Roche Molecular Systems, Inc. as is TaqMan, which is used under permission and license.
Roadmap

BOOKLET 1  Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments

BOOKLET 2  QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve Experiments

BOOKLET 3  QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve and Comparative C_T Experiments

  PART I:  Running Relative Standard Curve Experiments

  PART II:  Running Comparative C_T Experiments

BOOKLET 4  QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Genotyping Experiments

BOOKLET 5  QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence Experiments

BOOKLET 6  QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Melt Curve Experiments

BOOKLET 7  QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes
Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments

Booklet 1

Publication Number 4489822
Revision A
For Research Use Only. Not for use in diagnostic procedures.
About This Guide ................................................................. 5
Revision history ................................................................. 5
Purpose ............................................................................. 5
Prerequisites ....................................................................... 5
How to use these booklets as tutorials .............................. 6
How to use the guides with your own experiments ............ 6
Assumptions ........................................................................ 6
How to access an example experiment ............................. 7
Start the QuantStudio™ 6 and 7 Flex Software ................. 7
Open an example experiment ............................................. 7
A note on system security ................................................ 9
User attention words ......................................................... 9

CHAPTER 1 General Experiment Information and Instructions .... 11
Set up an experiment .......................................................... 12
Define experiment properties ............................................ 12
Define targets, samples, and biological replicate groups ...... 15
Assign targets, samples, and biological replicate groups ..... 16
Assign targets, samples, and biological replicate groups - alternate procedure 19
Define the run method ....................................................... 20
Prepare reactions ............................................................... 22
Supported reagents ........................................................... 22
Precautions while preparing reactions ............................... 22
Materials required while preparing the dilutions ............... 22
Guidelines for preparing the dilutions, reaction mix, and plate 23
Seal the reaction plate ....................................................... 23
Fill and seal the array card ............................................... 25
Capping and uncapping the 96-well reaction tubes and tube strips 28
Start the experiment .......................................................... 30
Prepare the instrument for use .......................................... 30
Load the reaction plate or array card into the instrument ...... 33
Start the experiment .......................................................... 34
Monitor the experiment ..................................................... 35
Unload the instrument ...................................................... 41
Transfer experiment results .............................................. 42
Review experiment results ............................................... 44
About analysis results ....................................................... 44
To override calibration ..................................................... 44
To display wells .................................................................. 45
To display multiple plots .................................................. 45
To display an expanded view of a plot or wells .................. 46
To edit plot properties ...................................................... 46
To save current settings as default ................................. 47
Contents

To publish the analyzed data ......................................................... 47
Export an experiment .................................................................... 47
   About exporting an experiment .................................................. 47
   Export procedure .................................................................... 48

■ CHAPTER 2  Experiment Shortcuts ................................. 53

   Using experiment templates .................................................... 53
      To create a template ............................................................. 53
      To create a new experiment using a template ......................... 54
      To create an experiment using a template on the QuantStudio™ 6 or 7 Instrument touchscreen 54
      Use a template to create a batch of experiments ...................... 55

   Run an experiment with QuickStart ........................................ 57
      QuickStart from the QuantStudio™ 6 and 7 Flex Software ........ 57
      QuickStart from the QuantStudio™ 6 or 7 Instrument touchscreen 58

   Import experiment setup .......................................................... 58
      Import plate setup for an experiment ..................................... 58
      Import sample information .................................................. 59

   Create an experiment using ReadiApp ...................................... 62

Index ....................................................................................... 63
About This Guide

CAUTION! ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard types specified in procedures may be abbreviated in this document. For the complete safety information, refer to the instrument user guide.

IMPORTANT! Before using this product, read and understand the information in the instrument user guide.

Revision history

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>October 2013</td>
<td>New document</td>
</tr>
</tbody>
</table>

Purpose

The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments Getting Started Guide functions as both a tutorial and as a guide for performing your own experiments on the QuantStudio™ 6 and 7 Flex Instruments.

Note: For differences between the QuantStudio™ 6 System and the QuantStudio™ 7 System, refer to the QuantStudio™ 6 and 7 Flex Real-Time PCR Systems Maintenance and Administration Guide (Pub. no. 4489821).

Prerequisites

This getting started guide is intended for personnel who have been specifically trained by Life Technologies. The manufacturer is not liable for damage or injury that results from use of this manual by unauthorized or untrained parties.

This guide uses conventions and terminology that assume a working knowledge of the Microsoft® Windows® operating system, the Internet, and Internet-based browsers.

Note: First-time users of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, please read Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments thoroughly. The booklet provides information and general instructions that are applicable to all the experiments described in this binder.
How to use these booklets as tutorials

Each booklet in this guide provides a tutorial for running an example experiment using QuantStudio™ 6 and 7 Flex Real-Time PCR System Software and the example data provided on the installation CD. The following booklets are provided:

- **Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments** – introductory information and experiment workflow common to all experiments.
- **QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve and Comparative CT Experiments** – designing, running, and analyzing Relative Standard Curve and Comparative CT experiments.
  
  **Note:** This booklet also provides information on setting up, running, and analyzing a gene expression study of two Comparative CT experiments.
- **QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Genotyping Experiments** – designing, running, and analyzing a Genotyping experiment.
- **QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence Experiments** – designing, running, and analyzing a Presence/Absence experiment.
- **QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Melt Curve Experiments** – designing, running, and analyzing a Melt Curve experiment.
- **QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes** – common information such as ordering information, additional documentation, and glossary.
  
  **Note:** In all booklets, the term “experiment” refers to the entire process of performing an experiment, including setup, run, and analysis.

How to use the guides with your own experiments

Each booklet contains instructions specific to an example experiment provided on the installation CD. However, you can use the booklets as guides for your own experiments; tips for running your own experiments are provided at various points in each booklet.

Assumptions

This guide assumes that you have access to the example experiments provided with the software.
How to access an example experiment

Start the QuantStudio™ 6 and 7 Flex Software

Double-click (QuantStudio™ 6 and 7 Flex Real-Time PCR System Software shortcut) to access the Home screen, shown in the following image.

Open an example experiment

1. In the Home screen, select Open from the toolbar.
2. Navigate to the examples folder. The default path is: <drive>:\Program Files\Applied Biosystems\QuantStudio 6 and 7 Flex Software\examples\QS6Flex or <drive>:\Program Files\Applied Biosystems\QuantStudio 6 and 7 Flex Software\examples\QS7Flex.

where, <drive> is the computer hard drive on which the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software is installed. The default installation drive for the software is the C: drive.
3. Select an example experiment file to open, then click **Open**.

<table>
<thead>
<tr>
<th>Experiment type</th>
<th>Example experiment file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Curve</td>
<td>QS6_96-Well Standard Curve Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS6_384-Well Standard Curve Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_TaqMan_Array_Standard Curve Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_TaqMan_Array_RNaseP_Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_384-Well Standard Curve Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_96-Well Standard Curve Example.eds</td>
</tr>
<tr>
<td>Relative Standard Curve</td>
<td>QS6_96-Well Relative Standard Curve Example 2.eds</td>
</tr>
<tr>
<td></td>
<td>QS6_96-Well Relative Standard Curve Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS6_384-Well.Relative Standard Curve Example 2.eds</td>
</tr>
<tr>
<td></td>
<td>QS6_384-Well.Relative Standard Curve Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_96-Well Relative Standard Curve Example 2.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_96-Well Relative Standard Curve Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_384-Well.Relative Standard Curve Example 2.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_384-Well.Relative Standard Curve Example.eds</td>
</tr>
<tr>
<td>Comparative Ct</td>
<td>QS6_96-Well Comparative Ct Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS6_384-Well_Comparative Ct_Example_1.eds</td>
</tr>
<tr>
<td></td>
<td>QS6_384-Well_Comparative Ct_Example_2.eds</td>
</tr>
<tr>
<td></td>
<td>QS6_384-Well_Comparative Ct_Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_96-Well Comparative Ct Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_384-Well_Comparative Ct_Example_1.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_384-Well_Comparative Ct_Example_2.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_384-Well_Comparative Ct_Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_TaqMan_Array_Comparative_Ct_Example.eds</td>
</tr>
<tr>
<td>Multiplex</td>
<td>QS6_96-Well Multiplex Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS6_384-Well_Multiplex_Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_96-Well Multiplex Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_384-Well_Multiplex_Example.eds</td>
</tr>
<tr>
<td>Genotyping</td>
<td>QS7_96-Well SNP Genotyping Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_384-Well_SNPGenotyping_Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS6_96-Well SNP Genotyping Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS6_384-Well_SNPGenotyping_Example.eds</td>
</tr>
<tr>
<td>Presence/Absence</td>
<td>QS6_384-Well_Presence-Absence_Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS6_96-Well_Presence-Absence_Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_96-Well_Presence-Absence_Example.eds</td>
</tr>
<tr>
<td></td>
<td>QS7_384-Well_Presence-Absence_Example.eds</td>
</tr>
</tbody>
</table>
About This Guide

A note on system security

The Security, Auditing, and e-Signature (SAE) feature in QuantStudio™ 6 and 7 Flex Real-Time PCR System Software enables role-based access control to enforce data integrity and authentication of users logging into the system, to strengthen system security. The feature tracks actions performed by users on experiments, templates, and studies, and it tracks changes to the SAE settings. You can enable or disable this feature to accommodate your security needs.

To enable or disable the feature, from the toolbar select Tools ▶ Security ▶ Settings.

For more information on the SAE feature, please refer to the instrument user guide.

User attention words

Five user attention words may appear in this document. Each word implies a particular level of observation or action as described below:

**Note:** Provides information that may be of interest or help but is not critical to the use of the product.

**IMPORTANT!** Provides information that is necessary for proper instrument operation or accurate chemistry kit kit use.
About This Guide

User attention words

---

**CAUTION!** Indicates a potentially hazardous situation that, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

**WARNING!** Indicates a potentially hazardous situation that, if not avoided, could result in death or serious injury.

**DANGER!** Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury.

---

Except for IMPORTANTs, the safety alert words in user documentation appear with an open triangle figure that contains a hazard symbol. These hazard symbols are identical to the hazard symbols that are affixed to the instrument. See the “Safety” appendix for descriptions of the symbols.
General Experiment Information and Instructions

This chapter covers:

- Set up an experiment ......................................................... 12
  Define experiment properties .............................................. 12
  Define targets, samples, and biological replicate groups ............... 15
  Assign targets, samples, and biological replicate groups ............... 16
  Assign targets, samples, and biological replicate groups - alternate procedure 19
  Define the run method ..................................................... 20

- Prepare reactions ........................................................... 22
  Supported reagents ......................................................... 22
  Precautions while preparing reactions .................................. 22
  Materials required while preparing the dilutions ....................... 22
  Guidelines for preparing the dilutions, reaction mix, and plate ...... 23
  Seal the reaction plate .................................................... 23
  Fill and seal the array card .............................................. 25
  Capping and uncapping the 96-well reaction tubes and tube strips .... 28

- Start the experiment ....................................................... 30
  Prepare the instrument for use .......................................... 30
  Load the reaction plate or array card into the instrument ........... 33
  Start the experiment ...................................................... 34
  Monitor the experiment .................................................. 35
  Unload the instrument .................................................... 41
  Transfer experiment results ............................................. 42

- Review experiment results ............................................... 44
  About analysis results .................................................... 44
  To override calibration .................................................... 44
  To display wells ........................................................... 45
  To display multiple plots ................................................. 45
  To display an expanded view of a plot or wells ....................... 46
  To edit plot properties .................................................. 46
  To save current settings as default .................................... 47
  To publish the analyzed data ........................................... 47

- Export an experiment .................................................... 47
  About exporting an experiment ......................................... 47
  Export procedure ......................................................... 48
Note: For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ 6 and 7 Flex Real-Time PCR System Software by pressing F1, clicking Help in the toolbar, or selecting Help → QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Help.

Set up an experiment

Note: To start the QuantStudio™ 6 and 7 Flex Software, see “Start the QuantStudio™ 6 and 7 Flex Software” on page 7.

Define experiment properties

All experiments require the same general setup tasks; individual booklets supply specific parameters. The following procedures outline general steps to take to set up an experiment.

Access QuantStudio™ 6 and 7 Flex Software and click (Experiment Setup). Click Experiment Properties to access the Experiment Properties screen.

Define experiment name and type

1. Enter a unique experiment name in the Experiment Name field. The default is a date and time stamp, which you can change. For example, 2010-04-12 173730.
   • Enter a name that is descriptive and easy to remember. You can enter up to 100 characters.
   • You can only use the alpha-numeric, hyphen (-), underscore (_), and spaces ( ) characters.
   
   Note: Ensure each experiment name is unique. If you have named two different experiments with the same name, you cannot run them on the same instrument. You will receive the following error message when attempting to start the run:

   ![Error Message]

   2. (Optional) Enter or scan the barcode on the reaction plate. You can enter up to 100 characters in the Barcode field.

   3. (Optional) Enter a user name to identify the owner of the experiment. You can enter up to 100 characters in the User Name field.

   4. (Optional) Enter comments to describe the experiment.

   5. Select the instrument type you are using to run the experiment
   • QuantStudio™ 6 Flex System
   • QuantStudio™ 7 Flex System

   6. Select the block type you are using to run the experiment
   • 384-Well Block
   • Array Card Block (only applicable to the QuantStudio™ 7 Flex System)
7. Select the experiment type:
   - Standard Curve
   - Relative Standard Curve
   - Comparative $C_T (\Delta\Delta C_T)$
   - Melt Curve
   - Genotyping
   - Presence/Absence

Select the reagent

Select the reagent you are using to detect the target sequence:
   - TaqMan® Reagents
   - SYBR® Green Reagents
   - Other

Note: If you select SYBR® Green as the reagent, then you have the option of including a melt curve for that experiment.

Define the instrument run properties

1. Select the ramp speed for the experiment:
   - Standard
   - Fast

2. For Genotyping and Presence/Absence experiments, select the options for the data collection to include in the experiment run:
   - Pre-PCR Read - to include data before amplification occurs. Use the data collected during pre-PCR read to normalize fluorescence data collected during post-PCR read.
   - Amplification - to include real-time data.
   - Post-PCR Read - to include data after amplification has taken place.

3. For the Melt Curve experiment, select the Include PCR check box, to include PCR.

Review the analysis settings

Analysis Settings are different for each experiment type. The software analyzes the data using the default analysis settings. If the default analysis settings in the QuantStudio™ 6 and 7 Flex Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box and save the changed analysis settings to the Analysis Settings Library.

Note: For information on Analysis Settings Library, refer to Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes.
Enter the reagent information

In the Reagent Information panel you can enter detailed reagent information, including the part number, lot number, and expiration date of the reagents you will use in your experiment. This information can be entered before setting up your experiment or starting your calibration run.

1. In the Reagent Information panel, click New to add a line for reagent details, or Delete to remove an existing one.

2. Click within the first four fields to enter your reagent Type, Name, Part Number, or Lot Number, respectively:

3. Click the Expiration Date field, and click the “down arrow” to display the current month’s calendar. Select the reagent’s expiration date from that month, or click the “forward arrow” to select a future date.

Save the experiment

Save the experiment. The default file name (.eds extension) is the experiment name that you entered when you set up the experiment and saved it for the first time. Changes to the experiment name after the first save do not update the file name. To change the file name, select File ▶ Save As.

The following is an image of the Experiment Properties screen for a Standard Curve experiment:
Define targets, samples, and biological replicate groups

Use the Define screen to define targets, samples and biological replicates for your experiment.

**Note:** You can start a run without these definitions, but there will be no real-time data (data will not be visible) in the amplification plots (the amplification plots can be seen only after you have set up the plate).

1. Click **Define** to access the Define screen.

2. Define targets.

**Note:** For Genotyping experiments, use this screen to specify the number of SNP assays to include in the experiment. For more information on defining SNP assays, refer to Booklet 4, *QuantStudio™ 6 and 7 Real-Time PCR System Software Getting Started Guide for Genotyping Experiments*.

   a. Click **New** to add targets and define them.

   b. In the target table, click a cell in the Target Name column for the target, then enter your target name. The default name is Target 1.

   c. Select the **Reporter** and **Quencher** from the respective drop-down menu.

      **Note:** The default reporter and quencher dyes used depend on the reagent selected during experiment setup. For example, if TaqMan® is the selected reagent, the default reporter FAM and default quencher is NFQ-MGB.

   d. Select the target **Color** from the drop-down menu.

   e. *(Optional)* Click **Save to Library** to save the newly added or existing edited targets to the target library.

      **Note:** Use the targets from the Target Library to avoid re-entering the information. Refer to Appendix B, Supplemental Information in Booklet 7, *QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes* for information on target libraries.

   f. *(Optional)* Click **Import from Library** to add targets from the target library.

3. Define samples.

   a. Click **New** to add samples and name them.

   b. In the samples table, click a cell in the Sample Name column for the sample to define and enter your sample name. The default sample name is Sample 1.

   c. Select the sample **Color** from the drop-down menu.

   d. *(Optional)* Click **Save to Library** to save the newly added or existing edited samples to the sample library.

      **Note:** Use the samples from the Sample Library to avoid re-entering the information. Refer to Appendix B, Supplemental Information in Booklet 7, *QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes* for information on sample libraries.

   e. *(Optional)* Click **Import from Library** to add samples from the sample library.

4. *(Optional)* Define biological replicates.

   a. In the Define Biological Replicates Groups table, click **New** to add biological replicate group and name them. You can enter up to 100 characters in this field.
b. Select the Color from the drop-down menu.

c. Click in the Comments column to add comments for that biological replicate group.

5. Select the Passive Reference dye from the drop-down menu.

6. Define custom task name.

Note: The Custom Task Name panel is visible only when the Hide the custom task name definition and assignment UI check box under the Setup tab in the Preferences dialog box is unselected.

The following is an image of the Define screen for a Standard Curve experiment:

### Assign targets, samples, and biological replicate groups

Use the Assign screen to assign targets, samples, and biological replicate groups to wells in the reaction plate. For Genotyping experiments, use this screen to assign SNP assays.

Note: You can start a run without these assignments, but there will be no real-time data in the amplification plots (the amplification plots can be seen only after you have set up the plate).

1. Click Assign to access the Assign screen.

2. Assign targets.
   
   a. Select wells using the plate layout or the well table on the Assign screen.

   b. Select a target and assign its task, in the plate, from the drop-down menu. Depending on the experiment type, options are:
3. Assign Samples.

   a. Select wells using the plate layout or the well table on the Assign screen.
   b. Select the check box next to the sample to assign to the selected wells.

   **Note:** You can assign only one sample to a well. If the selected wells contain mixed assignments (indicated by a symbol), remove existing sample assignments before you make the new sample assignment.

4. Assign Biological Replicate Groups.

   a. Select wells using the plate layout or the well table on the Assign screen.
   b. Select the check box next to the biological replicate group to assign to the selected wells.

---

<table>
<thead>
<tr>
<th>Experiment type</th>
<th>Legend</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Curve</td>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>S</td>
<td>Standard</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Negative Control</td>
</tr>
<tr>
<td>Relative Standard Curve</td>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>S</td>
<td>Standard</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Negative Control</td>
</tr>
<tr>
<td>Comparative CT</td>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Negative Control</td>
</tr>
<tr>
<td>Genotyping</td>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>1/1</td>
<td>Positive Control Allele 1/ Allele 1</td>
</tr>
<tr>
<td></td>
<td>2/2</td>
<td>Positive Control Allele 2/ Allele 2</td>
</tr>
<tr>
<td></td>
<td>1/2</td>
<td>Positive Control Allele 1/ Allele 2</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Negative Control</td>
</tr>
<tr>
<td>Presence/Absence</td>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>I</td>
<td>Internal Positive Control</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Negative Control</td>
</tr>
<tr>
<td></td>
<td>V</td>
<td>Blocked Internal Positive Control</td>
</tr>
<tr>
<td>Melt Curve</td>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Negative Control</td>
</tr>
</tbody>
</table>
The following is an image of the Assign screen for a Standard Curve experiment:
Assign targets, samples, and biological replicate groups - alternate procedure

As shown below, you can also paste assignment information from an *.xls file into the plate layout of the QuantStudio™ 6 and 7 Flex Software for wells with single targets.

Note: You must select the header and the Well Number column while copying information from the *.xls file.

Note: Any of the columns not copied are treated as NULL values for those columns.
Chapter 1 General Experiment Information and Instructions

Set up an experiment

**Note:** An example copy and paste file is provided with the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software and is located at C:\Program Files\Applied Biosystems\QuantStudio 6 and 7 Flex Software\examples\User Sample Files. where, <drive> is the computer hard drive on which the QuantStudio™ 6 and 7 Flex Software is installed. The default installation drive for the software is the C: drive.

**Define the run method**

Use the Run Method screen to set up the run method for your own experiments in the QuantStudio™ 6 and 7 Flex Software.

**Note:** Refer to the Booklet 7, QuantStudio™ 6 and 7 Real-Time PCR System Software Experiments - Appendixes for information on analysis settings.

1. Click **Run Method** to access the Run Method screen.
   **Note:** You can save multiple run methods to the Run Method Library for later use. Refer to Appendix B, Supplemental Information in Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes for information on run method libraries.

2. Enter a number for the reaction volume per well. See “Instrument consumables” on page 17 for maximum reaction volumes for the consumables supported by the QuantStudio™ 6 and 7 Flex Software.

3. In the **Graphical View** tab, review and, if necessary, edit the run method.
   - Make sure that the thermal profile is appropriate for your reagents.
   - Edit the default run method or replace it with one from the run method library included in the QuantStudio™ 6 and 7 Flex Software.
   - Enable data collection by clicking .
     **Note:** Enabling data collection is especially useful when you later need to analyze data collected in real-time during the various stages.
   - Edit the ramp rate. You can increase or decrease the ramp rate for a stage.
     **Note:** Ramp rates are decimal numbers from 0.015—3.4.
   - Edit the PCR Stage.
     - Change the Number of Cycles for the PCR stage.
     - Select the **Enable AutoDelta** check box, to increase or decrease the temperature and/or hold time for each subsequent cycle or to change the Starting Cycle for AutoDelta. Enabling AutoDelta displays the ▲ icon. Click the AutoDelta Off ▲ icon to change the AutoDelta settings for the cycling stage in the AutoDelta Settings dialog box. Then, click **Save Setting** to display the AutoDelta On ▲ icon.
Note: If you selected SYBR® Green as the reagent, the Melt Curve stage automatically appears in the Run Method screen. If you delete the Melt Curve Stage section from the protocol, then the melt curve is active in the Add Stage drop-down menu.

4. (Optional) Complete the tasks on the Optical Filters tab:

**IMPORTANT!** Do not alter the optical filters for system dyes. This feature is optional when you use custom dyes, where you can select a filter set to match the profile of the dye. For more information on how to select the appropriate filter set, contact Life Technologies.

By default, the Optical Filters tab is not visible. To show the Optical Filters tab, go to Tools → Preferences, and select the Show optical filters for run method check box under the Default tab.

- To add a new filter set to the filter set library, click **Save**.
- To load a saved filter set, click **Load**.
- To go back to the original filter set combinations, click **Revert to Defaults**.
Prepare reactions

Life Technologies supports the following reagents for experiments performed with the QuantStudio™ 6 and 7 Flex Software.

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Experiment type</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® reagents</td>
<td>• Standard Curve</td>
</tr>
<tr>
<td></td>
<td>• Relative Standard Curve</td>
</tr>
<tr>
<td></td>
<td>• Comparative C&lt;sub&gt;T&lt;/sub&gt; (ΔΔC&lt;sub&gt;T&lt;/sub&gt;)</td>
</tr>
<tr>
<td></td>
<td>• Genotyping</td>
</tr>
<tr>
<td></td>
<td>• Presence/ Absence</td>
</tr>
<tr>
<td>SYBR® Green reagents</td>
<td>• Standard Curve</td>
</tr>
<tr>
<td></td>
<td>• Relative Standard Curve</td>
</tr>
<tr>
<td></td>
<td>• Comparative C&lt;sub&gt;T&lt;/sub&gt; (ΔΔC&lt;sub&gt;T&lt;/sub&gt;)</td>
</tr>
<tr>
<td></td>
<td>• Melt Curve</td>
</tr>
<tr>
<td>Other reagents</td>
<td>• Standard Curve</td>
</tr>
<tr>
<td></td>
<td>• Relative Standard Curve</td>
</tr>
<tr>
<td></td>
<td>• Comparative C&lt;sub&gt;T&lt;/sub&gt; (ΔΔC&lt;sub&gt;T&lt;/sub&gt;)</td>
</tr>
<tr>
<td></td>
<td>• Genotyping</td>
</tr>
<tr>
<td></td>
<td>• Presence/ Absence</td>
</tr>
<tr>
<td></td>
<td>• Melt Curve</td>
</tr>
</tbody>
</table>

Note: The QuantStudio™ 6 and 7 Flex Software can accommodate other reagents, but performance claims have not been tested by Life Technologies.

Precautions while preparing reactions

• Do not prepare the reactions on a wet table. Wet surfaces lead to contamination of your reactions.
• Wear appropriate protective eyewear, clothing, and powder-free gloves.
• Use the appropriate consumables. The quality of pipettors and tips and the care used in measuring and mixing dilutions affect data accuracy.
• Perform dilutions exactly as instructed. Mistakes or inaccuracies in making the dilutions directly affect the quality of results.
• Use a permanent marker or pen to mark a tube and the side of a plate or array card. Do not use fluorescent markers.
• Ensure that the arrangement of the PCR reactions matches the plate layout displayed in the QuantStudio™ 6 and 7 Flex Software.

Materials required while preparing the dilutions

• DI water or DEPC water
• Microcentrifuge tubes
• Pipettors
• Pipette tips
• Vortex mixer
• Centrifuge
• Sample stock
Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments

Chapter 1  General Experiment Information and Instructions

Prepare reactions

• Standard stock
• Reaction mix components
• Plate or array card

Guidelines for preparing the dilutions, reaction mix, and plate

• Include excess volume in your calculations to provide excess volume for the loss that occurs during reagent transfers.
• Use TE buffer or water to dilute the standards and samples.
• Prepare the reagents according to the manufacturer’s instructions.
• Keep the dilutions and assay mix protected from light, in the freezer, until you are ready to use it. Excessive exposure to light may affect the fluorescent probes or dyes.
• Prior to use:
  – Mix the master mix thoroughly by swirling the bottle.
  – Resuspend the assay mix by vortexing, then centrifuge the tube briefly.
  – Thaw any frozen samples by placing them on ice. When thawed, resuspend the samples by vortexing, then centrifuge the tubes briefly.
• Do not allow the bottom of the reaction plate to become dirty. Fluids and other contaminants that adhere to the bottom of the reaction plate can contaminate the sample block(s) and cause an abnormally high background signal.

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Correct Image]</td>
<td>![Incorrect Images]</td>
</tr>
</tbody>
</table>

- Liquid is at the bottom of the well.
- Not centrifuged with enough force
  - Or
  - Not centrifuged for enough time

• Place the reaction plate or array card at 4°C and in the dark until you are ready to load it into the instrument.

Seal the reaction plate

If you use optical adhesive film to seal your reaction plates, seal each reaction plate as follows:

**Note:** The sealing instructions are applicable to 384-well and 96-well reaction plates.

1. Load the reaction plate using the plate layout described in “Assign targets, samples, and biological replicate groups” on page 16.
   **Note:** For 96-well reaction plates, place the reaction plate onto the center of the 96-well base, then perform this step. Ensure that the reaction plate is flush with the top surface of the 96-well base.

2. Remove a single optical adhesive film (film) from the box. Bend both end-tabs upward. Hold the film backing side up.
3. In one swift movement, peel back the white protective backing from the center sealing surface. Do not touch the center sealing surface.

**IMPORTANT!** Improper peeling of the optical adhesive film may result in haziness, but it will not affect results. Haziness disappears when the film comes into contact with the heated cover in the instrument.

4. Holding the film by the end-tabs, lower the film onto the reaction plate (adhesive side facing the reaction plate). Ensure that the film completely covers all wells of the reaction plate.

5. Applying firm pressure, move the applicator slowly across the film, horizontally and vertically, to ensure good contact between the film and the entire surface of the reaction plate.

6. Using the applicator to hold the edge of the film in place, grasp one end of the end-tab and pull up and away sharply. Repeat for the other end-tab.

**Note:** Ensure clean removal of both end-tabs from the dotted line. Improper peeling of the end-tab can cause sticking of plate on the heated cover assembly.

7. To ensure a tight, evaporation-free seal, repeat step 5. Applying firm pressure, run the edge of the applicator along all four sides of the outside border of the film.

**Note:** Optical adhesive films do not adhere on contact. The films require the application of pressure to ensure a tight, evaporation-free seal.
8. Inspect the reaction plate to ensure that all wells are sealed. You should see an imprint of all wells on the surface of the film. The perforated tab should be completely torn off to avoid plates from sticking to the instrument after a run.

**IMPORTANT!** Remove all excess adhesive from the perimeter of the optical adhesive cover. When the film is applied, the glue from the optical adhesive cover can adhere to the edges of the plate. If the excess glue is not removed, the plate may adhere to the sample block of the QuantStudio™ 6 or 7 Instrument.

**Fill and seal the array card**

**Fill and spin the array card**

**IMPORTANT!** Wear powder-free gloves while preparing the Arrays.

1. Remove an array card from its box and place it on a clean, dry surface.
2. Using a permanent marker, mark the side of the empty array cards.
3. Transfer the experiment-related chemistries and solutions into the port of the array card.
   For each transfer:
   a. Place the array card on a lab bench, with the foil side down.
   b. Load 100 μL of fluid into a pipette.
c. Hold the pipette in an angled position (~45 degrees) and place the tip into the fill port. The fill port is the larger of the two holes on the left side of the fill reservoir.

![Fill port and vent port diagram]

**IMPORTANT!** Do not allow the tip to contact and possibly damage the coated foil beneath the fill port.

4. Place the filled array card(s) into a centrifuge array card carrier clip and place empty array card(s) in the remaining slots. Confirm that the labels on the buckets and clips are oriented in the same direction.

![Filled array and empty array]

**IMPORTANT!** Balance the loads in opposite buckets in the centrifuge.

5. Place the filled carrier clips into the centrifuge buckets. Ensure that the array card fill reservoirs and bucket and clip labels face outward when loaded into the centrifuge. Balance the loads in opposite buckets.

**IMPORTANT!** You must run the centrifuge with all four buckets in place and each of the two carriers filled with the array card. Place empty array cards into unfilled slots.

6. Close the centrifuge cover, then spin the array card(s) for 1 minute at 1200 rpm.
7. When the run is finished, stop the centrifuge, then spin the array card(s) again for 1 minute at 1200 rpm.

**IMPORTANT!** Do not try to save time by doing one spin for 2 minutes. The two sets of ramps are important for a good fill into the array card.

8. When the second run is finished, open the centrifuge and check that the fluid levels in the reservoirs of each array card have decreased by the same amount. Also, check for the formation of bubbles in all wells and note possible problems.

9. If necessary, centrifuge the array card(s) for an additional minute to fill any unfilled wells. Do not exceed three 1-minute runs or centrifuge the array card for longer than 1 minute at a time.

*Note:* Contact Life Technologies for more information on loading an array card.

**Seal the array card(s)**

1. With the carriage (roller assembly) of the Array Card Staker/Sealer in the Start position, place a filled array card into the fixture with the foil side up so that the fill reservoirs are the farthest away from the carriage.

2. Press down on all four corners of the array card to ensure that it is fully seated within the fixture.

3. Use the two alignment pins in the fixture to position the array card correctly.
4. Seal the array card by running the carriage slowly over it. Run the carriage over the array card in one direction only. Do not apply downward force on the carriage as you move it forward over the card.

![Carriage over array card]

5. Remove the sealed array card from the fixture and trim the fill reservoirs from the array card assembly using scissors. Trim the foil array card so that the edge is even with the plastic carrier.

![Scissors trimming array card]

**IMPORTANT!** Completely remove the fill reservoirs from the array card so that the edge is free of residual plastic. The plastic from the fill reservoirs that extends beyond the edge of the card can prevent the card from seating properly on the sample block and affect amplification.

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Correct array card]</td>
<td>![Incorrect array card]</td>
</tr>
</tbody>
</table>

**IMPORTANT!** As you seal the remaining filled array cards, store them in a dark place until you are ready to use them. The fluorescent dyes in the array card are photosensitive. Prolonged exposure to light can diminish the fluorescence of the dye.

**WARNING!** Use the flat caps for the 0.2 mL tubes and 0.1 mL tubes. Rounded caps can damage the heated cover.

**Note:** Ensure that you secure the caps on the tubes and tube-strips tightly to avoid sample evaporation.
If you use the 96-well MicroAmp® Optical 8-Tube Strips or MicroAmp® Optical Tubes without Cap, use the MicroAmp® Cap Installing Tool and use the following instructions:

- Applying the MicroAmp® Optical 8-Cap Strip or MicroAmp® Optical Tubes without Cap to the tubes
- Removing a cap string from a plate

**Required materials:**
- MicroAmp® Cap Installing Tool
- MicroAmp® Optical 8-Tube Strips or MicroAmp® Optical Tubes without cap
- MicroAmp® Optical 8-Cap Strip

### Apply the MicroAmp® Optical 8-Cap Strip (flat)

1. Grasp the Cap Installing Tool so that the grooved side is exposed.
2. Hold the strip of caps over the tube strip or the row of tubes.
3. Use the grooved side (shown) of the Cap Installing Tool to push and seat each cap firmly in place. Use a rocking motion to properly seat each cap.

### Remove a cap string from a plate

The MicroAmp® Cap Installing Tool is also used for removing the MicroAmp® Optical 8-Cap Strip from the 96-well optical plates and tray/retainer assemblies. To remove the cap or cap strip:
1. Insert the small protrusions on the side of the Cap Installing Tool under the webbing between the caps on a cap strip.

2. Slowly pry the strip from the plate or Tray/Retainer assembly.

Start the experiment

To start an experiment:

1. Prepare the instrument for use as shown below.
2. Load the reaction plate or array card into the instrument, as shown on page 33.
3. Run the experiment as shown on page 34.

Prepare the instrument for use

Start the QuantStudio™ 6 or 7 Instrument

1. Touch anywhere on the touchscreen to determine if the QuantStudio™ 6 or 7 Instrument is in standby mode.
   Does the touchscreen display the Standby screen after you touch it?
   - Yes – The instrument is ready for use. Go to step 3 below.
   - No – Go to step 2 to power on the instrument.

2. Toggle the power button on the rear of the QuantStudio™ 6 or 7 Instrument, then wait for it to start.

   The QuantStudio™ 6 or 7 Instrument is ready to use when the touchscreen displays the Main Menu.

3. Power on the monitor.

4. Power on the computer:
Chapter 1  General Experiment Information and Instructions

Start the experiment

1. Press the computer power button, then wait for it to start.

2. When the Login screen appears, enter your user name and password, then click OK.

5. Start the QuantStudio™ 6 and 7 Flex Software:

   a. From the desktop, double-click QuantStudio™ 6 and 7 Flex Software.

      Note: If the shortcut is not present on the desktop, select Start ➤ All Programs ➤ Applied Biosystems ➤ QuantStudio™ 6 and 7 Flex Software ➤ QuantStudio™ 6 and 7 Flex Software to start the software.

      IMPORTANT! If the QuantStudio™ 6 and 7 Flex Software will not start, confirm that no other instances of the instrument control software are open. If any instance of the software is open, close it before starting the QuantStudio™ 6 and 7 Flex Software.

   b. From the Login dialog box, enter your user name and password, then click Log In.

      ![Login dialog box]

      Note: If the QuantStudio™ 6 and 7 Flex Software displays the License Central screen after you log into the software, your license file may be corrupt. Contact Life Technologies support to obtain a replacement license file.

Add the instrument to the My Instruments group

Before you can use the QuantStudio™ 6 or 7 Instrument, you must add the instrument to the “My Instruments” group in the QuantStudio™ 6 and 7 Flex Software.

1. Power on the instrument and start the software as explained in “Start the QuantStudio™ 6 or 7 Instrument” on page 30.

2. From the QuantStudio™ 6 and 7 Flex Software Home tab, click Instrument Console.

3. From the Instrument Console, confirm the instrument state:

   a. Confirm that the instrument icon appears in the My Instruments group.
b. Confirm that a green check box appears in the upper-right corner of the instrument icon.

4. If your instrument does not appear within the My Instruments group, add it as follows:
   a. From the Instrument Console, select your QuantStudio™ 6 or 7 Instrument from the list of instruments on the network.
   b. Click Add to My Instruments.

Note: The details for a QuantStudio™ 6 or 7 Instrument in the My Preferred list can be exported even if the network connection has been interrupted. The exported details from the disconnected instrument would contain the data most recently downloaded from the instrument before the interruption.

Enable or change the Notification Settings

You can configure the QuantStudio™ 6 and 7 Flex Software to alert you by email when the QuantStudio™ 6 or 7 Instrument begins and completes a run, or if an error occurs during a run.

Note: For details on using the Notification Settings feature, refer to the instrument user guide.
CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100°C. Keep your hands away until the sample block(s) reaches room temperature.

IMPORTANT! Wear powder-free gloves when you handle the reaction plate or array card.

IMPORTANT! Plates and array cards should be loaded and unloaded by operators who have been warned of the moving parts hazard and have been adequately trained.

1. Eject the QuantStudio™ 6 or 7 Instrument tray by doing either of the following:
   - From the QuantStudio™ 6 or 7 Instrument touchscreen, touch.
   - From the QuantStudio™ 6 and 7 Flex Software, select Instrument
     Instrument Console, select your instrument icon, then click Open Door.

2. Load the reaction plate or array card into the plate adapter. When you load the reaction plate or array card, ensure that:
   - Well A1 is positioned at the top-left of the tray for any of the plate formats.
   - The barcode (for any of the plate formats) is facing the front of the instrument.
   - If using reaction tubes or tube strips, make sure you use adaptors. The adaptors are attached to the plate transport arm. The tray containing the tubes or tube strips must be placed on the adaptor and not into the sample block directly.

   IMPORTANT! For optimal performance with partial loads, load at least 16 tubes in one of the following arrangements. You can load empty tubes if you do not have enough reaction volume to load the required number of tubes:
   - Adjacent columns of 8 tubes, using rows A through H. For example, use wells in columns 6 and 7 (rows A through H).
   - Or
   - Adjacent rows of 8 tubes, using columns 3 through 10. For example, use wells in row D (columns 3 through 10) and row E (columns 3 through 10).

3. Close the QuantStudio™ 6 or 7 Instrument tray by doing either of the following:
   - From the instrument touchscreen, touch.
   - From the Instrument Console screen, click Close Door.
Start the experiment

**IMPORTANT!** Ensure that instrument calibration is up-to-date. If a calibration has expired, you will get a warning when you start a run. For information on calibrating the QuantStudio™ 6 or 7 Instrument, refer to instrument user guide.

**IMPORTANT!** Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 6 or 7 Instrument is in operation.

**Note:** Ensure each experiment name is unique. If you have named two different experiments with the same name, you cannot run them on the same instrument. You will receive the following error message when attempting to start the run:

If you do not want to delete the existing experiment, rename the duplicate experiment and then proceed to the run.

You can run the experiment in either of the following two ways:

- Start the experiment from the QuantStudio™ 6 and 7 Flex Software
- Start the experiment from the QuantStudio™ 6 or 7 Instrument touchscreen

**Note:** The example experiments in each of the getting started guide booklets start a run from the QuantStudio™ 6 and 7 Flex Software.

**Start the experiment from the QuantStudio™ 6 and 7 Flex Software**

1. In the QuantStudio™ 6 and 7 Flex Software, click Run in the navigation pane.

   **IMPORTANT!** Ensure that the *.eds file you created is open before you start a run.

2. Click **START RUN**. Select the instrument for the run from the My Instruments drop-down menu.

   **IMPORTANT!** If the preferred instrument for running the experiment is not present under My Instruments or the custom group, or if it is unavailable, clicking START RUN does not display instrument names in the drop-down menu. See “Add the instrument to the My Instruments group” on page 31 for instructions on adding an instrument to the My Instruments group.
Start the experiment from the QuantStudio™ 6 or 7 Instrument touchscreen

1. Touch the QuantStudio™ 6 or 7 Instrument touchscreen to awaken it.
   Note: If the touchscreen is not at the Main Menu screen, touch .
2. In the Main Menu screen, touch Browse Experiments.
3. In the Browse screen, touch Folders, to display the folders containing the experiment setup files.
4. Touch any of the folder names to display the experiments in that folder.
   Note: You can create and save new experiments from the QuantStudio™ 6 or 7 Instrument touchscreen, or transfer experiments created and saved in the QuantStudio™ 6 and 7 Flex Software to folders in the QuantStudio™ 6 or 7 Instrument touchscreen via a USB flash drive.
5. In the Experiments screen, select the desired experiment, then: to view or edit the experiment before starting the run.
   • Touch View/Edit, then go to step 6 to view or edit the experiment before starting the run.
   • Touch Save and Start Run, then go to step 7 to start the run immediately.
6. (Optional) Modify the experiment parameters as needed.
   a. In the Edit Experiment screen, you can use the:
      • Add and Delete buttons to add and delete a stage or step to the thermal profile.
      • Add Melt Curve button to add a melt curve to the thermal profile.
      • Save button to save the experiment you modify.
   b. In the Save Experiment screen, touch each field to edit the:
      • Experiment name
      • Folder to save the experiment
      • Reaction volume
      • Barcode Number
      • Notes
      When finished, touch Save & Start Run to start the experiment.
7. In the Start Run screen, touch each field as needed to modify the associated parameter, then touch Start Run Now to start the experiment.

Monitor the experiment

Note: If the connection between the QuantStudio™ 6 and 7 Flex Software and the QuantStudio™ 6 or 7 Instrument is disrupted while running an experiment, remove and then add the instrument to the My Instruments list in the Instrument Console. You may then resume monitoring the experiment.
You can monitor an experiment run in three ways:

- From the Run screen of the QuantStudio™ 6 and 7 Flex Software, while the experiment is in progress, as shown below.
- From the Instrument Console of the QuantStudio™ 6 and 7 Flex Software (to monitor an experiment started from another computer or from the QuantStudio™ 6 or 7 Instrument touchscreen) as described in “From the QuantStudio™ 6 and 7 Flex Software Instrument Console” on page 36.
- From the QuantStudio™ 6 or 7 Instrument touchscreen, as described in “From the QuantStudio™ 6 or 7 Instrument touchscreen” on page 40.

**From the QuantStudio™ 6 and 7 Flex Software Run screen**

1. Click Amplification Plot from the Run Experiment Menu to monitor the amplification plot of the experiment you are running.

   **Note:** For Melt Curve experiments, click Melt Curve Plot from the Run Experiment Menu.

2. Click Temperature Plot from the Run Experiment Menu to monitor the temperature plot of the experiment you are running.

**From the QuantStudio™ 6 and 7 Flex Software Instrument Console**

1. In the Instrument Console screen, select the icon of the instrument that you are using to run the experiment.

2. Click Manage Instrument.


You can view the progress of the run in real time from the Run screen. During the run, periodically view the Amplification Plot, Temperature Plot and Run Method (see page 37, 38, and 38 respectively) available from the QuantStudio™ 6 and 7 Flex Software for potential problems.

<table>
<thead>
<tr>
<th>To…</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop the run</td>
<td>• In the QuantStudio™ 6 and 7 Flex Software, click <strong>STOP RUN</strong>.</td>
</tr>
<tr>
<td></td>
<td>• In the Stop Run dialog, click one of the following:</td>
</tr>
<tr>
<td></td>
<td>– <strong>Stop Immediately</strong> to stop the run immediately.</td>
</tr>
<tr>
<td></td>
<td>– <strong>Stop after Current Cycle/Hold</strong> to stop the run after the current cycle or hold.</td>
</tr>
<tr>
<td></td>
<td>– <strong>Cancel</strong> to continue the run.</td>
</tr>
<tr>
<td>View amplification data in real time</td>
<td>Select <strong>Amplification Plot</strong>. See “To monitor the Amplification Plot” on page 37.</td>
</tr>
<tr>
<td>View temperature data for the run in real time</td>
<td>Select <strong>Temperature Plot</strong>. See “To monitor the Temperature Plot” on page 38.</td>
</tr>
<tr>
<td>View progress of the run in the Run Method screen</td>
<td>Select <strong>Run Method</strong>. See “To monitor the Run Method” on page 38.</td>
</tr>
</tbody>
</table>
Chapter 1 General Experiment Information and Instructions

Start the experiment

Note: The individual experiment booklets provide illustrations of the different experiments in real time.

Note: For Melt Curve experiments, click Melt Curve Plot from the Run Experiment Menu.

The following is an image of the Run screen for a Standard Curve experiment:

To monitor the Amplification Plot

To view data in the Amplification Plot, click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab, then select the wells to view.

The Amplification Plot screen allows you to view sample amplification as your instrument collects fluorescence data during a run. If a method is set up to collect real-time data, the Amplification Plot screen displays the data for the wells selected in the Plate Layout tab. The plot contrasts normalized dye fluorescence (ΔRn) and cycle number.

The Amplification Plot screen is useful for identifying and examining abnormal amplification, including:

- Increased fluorescence in negative control wells.
- Absence of detectable fluorescence at an expected cycle (determined from previous similar experiments run using the same reagents under the same conditions).

Note: If you notice abnormal amplification or a complete absence of fluorescence, refer to the instrument user guide to troubleshoot the error.

<table>
<thead>
<tr>
<th>To...</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/disable the Notification Settings</td>
<td>Select or deselect Enable Notifications. See “Enable or change the Notification Settings” on page 32.</td>
</tr>
</tbody>
</table>

Note: Enable or change the Notification Settings on page 32.
To monitor the Temperature Plot

To view data in the Temperature Plot screen, click **Temperature Plot** from the Run Experiment Menu.

During a run, the Temperature Plot screen displays the temperatures of the sample block(s), the heated cover, and samples (calculated) in real-time.

<table>
<thead>
<tr>
<th>To...</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or remove temperature plots</td>
<td>Select <strong>Cover</strong> or <strong>Sample Block</strong> to view the presence of the associated data in the plot.</td>
</tr>
<tr>
<td>Change the time to display in the plot</td>
<td>From the <strong>View</strong> drop-down menu, select the amount of time to display in the plot.</td>
</tr>
</tbody>
</table>
| Display a fixed time window during the instrument run | Select **Fixed View**. If the entire plot does not fit in the screen, the screen is not updated as the run progresses. For example, if you select 10 minutes from the **View** drop-down menu, the plot will show data for 10 minutes. If the **Fixed View** is:  
  • Deselected, the plot updates as the run progresses even after 10 minutes.  
  • Selected, the plot does not update as the run progresses even after 10 minutes. |

The Temperature Plot screen can be useful for identifying hardware failures. When monitoring the Temperature Plot screen, observe the Sample and Block plots for abnormal behavior.

- The Sample and Block plots should mirror each other approximately. A significant deviation of the plots may indicate a problem.
- The Cover plot should maintain the constant temperature specified in the method. A departure from the constant temperature may indicate a problem.

**Note:** If you notice abnormal temperatures, refer to the instrument user guide to troubleshoot the error.

To monitor the Run Method

To view data in the Run Method screen, click **Run Method** from the Run Experiment Menu.

The Run Method screen displays the run method selected for the run in progress. The software updates the Run Status field throughout the run.

<table>
<thead>
<tr>
<th>To...</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the number of cycles</td>
<td>In the <strong>Adjust # of Cycles</strong> field, enter the number of cycles to apply to the Cycling Stage.</td>
</tr>
<tr>
<td>Add a melt curve stage to the end of the run</td>
<td>Select <strong>Add Melt Curve Stage to End</strong>.</td>
</tr>
<tr>
<td>Add a Hold stage to the end of the run</td>
<td>Select <strong>Add Holding Stage to End</strong>.</td>
</tr>
</tbody>
</table>
If an alert appears, click the error for more information and troubleshoot the problem as explained in the QuantStudio™ 6 and 7 Flex Software Help (click ? or press F1).

Editing the run method during a run

You can edit the run method while an experiment run is in progress on the Run Method screen from the Setup menu.

1. Increase or decrease the number of cycles by entering the cycle number in the Adjust # of Cycles box.

   **Note:** Ensure that you select the stage for which you want to increase or decrease the number of cycles in the graphical view of the run method. The Adjust # of Cycles box appears disabled if the corresponding stage is not selected.

2. Select the appropriate check box to add a melt curve stage, holding stage, or infinite hold stage respectively, to the end of the run.

3. Click Send to Instrument.
To view the run data

After a run is complete, you can view a run report by clicking View Run Data. The View Run Data screen displays information about the completed run, as in the following image from a Standard Curve experiment:

The run report data helps in:

- Comparing two experiments of the same type run on two different instruments.
- Troubleshooting. For example, after a firmware upgrade, you can compare an experiment run before and after the upgrade to determine if the upgrade affected performance.

From the QuantStudio™ 6 or 7 Instrument touchscreen

The touchscreen displays the method for the experiment, the date and time at which the run started, the time remaining in the run, and other information.

<table>
<thead>
<tr>
<th>To…</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the time elapsed and the time remaining in the run</td>
<td>Touch the Time View tab, then touch Experiment View tab to return to the Run Method screen.</td>
</tr>
<tr>
<td>Stop the run</td>
<td>Touch STOP to stop the protocol run immediately.</td>
</tr>
<tr>
<td>View the Events Log</td>
<td>Touch ☰ to view the list of run events that occurred during the run. Touch ☰ again to close the event list.</td>
</tr>
</tbody>
</table>

The run method on the QuantStudio™ 6 or 7 Instrument touchscreen looks like this:
Unloading the instrument

When your QuantStudio™ 6 or 7 Instrument displays the Main Menu screen, unload the reaction plate from the instrument and transfer the experiment data to the computer for analysis.

Unload the reaction plate or array card

**CAUTION! PHYSICAL INJURY HAZARD.** During instrument operation, the temperature of the sample block(s) can exceed 100°C. Allow the consumable to cool to room temperature before removing.
When the QuantStudio™ 6 or 7 Instrument displays the Main Menu screen, you can unload the plate or array card as follows:

1. After the run, touch ▶️ on the QuantStudio™ 6 or 7 Instrument touchscreen or click Open Door in the Instrument Console screen of the QuantStudio™ 6 and 7 Flex Software to eject the plate or array card.

2. Remove the reaction plate or array card from the instrument tray and dispose of it according to your laboratory regulations.

3. Touch ▶️ on the QuantStudio™ 6 or 7 Instrument touchscreen or click Close Door to retract the plate adapter back into the instrument.

If the QuantStudio™ 6 or 7 Instrument does not eject the plate, remove the plate as follows:

   a. Power off the QuantStudio™ 6 or 7 Instrument.
   b. Wait for 15 minutes, then power on the QuantStudio™ 6 or 7 Instrument and eject the plate.
   c. If the plate does not eject, power off and unplug the QuantStudio™ 6 or 7 Instrument, then open the access door.
   d. Wearing powder-free gloves, reach into the QuantStudio™ 6 or 7 Instrument and remove the plate from the heated cover, then close the access door.

You can transfer the experiment results in either of the following two ways:

**Download the experiment from the QuantStudio™ 6 or 7 Instrument over the network**

When the QuantStudio™ 6 or 7 Instrument completes an experiment without a connection to the QuantStudio™ 6 and 7 Flex Software, the software allows you to download the results from the instrument through the network connection.

1. In the QuantStudio™ 6 and 7 Flex Software, select Instrument ➔ Instrument Console.

2. Select the instrument icon of the QuantStudio™ 6 or 7 Instrument from the My Instruments list, then click Manage Instrument to open the Instrument Manager.

   **Note:** If the Manage Instrument button is inactive, add your QuantStudio™ 6 or 7 Instrument to the My Instruments group as explained in “Add the instrument to the My Instruments group” on page 26.

3. From the Instrument Manager, click Manage Files, then click File Manager.

4. From the File Manager screen, download the file(s):
   
   a. From the Folders field, select the folder that contains the files that you want to download.
   b. From the Experiments field, select the files to download. To select multiple files, Ctrl-click or Shift-click files in the list.
   c. From the Folders field, select the folder that contains the files that you want to download.

5. From the Save dialog box, select the folder to hold the experiment results and click Save. The experiments folder is located at:
Transfer the experiment from the QuantStudio™ 6 or 7 Instrument to the computer via a USB drive:

1. Plug a USB drive into the USB port below the touchscreen.

2. Touch the QuantStudio™ 6 or 7 Instrument touchscreen, to awaken it.

3. If the touchscreen is not at the Main Menu screen, touch .

4. From the Main Menu of the QuantStudio™ 6 or 7 Instrument touchscreen, touch to save the data to the USB drive.

5. Select one or multiple experiments (by touching them). Then touch to copy selected experiments to the USB drive.

   Note: If your instrument cannot find the USB drive, remove the USB drive, then try again. If the instrument still does not recognize the USB drive, try another USB drive.

6. Touch to return to the Main Menu.

7. Remove the USB drive from your instrument, then connect it to one of the USB ports on your computer.

8. In the computer desktop, use the Windows explorer to open the USB drive.

9. Copy the example experiment file to:
   
   C: \ Applied Biosystems \ QuantStudio 6 and 7 Flex Software \ User Files \ experiments
Review experiment results

About analysis results

Immediately after a run, the QuantStudio™ 6 and 7 Flex Software automatically analyzes the data using the default analysis settings, then displays the Amplification Plot screen.

**Note:** For auto-analysis of data, after a run, go to **Tools ➤ Preferences ➤ Experiment** and select the **Auto Analysis** check box.

To reanalyze the data, select all the wells in the plate layout, then click **Analyze**.

To override calibration

Each experiment file (.eds) stores the calibration data from the QuantStudio™ 6 or 7 Instrument it was run on. The calibration data can affect the analysis results of an experiment.

If you have run multiple experiments on different QuantStudio™ 6 or 7 Instruments and prefer the analysis results from a particular instrument, then you can choose to use the calibration data from another QuantStudio™ 6 or 7 Instrument.

**To use the calibration data of another experiment**

1. Open the experiment file (.eds), in which you want to import the calibration data from another QuantStudio™ 6 or 7 Instrument, in the QuantStudio™ 6 and 7 Flex Software.

2. Go to **Analysis ➤ Override Calibration ➤ Use Calibration From Another File**.

3. Browse to experiment file (.eds) from which you want to use the calibration data.

   **Note:** You can choose to override the calibration data in an experiment with the calibration data of any other experiment type; however the calibration data being used must be from the same instrument type, QuantStudio™ 6 Instrument or the QuantStudio™ 7 Instrument. Calibration data from an experiment in the QuantStudio™ 7 Instrument can be used to override calibration data of an experiment in the QuantStudio™ 6 Instrument, but not vice-versa.

4. Click **Open**.

**To revert to the original calibration data**

1. Open the experiment file (.eds), in which you want to import the original calibration data, in the QuantStudio™ 6 and 7 Flex Software.

2. Go to **Analysis ➤ Override Calibration ➤ Revert To Original Calibration**.
The experiment file will display analysis results as per the calibration data of the QuantStudio™ 6 or 7 Instrument that the experiment was run on.

To display wells

To display specific wells in the analysis plots, select the wells in the Plate Layout tab:

- To select wells of a specific type, use the Select Wells With drop-down menus:
  Select **Sample, Target, or Task**, then select the sample, target, or task name.
- To select a single well, click the well in the plate layout.
- To select multiple wells, click and drag over the desired wells, press **Ctrl-click**, or press **Shift-click** in the plate layout.
- To select all the wells, click the upper left corner of the plate layout.

The following is an image of the plate layout for a Standard Curve experiment:

To display multiple plots

Use the Multiple Plots View screen to display up to four plots simultaneously. To navigate within the Multiple Plots View screen, from the Experiment Menu pane, select **Analysis ▶ Multiple Plots View**.

- To display four plots, click **Show plots in a 2×2 matrix**.
- Similarly, to display two plots in rows, click **Show plots in two rows** and to display two plots vertically, click **Show plots in two columns**.
- To display a specific plot, select the plot from the drop-down menu above each plot display.
Chapter 1 General Experiment Information and Instructions
Review experiment results

The following is an image of the Multiple Plots View screen for a Standard Curve example experiment:

To display an expanded view of a plot or wells
• Click to expand the view of a plot, displayed on the left-hand side of the screen.
• Click to expand the view of the Plate Layout or Well Table displayed on the right-hand side of the screen.

To edit plot properties
Use the Plot Properties dialog box on the Analysis screen to edit plot settings such as the font and color of the plot text, and the labels on the X axis and Y Axis.

1. Click on the Analyze screen (the icon appears above the plot) to open the Plot Properties dialog box.

2. Edit the settings under the General, X Axis, and Y Axis tab.
   • Click the General tab to edit the plot title text, font, or color. You can also select whether to show the plot title.
   • Click the X Axis tab to edit the x axis label text, font, or color; select the tick marks and tick mark labels to display; and select the range to display.
   • Click the Y Axis tab to edit the y axis label text, font, or color; select the tick marks and tick mark labels to display; and select the range to display.

3. Click OK.
To save current settings as default

You can change the Plot Settings for the different analysis plots, and save them as defaults.

Select the Save current settings as the default check box on the respective plot screens under the Analysis Experiment Menu.

To publish the analyzed data

<table>
<thead>
<tr>
<th>To...</th>
<th>Click</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save a plot as an image file</td>
<td>![Image Icon]</td>
</tr>
<tr>
<td>Print a plot</td>
<td>![Print Icon]</td>
</tr>
<tr>
<td>Copy a plot to the clipboard</td>
<td>![Copy Icon]</td>
</tr>
<tr>
<td>Print a report</td>
<td>![Print Report Icon]</td>
</tr>
<tr>
<td>Export data</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To...</th>
<th>Go to</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print the plate layout</td>
<td>File ▶ Print...</td>
<td>Select the background color, and click <strong>Print</strong></td>
</tr>
<tr>
<td>Create slides</td>
<td>File ▶ Send to PowerPoint...</td>
<td>Select the slides for your presentation, and click <strong>Create Slides</strong></td>
</tr>
<tr>
<td>Print a report</td>
<td>File ▶ Print Report...</td>
<td>Select data for the report, and click <strong>Print Report</strong></td>
</tr>
</tbody>
</table>

Export an experiment

About exporting an experiment

The Export feature of QuantStudio™ 6 and 7 Flex Software allows you to export:

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate setup files for future experiments</td>
<td>Plate setup files contain setup information such as the well number, sample name, sample color, target name, dyes, and other reaction plate contents.</td>
</tr>
</tbody>
</table>
Export an experiment

Export procedure

1. Open the experiment file that contains the data to export, and from the Experiment Menu, click Export.

   Note: If you want the data to be exported automatically after analysis, select the Auto Export check box during experiment setup or before running an experiment.

2. Select the format for exported data:
   - QuantStudio™ 6 and 7 Format - Supports .txt, .xls, and .xlsx data.
   - QuantStudio™ Dx/ ViiA™ 7 Format - Supports .txt, .xls, and .xlsx data.
   - 7900 Format - Supports only .txt data, where:
     - Single experiments are exported in the SDS 2.4 detector centric export format of the 7900 Sequence Detection System.
     - Studies are exported in the SDS 2.3 RQ manager detector centric export format of the 7900 Sequence Detection System.
   - RDML Format - RDML (Real Time Data Markup Language) - Supports only .xml type of data.

### Data type | Description
--- | ---
Analyzed data in different formats for further analysis | The data can be exported in the QuantStudio™ 6 and 7 format, QuantStudio™ Dx/ ViiA™ 7 format, the 7900 SDS format, and the RDML format.
  - The 7900 format is applicable only to Standard Curve, Relative Standard Curve, Genotyping, Presence/Absence, and Melt Curve experiments.
  - The RDML export format is applicable only to Standard Curve, Relative Standard Curve, Comparative Ct, and Melt Curve experiments. The RDML format is available only in a single file format.
  - For Standard Curve experiments, you can also export the analyzed data from the QuantStudio™ 6 and 7 Flex Software to the external applications, TaqMan® Protein Expression Data Analysis Software and CopyCaller® Software if they are installed on your computer before the QuantStudio™ 6 and 7 Flex Software is installed. The applications appear in the Tools menu.
Gene Expression studies | These are used to carry out a comparative analysis.
3. Select to export all data in one file or in separate files for each data type.
   - **One File** - All data types are exported in one file.
     - If you select the *.xls format, a worksheet is created for each data type.
     - If you select the *.txt format, the data are grouped by data type.
   - **Separate Files** - Each data type is exported in a separate file. For example, if you select three different data types Results, Amplification, and Multicomponent to export, three separate files (one each for Results, Amplification, and Multicomponent) are created. You can select the type of file (*.xls, *.xlsx or *.txt) to export from the File Type drop-down menu.
     
     **Note:** You cannot use an exported *.xls or an *.xlsx file when importing plate setup information.

4. *(Optional)* Select the **Open file(s) when export is complete** check box to automatically open the file when export is complete.

5. Enter a file name and location.
   a. Enter a name for the export file in the **Export File Name** field.
   b. Enter the **Export File Location**. Click **Browse** if you do not want to save the export file in the default export folder.

   **Note:** To set up the Export File Location, go to **Tools ▶ Preferences**, and select the **Export** tab. You can select the **Use Last File Location** or **Use Default Folder** check box.

6. Select the data to export:

<table>
<thead>
<tr>
<th>Select...</th>
<th>To export...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample setup</td>
<td>Well, sample name, sample color, and target name of samples in the plate</td>
</tr>
<tr>
<td>Raw data</td>
<td>Raw fluorescence data for each filter, for each cycle</td>
</tr>
<tr>
<td>Amplification data</td>
<td>Amplification results, such as $C_T$ values, Rn, or $\Delta Rn$</td>
</tr>
</tbody>
</table>
### Export an experiment

**Exporting data**

<table>
<thead>
<tr>
<th>Select...</th>
<th>To export...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multicomponent data</td>
<td>Fluorescence data for each dye, for each cycle</td>
</tr>
<tr>
<td>Results</td>
<td>Results information, such as C&lt;sub&gt;T&lt;/sub&gt; values, Rn, or calls</td>
</tr>
<tr>
<td>Technical Replicate Results (Tech. Rep. Results)</td>
<td>Technical replicates information, such as Sample name, Target name, Task, or RQ</td>
</tr>
<tr>
<td>Biological Replicate Results (Bio. Rep. Results)</td>
<td>Biological replicates information, such as Biogroup name, Target name, Task, or RQ</td>
</tr>
<tr>
<td>Clipped Data</td>
<td>Information that is unique to the 7900 format. Data from the last three raw data points per step (clipped from the rest). The three data points are averaged to give you the final fluorescence data value for each step.</td>
</tr>
<tr>
<td>Reagent Information</td>
<td>Information about the reagent selected for the experiment</td>
</tr>
</tbody>
</table>

**Note:** Results data are not available for export until the run status is complete and the data are analyzed.

**Note:** The Technical Replicate Results, Biological Replicates Results, and Clipped Data are available only in Relative Standard Curve and Comparative C<sub>T</sub> experiments.

7. *(Optional)* For Standard Curve experiments, select the external application, **TaqMan<sup>®</sup> Protein Expression Data Analysis Software** or **CopyCaller<sup>®</sup> Software** if either Software is installed on your computer.

**Note:** For more information on the TaqMan<sup>®</sup> Protein Expression Data Analysis Software or CopyCaller<sup>®</sup> Software, contact Life Technologies.

8. *(Optional)* After you have defined the export properties or after moving the table headings order, you can save those export settings as an export set by clicking **Save Export Set As**. Later you can import the heading order into another file by clicking **Load Export Set**.

**Note:** It is advisable to keep the default order of the table headings if you are using the external Life Technologies applications, **TaqMan<sup>®</sup> Protein Expression Data Analysis Software** or **CopyCaller<sup>®</sup> Software** for further analysis.

9. Click **Start Export**.
The following is an image of the Export screen for a Standard Curve experiment:

The following is an image of the exported file when opened in Notepad:
Experiment Shortcuts

This chapter provides you with shortcuts to use in the QuantStudio™ 6 and 7 Flex Software after you have learned experiment basics.

You can reuse experiment settings and plate setup information by: directly importing and editing a template, using the QuickStart feature with a template, importing experiment setup information, or importing a sample definition file; you can also prepare several experiments at once or create a new experiment using the ReadiApp feature.

The chapter covers:

- Using experiment templates .................................................. 53
- Run an experiment with QuickStart ........................................ 57
- Import plate setup for an experiment ...................................... 58
- Import sample information ..................................................... 59
- Create an experiment using ReadiApp ...................................... 62

Using experiment templates

You can use a template (.edt) to create a new experiment. Templates are useful when you want to create many experiments with the same experiment parameters.

You can create an experiment from a template from the QuantStudio™ 6 and 7 Flex Software and from the QuantStudio™ 6 or 7 Instrument touchscreen.

Note: To access the QuantStudio™ 6 and 7 Flex Software example templates, navigate to the templates folder located at `<drive>`:\Program Files\Applied Biosystems\QuantStudio 6 and 7 Flex Software\examples\User Sample Files.

where, `<drive>` is the computer hard drive on which the QuantStudio™ 6 and 7 Flex Software is installed. The default installation drive for the software is the C: drive.

To create a template

1. Log in to the QuantStudio™ 6 and 7 Flex Software and, from the Home screen, open an existing experiment, or create a new experiment.

   Note: To create a new experiment using the Experiment Setup, see “Set up an experiment” on page 12.

2. Select File ▶ Save As Template.

   Note: The information saved in a template includes plate setup information (defined targets and samples, plate assignment of targets and samples), reagent information, thermal protocol, and analysis settings such as quantification cycling method.

3. Enter a file name, select a location for the template, then click Save and ☑ Close. You can use that experiment as a template for similar experiments.
To create a new experiment using a template

1. From the Home screen, click **Template**.

2. Locate and select the template file, then click **Open**.
   A new experiment is created using the setup information from the template.

3. Confirm that the following are correct before you prepare the reactions and run the experiment:
   - Experiment properties (experiment name, experiment type, block type, reagent, run properties)
   - Plate definitions (targets, samples, and biological replicates)
   - Plate assignments (targets, samples, and biological replicates)
   - Run method (thermal protocol)

4. Proceed to preparing reactions, running the experiment, and analyzing the data.

You can run experiments using templates from the QuantStudio™ 6 or 7 Instrument touchscreen by importing the templates from the QuantStudio™ 6 and 7 Flex Software instrument console or a USB drive. You can also modify the experiment parameters in the templates as per your requirement.

To edit a template before running the experiment

1. Touch **New** on the View Templates screen to create a new experiment from the existing template.
   **Note:** Select a template before you touch **New**.

2. Edit the experiment parameters in the Create New Experiment screen.

3. Touch **Save & Exit** to save and exit the experiment or touch **Save & Start Run** to save and start an experiment run.

To run a pre-existing template

1. Touch **View Templates** on the Home screen of the QuantStudio™ 6 or 7 Instrument touchscreen.

2. Select a pre-existing template from the templates list on the View Templates screen.

3. Touch **View** to see the run profile before you start a run.

4. After confirming the template setup is correct, touch **View** to go back to View Templates screen. Touch **Start Run**.
Use a template to create a batch of experiments

Use the batch experiment utility to create multiple experiment files from the same template without using Experiment Setup.

1. In the menu bar, select **Tools → Batch Experiment Setup**. The following is an image of the Batch Experiment Setup Utility dialog box:

![Batch Experiment Setup Utility](image)

2. Select the file(s) to use to create the new experiments:
   a. Click **Browse** in the Experiment Template File field.
      
      **Note:** To use one of the example setup files, browse to `<drive>:\Program Files\Applied Biosystems\QuantStudio 6 and 7 Flex Software\examples\User Sample Files`

   b. Locate an *.edt file to import, then click **Select**.

   c. *(Optional)* Repeat steps 2a and 2b for the remaining setup file types to import (Assay Information File (*.txt or *.xml), Plate Setup File (*.txt)).
3. Select the option to create experiment files. The selected option determines the number of experiment files created:
   - **Specify Number of Files** - Enter a number from 1 to 100.
   - **Barcode** - Click **Browse** and select a Barcode File (*.txt) to import. The software automatically adds the Plate Barcode attribute to the file name format. The number of experiments created equals the number of barcodes present in the barcode file.

   **Note:** A Barcode File contains one barcode per line. An example Barcode File looks like the following image:

   ![Barcode Example](image)

4. **(Optional)** Edit the file name format. Use the File Name Preview to verify your settings.
   - Select the check box to include or exclude the **Custom Name Field** attribute from the file name. If included, click the Custom Name Field and enter up to 100 letters and/or numbers to identify the batch of experiments.

   **Note:** The file name can contain a total of 100 characters, including all file name attributes.

   - Click **Move Up** or **Move Down** to change the order of the selected file name attributes.

5. Select the location for the experiment files to be created:
   a. Click **Browse** in the Export Setup Files to: field.
   b. Review the location for the experiment files. Navigate to a new location if you do not want to export the experiment files to that folder, then click **Select**.

6. Click **Create Experiments**. A confirmation message appears when the batch of experiments has been created.
Run an experiment with QuickStart

You can use a template to run an experiment with the QuantStudio™ 6 and 7 Flex Software QuickStart feature:

QuickStart from the QuantStudio™ 6 and 7 Flex Software

1. Prepare the reactions.
2. Log in to the QuantStudio™ 6 and 7 Flex Software and, from the Home screen, click QuickStart to access the QuickStart dialog box.
3. In the QuickStart dialog box, enter or select the:
   a. Instrument icon of the instrument to perform the run on.
   b. Experiment name.
   c. Experiment template file.
   d. (Optional) Barcode and User Name for the experiment.
4. (Optional) To review the experiment or to make changes to any of the experiment parameters, click Experiment Setup.
   The following is an image of the QuickStart dialog box:

   ![QuickStart dialog box]

5. Proceed to running the experiment and analyzing the data.
QuickStart from the QuantStudio™ 6 or 7 Instrument touchscreen

You can QuickStart an experiment from the QuantStudio™ 6 or 7 Instrument touchscreen in the following ways:

- Start an experiment using a pre-defined template.
- Start an experiment with a pre-defined short-cut button.

Start an experiment using a pre-defined template

You can use a pre-existing template from the default experiments folder or use a custom template from another folder to start a run.

Start an experiment with a pre-defined short-cut button

The QuantStudio™ 6 or 7 Instrument touchscreen displays up to 18 shortcut buttons to templates or folders that contain experiments to be run. The shortcut buttons are present under MY SHORTCUTS on the Home screen. To start a run, touch any of the pre-defined experiment or folder buttons.

To create a shortcut button for a preferred experiment or a folder that contains experiments:

1. Touch Settings to open the Settings Menu.
2. Touch Set Up Shortcuts to list the Shortcut Targets.
3. On the Shortcut Targets list screen, select an existing template Shortcut Target button or an unused button.
4. Touch Set Shortcut. If you selected an unused button, then touching Set Shortcut will list out the templates and folders to set the shortcut for.
5. Under the From Templates tab, select the templates for which you are creating the shortcut button.
6. (Optional) Create a shortcut button to show the templates or experiments in a particular folder for quick access, from those listed under the From Folders tab. You can touch Edit to create or edit shortcut buttons.

Import experiment setup

Import plate setup for an experiment

You can import the plate setup for a new experiment from an exported file with one of the following formats:

- *.txt - Text format
- *.xml - XML format
- *.csv - Comma separated values format
- *.eds - EDS file format
- *.edt - EDS template files format
- *.sdt - Sequence Detection System (SDS) template files format
- *.sds - 7900 v2.4 format

IMPORTANT! Make sure the file you select contains only plate setup data and that the experiment types match.
**Note:** For instructions on exporting an experiment, see “Export an experiment” on page 47.

To Import the plate setup data:

1. Create a new experiment or open an existing experiment.
2. In the Experiment Setup screen, select File ▶ Import Plate Setup or access the Import drop-down menu in the toolbar and select Import Plate Setup.
3. Click Browse, locate and select the file to import, then click Select.
   **Note:** To use one of the example setup files, browse to C:\Program Files\Applied Biosystems\QuantStudio 6 and 7 Flex Software\examples\User Sample Files
4. Click Start Import. The setup data from the exported text file is imported into the open experiment.
   **Note:** If your experiment already contains plate setup information, the software asks if you want to replace the plate setup with the data from the import file. Click Yes to replace the plate setup.
5. After importing plate setup information, use Experiment Setup to set up your experiment, and then run the experiment.
   **Note:** You can import plate setup information from a 96-well plate into a 384-well plate, provided that the file you are importing the information from is a .txt file.

**Import sample information**

You can import sample information from a sample definition file to include in the plate setup for your experiment. A sample definition file is a comma-delimited file (*.csv) or a tab-delimited text file (*.txt) that contains the following setup information: well number, sample name, and custom sample properties.

**Note:** Make sure that the sample definition file you select contains only sample information.

**Create a sample definition file**

1. Open a text editing program such as Notepad.
2. Enter the following column headers in the first row (press the Tab key between each entry if you are saving the file as *.txt or enter a comma between each entry if you are saving the file as *.csv):
   - Well
   - Sample Name
   - (Optional) Column header names for up to 32 user-defined custom fields (for example, Custom 1, Custom 2, etc.)
3. For each subsequent row, enter the well number, press the Tab key or enter a comma, then enter the sample name. Optionally, press the Tab key, then enter the custom properties for the sample.

4. Save the file with the .txt or .csv file extension.

An example sample definition, saved with the .csv extension, file looks like this:

<p>| | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Sample 1</td>
<td>1</td>
<td>22</td>
<td>Female</td>
<td>25</td>
<td>black</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Sample 2</td>
<td>2</td>
<td>26</td>
<td>Male</td>
<td>26</td>
<td>brown</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Sample 3</td>
<td>3</td>
<td>45</td>
<td>Female</td>
<td>50</td>
<td>blonde</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>Sample 4</td>
<td>4</td>
<td>31</td>
<td>Male</td>
<td>33</td>
<td>red</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>Sample 5</td>
<td>5</td>
<td>29</td>
<td>Female</td>
<td>45</td>
<td>grey</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>Sample 6</td>
<td>6</td>
<td>36</td>
<td>Male</td>
<td>36</td>
<td>black</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>Sample 7</td>
<td>7</td>
<td>31</td>
<td>Female</td>
<td>33</td>
<td>black</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>Sample 8</td>
<td>8</td>
<td>32</td>
<td>Male</td>
<td>67</td>
<td>black</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>Sample 9</td>
<td>9</td>
<td>33</td>
<td>Female</td>
<td>55</td>
<td>brown</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>Sample 10</td>
<td>10</td>
<td>33</td>
<td>Male</td>
<td>44</td>
<td>blonde</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>Sample 11</td>
<td>11</td>
<td>34</td>
<td>Female</td>
<td>26</td>
<td>red</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>Sample 12</td>
<td>12</td>
<td>34</td>
<td>Male</td>
<td>26</td>
<td>grey</td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>Sample 13</td>
<td>13</td>
<td>35</td>
<td>Female</td>
<td>50</td>
<td>black</td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>Sample 14</td>
<td>14</td>
<td>36</td>
<td>Male</td>
<td>33</td>
<td>black</td>
</tr>
<tr>
<td>16</td>
<td></td>
<td>Sample 15</td>
<td>15</td>
<td>36</td>
<td>Female</td>
<td>46</td>
<td>black</td>
</tr>
<tr>
<td>17</td>
<td></td>
<td>Sample 16</td>
<td>16</td>
<td>36</td>
<td>Male</td>
<td>36</td>
<td>brown</td>
</tr>
<tr>
<td>18</td>
<td></td>
<td>Sample 17</td>
<td>17</td>
<td>37</td>
<td>Female</td>
<td>33</td>
<td>blonde</td>
</tr>
<tr>
<td>19</td>
<td></td>
<td>Sample 18</td>
<td>18</td>
<td>37</td>
<td>Male</td>
<td>67</td>
<td>red</td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>Sample 19</td>
<td>19</td>
<td>36</td>
<td>Female</td>
<td>55</td>
<td>grey</td>
</tr>
<tr>
<td>21</td>
<td></td>
<td>Sample 20</td>
<td>20</td>
<td>36</td>
<td>Male</td>
<td>44</td>
<td>black</td>
</tr>
</tbody>
</table>

**Import sample information from a sample definition file**

1. Create a new experiment or open the experiment to receive the setup data (select File ➤ Open, select the file to open, then click Open).

2. From the open experiment, select File ➤ Import Plate Setup.

3. Click Browse to browse your computer for a sample definition text file (*.csv). After you locate the file and select it, click Select.

   **Note:** To use one of the example setup files, browse to `C:\Program Files\Applied Biosystems\QuantStudio 6 and 7 Flex Software\examples\User Sample Files`

4. Click Start Import.

5. If your experiment already contains plate setup information, the software asks you if you want to replace the plate setup with the data from the file. Click Yes to replace the plate setup information.

The samples appear in the Samples table for the experiment. All samples and well assignments in the experiment are replaced with those in the file. If defined, the custom sample properties also appear in the Well Table of the Analysis Section, and also in the Plate Layout tooltips in both the Setup and Analysis screens. The custom fields can be exported with the results data.

**Note:** You cannot edit the custom sample properties from within the Well Table. To modify this information, edit the custom fields in the sample definition file and import the file again. All of the sample information in the experiment is replaced with the information in the new file.
The following is an image of the Assign screen with information from the above sample definition file:

The following is an image of the Well Table in the Analysis section:
Create an experiment using ReadiApp

You can use the ReadiApp feature to set up an experiment in the QuantStudio™ 6 and 7 Flex Software. The ReadiApp feature provides a shortcut to create experiments for the assays purchased from Life Technologies.

The default ReadiApp templates available in the QuantStudio™ 6 and 7 Flex Software include:

- TaqMan® Gene Signature Array Cards
- Custom TaqMan® Array Cards
- TaqMan® Gene Expression Assays
- TaqMan® Drug Metabolism Assays
- TaqMan® Array MicroRNA Cards
- TaqMan® Copy Number Assays (CNV)
- TaqMan® SNP Genotyping Assays

1. Log in to the QuantStudio™ 6 and 7 Flex Software and, from the Set Up menu on the Home screen, click ReadiApp.

2. Click the assay to use to set up an experiment.
   
   **Note:** Click Cancel to exit the ReadiApp dialog box.

3. A new experiment is created using the setup information from the template.

4. (Optional) Edit the experiment properties.

4. Proceed to preparing reactions, running the experiment, and analyzing the data.
Numerics

7900 Format 48

A
array card, filling and sealing 25
assigning targets, samples, and biological replicate groups 16, 19
auto-analysis 44

B
batch experiment utility 55
batch of experiments, from template 55
biological replicates
assigning 17, 19
defining 15
block type
384-Well Block 12
96-Well Block (0.2mL) 13
Array Card Block 12
Fast 96-Well Block (0.1mL) 13

column in .xls file
Well Number 19
Well Position 19
comma delimited file 59
custom task name, defining 16

data collection options, settings
Amplification 13
Post-PCR Read 13
Pre-PCR Read 13
default reporter 15
default run method 20
defining custom task name 16
defining instrument run properties 13
defining run method 20
defining targets, samples, and biological replicates 15
dilutions
 guidelines for preparing 23
 materials for preparing 22

E
entering reagent information 14

experiment
exporting 47
preparing reactions 22
reviewing results 44
setting up 12
shortcuts 53
start 34
starting 30
experiment name 12
experiment properties, defining 12
experiment setup, import 58
experiment templates, using 53
experiment type
Comparative CT (ΔΔCT) 13
Genotyping 13
Melt Curve 13
Presence/Absence 13
Relative Standard Curve 13
Standard Curve 13
experiment, starting 34
export data type
Amplification data 49
Biological Replicate Results (Bio. Rep. Results) 50
Clipped Data 50
Multicomponent data 50
Raw data 49
reagent information 50
Results 50
Sample setup 49
Technical Replicate Results (Tech. Rep. Results) 50
exporting
exporting experiments 47
saving export data as 50
selecting export data 49

H
heated cover 38

I
import experiment setup 58
importing experiment data
plate setup 58
sample information 59
installation CD 6
instrument
adding to My Instruments 31
preparation for use  30
preparing for use  30
instrument run properties, defining  13
instrument type
  QuantStudio 6 Flex System  12
  QuantStudio 7 Flex System  12
instrument, starting  30

M
materials for dilutions
  master mix  23
melt curve  13
monitoring the experiment  35
multiple plots, displaying  45
My Instruments group  31

N
notification settings, enable or change  32
NULL, values in well assignments  19

O
optical adhesive film  23
overriding calibration data  44

P
passive reference  16
PCR Stage, editing during experiment design  20
plate adapter  33
plate setup data, importing  58
plot properties  46
preparing instrument for use  30

Q
QuantStudio™ Dx/ ViiA™ 7 Format  48
quencher  15
QuickStart  53, 57

R
ramp speed  13
RDML Format  48
reaction plate, sealing  23
reaction tubes and strips, capping and uncapping  28
reactions
  precautions  22
preparing  22
reagent
  information  14
  selection  13
reagent information, entering  14
reagent, selecting  13
reagents, selecting
  supported reagents  22
  SYBR® Green Reagents  13
  TaqMan® Reagents  13
reporter  15
results, reviewing  44
roller assembly  27
run properties, defining  20
Run screen  36
  View Run Data  40

S
sample block(s)  38
sample definition file, creating  59
sample information, importing  59
samples
  assigning  17, 19
  defining  15
selecting reagents  13
shortcuts, experiments  53
starting the experiment  34
starting the instrument  30
storage conditions, photosensitive  28
system security  9

T
tab-delimited text file, for sample definitions  59
targets
  assigning  16, 19
  defining  15
template
  creating batch of experiments from template  55
thermal profile  20
transferring experiment results  42

U
unloading an experiment  41
USB
  drive  43
W
wells, displaying 45
For Research Use Only. Not for use in diagnostic procedures.
About Standard Curve Experiments

Before you begin

The Standard Curve method is used for determining absolute target quantity in samples. With the standard curve method, the software measures amplification of the target in samples and in a standard dilution series. Data from the standard dilution series are used to generate the standard curve. Using the standard curve, the software interpolates the absolute quantity of target in the samples.

Assemble required components

- **Sample** – The tissue group that you are testing for a target gene.
- **Standard** – A sample that contains known quantities of the target; used in quantification experiments to generate standard curves.
- **Standard dilution series** – A set of standards containing a range of known quantities. The standard dilution series is prepared by serially diluting standards.
- **Replicates** – The total number of identical reactions containing identical samples, components, and volumes.
- **Negative controls** – Wells that contain water or buffer instead of sample template. No amplification of the target should occur in negative control wells.

PCR Options

When performing real-time PCR, choose between:

- Singleplex and multiplex PCR (below)
- 1-step and 2-step RT-PCR (page 6)

IMPORTANT! First-time users of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software please read Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments and Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes of this binder thoroughly. The booklet provides information and general instructions that are applicable to all the experiments described in this binder.

**Note:** For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ 6 and 7 Flex Real-Time PCR System Software by pressing F1, clicking in the toolbar, or selecting Help › QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Help.
Singleplex and Multiplex PCR

You can perform a PCR reaction using either:

- **Singleplex PCR** – In singleplex PCR a single primer set is present in the reaction tube or well. Only one target or endogenous control can be amplified per reaction. 
  
  or

- **Multiplex PCR** – In multiplex PCR, two or more primer sets are present in the reaction tube or well. Each set amplifies a specific target or endogenous control. Typically, a probe labeled with FAM™ dye detects the target and a probe labeled with VIC® dye detects the endogenous control.

**IMPORTANT!** SYBR® Green reagents cannot be used for multiplex PCR.

1- and 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in separate reactions (2-step). The reagent configuration you use depends on whether you are performing 1- or 2-step RT-PCR:

- **1-step RT-PCR** – In 1-step RT-PCR, RT and PCR take place in one buffer system. Using one buffer system provides the convenience of a single-tube preparation for RT and PCR amplification. However, you cannot use Fast PCR master mix or the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

- **2-step RT-PCR** – 2-step RT-PCR is performed in two separate reactions: First, total RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful for detecting multiple transcripts from a single cDNA template or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be used to prevent carryover contamination.

  **Note:** The Standard Curve example experiment is designed for singleplex PCR, where every well contains a primer/probe set for a single target; the reactions are set up for a 2-step RT-PCR.

About the example experiment

To illustrate how to perform Standard Curve experiments, this guide leads you through the process of designing and performing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

The objective of the Standard Curve example experiment is to determine the quantity of the RNase P gene in two populations.
In the standard curve example experiment:

- The samples are genomic DNA isolated from two populations.
- The target is the RNase P gene.
- One standard curve is set up for the RNase P gene (target). The standard used for the standard dilution series contains known quantities of the RNase P gene. Because a single target is being studied, only one standard curve is required.
  
  **Note:** In experiments where multiple targets are being studied, a standard curve is required for each target.

- Three replicates of each sample and each dilution point in the standard curve are performed to ensure statistical significance.
- The experiment is designed for singleplex PCR, where every well contains a primer/probe set for a single target.
- Reactions are set up for 2-step RT-PCR.
- Primer/probe sets are from Life Technologies RNase P assay.

  **Note:** The human RNase P FAM™ dye-labeled MGB probe is not available as a TaqMan® Gene Expression Assay. It can be ordered as a Custom TaqMan® Gene Expression Assay (Part no. 4331348).
Chapter 1 About Standard Curve Experiments

About the example experiment
Design the Experiment

This chapter explains how to design the example experiment from the Experiment Setup menu.

This chapter covers:

- Define the experiment properties ............................................. 9
- Define targets, samples, and biological replicates .................... 10
- Assign targets, samples, and biological groups ...................... 11
- Set up the run method ....................................................... 13
- For more information ....................................................... 14

Note: To automatically export the analyzed data to a specified location, select the Auto Export task from the Export screen, before running the experiment. For more information on Auto Export, refer to Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.

Define the experiment properties

Click Experiment Setup ▶ Experiment Properties to create a new experiment in the QuantStudio™ 6 and 7 Flex Software. Enter:

<table>
<thead>
<tr>
<th>Field or selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Name</td>
<td>QS6_QuantStudio_384-Well_Standard_Curve_Example</td>
</tr>
<tr>
<td>Barcode</td>
<td>Leave field empty</td>
</tr>
<tr>
<td>User Name</td>
<td>Example User</td>
</tr>
<tr>
<td>Comments</td>
<td>Standard Curve example</td>
</tr>
<tr>
<td>Instrument type</td>
<td>QuantStudio™ 6 Flex System</td>
</tr>
<tr>
<td>Block</td>
<td>384-Well Block</td>
</tr>
<tr>
<td>Experiment Type</td>
<td>Standard Curve</td>
</tr>
<tr>
<td>Reagents</td>
<td>TaqMan® Reagents</td>
</tr>
<tr>
<td>Ramp speed</td>
<td>Fast</td>
</tr>
<tr>
<td>Reagent Information</td>
<td>NA</td>
</tr>
</tbody>
</table>

Save the experiment.
Define targets, samples, and biological replicates

Click Define to access the Define screen. Enter:

1. Targets

<table>
<thead>
<tr>
<th>Target name</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>RNaseP</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
</tbody>
</table>

2. Samples

<table>
<thead>
<tr>
<th>Sample name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>5K</td>
<td></td>
</tr>
<tr>
<td>10K</td>
<td></td>
</tr>
</tbody>
</table>

3. Dye to be used as a Passive Reference
ROX

4. Custom Task Name
Not applicable
Your Define screen should look like this:

### Targets

<table>
<thead>
<tr>
<th>Target Name</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>RNase P</td>
<td>FAM</td>
<td>HQ-660</td>
<td></td>
</tr>
</tbody>
</table>

### Samples

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td></td>
</tr>
<tr>
<td>LOQ</td>
<td></td>
</tr>
</tbody>
</table>

### Biological Replicate Groups

<table>
<thead>
<tr>
<th>Biological Group Name</th>
<th>Color</th>
</tr>
</thead>
</table>

### Passive Reference

<table>
<thead>
<tr>
<th>Field</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>RDX</td>
</tr>
</tbody>
</table>

### Custom Task Name

<table>
<thead>
<tr>
<th>Field</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** This example experiment does not define biological replicate groups. Leave Biological Replicate Groups blank.

**Assign targets, samples, and biological groups**

Click **Assign** to access the Assign screen.

1. Define and set up standards.
   a. Click **Define and Set Up Standards** on the Assign screen.
   b. Select a target.
     
   c. Define the standard curve.
     
<table>
<thead>
<tr>
<th>Field</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td># of Points</td>
<td>5</td>
</tr>
<tr>
<td># of Replicates</td>
<td>16</td>
</tr>
<tr>
<td>Starting Quantity</td>
<td>1250.0</td>
</tr>
<tr>
<td>Serial Factor</td>
<td>2x</td>
</tr>
</tbody>
</table>

   d. Select and arrange wells for the standards.
Chapter 2 Design the Experiment
Assign targets, samples, and biological groups

2. Assign targets and samples.

<table>
<thead>
<tr>
<th>Target name</th>
<th>Well number</th>
<th>Task</th>
<th>Quantity</th>
<th>Sample name</th>
</tr>
</thead>
<tbody>
<tr>
<td>RNaseP</td>
<td>A1 - P1 (column 1)</td>
<td>Negative</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>RNaseP</td>
<td>A2 - P2 (column 2)</td>
<td>Standard</td>
<td>1250</td>
<td>None</td>
</tr>
<tr>
<td>RNaseP</td>
<td>A3 - P3 (column 3)</td>
<td>Standard</td>
<td>2500</td>
<td>None</td>
</tr>
<tr>
<td>RNaseP</td>
<td>A4 - P4 (column 4)</td>
<td>Standard</td>
<td>5000</td>
<td>None</td>
</tr>
<tr>
<td>RNaseP</td>
<td>A5 - P5 (column 5)</td>
<td>Standard</td>
<td>10000</td>
<td>None</td>
</tr>
</tbody>
</table>

e. Click Apply, and then Close.

Your Define and Set Up Standards dialog box should look like this:
### Chapter 2  
Design the Experiment

#### Set up the run method

Click **Run Method** to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- Reaction Volume Per Well: 20 µL
- Thermal Profile

---

<table>
<thead>
<tr>
<th>Target name</th>
<th>Well number</th>
<th>Task</th>
<th>Quantity</th>
<th>Sample name</th>
</tr>
</thead>
<tbody>
<tr>
<td>RNaseP</td>
<td>A6 - P6 (column 6)</td>
<td>Standard</td>
<td>20000</td>
<td>None</td>
</tr>
<tr>
<td>RNaseP</td>
<td>A7 - P15 (columns 7 -15)</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>5K</td>
</tr>
<tr>
<td>RNaseP</td>
<td>A16 - P24 (columns 16 - 24)</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>10K</td>
</tr>
</tbody>
</table>

Your Assign screen should look like this:
Chapter 2  Design the Experiment

Your Run Method screen should look like this:

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold Stage</td>
<td>Step 1</td>
<td>1.9°C/s</td>
<td>95°C</td>
<td>20 seconds</td>
</tr>
<tr>
<td>PCR Stage</td>
<td>Step 1</td>
<td>1.9°C/s</td>
<td>95°C</td>
<td>1 second</td>
</tr>
<tr>
<td>Number of Cycles</td>
<td>40 (default)</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>20 seconds</td>
</tr>
<tr>
<td>Enable AutoDelta</td>
<td>Unchecked (default)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Starting Cycle:</td>
<td>Disabled when Enable AutoDelta is unchecked</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumables</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
<tr>
<td></td>
<td>Appendix A in Booklet 7, <em>QuantStudio™ 6 and 7 Flex Real-Time PCR System Software - Appendixes</em></td>
<td></td>
</tr>
<tr>
<td>For more information on...</td>
<td>Refer to...</td>
<td>Publication number</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Amplification efficiency</td>
<td><em>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</em></td>
<td>127AP05-03</td>
</tr>
<tr>
<td>Using Alternative Setup</td>
<td>Chapter 3 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Chapter 2  Design the Experiment

For more information
Prepare the Reactions

Assemble required materials

- Items listed in Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments*
- Samples - Human Raji cell line-derived cDNA samples (100 ng/μL)
- Example experiment reaction mix components:
  - TaqMan® Fast Universal PCR Master Mix
  - RNase P Assay Mix (20X) (Part no. 4316831)

*Note:* Fast Universal Master Mix is not recommended to be used with the 96-well (0.2 mL) reaction plates or reaction tubes and tube strips sealed with caps.

Prepare the sample dilutions

To determine the quantity of the RNase P gene in the example experiment, dilute the samples (as directed below) before adding the samples to the final reaction mix.

The stock concentration of each sample is 100 ng/μL. After dilution, the sample Pop1 has a concentration of 6.6 ng/μL and Pop 2 has a concentration of 3.3 ng/μL. Add 2μL to each reaction.

Use this table for sample dilution volumes for the example experiment.

<table>
<thead>
<tr>
<th>Sample name</th>
<th>Stock concentration (ng/μL)</th>
<th>Sample volume (μL)</th>
<th>Diluent volume (μL)</th>
<th>Total volume of diluted sample (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pop1</td>
<td>100.0</td>
<td>25</td>
<td>355</td>
<td>380</td>
</tr>
<tr>
<td>Pop2</td>
<td>100.0</td>
<td>12.5</td>
<td>367.5</td>
<td>380</td>
</tr>
</tbody>
</table>

*Note:* For your own experiment, adjust the input amounts of the template depending on the template type and target abundance.
1. Label a separate microcentrifuge tube for each diluted sample:
   - Pop 1
   - Pop 2

2. Add the required volume of water (diluent) to each empty tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample name</th>
<th>Diluent volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pop 1</td>
<td>355</td>
</tr>
<tr>
<td>2</td>
<td>Pop 2</td>
<td>367.5</td>
</tr>
</tbody>
</table>

3. Add the required volume of sample stock to each tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample name</th>
<th>Sample volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pop 1</td>
<td>25</td>
</tr>
<tr>
<td>2</td>
<td>Pop 2</td>
<td>12.5</td>
</tr>
</tbody>
</table>

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

### Prepare the standard dilution series

The standard concentration in stock is 20,000 copies/µL:

<table>
<thead>
<tr>
<th>Standard name (labeled tube)</th>
<th>Dilution point</th>
<th>Source</th>
<th>Source volume (µL)</th>
<th>Diluent volume (µL)</th>
<th>Total volume (µL)</th>
<th>Standard concentration (copies/µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>RNase P Std. 1</td>
<td>1 (20,000)</td>
<td>Stock</td>
<td>18</td>
<td>18</td>
<td>36</td>
<td>10,000</td>
</tr>
<tr>
<td>RNase P Std. 1</td>
<td>2 (10,000)</td>
<td>Dilution 1</td>
<td>18</td>
<td>18</td>
<td>36</td>
<td>5,000</td>
</tr>
<tr>
<td>RNase P Std. 1</td>
<td>3 (5,000)</td>
<td>Dilution 2</td>
<td>18</td>
<td>18</td>
<td>36</td>
<td>2,500</td>
</tr>
<tr>
<td>RNase P Std. 1</td>
<td>4 (2500)</td>
<td>Dilution 3</td>
<td>18</td>
<td>18</td>
<td>36</td>
<td>1250</td>
</tr>
<tr>
<td>RNase P Std. 1</td>
<td>5 (1250)</td>
<td>Dilution 4</td>
<td>18</td>
<td>18</td>
<td>36</td>
<td>625</td>
</tr>
</tbody>
</table>

1. Prepare five standard dilutions:

   **Note:** For dilution 1, first vortex the stock for 3 to 5 seconds, then centrifuge the RNase P Std. 1 tube briefly before pipetting stock into the tube.

   For each dilution:

   a. Use a new pipette tip to add 18 µL of source to the tube containing the standard.
   b. Vortex the tube for 3 to 5 seconds, then centrifuge the tube briefly.
2. Place the standards on ice until you prepare the reaction plate.

**Prepare the reaction mix (“cocktail mix”)**

For the RNase P assay (Standard Curve example experiment), the following table lists the universal assay conditions (volume and final concentration) for using the TaqMan® Fast Universal PCR Master Mix.

<table>
<thead>
<tr>
<th>Reaction component</th>
<th>Volume for 1 reaction (µL)</th>
<th>Volume for 384 reactions + 10% excess (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® Fast Universal PCR Master Mix Kit</td>
<td>5</td>
<td>2115</td>
</tr>
<tr>
<td>RNase P Assay (20X)</td>
<td>0.5</td>
<td>211.5</td>
</tr>
<tr>
<td>Water</td>
<td>3.5</td>
<td>1480.5</td>
</tr>
<tr>
<td>Total reaction mix volume</td>
<td>9</td>
<td>3807</td>
</tr>
</tbody>
</table>

1. Label an appropriately sized tube for the reaction mix: *RNase P Reaction Mix*.

2. Add the required volumes of each cocktail mix component to the tube.
   **Note:** Do not add the sample or standard at this time.

3. Mix the cocktail thoroughly by gently pipetting up and down several times, then cap the tube.

4. Centrifuge the tube briefly to remove air bubbles.

5. Place the cocktail mix on ice until you prepare the reaction plate.
   **Note:** You can separately add the sample to the reaction plate, as opposed to preparing individual reaction mixes for each sample.

**Prepare the reaction plate**

**Example experiment reaction plate components**

The reaction plate for the Standard Curve example experiment contains:

- A MicroAmp® Optical 384-Well Reaction Plate
- Reaction volume: 20 µL/well
- 288 Unknown wells
- 80 Standard wells
- 16 Negative control wells
Chapter 3 Prepare the Reactions

Prepare the reaction plate

The following is an image of the plate layout:

To prepare the reaction plate components:

1. Prepare the negative control reactions for the target:
   a. To an appropriately sized tube, add the volumes of reaction mix and water listed below.

<table>
<thead>
<tr>
<th>Tube</th>
<th>Reaction mix</th>
<th>Reaction mix volume (μL)</th>
<th>Water volume (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RNase P reaction mix</td>
<td>157.5</td>
<td>17.5</td>
</tr>
</tbody>
</table>

   b. Mix the reaction by gently pipetting up and down, then cap the tube.
   c. Centrifuge the tube briefly to remove air bubbles.
   d. Add 10 μL of the negative control reaction to the appropriate wells in the reaction plate.

2. For each replicate group, prepare the standard reactions:
   a. To appropriately sized tubes, add the volumes of reaction mix and standard listed below.
Chapter 3  Prepare the Reactions

Prepare the reaction plate

3. For each replicate group, prepare the reactions for the unknowns:
   a. To appropriately sized tubes, add the volumes of reaction mix and sample
      listed below.

<table>
<thead>
<tr>
<th>Tube</th>
<th>Unknown reaction</th>
<th>Reaction mix</th>
<th>Reaction mix volume (µL)</th>
<th>Sample</th>
<th>Sample volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RNase P pop1</td>
<td>RNase P reaction mix</td>
<td>1422</td>
<td>pop1</td>
<td>158</td>
</tr>
<tr>
<td>2</td>
<td>RNase P pop2</td>
<td>RNase P reaction mix</td>
<td>1422</td>
<td>pop2</td>
<td>158</td>
</tr>
</tbody>
</table>

   b. Mix the reactions by gently pipetting up and down, then cap the tubes.
   c. Centrifuge the tubes briefly to remove air bubbles.
   d. Add 10 µL of the unknown (sample) reaction to the appropriate wells in the reaction plate.

4. Seal the reaction plate with optical adhesive film.
5. Centrifuge the reaction plate briefly to remove air bubbles.
6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the reaction plate again at a higher speed and for a longer period of time.

7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

### For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning the reaction plate components</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em> Appendix A in Booklet 7, <em>QuantStudio™ 6 and 7 Flex Real-Time PCR System Software - Appendixes</em></td>
</tr>
<tr>
<td>Sealing the reaction plate</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em> Appendix A in Booklet 7, <em>QuantStudio™ 6 and 7 Flex Real-Time PCR System Software - Appendixes</em></td>
</tr>
</tbody>
</table>
Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 6 or 7 Instrument.

This chapter covers:

- Start the run ................................................................. 23
- Monitor the run .............................................................. 23

**IMPORTANT!** Run the experiment at the same ambient temperature at which you calibrated the instrument. Extreme variations in ambient temperature can affect the heating and cooling of the instrument and influence experimental results.

**IMPORTANT!** Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 6 or 7 Instrument is in operation.

**Start the run**

1. Open the Standard Curve example file that you created using instructions in Chapter 2.
2. Load the reaction plate into the instrument.
3. Start the run.

**Monitor the run**

Monitor the example experiment run:

- From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software using the Run screen, while the experiment is in progress.
- From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software (to monitor an experiment started from another computer or from the QuantStudio™ 6 or 7 Instrument touchscreen).
- From the QuantStudio™ 6 or 7 Instrument touchscreen.
1. In the Instrument Console screen, select the instrument icon.
2. Click Manage Instrument or double-click on the instrument icon.
3. On the Manage Instrument screen, click Monitor Running Experiment to access the Run screen.

View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all the three plots available from the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software for potential problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab, then select the wells to view.

The following is an image of the Amplification Plot screen as it appears at the end of the example experiment.
View the Temperature Plot

Click **Temperature Plot** from the Run Experiment Menu.

The following is an image of the Temperature Plot screen as it appears during the example experiment.

**Note:** The Sample temperature displayed in the Current Temperatures group is an estimated value.
View the Run Method

Click **Run Method** from the Run Experiment Menu.

The following is an image of the Run Method screen as it appears in the example experiment.

View the run data

Click **View Run Data** from the Run Experiment Menu.

The following is an image of the View Run Data screen as it appears in the example experiment.
You can also view the progress of the run from the QuantStudio™ 6 or 7 Instrument touchscreen.

The following are images of the Run Method screen on the QuantStudio™ 6 or 7 Instrument touchscreen:

**Experiment View**

![Experiment View Image]

**Time View**

![Time View Image]
In Section 5.1 of this chapter you review the analyzed data using several of the analysis screens and publish the data. Section 5.2 of this chapter walks you through the process of modifying experiment parameters to troubleshoot problems with experiment results before rerunning an experiment.

This chapter covers:

**Section 5.1 Review Results** ................................................................. 31

- Analyze the example experiment ................................................. 31
- View the Standard Curve Plot ....................................................... 31
- Assess amplification results using the Amplification Plot .......... 33
- Identify well problems using the Well Table .............................. 39
- Confirm accurate dye signal using the Multicomponent Plot ...... 42
- Determine signal accuracy using the Raw Data Plot ................. 44
- Review the flags in the QC Summary ............................................ 46
- For more information ................................................................. 47

**Section 5.2 Adjust parameters for re-analysis of your own experiments** ........ 49

- Adjust analysis settings ............................................................. 49
- Improve C_T precision by omitting wells ................................... 52
- For more information ................................................................. 53
Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.
2. Click Analyze. The software analyzes the data using the default analysis settings.
   Note: You can also access the experiment to analyze from the Home screen.

View the Standard Curve Plot

The Standard Curve Plot screen displays the standard curve for samples designated as standards. The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software calculates the quantity of an unknown target from the standard curve.

Purpose

The purpose of viewing the standard curve for the example experiment is to identify:

- Slope and amplification efficiency
- R² value (correlation coefficient)
- Cₜ values

To view and assess the Standard Curve Plot

1. From the Experiment Menu pane, select Analysis → Standard Curve.
   Note: If no data are displayed, click Analyze.
2. Display all 384 wells in the Standard Curve Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.
3. Enter the Plot Settings:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>All</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Target</td>
</tr>
<tr>
<td>![Toggle Button]</td>
<td>Check (default)</td>
</tr>
</tbody>
</table>

(This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.)

4. View the values displayed below the standard curve.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slope</td>
<td>-3.289</td>
</tr>
<tr>
<td>R²</td>
<td>0.997</td>
</tr>
<tr>
<td>Amplification efficiency</td>
<td>101.414%</td>
</tr>
<tr>
<td>Error</td>
<td>0</td>
</tr>
</tbody>
</table>
5. Check that all samples are within the standard curve. In the example experiment, as shown in the following image, all samples (blue dots) are within the standard curve (red dots).

6. Check the CT values:
   a. Click the Well Table tab.
   b. From the Group By menu, select Replicate.
   c. Look at the values in the CT column. In the example experiment, the CT values fall within the expected range (>8 and <35).
Tips for analyzing your own experiments

When you analyze your own standard curve experiment, look for:

- **Slope and amplification efficiency values** – The amplification efficiency is calculated using the slope of the regression line in the standard curve. A slope close to $-3.3$ indicates optimal, 100% PCR amplification efficiency. Factors that affect amplification efficiency:
  - Range of standard quantities – For accurate and precise efficiency measurements, use a broad range of standard quantities, 5 to 6 logs ($10^5$ to $10^6$ fold).
  - Number of standard replicates – For accurate efficiency measurements, include replicates to decrease the effects of pipetting inaccuracies.
  - PCR inhibitors – PCR inhibitors in the reaction can reduce amplification efficiency.

- **$R^2$ values (correlation coefficient)** – The $R^2$ value is a measure of the closeness of fit between the regression line and the individual $C_T$ data points of the standard reactions. A value of 1.00 indicates a perfect fit between the regression line and the data points. An $R^2$ value >0.99 is desirable.

- **$C_T$ values** – The threshold cycle ($C_T$) is the PCR cycle number at which the fluorescence level meets the threshold.
  - A $C_T$ value $>8$ and $<35$ is desirable.
  - A $C_T$ value $<8$ indicates that there is too much template in the reaction.
  - A $C_T$ value $>35$ indicates a low amount of target in the reaction; for $C_T$ values $>35$, expect a higher standard deviation.

If your experiment does not meet the guidelines above, troubleshoot as follows:

- Omit wells (see “Improve $C_T$ precision by omitting wells” on page 52).
- Rerun the experiment.

Assess amplification results using the Amplification Plot

Amplification plots available for viewing

The Amplification Plot screen displays amplification of all samples in the selected wells. There are three plots available:

- **$\Delta R_n$ vs Cycle** – $\Delta R_n$ is the magnitude of normalized fluorescence signal generated by the reporter at each cycle during the PCR amplification. This plot displays $\Delta R_n$ as a function of cycle number. Use this plot to identify and examine irregular amplification and to view threshold and baseline values for the run.

- **$R_n$ vs Cycle** – $R_n$ is the fluorescence signal from the reporter dye normalized to the fluorescence signal from the passive reference. This plot displays $R_n$ as a function of cycle number. Use this plot to identify and examine irregular amplification.

- **$C_T$ vs Well** – $C_T$ is the PCR cycle number at which the fluorescence meets the threshold in the amplification plot. This plot displays $C_T$ as a function of well position. Use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.
Purpose

The purpose of viewing the amplification plot for the example experiment is to identify:

- Correct baseline and threshold values
- Outliers

View the Amplification Plot

1. From the Experiment Menu pane, select Analysis ▶ Amplification Plot.
   **Note:** If no data are displayed, click Analyze.

2. Display the RNase P wells in the Amplification Plot screen. Click the Plate Layout tab. Enter the Plot Settings:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Wells With</td>
<td>Target ▶ RNaseP</td>
</tr>
</tbody>
</table>

3. In the Amplification Plot screen, enter:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>△Rn vs Cycle</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Well (default)</td>
</tr>
</tbody>
</table>

   (This is a toggle button. When the legend is displayed, the button changes to **Hide the plot legend**.)

4. View the baseline values.
   a. From the Graph Type drop-down menu, select Linear.
b. Select the **Baseline** check box to show the start cycle and end cycle.

c. Verify that the baseline is set correctly: The end cycle should be set a few cycles before the cycle number where significant fluorescent signal is detected. In the example experiment, the baseline is set correctly.

5. View the threshold values.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Type</td>
<td>Log</td>
</tr>
<tr>
<td>Target</td>
<td>RNaseP</td>
</tr>
</tbody>
</table>

a. Select the **Threshold** check box to show the threshold.

b. Verify that the threshold is set correctly. In the example experiment, the threshold is in the exponential phase.
6. Locate outliers:
   
   a. From the Plot Type drop-down menu, select $C_T$ vs Well.
   
   b. Look for outliers from the amplification plot. In the example experiment, there are no outliers for RNase P.

**Tips for analyzing your own experiments**

When you analyze your own standard curve experiment, look for:

**Outliers**

- **A typical amplification plot** – The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software automatically calculates baseline and threshold values based on the assumption that the data exhibit a *typical* amplification plot. A typical amplification plot has four distinct sections:
  - Plateau phase
  - Linear phase
  - Exponential (geometric phase)
  - Baseline
The following is an image of a typical amplification plot:

![Amplification Plot](Image)

**IMPORTANT!** Experimental error (such as contamination or pipetting errors) can produce atypical amplification curves that can result in incorrect baseline and threshold value calculations by the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software. Life Technologies recommends that you examine the Amplification Plot screen and review the assigned baseline and threshold values for each well after analysis.

- **Correct threshold values:**
  
  **Threshold Set Correctly**
  
  The threshold is set in the exponential phase of the amplification curve. Threshold settings above or below the optimum increase the standard deviation of the replicate groups.
Chapter 5  Review Results and Adjust Experiment Parameters

Assess amplification results using the Amplification Plot

Threshold Set Too Low
The threshold is set below the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar up into the exponential phase of the curve.

Threshold Set Too High
The threshold is set above the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar down into the exponential phase of the curve.

- Correct baseline values:

Baseline Set Correctly
The amplification curve begins after the maximum baseline.

Baseline Set Too Low
The amplification curve begins too far to the right of the maximum baseline. Increase the End Cycle value.
Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including:

- The sample name, target name, task, and dyes
- The calculated threshold cycle (C_T), normalized fluorescence (Rn), and quantity values
- Comments
- Flags

Purpose

The purpose of viewing the well table is to identify:

- Quantity values
- Flags
- C_T values (including C_T standard deviation)

View the well table

1. From the Experiment Menu pane, select **Analysis**, then select the **Well Table** tab.
   
   **Note:** If no data are displayed, click **Analyze**.

2. Use the Group By drop-down menu to group wells by a specific category. For the example experiment, group the wells by replicate, flag, or C_T value.

   **Note:** You can select only one category at a time.

Baseline Set Too High

The amplification curve begins before the maximum baseline. Decrease the End Cycle value.
To group by replicate

From the Group By drop-down menu, select Replicate. The software groups the replicate wells: negative controls, standards, and samples. In the example experiment, note that the quantity values within each replicate group are similar.

Note: In the example experiment, the Quantity, Quantity Mean, and Quantity SD columns have been moved from their default locations to the beginning of the Well Table. To move a column, click and drag on the column heading.

The well table looks like this:
### To group by flag

From the Group By drop-down menu, select **Flag**. The software groups the flagged and unflagged wells. In the example experiment, there are no flagged wells.

#### Table Layout

<table>
<thead>
<tr>
<th>Well</th>
<th>Flag</th>
<th>CT</th>
<th>Sample Name</th>
<th>Target Name</th>
<th>Quantity TC</th>
<th>Sample Name</th>
<th>Target Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Well Summary:

- **In Fluo**: 204
- **Gels**: 204
- **Flaged**: 0
- **Flag by Analysis**: 0
- **Flag by Result**: 0
- **Sample tidy**: 204
- **Target tidy**: 204

---

### To group by CT value

From the Group By drop-down menu, select **CT**. The software groups the wells by CT value: low, medium, high, and undetermined. In the example experiment, the CT values are within the expected range (>8 and <35).

#### Table Layout

<table>
<thead>
<tr>
<th>Well</th>
<th>CT</th>
<th>Sample Name</th>
<th>Target Name</th>
<th>Quantity TC</th>
<th>Sample Name</th>
<th>Target Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Well Summary:

- **In Fluo**: 204
- **Gels**: 204
- **Flaged**: 0
- **Flag by Analysis**: 0
- **Flag by Result**: 0
- **Sample tidy**: 204
- **Target tidy**: 204

---

`QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Standard Curve Experiments`
Chapter 5  Review Results and Adjust Experiment Parameters

Confirm accurate dye signal using the Multicomponent Plot

Tips for analyzing your own experiments

- **Replicate** – The software groups the wells by replicate: negative controls, standards, and samples. Look in the Quantity columns to make sure the quantity values for each replicate group are similar indicating tight CT precision.

- **Flag** – The software groups the flagged and unflagged wells. A flag indicates that the software has found a potential error in the flagged well. For a description of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software flags, see “Flag Settings” on page 50.

- **CT** – The threshold cycle (CT) is the PCR cycle number at which the fluorescence level meets the threshold. A CT value >8 and <35 is desirable. A CT value <8 indicates that there is too much template in the reaction. A CT value >35 indicates a low amount of target in the reaction; for CT values >35, expect a higher standard deviation.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

Purpose

In the standard curve example experiment, you review the Multicomponent Plot screen for:

- ROX™ dye (passive reference)
- FAM™ dye (reporter)
- Spikes, dips, and/or sudden changes
- Amplification in the negative control wells

View the Multicomponent Plot

1. From the Experiment Menu pane, select Analysis ▶ Multicomponent Plot.
   
   **Note:** If no data are displayed, click Analyze.

2. Display the unknown and standard wells one at a time in the Multicomponent Plot screen:
   a. Click the Plate Layout tab.
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.

   **Note:** If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click Show a legend for the plot (default).

   **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal remains constant throughout the PCR process; a constant ROX dye signal indicates typical data.
6. Check the FAM dye signal. In the example experiment, the FAM dye signal increases throughout the PCR process; increase in FAM dye signal indicates normal amplification.

7. Select the negative control wells one at a time and check for amplification. In the example experiment, there is no amplification in the negative control wells.
Tips for confirming dye accuracy in your own experiment

When you analyze your own standard curve experiment, look for:

- **Passive reference** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.
- **Reporter dye** – The reporter dye fluorescence level should display a flat region corresponding to the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.
- **Irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.
- **Negative control wells** – There should not be any amplification in the negative control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter for the selected wells during each cycle of the real-time PCR.

**Purpose**

In the standard curve example experiment, you review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

**View the Raw Data Plot**

1. From the Experiment Menu pane, select **Analysis ➤ Raw Data Plot**.  
   **Note:** If no data are displayed, click Analyze.
2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.
3. Click **Show a legend for the plot** (default). The legend displays the color code for each row of the reaction plate (see the legend in the Raw Data Plot shown below).
4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example experiment, there is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.

The filters used for the example experiment are:

<table>
<thead>
<tr>
<th>PCR Filter</th>
<th>Load</th>
<th>Save</th>
<th>Reset to Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emission Filter</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x1(474±10)</td>
<td>☑️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>x2(228±5)</td>
<td></td>
<td>☑️</td>
<td></td>
</tr>
<tr>
<td>x3(21±10)</td>
<td></td>
<td>☑️</td>
<td></td>
</tr>
<tr>
<td>x4(48±5)</td>
<td></td>
<td>☑️</td>
<td></td>
</tr>
<tr>
<td>x5(4±10)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x6(2±10)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Melt Curve Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>x1(474±10)</td>
</tr>
<tr>
<td>x2(228±5)</td>
</tr>
<tr>
<td>x3(21±10)</td>
</tr>
<tr>
<td>x4(48±5)</td>
</tr>
<tr>
<td>x5(4±10)</td>
</tr>
<tr>
<td>x6(2±10)</td>
</tr>
</tbody>
</table>
Tips for determining signal accuracy in your own experiments

When you analyze your own standard curve experiment, look for the following in each filter:

- Characteristic signal growth
- No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software flags, including the flag frequency and location for the open experiment.

View the QC Summary

1. From the Experiment Menu pane, select Analysis ▶ QC Summary.
   
   **Note:** If no data are displayed, click Analyze.

2. Review the Flags Summary.
   
   **Note:** A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment. If the frequency is >0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.

In the example experiment, there are no flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed information about the flag. In the example experiment, the Frequency column displays 0 for all flags.

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view information on correcting the flag.
Possible flags

The flags listed below may be triggered by the experiment data.

**Note:** To change the flag settings, refer to “Flag Settings” on page 50.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pre-processing flag</strong></td>
<td></td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td><strong>Primary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>CT algorithm failed</td>
</tr>
<tr>
<td><strong>Secondary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>OUTLIERRG</td>
<td>Outlier in replicate group</td>
</tr>
<tr>
<td>AMPNC</td>
<td>Amplification in negative control</td>
</tr>
<tr>
<td>HIGHSD</td>
<td>High standard deviation in replicate group</td>
</tr>
</tbody>
</table>

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing data</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle (C T), flags, and advanced options.

If the default analysis settings in the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.
2. Click Analysis ➤ Analysis Settings to open the Analysis Settings dialog box.
   In the example experiment, the default analysis settings are used for each tab:
   - C T Settings
   - Flag Settings
   - Advanced Settings
   - Standard Curve Settings
   The following is an image of the Analysis Settings dialog box for a Standard Curve experiment:
3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” below).

**Note:** You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments*.

4. Click **Apply Analysis Settings** to apply the current analysis settings.

**Note:** You can go back to the default analysis settings, by clicking **Revert to Default Analysis Settings**.

### Adjust analysis settings

#### C_T Settings

- **Data Step Selection**
  Use this feature to select one stage/step combination for C_T analysis when there is more than one data collection point in the run method.

- **Algorithm Settings**
  Use the Baseline Threshold algorithm to determine the C_T values.
  The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for gene quantification.

- **Default C_T Settings**
  Use the default C_T settings feature to calculate C_T for the targets that do not have custom settings. To edit the default settings, click **Edit Default Settings**.

- **C_T Settings for Target**
  When you manually set the threshold and baseline, Life Technologies recommends:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Enter a value for the threshold so that the threshold is:</td>
</tr>
<tr>
<td></td>
<td>• Above the background.</td>
</tr>
<tr>
<td></td>
<td>• Below the plateau and linear regions of the amplification curve.</td>
</tr>
<tr>
<td></td>
<td>• Within the exponential phase of the amplification curve.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Select the Start Cycle and End Cycle values so that the baseline ends before significant fluorescent signal is detected.</td>
</tr>
</tbody>
</table>

**Note:** This setting is applicable only to the Baseline Threshold algorithm.

**Note:** Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.

#### Flag Settings

Use the Flag Settings tab to:

- Adjust the sensitivity so that more wells or fewer wells are flagged.
- Change the flags that are applied by the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

To adjust the flag settings
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.
   
   **Note:** If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.
   
   **Note:** After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments using the Standard Deviation calculations may change the result of $C_T$ SD. For some flags, analysis results calculated before the well is rejected are maintained.

4. Click **Apply Analysis Settings** in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.

The following is an image of the Flag Settings tab:

![Flag Settings Tab](image)

**Advanced Settings**

Use the Advanced Settings tab to change baseline settings well-by-well.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.

2. Deselect the **Use $C_T$ Settings Defined for Target** check box.
3. Define the custom baseline settings:
   - For automatic baseline calculations, select the **Automatic Baseline** check box.
   - To define the baseline, deselect the **Automatic Baseline** check box, then enter the baseline start cycle and baseline end cycle.

**Standard Curve Settings**

Use this tab to review the settings of the current standard curve experiment or to import the standard curve from an external experiment (with the same samples and targets) and apply it to the current experiment.

**Note:** The run method must be the same. Life Technologies recommends using the standard curve from the current experiment.

For the example experiment, the settings from the current experiment have been used.

---

**Improve $C_T$ precision by omitting wells**

Experimental error may cause some wells to be amplified insufficiently or not at all. These wells typically produce $C_T$ values that differ significantly from the average for the associated replicate wells. If included in the calculations, these outliers can result in erroneous measurements; to ensure $C_T$ precision, omit the outliers from the analysis.

1. From the Experiment Menu pane, select **Analysis ▶ Amplification Plot**.

**Note:** If no data are displayed, click **Analyze**.
Section 5.2 Adjust parameters for re-analysis of your own experiments

2. In the Amplification Plot screen, select **C<sub>T</sub> vs Well** from the Plot Type drop-down menu.

3. Select the **Well Table** tab.

4. In the Well Table, view outliers:
   a. From the Group By drop-down menu, select **Replicate**.
   b. Look for any outliers in the replicate group (make sure they are flagged).
   c. Select the **Omit** check box next to outlying well(s), as shown in the following image.

5. Click **Analyze** to reanalyze the experiment data with the outlying well(s) removed from the analysis.

   **Note:** You can also omit undesirable wells in an experiment from the Plate Layout screen. To omit a well from the Plate Layout screen, right-click the well and select **Omit**.

---

**For more information**

<table>
<thead>
<tr>
<th>For more information on</th>
<th>Refer to</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification efficiency</td>
<td>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note.</td>
<td>127AP05-03</td>
</tr>
</tbody>
</table>
Chapter 5 Review Results and Adjust Experiment Parameters
For more information
Export Experiment Results

1. Open the Standard Curve example experiment file that you analyzed in Chapter 5.

2. In the Experiment Menu, click Export.
   
   **Note:** To export data automatically after analysis, select the Auto Export check box during experiment setup or before running the experiment. Auto export is unchecked for the example experiment.

3. Select *QuantStudio™ 6 and 7* format.

4. Complete the Export dialog box as shown below:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export/ Select</td>
<td>Results</td>
</tr>
<tr>
<td>Content</td>
<td></td>
</tr>
<tr>
<td>Export Data To</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>QS6_QuantStudio_384-Well_Standard_Curve_Example_data</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td>C:\Applied Biosystems\QuantStudio 6 and 7 Flex Software\User Files\Export</td>
</tr>
</tbody>
</table>
Chapter 6 Export Experiment Results

Your Export screen should look like this:

Your exported file when opened in Notepad should look like this:
Index

A
absolute quantity 5
adjusting analysis settings 49
adjusting parameters, re-analyzing own experiments 49
Advanced Settings tab 51
Algorithm Settings, Baseline Threshold 50
amplification efficiency, factors affecting
- PCR inhibitors 33
- standard quantities 33
- standard replicates 33
amplification plot
- amplification efficiency 15, 33, 53
- assessing amplification results 33
- reviewing baseline values 34
- reviewing outliers 36
- reviewing threshold values 35
- tips for analyzing own experiments 36
- viewing 24, 34
AMPNC flag 47
analysis results, exporting 55
Analysis Settings
- Advanced Settings 49
- C_T Settings 49
- Flag Settings 49
- Standard Curve Settings 49
Analyze
- Amplification Plot 33
- Multicomponent Plot 42
- QC Summary 46
- Raw Data Plot 44
- Standard Curve Plot 31
- Well Table 39
Auto Export 55
Automatic Threshold 50

B
BADROX flag 47
baseline values, correcting 38
BLFAIL flag 47

C
cocktail mix 19
components
- reaction mix 17
- reaction plate 20
correlation coefficient 33
C_T settings
- algorithm settings 50
- data step, selecting 50
- default 50
- target 50
C_T Settings tab 50
CTFAIL flag 47

designing experiment
- assigning targets, samples, and biological groups 11
- defining and setting up standards 11
- defining experiment properties 9
- defining targets, samples, and biological replicates 10
- setting up run method 13
dye accuracy
- irregularities in the signal 44
- negative control wells 44
- passive reference 44
- reporter dye 44

E
eexample experiment 6
experiment properties, defining 9
EXPFAIL flag 47

F
Flag Settings tab 50
flags
- primary analysis 47
flags, QC
- AMPNC 47
- BADROX 47
- BLFAIL 47
- CTFAIL 47
- EXPFAIL 47
- HIGHSD 47
- NOAMP 47
- NOISE 47
- NOSIGNAL 47
- OFFSCALE 47
- OUTLIERRG 47
- SPIKE 47
- THOLDFAIL 47
G
Group By
C_T value 41
flag 41
replicate 40

H
HIGHSD flag 47

I
improving C_T precision, omitting wells 52

M
multicomponent plot
confirming dye accuracy 42
tips for analyzing own experiment 44
viewing 44

N
NOAMP flag 47
NOISE flag 47
NOSIGNAL flag 47

O
OFFSCALE flag 47
omitting wells 52
OUTLIERRG flag 47

P
PCR options
1-step RT-PCR 6
2-step RT-PCR 6
Multiplex PCR 6
Singleplex PCR 6
preparing reactions
reaction mix 19
reaction plate 19
required materials 17
sample dilutions 17
standard dilution series 18
standard dilutions 18
Pre-processing flag
OFFSCALE 47
Primary analysis flags
BADROX 47
BLFAIL 47
CTFAIL 47
EXPFAIL 47
NOAMP 47
NOISE 47
NOSIGNAL 47
SPIKE 47
THOLDFAIL 47
primer set 6

Q
QC Summary, reviewing flags 46
QC summary, viewing 46

R
raw data plot
determining signal accuracy 44
tips for analyzing own experiments 46
viewing 44
reactions, assembling materials for 17
required components
negative controls 5
replicates 5
sample 5
standard 5
standard dilution series 5
reverse transcription 6
review results 31
RNase P 6
run
monitoring 23
starting 23
run method
reaction volume per well 13
setting up 13
thermal profile 13
viewing 26
Run screen
Amplification Plot 24
Run Method 26
Temperature Plot 25
View Run Data 26

S
sample dilutions, preparing reactions 17
samples, defining 10
Secondary analysis flags
   AMPNC 47
   HIGHSD 47
   OUTLIERRG 47
SPIKE flag 47
standard 5
standard curve experiments
   overview 5
   PCR options 5
      required components, assemble 5
standard curve plot
   tips for analyzing own experiment 33
      viewing 31
         viewing and assessing 31
Standard Curve Settings tab 52
standard curve values
   amplification efficiency 31
   correlation coefficient 31
   C_T values 31
standard dilution series, preparing reactions 18
standards, defining and setting up 11

T

targets and samples, assigning 12
targets, defining 10
targets, samples, and biological groups, assigning 11
targets, samples, and biological replicates, defining 10
temperature plot, viewing 25
THOLDFAIL flag 47
threshold cycle 33
threshold values, correcting 37
touchscreen, running experiment from
   Experiment View 27
   Time View 27

W

well table
   assessing own experiments 42
   identifying well problems 39
   viewing 39
CHAPTER 5  Review Results and Adjust Experiment Parameters . . 37

Section 5.1 Review Results ................................................. 39
Analyze the example experiment ............................................. 39
View the Standard Curve Plot .................................................. 39
  Example experiment standard curve values ............................... 39
  To view and assess the Standard Curve plot .............................. 39
  Tips for analyzing your own experiments ................................. 41
Assess amplification results using the Amplification Plot ................. 42
  Amplification plots available for viewing ................................. 42
  Purpose ........................................................................... 42
  View the Amplification Plot .................................................. 42
  Tips for analyzing your own experiments ................................. 46
Assess the gene expression profile using the Gene Expression Plot ........... 49
  Example experiment values .................................................. 50
  View the Gene Expression Plot .............................................. 50
  Assessing the gene expression plot in your own experiments ......... 51
Identify well problems using the Well Table ................................ 51
  Example experiment values and flags ..................................... 51
  View the well table ............................................................ 51
  Assessing the well table in your own experiments .................... 52
Confirm accurate dye signal using the Multicomponent Plot .................. 53
  Purpose ........................................................................... 53
  View the Multicomponent Plot .............................................. 53
  Tips for confirming dye accuracy in your own experiment ........... 55
Determine signal accuracy using the Raw Data Plot ......................... 55
  About the example experiment ............................................. 55
  View the Raw Data Plot ...................................................... 55
  Tips for determining signal accuracy in your own experiment ....... 56
View the endogenous control profile using the QC Plot ...................... 57
Review the QC flags in the QC Summary .................................... 58
  View the QC Summary ........................................................ 58
  Possible flags .................................................................... 59
For more information ............................................................. 60

Section 5.2 Adjust parameters for re-analysis of your own experiments .... 61
Adjust analysis settings ................................................................ 61
  View the analysis settings .................................................... 61
  Adjust analysis settings ......................................................... 62
Improve C_T precision by omitting wells ...................................... 65
For more information ............................................................. 66
PART 2  Running Comparative CT Experiments  .................  69

CHAPTER 7  About Comparative C\textsubscript{T} Experiments  ...............  71

About Comparative C\textsubscript{T} experiments ...........................................  71
Assemble required components ...............................................................  71
PCR options .................................................................................................  72
About the example experiment ...............................................................  73

CHAPTER 8  Design the Experiment  ..........................  75

Define the experiment properties ............................................................  75
Define targets, samples and biological replicates ......................................  76
Assign targets, samples and biological groups ..........................................  78
Set up the run method ..............................................................................  79
Tips for designing your own experiment ..................................................  80
For more information ..............................................................................  81

CHAPTER 9  Prepare the Reactions  .......................  83

Assemble required materials .................................................................  83
Prepare the template ..................................................................................  83
Example experiment settings ....................................................................  83
Prepare the template ..................................................................................  84
Prepare the sample dilutions .....................................................................  84
Prepare the reaction mix ("cocktail mix") ..................................................  84
Prepare the reaction plate ..........................................................................  85
Example experiment reaction plate components .......................................  85
To prepare the reaction plate components ...............................................  86
Tips for preparing reactions for your own experiments .............................  86
Tips for preparing templates .....................................................................  86
Tips for preparing the reaction mix ..........................................................  86
Tips for preparing the reaction plate .........................................................  87
For more information ..............................................................................  87

CHAPTER 10  Run the Experiment  .......................  89

Start the run .............................................................................................  89
Monitor the run ..........................................................................................  89
From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software .................................................................  90
From the QuantStudio™ 6 or 7 Instrument touchscreen ................................ 92
CHAPTER 11  Review Results and Adjust Experiment Parameters  .  95

Section 11.1  Review Results  ................................................................. 97
Analyze the example experiment  ......................................................... 97
Assess the gene expression profile using the Gene Expression Plot  ................. 97
  Example experiment values ............................................................ 98
  View the Gene Expression Plot ....................................................... 98
  Assessing the gene expression plot your own experiments ......................... 99
Identify well problems using the Well Table ........................................... 99
  Example experiment values and flags ............................................... 99
  View the well table ................................................................... 99
  Assessing the well table in your own experiments .................................. 100
Assess amplification results using the Amplification Plot  .............................. 101
  Amplification plots available for viewing ........................................... 101
  Purpose ................................................................. 101
  View the Amplification Plot ......................................................... 101
  Tips for analyzing your own experiments ......................................... 105
Confirm accurate dye signal using the Multicomponent Plot  ......................... 108
  Purpose ........................................................................... 108
  View the Multicomponent Plot ..................................................... 108
  Tips for confirming dye accuracy in your own experiment ....................... 110
Determine signal accuracy using the Raw Data Plot .................................... 110
  About the example experiment ....................................................... 110
  View the Raw Data Plot ........................................................... 110
  Tips for determining signal accuracy in your own experiment .................. 111
View the endogenous control profile using the QC Plot  ............................... 112
  Example experiment settings ....................................................... 112
  View the QC Plot .................................................................. 112
Review the flags in the QC Summary ...................................................... 113
  View the QC Summary ............................................................ 113
  Possible flags .................................................................. 114

For more information .................................................................. 115

Section 11.2  Adjust parameters for re-analysis of your own experiments ....... 117
Adjust analysis settings .................................................................. 117
  View the analysis settings ........................................................... 117
  Adjust analysis settings ............................................................ 118
Improve C_T precision by omitting wells ................................................... 120

CHAPTER 12  Export Analysis Results  ................................. 123

CHAPTER 13  Design and Analyze a Gene Expression Study ....... 125

About Gene Expression studies .......................................................... 126
About the example study ................................................................ 126
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design a study</td>
<td>127</td>
</tr>
<tr>
<td>Create a new study</td>
<td>127</td>
</tr>
<tr>
<td>Set up the study in the Study Properties screen</td>
<td>127</td>
</tr>
<tr>
<td>Filter the experiments in the study</td>
<td>127</td>
</tr>
<tr>
<td>Define Replicates</td>
<td>128</td>
</tr>
<tr>
<td>Example study settings</td>
<td>128</td>
</tr>
<tr>
<td>To define replicates</td>
<td>128</td>
</tr>
<tr>
<td>Edit a Biological Replicate Group</td>
<td>130</td>
</tr>
<tr>
<td>Remove Biological Replicate Groups</td>
<td>130</td>
</tr>
<tr>
<td>Tips for designing your own study</td>
<td>131</td>
</tr>
<tr>
<td>Analyze the example study</td>
<td>132</td>
</tr>
<tr>
<td>Access the example study</td>
<td>132</td>
</tr>
<tr>
<td>View the experiment data and well results</td>
<td>132</td>
</tr>
<tr>
<td>View the analysis settings</td>
<td>134</td>
</tr>
<tr>
<td>Tips for analyzing your own study</td>
<td>135</td>
</tr>
<tr>
<td>Assess amplification results using the Amplification Plot</td>
<td>138</td>
</tr>
<tr>
<td>Tips for assessing amplification in your own study</td>
<td>139</td>
</tr>
<tr>
<td>Assess the gene expression profile using the Gene Expression Plot</td>
<td>140</td>
</tr>
<tr>
<td>About the example study</td>
<td>140</td>
</tr>
<tr>
<td>View the Gene Expression Plot</td>
<td>140</td>
</tr>
<tr>
<td>Tips for assessing the gene profile in your own study</td>
<td>143</td>
</tr>
<tr>
<td>View the replicate results data and the well results data</td>
<td>144</td>
</tr>
<tr>
<td>Column descriptions</td>
<td>144</td>
</tr>
<tr>
<td>About the example study</td>
<td>146</td>
</tr>
<tr>
<td>View the results data</td>
<td>146</td>
</tr>
<tr>
<td>Tips for viewing replicate results in your own study</td>
<td>147</td>
</tr>
<tr>
<td>Omit replicates from the analysis</td>
<td>147</td>
</tr>
<tr>
<td>Confirm accurate dye signal using the Multicomponent Plot</td>
<td>148</td>
</tr>
<tr>
<td>About the example study</td>
<td>148</td>
</tr>
<tr>
<td>View the Multicomponent Plot</td>
<td>148</td>
</tr>
<tr>
<td>Tips for confirming dye-signal accuracy in your own studies</td>
<td>149</td>
</tr>
<tr>
<td>View the QC Plots</td>
<td>149</td>
</tr>
<tr>
<td>View the Endogenous Control Profile plot</td>
<td>150</td>
</tr>
<tr>
<td>View the box plots</td>
<td>150</td>
</tr>
<tr>
<td>View the Technical Replicates Correlation plot</td>
<td>151</td>
</tr>
<tr>
<td>View the Biological Group Correlation plot</td>
<td>154</td>
</tr>
<tr>
<td>Heat maps</td>
<td>156</td>
</tr>
<tr>
<td>Tips for viewing your own scatter plots and heat maps</td>
<td>157</td>
</tr>
<tr>
<td>View the QC Summary</td>
<td>158</td>
</tr>
<tr>
<td>About the example study</td>
<td>158</td>
</tr>
<tr>
<td>View the QC Summary</td>
<td>158</td>
</tr>
<tr>
<td>Possible flags</td>
<td>158</td>
</tr>
<tr>
<td>Tips for using flags to evaluate your study</td>
<td>160</td>
</tr>
<tr>
<td>Compare analysis settings</td>
<td>160</td>
</tr>
<tr>
<td>About the example study</td>
<td>160</td>
</tr>
</tbody>
</table>
Contents

Modify comparison criteria ................................................. 160
Tips for managing your own comparison .............................. 164
Revert to the default analysis settings ................................. 164
Omit wells from the analysis ............................................. 164
Export the study ............................................................. 165
For more information ....................................................... 168

Index .................................................................................. 169
PART 1
Running Relative Standard Curve Experiments
This chapter covers:

- About Relative Standard Curve experiments ........................................ 11
- About the example experiment ............................................................. 13

**IMPORTANT!** First-time users of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, please read Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments* and Booklet 7, *QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes* of this binder thoroughly. The booklets provide information and general instructions that are applicable to all the experiments described in this binder.

**Note:** For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ 6 and 7 Flex Real-Time PCR System Software by pressing F1, clicking 📚 in the toolbar, or selecting Help » QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Help.

### About Relative Standard Curve experiments

The Relative Standard Curve method is used to determine relative target quantity in samples. The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software measures amplification of the target and of the endogenous control in samples, in a reference sample, and in a standard dilution series. Measurements are normalized using the endogenous control. Data from the standard dilution series are used to generate the standard curve. Using the standard curve, the software interpolates target quantity and endogenous control quantity in the samples and the reference sample. For each sample and reference sample, the target quantity is normalized by endogenous control quantity (quantity of target/quantity of endogenous control). The normalized quotient from samples is divided by the quotient from the reference sample to get relative quantification (fold change). The software determines the relative quantity of target in each sample by comparing target quantity in each sample to target quantity in the reference sample.

Relative Standard Curve experiments are commonly used to:

- Compare expression levels of a gene in different tissues.
- Compare expression levels of a gene in a treated sample and an untreated sample.
- Compare expression levels of wild-type alleles and mutated alleles.
- Analyze the gene expression changes over time under specific treatment conditions.
The Comparative CT ($\Delta \Delta C_T$) method is used to determine the relative target quantity in samples. With the comparative $C_T$ method, the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software measures amplification of the target and of the endogenous control in samples and in a reference sample. For more information on Comparative CT ($\Delta \Delta C_T$) experiments, refer to Part II, Running Comparative CT ($\Delta \Delta C_T$) Experiments of this booklet.

### Assemble required components

- **Sample** – The tissue group that you are testing for a target gene.
- **Reference sample (also called a calibrator)** – The sample used as the basis for relative quantification results. For example, in a study of drug effects on gene expression, an untreated control is an appropriate reference sample.
- **Standard** – A sample that contains known quantities of the target; used in quantification experiments to generate standard curves.
- **Standard dilution series** – A set of standards containing a range of known quantities. The standard dilution series is prepared by serially diluting standards.
- **Endogenous control** – A gene that is used to normalize template input differences, and sample-to-sample or run-to-run variation.
- **Replicates** – The total number of identical reactions containing identical components and identical volumes.
- **Negative controls** – Wells that contain water or buffer instead of sample template. No amplification of the target should occur in negative control wells.

### PCR options

When performing real-time PCR, choose between:

- Singleplex and multiplex PCR (below)
- 1-step and 2-step RT-PCR (page 13)

#### Singleplex and Multiplex PCR

You can perform a PCR reaction using either:

- **Singleplex PCR** – In singleplex PCR a single primer and probe set is present in the reaction tube or well. Only one target or endogenous control can be amplified per reaction.

  *Or*

- **Multiplex PCR** – In multiplex PCR, two or more primer and probe sets are present in the reaction tube or well. Each set amplifies a specific target or endogenous control. Typically, a probe labeled with FAM™ dye detects the target and a probe labeled with VIC® dye detects the endogenous control.

<table>
<thead>
<tr>
<th>Target Primer Set</th>
<th>Endogenous Control Primer Set</th>
<th>cDNA</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Singleplex PCR</th>
<th>Multiplex PCR</th>
</tr>
</thead>
</table>

**IMPORTANT!** SYBR® Green reagents cannot be used for multiplex PCR.
1- and 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in separate reactions (2-step). The reagent configuration you use depends on whether you are performing 1- or 2-step RT-PCR:

- **1-step PCR**— In 1-step RT-PCR, RT and PCR take place in one buffer system. Using one buffer system provides the convenience of a single-tube preparation for RT and PCR amplification. However, you cannot use Fast PCR Master Mix or the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

- **2-step PCR**— 2-step RT-PCR is performed in two separate reactions: First, total RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful for detecting multiple transcripts from a single cDNA template or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be used to prevent cDNA carryover contamination.

**About the example experiment**

To illustrate how to perform a Relative Standard Curve, this guide leads you through the process of designing and performing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

The objective of the Relative Standard Curve example experiment is to compare the expression of the FAS transcriptional factor (an oncoprotein that activates the transcription of growth-associated genes) in Human cDNA tissues.

In the Relative Standard Curve example experiment:

- The samples are kidney, liver, brain, and heart.
- The target is FAS.
- The endogenous control is HPRT.
- The reference sample is brain.
- One standard curve is set up for FAS. The standard used for the standard dilution series is a Human cDNA sample of known total concentration.
- One standard curve is set up for HPRT (endogenous control). The standard used for the standard dilution series is a Human Male Raji cDNA sample of known total concentration.
- Reactions are set up for 2-step RT-PCR. The Invitrogen VILO Kit is used for reverse transcription; the TaqMan® Gene Expression Master Mix (2X) is used for PCR.
- Select primer and probe sets from the Life Technologies TaqMan® Gene Expression Assays product line:
  - For the target assay (FAS), select assay ID Hs00907759_m1.
  - For the endogenous control assay (HPRT), select assay ID Hs99999909_m1.
Chapter 1 About Relative Standard Curve Experiments

About the example experiment
Design the Experiment

This chapter explains how to design the example experiment from the Experiment Setup menu.

This chapter covers:

- Define the experiment properties ........................................ 15
- Define targets, samples, and biological replicates .................. 16
- Assign targets, samples, and biological groups ..................... 17
- Set up the run method ..................................................... 19
- Tips for designing your own experiment .............................. 20
- For more information ..................................................... 21

Note: To automatically export the analyzed data to a specified location, select the Auto Export task from the Export screen, before running the experiment. For more information on Auto Export, refer to Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.

Define the experiment properties

Click Experiment Setup    Experiment Properties to create a new experiment in the QuantStudio™ 6 and 7 Flex Software. Enter:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Name</td>
<td>QS6_QuantStudio_384-Well_Relative_Standard_Curve_Example</td>
</tr>
<tr>
<td>Barcode</td>
<td>Leave field empty</td>
</tr>
<tr>
<td>User Name</td>
<td>Example User</td>
</tr>
<tr>
<td>Comments</td>
<td>Relative Standard Curve example</td>
</tr>
<tr>
<td>Instrument type</td>
<td>QuantStudio™ 6 Flex System</td>
</tr>
<tr>
<td>Block</td>
<td>384-Well Block</td>
</tr>
<tr>
<td>Experiment Type</td>
<td>Relative Standard Curve</td>
</tr>
<tr>
<td>Reagents</td>
<td>TaqMan® Reagents</td>
</tr>
<tr>
<td>Ramp speed</td>
<td>Standard</td>
</tr>
<tr>
<td>Reagent information</td>
<td>NA</td>
</tr>
</tbody>
</table>

Save the experiment.
Chapter 2 Design the Experiment

Define targets, samples, and biological replicates

Your Experiment Properties screen should look like this:

![Experiment Properties Screen]

Define targets, samples, and biological replicates

Click **Define** to access the Define screen. Enter:

1. **Targets**

<table>
<thead>
<tr>
<th>Target name</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAS</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>HPRT</td>
<td>VIC</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
</tbody>
</table>

2. **Samples**

<table>
<thead>
<tr>
<th>Sample name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brain</td>
<td></td>
</tr>
<tr>
<td>Heart</td>
<td></td>
</tr>
<tr>
<td>Kidney</td>
<td></td>
</tr>
<tr>
<td>Liver</td>
<td></td>
</tr>
</tbody>
</table>

3. **Dye to be used as a Passive Reference**

   ROX

4. **Custom Task Name**

   Not applicable
5. Analysis Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Sample</td>
<td>Brain</td>
</tr>
<tr>
<td>Endogenous Control</td>
<td>HPRT</td>
</tr>
</tbody>
</table>

Your Define screen should look like this:

Note: This example experiment does not define biological replicate groups. Leave Biological Replicate Groups blank.

Assign targets, samples, and biological groups

Click Assign to access the Assign screen.

Note: To automatically set up and assign standards, click Define and Set Up Standards to open the Define and Set Up Standards dialog box.

To assign the targets and samples:

1. Set up the standards.

2. For the first standard for the FAS target:
   a. Click-drag to select wells A9-A16.
   b. Check check box next to FAS in the Targets list.
   c. Select S in the Task drop-down menu.
   d. Enter 625 in the Quantity column.
e. Repeat steps a through c for each of the standards for the FAS target, selecting the wells listed in the table below, and entering the corresponding quantity.

3. Repeat step 2 for each standard for the HPRT target.

<table>
<thead>
<tr>
<th>Target name</th>
<th>Well number</th>
<th>Task</th>
<th>Quantity</th>
<th>Sample name</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAS</td>
<td>A1 - A8</td>
<td>Negative</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>E1 - E12</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Kidney</td>
</tr>
<tr>
<td></td>
<td>E13 - E24</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>I1 - I12</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>I13 - I24</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>A9 - A16</td>
<td>Standard</td>
<td>625</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>A17 - A24</td>
<td>Standard</td>
<td>2,500</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>C1 - C8</td>
<td>Standard</td>
<td>312.50</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>C9 - C16</td>
<td>Standard</td>
<td>1,250</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>C17 - C24</td>
<td>Standard</td>
<td>5,000</td>
<td>None</td>
</tr>
<tr>
<td>HPRT</td>
<td>P1 - P8</td>
<td>Negative</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>H1 - H12</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Kidney</td>
</tr>
<tr>
<td></td>
<td>H13 - H24</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>L1 - L12</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>L13 - L24</td>
<td>Unknown</td>
<td>Determined by run</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>N1 - N8</td>
<td>Standard</td>
<td>165.25</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>N9 - N16</td>
<td>Standard</td>
<td>625</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>N17 - N24</td>
<td>Standard</td>
<td>2,500</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>P9 - P16</td>
<td>Standard</td>
<td>312.50</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>P17 - P24</td>
<td>Standard</td>
<td>1,250</td>
<td>None</td>
</tr>
</tbody>
</table>
Your Assign screen should look like this:

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- Reaction Volume Per Well: 10 μL
- Thermal Profile

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>50°C</td>
<td>2 minutes</td>
</tr>
<tr>
<td></td>
<td>Step 2</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>10 minutes</td>
</tr>
<tr>
<td>PCR Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>15 seconds</td>
</tr>
<tr>
<td>Number of Cycles: 40</td>
<td>Step 2</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>1 minute</td>
</tr>
<tr>
<td>Enable AutoDelta: Unchecked (default)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Starting Cycle: Disabled when Enable AutoDelta is unchecked</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Tips for designing your own experiment

Life Technologies recommends that you:

- Set up a standard curve for each target assay in the reaction plate.
- Identify each target assay with a unique name and color. You can enter up to 100 characters in the Target Name field.
- Identify each sample using a unique name and color. You can enter up to 100 characters in the Sample Name field.
- Select an endogenous control for each sample. The endogenous control is a target that is present in all samples under investigation. It should be expressed equally in all sample types, regardless of treatment or tissue origin (examples of endogenous controls are β-actin, GAPDH, and 18S ribosomal RNA [18S rRNA]). The endogenous control is used to normalize the PCR results; the endogenous control corrects for variable sample mass, nucleic acid extraction efficiency, reverse transcription efficiency, and pipette calibration errors.

**Note**: Each sample type (for example, each tissue in a study comparing multiple tissues) requires an endogenous control.

- Enter at least five dilution points for each standard curve in the reaction plate.
- Enter at least three replicates (identical reactions) for each point in the standard curve and for each sample reaction.
- Enter at least three negative control reactions for each target assay.
• Carefully consider the appropriate range of standard quantities for your assay because the range of standard quantities affects the amplification efficiency calculations:

  – For more accurate measurements of amplification efficiency, use a broad range of standard quantities, spanning between 5 and 6 logs. If you do so, use a PCR product or a highly concentrated template, such as a cDNA clone.

  – If you have a limited amount of cDNA template and/or if the target is a low-copy number transcript, or known to fall within a given range, a narrow range of standard quantities may be necessary.

• Minimally run a five-point curve of 1:10 dilutions to minimize the effects of small pipetting errors.

• Select a reference sample from your previously defined samples. Amplification results from the samples and from the reference sample are compared to determine relative expression.

• Select an endogenous control from your previously defined target assays. Amplification results from the endogenous control are used to normalize the amplification results from the target for differences in the amount of template added to each reaction.

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumables</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em> Appendix A in Booklet 7, <em>QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes</em></td>
<td>4489822</td>
</tr>
<tr>
<td>Amplification efficiency</td>
<td><em>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</em></td>
<td>127AP05-03</td>
</tr>
<tr>
<td>Using Alternative Setup</td>
<td>Chapter 3 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Relative Standard Curve example experiment.

This chapter covers:

- Assemble required materials ........................................ 23
- Prepare the template ................................................... 23
- Prepare the sample dilutions ........................................ 24
- Prepare the standard dilution series for FAS and HPRT assays .................................................. 24
- Prepare the reaction mix (“cocktail mix”) ........................................ 25
- Prepare the reaction plate ........................................ 26
- Tips for preparing reactions for your own experiments. ........................................ 28
- For more information. ........................................ 29

Assemble required materials

- Items listed in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments
- Samples - Total RNA isolated from kidney, heart, liver, and brain tissues.
- Example experiment reaction mix components:
  - TaqMan® Gene Expression Master Mix (2X)
  - FAS Assay Mix (20X)
  - HPRT Assay Mix (20X)

Note: Fast Universal Master Mix is not recommended to be used with the 96-well (0.2 mL) reaction plates or reaction tubes and tube strips sealed with caps.

Prepare the template

Prepare the template for the PCR reactions (both samples and standards) using one of the Invitrogen VILO kits, SuperScript® VILO™ cDNA Synthesis Kit (Part no. 4453650).

Example experiment settings

For the Relative Standard Curve example experiment, the template for the PCR reactions is cDNA reverse-transcribed from total RNA samples using the Invitrogen VILO kits.

To prepare the template

Use the Invitrogen VILO kits to reverse-transcribe cDNA from the total RNA samples. Follow the procedures in the Invitrogen VILO Kits Protocol (Pub. no. 100002284) to:
1. Isolate total RNA from cells using an Ambion® sample preparation kit appropriate to the tissue or cell type.

2. Quantify and perform quality control on the RNA.

3. Convert the RNA to cDNA via reverse transcription.

Prepare the sample dilutions

For the Relative Standard Curve example experiment, no more than 10% of your reaction should consist of the undiluted cDNA.

1. Label a separate microcentrifuge tube for each diluted sample:
   - Kidney
   - Heart
   - Liver
   - Brain

2. Add the required volume of water (diluent) to each empty tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample name</th>
<th>Diluent volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Kidney</td>
<td>76</td>
</tr>
<tr>
<td>2</td>
<td>Heart</td>
<td>76</td>
</tr>
<tr>
<td>3</td>
<td>Liver</td>
<td>76</td>
</tr>
<tr>
<td>4</td>
<td>Brain</td>
<td>76</td>
</tr>
</tbody>
</table>

3. Add the required volume of sample stock (100 ng/µL) to each empty tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample name</th>
<th>Diluent volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Kidney</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>Heart</td>
<td>4</td>
</tr>
<tr>
<td>3</td>
<td>Liver</td>
<td>4</td>
</tr>
<tr>
<td>4</td>
<td>Brain</td>
<td>4</td>
</tr>
</tbody>
</table>

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the standard dilution series for FAS and HPRT assays

The same standard materials are used to prepare the exact same dilutions for both the target genes. The prepared standards are then used to generate the two standard curves.

- The stock concentration for cDNA is 100 ng/µL.
- The volumes calculated for both the FAS and HPRT assays are:
Chapter 3  Prepare the Reactions

Prepare the reaction mix ("cocktail mix")

1. Label an appropriately sized tube for each reaction mix:
   - FAS Reaction Mix
   - HPRT Reaction Mix

2. For the FAS assay, add the required volumes of each component to the FAS Reaction Mix tube:

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume [µL] for 1 reaction</th>
<th>Volume [µL] for 96 reactions (plus 10% excess)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® Gene Expression Master Mix [2X]</td>
<td>5</td>
<td>530</td>
</tr>
<tr>
<td>FAS Assay Mix [20X]</td>
<td>0.5</td>
<td>53</td>
</tr>
<tr>
<td>Water</td>
<td>3.5</td>
<td>371</td>
</tr>
<tr>
<td>Total Reaction Mix Volume</td>
<td>9</td>
<td>954</td>
</tr>
</tbody>
</table>

3. For the HPRT assay, add the required volumes of each component to the HPRT Reaction Mix tube:
Chapter 3  Prepare the Reactions

Prepare the reaction plate

4. Mix the reaction in each tube by gently pipetting up and down, then cap each tube.

5. Centrifuge the tubes briefly to remove air bubbles.

6. Place the reaction mixes on ice until you prepare the reaction plate.

Note: Do not add the sample or standard at this time.

Prepare the reaction plate

The reaction plate for the Relative Standard Curve example experiment contains:

- A MicroAmp® Optical 384-Well Reaction Plate
- Reaction volume: 10 µL/well
- 96 Unknown wells
- 80 Standard wells
- 16 Negative control wells
- 192 Empty wells

The following is an image of the plate layout for the example experiment:
To prepare the reaction plate components

1. For each target, prepare the negative control reactions:
   a. To an appropriate volume tube, add the volumes of reaction mix and water listed below.

<table>
<thead>
<tr>
<th>Tube</th>
<th>Reaction mix</th>
<th>Reaction mix volume (µL)</th>
<th>Water volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FAS Reaction Mix</td>
<td>79.2</td>
<td>8.8</td>
</tr>
<tr>
<td>2</td>
<td>HPRT Reaction Mix</td>
<td>79.2</td>
<td>8.8</td>
</tr>
</tbody>
</table>

   b. Mix the reaction by gently pipetting up and down, then cap the tube.
   c. Centrifuge the tube briefly to remove air bubbles.
   d. Add 10 µL of the negative control reaction to the appropriate wells in the reaction plate.

2. For each replicate group, prepare the standard reactions:
   a. To appropriately sized tubes, add the volumes of reaction mix and standard listed below.

<table>
<thead>
<tr>
<th>Tube</th>
<th>Standard reaction</th>
<th>Reaction mix</th>
<th>Reaction mix volume (µL)</th>
<th>Standard</th>
<th>Standard volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FAS Std. 1</td>
<td>FAS Reaction Mix</td>
<td>79.2</td>
<td>FAS Std. 1</td>
<td>8.8</td>
</tr>
<tr>
<td>2</td>
<td>FAS Std. 2</td>
<td>FAS Reaction Mix</td>
<td>79.2</td>
<td>FAS Std. 2</td>
<td>8.8</td>
</tr>
<tr>
<td>3</td>
<td>FAS Std. 3</td>
<td>FAS Reaction Mix</td>
<td>79.2</td>
<td>FAS Std. 3</td>
<td>8.8</td>
</tr>
<tr>
<td>4</td>
<td>FAS Std. 4</td>
<td>FAS Reaction Mix</td>
<td>79.2</td>
<td>FAS Std. 4</td>
<td>8.8</td>
</tr>
<tr>
<td>5</td>
<td>FAS Std. 5</td>
<td>FAS Reaction Mix</td>
<td>79.2</td>
<td>FAS Std. 5</td>
<td>8.8</td>
</tr>
<tr>
<td>6</td>
<td>HPRT Std. 1</td>
<td>HPRT Reaction Mix</td>
<td>79.2</td>
<td>HPRT Std. 1</td>
<td>8.8</td>
</tr>
<tr>
<td>7</td>
<td>HPRT Std. 2</td>
<td>HPRT Reaction Mix</td>
<td>79.2</td>
<td>HPRT Std. 2</td>
<td>8.8</td>
</tr>
<tr>
<td>8</td>
<td>HPRT Std. 3</td>
<td>HPRT Reaction Mix</td>
<td>79.2</td>
<td>HPRT Std. 3</td>
<td>8.8</td>
</tr>
<tr>
<td>9</td>
<td>HPRT Std. 4</td>
<td>HPRT Reaction Mix</td>
<td>79.2</td>
<td>HPRT Std. 4</td>
<td>8.8</td>
</tr>
<tr>
<td>10</td>
<td>HPRT Std. 5</td>
<td>HPRT Reaction Mix</td>
<td>79.2</td>
<td>HPRT Std. 5</td>
<td>8.8</td>
</tr>
</tbody>
</table>

   b. Mix the reactions by gently pipetting up and down, then cap the tubes.
   c. Centrifuge the tubes briefly to remove air bubbles.
   d. Add 10 µL of the standard reaction to the appropriate wells in the reaction plate.
3. For each replicate group, prepare the reactions for the unknowns:
   a. To appropriately sized tubes, add the volumes of reaction mix and sample listed below:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Unknown reaction</th>
<th>Reaction mix</th>
<th>Reaction mix volume (µL)</th>
<th>Sample</th>
<th>Sample volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FAS Kidney</td>
<td>FAS Reaction Mix</td>
<td>118.8</td>
<td>Kidney</td>
<td>13.2</td>
</tr>
<tr>
<td>2</td>
<td>FAS Heart</td>
<td>FAS Reaction Mix</td>
<td>118.8</td>
<td>Heart</td>
<td>13.2</td>
</tr>
<tr>
<td>3</td>
<td>FAS Liver</td>
<td>FAS Reaction Mix</td>
<td>118.8</td>
<td>Liver</td>
<td>13.2</td>
</tr>
<tr>
<td>4</td>
<td>FAS Brain</td>
<td>FAS Reaction Mix</td>
<td>118.8</td>
<td>Brain</td>
<td>13.2</td>
</tr>
<tr>
<td>5</td>
<td>HPRT Kidney</td>
<td>HPRT Reaction Mix</td>
<td>118.8</td>
<td>Kidney</td>
<td>13.2</td>
</tr>
<tr>
<td>6</td>
<td>HPRT Heart</td>
<td>HPRT Reaction Mix</td>
<td>118.8</td>
<td>Heart</td>
<td>13.2</td>
</tr>
<tr>
<td>7</td>
<td>HPRT Liver</td>
<td>HPRT Reaction Mix</td>
<td>118.8</td>
<td>Liver</td>
<td>13.2</td>
</tr>
<tr>
<td>8</td>
<td>HPRT Brain</td>
<td>HPRT Reaction Mix</td>
<td>118.8</td>
<td>Brain</td>
<td>13.2</td>
</tr>
</tbody>
</table>

   b. Mix the reactions by gently pipetting up and down, then cap the tubes.
   c. Centrifuge the tubes briefly to remove air bubbles.
   d. Add 10 µL of the unknown (sample) reaction to the appropriate wells in the reaction plate.

4. Seal the reaction plate with optical adhesive film.

5. Centrifuge the reaction plate briefly to remove air bubbles.

6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the reaction plate again at a higher speed and for a longer period of time.

7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

**Tips for preparing reactions for your own experiments**

**Tips for preparing templates**

When you prepare your own Relative Standard Curve experiment, Life Technologies recommends the following templates:

- **Complementary DNA (cDNA)** – cDNA reverse-transcribed from total RNA samples.
- **Genomic DNA (gDNA)** – Purified gDNA already extracted from tissue or sample
### Tips for preparing sample dilutions
When you prepare your own Relative Standard Curve experiment, for optimal performance of TaqMan® Gene Expression Assays or Custom TaqMan® Gene Expression Assays, use 10 to 100 ng of cDNA template per 10μL reaction.

### Tips for preparing the reaction mix
If your experiment includes more than one target assay, prepare the reaction mix for each target assay separately.

### Tips for preparing the reaction plate
When you prepare your own Relative Standard Curve experiment, make sure the arrangement of the PCR reactions matches the plate layout displayed in the QuantStudio™ 6 and 7 Flex Software.

### For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning the reaction plate components</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
<tr>
<td>Sealing the reaction plate</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
This chapter explains how to run the example experiment on the QuantStudio™ 6 or 7 Instrument.

This chapter covers:

- Start the run .......................................................... 31
- Monitor the run ......................................................... 31

IMPORTANT! Run the experiment at the same ambient temperature at which you calibrated the instrument. Extreme variations in ambient temperature can affect the heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 6 or 7 Instrument is in operation.

Start the run

1. Open the Relative Standard Curve example file that you created using instructions in Chapter 2.
2. Load the reaction plate into the instrument.
3. Start the run.

Monitor the run

Monitor the example experiment run:

- From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software using the Run screen, while the experiment is in progress.
- From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software (to monitor an experiment started from another computer or from the QuantStudio™ 6 or 7 Instrument touchscreen).
- From the QuantStudio™ 6 or 7 Instrument touchscreen.
1. In the Instrument Console screen, select the instrument icon.
2. Click **Manage Instrument** or double-click on the instrument icon.
3. In the Manage Instrument screen, click **Monitor Running Experiment** to access the Run screen.

**View the Amplification Plot**

You can view the progress of the run in real time. During the run, periodically view all the three plots available from the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software for potential problems.

To view data in the Amplification Plot screen, click **Amplification Plot** from the Run Experiment Menu, and select the Plate Layout tab, then select the wells that you want to view.

The following is an image of the Amplification Plot screen as it appears at the end of the example experiment.
View the Temperature Plot

To view data in the Temperature Plot screen, click **Temperature Plot** from the Run Experiment Menu.

The following is an image of the Temperature Plot screen as it appears during the example experiment.

![Temperature Plot Screen]

**Note:** The Sample temperature displayed in the Current Temperatures group is an estimated value.
View the Run Method

To view data in the Run Method screen, click **Run Method** from the Run Experiment Menu.

The following is an image of the Run Method screen as it appears in the example experiment:

![Run Method Screen](image)

View run data

To view the run data, click **View Run Data** from the Run Experiment Menu.

The following is an image of the View Run Data screen as it appears in the example experiment:

![View Run Data Screen](image)
You can also view the progress of the run from the QuantStudio™ 6 or 7 Instrument touchscreen.

The following are images of the Run Method screen on the QuantStudio™ 6 or 7 Instrument touchscreen:

**Experiment view**

**Time view**
Chapter 4  Run the Experiment
Monitor the run
Review Results and Adjust Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis screens and publish the data. Section 5.2 of this chapter walks you through the process of modifying experiment parameters to troubleshoot problems with experiment results before rerunning an experiment.

This chapter covers:

- **Section 5.1 Review Results** ............................................................. 39
- Analyze the example experiment ..................................................... 39
- View the Standard Curve Plot .......................................................... 39
- Assess amplification results using the Amplification Plot ................. 42
- Assess the gene expression profile using the Gene Expression Plot ...... 49
- Identify well problems using the Well Table ..................................... 51
- Confirm accurate dye signal using the Multicomponent Plot .............. 53
- Determine signal accuracy using the Raw Data Plot ......................... 55
- View the endogenous control profile using the QC Plot ................... 57
- Review the QC flags in the QC Summary ........................................ 58
- For more information ................................................................. 60
- **Section 5.2 Adjust parameters for re-analysis of your own experiments** ..... 61
- Adjust analysis settings ............................................................... 61
- Improve CT precision by omitting wells ......................................... 65
- For more information ................................................................ 66
Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.
2. Click Analyze. The software analyzes the data using the default analysis settings. You can also access the experiment to analyze from the Home screen.

View the Standard Curve Plot

The Standard Curve Plot screen displays the standard curve for samples designated as standards. The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software calculates the quantity of an unknown target from the standard curve.

Example experiment standard curve values

In the standard curve example experiment, you review the Standard Curve Plot screen for the following regression coefficient values:

- Slope/amplification efficiency
- R² value (correlation coefficient)
- C_T values

To view and assess the Standard Curve plot

1. From the Experiment Menu pane, select Analysis \(\Rightarrow\) Standard Curve.
   Note: If no data are displayed, click Analyze.
2. Display all 384 wells in the Standard Curve Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.
3. Enter the Plot Settings:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>All</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Default</td>
</tr>
<tr>
<td>![Check](This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.)</td>
<td>Check (default)</td>
</tr>
</tbody>
</table>

4. View the values displayed below the standard curve. In the example experiment, the values for each target fall within the acceptable ranges:

<table>
<thead>
<tr>
<th>Target</th>
<th>Slope</th>
<th>R² Value</th>
<th>Amplification efficiency (Eff%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAS</td>
<td>-3.38</td>
<td>0.998</td>
<td>97.612</td>
</tr>
<tr>
<td>HPRT</td>
<td>-3.652</td>
<td>0.983</td>
<td>87.858</td>
</tr>
</tbody>
</table>
5. Check that all samples are within the standard curve. In the example experiment, all samples (blue dots) are within the standard curve (red dots).

6. Check the C\textsubscript{T} values:

7. Click the Well Table tab.

8. From the Group By drop-down menu, select Replicate.
9. Look at the values in the CT column. In the example experiment, the CT values fall within the expected range (>8 and <35).

<table>
<thead>
<tr>
<th>Sample</th>
<th>Well</th>
<th>Omit</th>
<th>Pct</th>
<th>Target Name</th>
<th>Table</th>
<th>Ct</th>
<th>Ct Mean</th>
<th>Ct SD</th>
<th>Quantity</th>
<th>Normalized</th>
<th>Efficiency</th>
</tr>
</thead>
<tbody>
<tr>
<td>209</td>
<td>197</td>
<td>1,000</td>
<td>P</td>
<td>UNIVW</td>
<td>UNIVM1</td>
<td>20.05</td>
<td>29.05</td>
<td>0.071</td>
<td>1,049,476</td>
<td>1.037</td>
<td>97.39</td>
</tr>
<tr>
<td>210</td>
<td>199</td>
<td>1,000</td>
<td>P</td>
<td>UNIVW</td>
<td>UNIVM1</td>
<td>20.00</td>
<td>29.05</td>
<td>0.071</td>
<td>1,019,329</td>
<td>1.027</td>
<td>97.39</td>
</tr>
<tr>
<td>211</td>
<td>191</td>
<td>1,000</td>
<td>P</td>
<td>UNIVW</td>
<td>UNIVM1</td>
<td>20.05</td>
<td>29.05</td>
<td>0.071</td>
<td>1,039,701</td>
<td>1.037</td>
<td>97.39</td>
</tr>
<tr>
<td>212</td>
<td>192</td>
<td>1,000</td>
<td>P</td>
<td>UNIVW</td>
<td>UNIVM1</td>
<td>20.04</td>
<td>29.05</td>
<td>0.071</td>
<td>1,012,422</td>
<td>1.037</td>
<td>97.39</td>
</tr>
<tr>
<td>213</td>
<td>193</td>
<td>1,000</td>
<td>P</td>
<td>UNIVW</td>
<td>UNIVM1</td>
<td>20.05</td>
<td>29.05</td>
<td>0.071</td>
<td>995,977</td>
<td>1.037</td>
<td>97.39</td>
</tr>
<tr>
<td>214</td>
<td>194</td>
<td>1,000</td>
<td>P</td>
<td>UNIVW</td>
<td>UNIVM1</td>
<td>20.05</td>
<td>29.05</td>
<td>0.071</td>
<td>1,020,571</td>
<td>1.037</td>
<td>97.39</td>
</tr>
<tr>
<td>215</td>
<td>195</td>
<td>1,000</td>
<td>P</td>
<td>UNIVW</td>
<td>UNIVM1</td>
<td>20.35</td>
<td>29.05</td>
<td>0.071</td>
<td>943,913</td>
<td>1.037</td>
<td>97.39</td>
</tr>
<tr>
<td>216</td>
<td>196</td>
<td>1,000</td>
<td>P</td>
<td>UNIVW</td>
<td>UNIVM1</td>
<td>20.04</td>
<td>29.05</td>
<td>0.071</td>
<td>1,001,774</td>
<td>1.037</td>
<td>97.39</td>
</tr>
<tr>
<td>217</td>
<td>197</td>
<td>1,000</td>
<td>P</td>
<td>UNIVW</td>
<td>UNIVM1</td>
<td>20.07</td>
<td>29.05</td>
<td>0.071</td>
<td>1,002,20</td>
<td>1.037</td>
<td>97.39</td>
</tr>
<tr>
<td>218</td>
<td>198</td>
<td>1,000</td>
<td>P</td>
<td>UNIVW</td>
<td>UNIVM1</td>
<td>20.02</td>
<td>29.05</td>
<td>0.071</td>
<td>1,132,761</td>
<td>1.037</td>
<td>97.39</td>
</tr>
</tbody>
</table>

Tips for analyzing your own experiments:

When you analyze your own Relative Standard Curve experiment, look for:

- **Slope/amplification efficiency values** – The amplification efficiency is calculated using the slope of the regression line in the standard curve. A slope close to −3.3 indicates optimal, 100% PCR amplification efficiency. Factors that affect amplification efficiency:
  - Range of standard quantities – For more accurate and precise efficiency measurements, use a broad range of standard quantities, 5 to 6 logs (10^5 to 10^6 fold).
  - Number of standard replicates – For more accurate efficiency measurements, include replicates to decrease the effects of pipetting inaccuracies.
  - PCR inhibitors – PCR inhibitors in the reaction can alter amplification efficiency.

- **R^2 values (correlation coefficient)** – The R^2 value is a measure of the closeness of fit between the regression line and the individual CT data points of the standard reactions. A value of 1.00 indicates a perfect fit between the regression line and the data points. An R^2 value >0.99 is desirable.

- **CT values** – The threshold cycle (CT) is the PCR cycle number at which the fluorescence level meets the threshold.
  - A CT value >8 and <35 is desirable.
  - A CT value ≤8 indicates that there is too much template in the reaction.
  - A CT value ≥35 indicates a low amount of target in the reaction; for CT values >35, expect a higher standard deviation.
If your experiment does not meet the guidelines above, troubleshoot as follows:

- Omit wells (see “Improve CT precision by omitting wells” on page 65).
  
  Or

- Rerun the experiment.

Assess amplification results using the Amplification Plot

Amplification plots available for viewing

The Amplification Plot screen displays amplification of all samples in the selected wells. There are three plots available:

- **ΔRn vs Cycle** – ΔRn is the magnitude of normalized fluorescence signal generated by the reporter at each cycle during the PCR amplification. This plot displays ΔRn as a function of cycle number. Use this plot to identify and examine irregular amplification and to view threshold and baseline values for the run.

- **Rn vs Cycle** – Rn is the fluorescence signal from the reporter dye normalized to the fluorescence signal from the passive reference. This plot displays Rn as a function of cycle number. Use this plot to identify and examine irregular amplification.

- **Cₜ vs Well** – Cₜ is the PCR cycle number at which the fluorescence meets the threshold in the amplification plot. This plot displays Cₜ as a function of well position. Use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log₁₀ graph type.

Purpose

The purpose of viewing the amplification plot for the example experiment is to identify:

- Correct baseline and threshold values

- Outliers

View the Amplification Plot

1. From the Experiment Menu pane, select **Analysis ▶ Amplification Plot**.
   
   **Note:** If no data are displayed, click **Analyze**.

2. Display the FAS wells in the Amplification Plot screen:
   
   a. Click the **Plate Layout** tab.

   b. From the Select Wells drop-down menu, select **Target**, then **FAS**.
The following is an image of the Plate Layout screen:

3. In the Amplification Plot screen, enter:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>ΔRn vs Cycle (default)</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Well (default)</td>
</tr>
</tbody>
</table>

(This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.)

4. View the baseline values:
   a. From the Graph Type drop-down menu, select Linear.
   b. Select the Baseline check box to show the start cycle and end cycle.
c. Verify that the baseline is set correctly: The end cycle should be set a few cycles before the cycle number where significant fluorescent signal is detected. In the example experiment, the baseline is set correctly.

5. View the threshold values:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Type</td>
<td>Log</td>
</tr>
<tr>
<td>Target</td>
<td>FAS</td>
</tr>
</tbody>
</table>

a. Select the Threshold check box to show the threshold.
Section 5.1 Review Results

Assess amplification results using the Amplification Plot

b. Verify that the threshold is set correctly. In the example experiment, the threshold is in the exponential phase.

6. Locate outliers:
   a. From the Plot Type drop-down menu, select C_T vs Well.
   b. Look for outliers from the amplification plot. In the example experiment, there are no outliers for FAS.

7. Repeat steps 2 through 6 for the HPRT wells.
Tips for analyzing your own experiments

When you analyze your own Relative Standard Curve experiment, look for:

- **Outliers**
- **A typical amplification plot** – The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software automatically calculates baseline and threshold values based on the assumption that the data exhibit a *typical* amplification plot. A typical amplification plot has four distinct sections:
  - Plateau phase
  - Linear phase
  - Exponential (geometric phase)
  - Baseline

A following is an image of a typical amplification plot:

---

**IMPORTANT!** Experimental error (such as contamination or pipetting errors) can produce atypical amplification curves that can result in incorrect baseline and threshold value calculations by the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software. Therefore, Life Technologies recommends that you examine the Amplification Plot screen and review the assigned baseline and threshold values for each well after analysis completes.
• Correct threshold values.

**Threshold Set Correctly**

The threshold is set in the exponential phase of the amplification curve. Threshold settings above or below the optimum increase the standard deviation of the replicate groups.

**Threshold Set Too Low**

The threshold is set below the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar up into the exponential phase of the curve.

**Threshold Set Too High**

The threshold is set above the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar down into the exponential phase of the curve.

• Correct baseline values

**Baseline Set Correctly**

The amplification curve begins after the maximum baseline.
Chapter 5  Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

Baseline Set Too Low
The amplification curve begins too far to the right of the maximum baseline. Increase the End Cycle value.

Baseline Set Too High
The amplification curve begins before the maximum baseline. Decrease the End Cycle value.

If your experiment does not meet the guidelines above, troubleshoot as follows:
• Omit wells (see “Improve CT precision by omitting wells” on page 65).
  Or
• Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on page 61).
Assess the gene expression profile using the Gene Expression Plot

The Gene Expression Plot screen displays the results of relative quantification calculations in the gene expression profile. There are two plots available:

- **RQ vs Target** – Groups the relative quantification (RQ) values by target. Each sample is plotted for each target. You can view the plot as the linear, log10, Ln, and log2 graph types. The Gene Expression plot when viewed as a linear graph type looks like this:
• **RQ vs Sample** – Groups the relative quantification (RQ) values by sample. Each target is plotted for each sample. You can view the plot as the linear, log10, Ln, and log2 graph types. The Gene Expression plot when viewed as a linear graph type looks like this:

![Gene Expression Plot](image)

**Example experiment values**

Review each target in the Gene Expression Plot screen for the expression level (or fold change) of the target sample relative to the reference sample.

**View the Gene Expression Plot**

1. From the Experiment Menu pane, select **Analysis ➤ Gene Expression**.  
   **Note:** If no data are displayed, click **Analyze**.

2. In the Gene Expression Plot screen:
   a. From the Plot Type drop-down menu, select **RQ vs Sample**.
   b. From the Graph Type drop-down menu, select **Log10**.
   c. From the Orientation drop-down menu, select **Vertical Bars**.

3. Click **Show a legend for the plot** (default).  
   **Note:** This is a toggle button. When the legend is displayed, the button changes to **Hide the plot legend**.
In the example experiment, the expression level of FAS in heart, kidney, and liver is displayed relative to its expression level in the reference sample (brain). Since the reference sample is compared to itself, the relative expression level is 1. When the result is displayed in the Log10 graph type, the expression level of the reference sample appears as 0 in the graph (log10 of 1 = 0).

Assessing the gene expression plot in your own experiments

When you analyze your own Relative Standard Curve experiment, look for differences in gene expression (as a fold change) relative to the reference sample.

Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including:

- The sample name, target name, task, and dyes
- The calculated threshold cycle (C_T), normalized fluorescence (Rn), and quantity values
- Flags

Example experiment values and flags

Review the Well Table to evaluate the C_T precision of the replicate groups.

View the well table

1. From the Experiment Menu pane, select Analysis ➤ Amplification Plot, then click the Well Table tab.
Chapter 5  Review Results and Adjust Experiment Parameters

Identify well problems using the Well Table

2. From the Group By drop-down menu, select **Replicate**.

3. Look at the C_T SD column to evaluate the C_T precision of the replicate groups. In the example experiment, the C_T SD have the expected value of < 0.5.

**Note:** To show or hide columns in the Well Table, select or deselect respectively the column name from the Show in Table drop-down menu.

Assessing the well table in your own experiments

When you analyze your own Relative Standard Curve experiment, look for standard deviation in the replicate groups (C_T SD values). If needed, omit outliers (“Improve CT precision by omitting wells” on page 65).
Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

Purpose

In the Relative Standard Curve example experiment, you review the Multicomponent Plot screen for:

- ROX™ dye (passive reference)
- FAM™ dye (reporter for RNase P)
- VIC® dye (reporter for HPRT)
- Spikes, dips, and/or sudden changes
- Amplification in the negative control wells

View the Multicomponent Plot

1. From the Experiment Menu pane, select Analysis > Multicomponent Plot.
   
   Note: If no data are displayed, click Analyze.

2. Display the unknown and standard wells one at a time in the Multicomponent Plot screen:
   
   a. Click the Plate Layout tab.
   
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.
      
      Note: If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click Show a legend for the plot (default).
   
   Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.
5. **Check the FAM and VIC dye signals.** In the example experiment, the FAM and VIC dyes signal increase throughout the PCR process, indicating normal amplification.

6. **Check the ROX dye signal.** In the example experiment, the ROX dye signal remains constant throughout the PCR process indicating typical data.

7. **Select the negative control wells one at time and check for amplification.** In the example experiment, there is no amplification in any of the negative control wells.
Tips for confirming dye accuracy in your own experiment

When you analyze your own Relative Standard Curve experiment, look for:

- **Passive reference** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.

- **Reporter dye** – The reporter dye fluorescence level should display a flat region corresponding to the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.

- **Irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.

- **Negative control wells** – There should not be any amplification in the negative control wells.

**Determine signal accuracy using the Raw Data Plot**

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter for the selected wells during each cycle of the real-time PCR.

**About the example experiment**

In the Relative Standard Curve example experiment, you review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

**View the Raw Data Plot**

1. From the Experiment Menu pane, select **Analysis > Raw Data Plot**.
   
   **Note**: If no data are displayed, click **Analyze**.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.

3. Click **Show a legend for the plot** (default). The legend displays the color code for each row of the reaction plate (see the legend in the Raw Data Plot shown below).
4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example experiment, there is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.

The filters used for the example experiment are:

**Tips for determining signal accuracy in your own experiment**

When you analyze your own Relative Standard Curve experiment, look for the following in each filter:

- Characteristic signal growth
- No abrupt changes or dips
View the endogenous control profile using the QC Plot

In the Relative Standard Curve experiment, the QC Plot screen displays the Endogenous Control Profile plot for all the targets in the experiment. The QC Plot serves as a tool to help users choose the best endogenous control for that experiment. The endogenous control profile plot is a visual display of the $C_T$ level of the endogenous control across the sample. You can view up to four endogenous controls at a time. The sample is plotted on the X-axis, and the $C_T$ is plotted on the Y-axis. The expression is viewed as a color and shape combination in the plot. Endogenous controls are also known as reference genes.

To view the QC Plot:

1. From the Experiment Menu pane, select Analysis → QC Plot.
   
   **Note:** If no data are displayed, click Analyze.

2. In the QC Plot screen, click Target Table to select a target to profile:
   
   a. In the Candidate Control column, select the check box of the target of the endogenous control profile to plot. In the example experiment, the endogenous control is HPRT.
   
   b. Select a color from the Color drop-down menu.
   
   c. Select a shape from the Shape drop-down menu.

3. Click the View Replicate Results Table.

4. Select the check box of the samples you want to plot.

5. Click Show a legend for the plot (default).
   
   **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.
The QC Plot in the Relative Standard Curve example experiment looks like this. Note that the endogenous control, HPRT is expressed at the same level in all the four samples:

![QC Plot](image)

This example experiment does not define Biological Groups.

**Review the QC flags in the QC Summary**

The QC Summary screen displays a list of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software flags, including the flag frequency and location for the open experiment.

**View the QC Summary**

1. From the Experiment Menu pane, select Analysis ▶ QC Summary.
   
   **Note:** If no data are displayed, click Analyze.

2. Review the Flags Summary.
   
   **Note:** A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment. If the frequency is >0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.

   In the example experiment, there are no flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed information about the flag. In the example experiment, the Frequency column displays 0 for all flags.

4. *(Optional)* For those flags with frequency >0, click the troubleshooting link to view information on correcting the flag.
The following is an image of the QC Summary screen for the example experiment:

### Possible flags

The flags listed below may be triggered by the experiment data.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>OUTLIERRG</td>
<td>Outlier in replicate group</td>
</tr>
<tr>
<td>AMPFAIL</td>
<td>Amplification algorithm failed</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>HOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>CT algorithm failed</td>
</tr>
<tr>
<td>OUTLIERRG</td>
<td>Outlier in replicate group</td>
</tr>
<tr>
<td>AMPNC</td>
<td>Amplification in negative control</td>
</tr>
<tr>
<td>HIGHSD</td>
<td>High standard deviation in replicate group</td>
</tr>
</tbody>
</table>

#### Pre-processing flag

- OFFSCALE: Fluorescence is offscale

#### Primary analysis flags

- BADROX: Bad passive reference signal
- NOAMP: No amplification
- NOISE: Noise higher than others in plate
- SPIKE: Noise spikes
- NOSIGNAL: No signal in well
- AMPFAIL: Amplification algorithm failed
- BLFAIL: Baseline algorithm failed
- HOLDFAIL: Thresholding algorithm failed
- CTFAIL: CT algorithm failed

#### Secondary analysis flags

- OUTLIERRG: Outlier in replicate group
- AMPNC: Amplification in negative control
- HIGHSD: High standard deviation in replicate group
## For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing data</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle (C_T), flags, and advanced options.

If the default analysis settings in the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.
2. Click Analysis ▶ Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:
- C_T Settings
- Flag Settings
- Relative Quantification Settings
- Advanced Settings
- Standard Curve Settings

The following is an image of the Analysis Settings dialog box for a Relative Standard Curve experiment:
3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” below).

Note: You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to Default Analysis Settings.

Adjust analysis settings

CT Settings

• Data Step Selection
  Use this feature to select one stage/step combination for CT analysis when there is more than one data collection point in the run method.

• Algorithm Settings
  Use the Baseline Threshold algorithm to determine the CT values.
  The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for gene quantification.

• Default CT Settings
  Use the default CT settings feature to calculate CT for the targets that do not have custom settings. To edit the default settings, click Edit Default Settings.

• CT Settings for Target
  When you manually set the threshold and baseline, Life Technologies recommends:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Enter a value for the threshold so that the threshold is:</td>
</tr>
<tr>
<td></td>
<td>• Above the background.</td>
</tr>
<tr>
<td></td>
<td>• Below the plateau and linear regions of the amplification curve.</td>
</tr>
<tr>
<td></td>
<td>• Within the exponential phase of the amplification curve.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Select the Start Cycle and End Cycle values so that the baseline ends before significant fluorescent signal is detected.</td>
</tr>
</tbody>
</table>

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.

Flag Settings

Use the Flag Settings tab to:

• Adjust the sensitivity so that more wells or fewer wells are flagged.

• Change the flags that are applied by the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.
To adjust the flag settings

1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.
   
   **Note:** If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.
   
   **Note:** After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments using the Standard Deviation calculations may change the result of C_T SD. For some flags, analysis results calculated before the well is rejected are maintained.

4. Click **Apply Analysis Settings** in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.

The following is an image of the Flag Settings tab:

![Image of Flag Settings tab]

**Relative Quantification Settings**

Use the Relative Quantification Settings tab to:

- Change the type of analysis, singleplex or multiplex.
- Change the reference sample and/or endogenous control.
Chapter 5  Review Results and Adjust Experiment Parameters
Adjust analysis settings

- Reject Outliers with ΔCₜ values less than or equal to the entered value.
  **Note:** The Outlier Rejection settings apply only to multiplex reactions.

- Select the algorithm to use to determine the relative quantification minimum and maximum values (error bars):
  - **Confidence Level** - Select to calculate the RQ minimum and maximum values based on the selected confidence level. Select the confidence level to use.
  - **Standard Deviations** - Select to calculate the RQ minimum and maximum values based on the selected number of standard deviations. Select the number of standard deviations to use.

**Advanced Settings**

Use the Advanced Settings tab to change baseline settings well-by-well.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.
2. Deselect the **Use Cₜ Settings Defined for Target** check box.
3. Define the custom baseline settings:
   - For automatic baseline calculations, select the **Automatic Baseline** check box.
   - To define the baseline, deselect the **Automatic Baseline** check box, then enter the baseline start cycle and baseline end cycle.

**Standard Curve Settings**

Use this tab to review the settings of the current standard curve experiment or to import the standard curve from an external experiment (with the same samples and targets) and apply it to this current experiment.

**Note:** The run method must be the same. Life Technologies recommends using the standard curve from the current experiment.
For the example experiment, the settings from the current experiment have been used.

![Image of Analysis Settings](image)

### Improve $C_T$ precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all. These wells typically produce $C_T$ values that differ significantly from the average for the associated replicate wells. If included in the calculations, these outliers can result in erroneous measurements; to ensure $C_T$ precision, omit the outliers from the analysis.

**Note:** In the Relative Standard Curve example experiment, there are no outliers. No wells need to be removed from analysis.

1. From the Experiment Menu pane, select **Analysis** > **Amplification Plot**.
   **Note:** If no data are displayed, click **Analyze**.

2. In the Amplification Plot screen, select **$C_T$ vs. Well** from the Plot Type drop-down menu.

3. Select the **Well Table** tab, select replicates to omit:

4. In the Well Table:
   a. From the Group By drop-down menu, select **Replicate**.
   b. Look for outliers in the replicate group (make sure they are flagged).
c. Select the *Omit* check box next to outlying well(s), as shown in the following image.

5. Click **Analyze** to reanalyze the experiment data with the outlying well(s) removed from the analysis.

**Note:** You can also omit undesirable wells in an experiment from the Plate Layout screen. To omit a well from the Plate Layout screen, right-click the well and select **Omit**.

---

*For more information on Amplification efficiency, refer to Amplification Efficiency of TaqMan® Gene Expression Assays Application Note.*

<table>
<thead>
<tr>
<th>For more information on</th>
<th>Refer to</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification efficiency</td>
<td>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</td>
<td>127AP05-03</td>
</tr>
</tbody>
</table>
Export Analysis Results

1. Open the Relative Standard Curve example experiment file that you analyzed in Chapter 5.

2. In the Experiment Menu, click Export.

   **Note:** To export data automatically after analysis, select the Auto Export check box during experiment setup or before running the experiment. Auto export is unchecked for the example experiment.

3. Select QuantStudio™ 6 and 7 format.

   **Note:** Select 7900 Format if you want to export the Clipped Data.

4. Complete the Export dialog box as shown below:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export/ Select Content</td>
<td>Results</td>
</tr>
<tr>
<td>Export Data To</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>QS6_QuantStudio_384-Well_Relative_Standard_Curve_Example_data</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td>C:\Applied Biosystems\QuantStudio 6 and 7 Flex Software\User Files\Export</td>
</tr>
</tbody>
</table>

Your Export screen should look like this:
Your exported file when opened in Notepad should look like this:

![Exported file content](image-url)
PART 2

Running Comparative $C_T$ Experiments
About Comparative \( C_T \) Experiments

This chapter covers:

- About Comparative CT experiments ................................................. 71
- About the example experiment ....................................................... 73

**IMPORTANT!** First-time users of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, please read Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments and Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes of this binder thoroughly. The booklets provide information and general instructions that are applicable to all the experiments described in this binder.

**Note:** For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ 6 and 7 Flex Software by pressing F1, clicking on the toolbar, or selecting Help > QuantStudio™ 6 and 7 Flex Software Help.

**About Comparative \( C_T \) experiments**

The Comparative CT (\( \Delta C_T \)) method is used to determine the relative target quantity in samples. With the comparative CT method, the QuantStudio™ 6 and 7 Flex Software measures amplification of the target and of the endogenous control in samples and in a reference sample. Measurements are normalized using the endogenous control. The software determines the relative quantity of target in each sample by comparing normalized CT (\( \Delta C_T \)) in each sample to normalized CT (\( \Delta C_T \)) in the reference sample.

Comparative CT experiments are commonly used to:

- Compare expression levels of a gene in different tissues.
- Compare expression levels of a gene in a treated sample and an untreated sample.
- Compare expression levels of wild-type alleles and mutated alleles.
- Analyze the gene expression changes over time under specific treatment conditions.

The Relative Standard Curve method determines the relative target quantity in samples. The QuanStudio™ 6 and 7 Flex Software measures amplification of the target and of the endogenous control in samples, in a reference sample, and in a standard dilution series. For more information on Relative Standard Curve experiments, refer to Part I, Running Relative Standard Curve Experiments of this booklet.

**Assemble required components**

- **Sample** – The tissue group that you are testing for a target gene.
- **Reference sample (also called a calibrator)** – The sample used as the basis for relative quantification results. For example, in a study of drug effects on gene expression, an untreated control is an appropriate reference sample.
• **Endogenous control** – A gene that is used to normalize template input differences, and sample-to-sample or run-to-run variation.

• **Replicates** – The total number of identical reactions containing identical components and identical volumes.

• **Negative controls** – Wells that contain water or buffer instead of sample template. No amplification of the target should occur in negative control wells.

**PCR options**

When performing real-time PCR, choose between:

• Singleplex and multiplex PCR (below)

  *and*

• 1-step and 2-step RT-PCR (page 72)

**Singleplex and Multiplex PCR**

You can perform a PCR reaction using either:

• **Singleplex PCR** – In singleplex PCR a single primer and probe set is present in the reaction tube or well. Only one target or endogenous control can be amplified per reaction.

  *Or*

• **Multiplex PCR** – In multiplex PCR, two or more primer and probe sets are present in the reaction tube or well. Each set amplifies a specific target or endogenous control. Typically, a probe labeled with FAM™ dye detects the target and a probe labeled with VIC® dye detects the endogenous control.

  **IMPORTANT!** SYBR® Green reagents cannot be used for multiplex PCR.

**1- and 2-Step RT-PCR**

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in separate reactions (2-step). The reagent configuration you use depends on whether you are performing 1- or 2-step RT-PCR:

• **1-step RT-PCR** – In 1-step RT-PCR, RT and PCR take place in one buffer system. Using one buffer system provides the convenience of a single-tube preparation for RT and PCR amplification. However, you cannot use Fast PCR Master Mix or the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

• **2-step RT-PCR** – 2-step RT-PCR is performed in two separate reactions: First, total RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful for detecting multiple transcripts from a single cDNA template or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be used to prevent carryover contamination.
About the example experiment

To illustrate how to perform comparative CT experiment, this guide leads you through the process of designing and performing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with the QuantStudio™ 6 and 7 Flex Software.

The objective of the comparative CT example experiment is to compare the expression of GH1, LPIN1, LIPC, GAPDH, and ACTB in liver, heart, brain, and lung tissues.

- The samples are liver, heart, lung, and brain tissues.
- The targets are GH1, LPIN1, LIPC, GAPDH, and ACTB.
- The reference sample is brain.
- The endogenous control is ACTB.
- The experiment is designed for singleplex PCR, where the targets and endogenous control assays are performed in separate wells.
- Reactions are set up for 2-step RT-PCR. The Invitrogen VILO Kit is used for reverse transcription; the TaqMan® Fast Universal PCR Master Mix is used for PCR.
- Primer and probe sets are selected from the Life Technologies TaqMan® Gene Expression Assays product line:
  - GH1 Assay Mix: Hs00236859_m1
  - LPIN1 Assay Mix: Hs00299515_m1
  - LIPC Assay Mix: Hs00165106_m1
  - GAPDH Assay Mix: Hs99999905_m1
  - ACTB Assay Mix: Hs99999903_m1
Chapter 7  About Comparative C\textsubscript{T} Experiments

About the example experiment
This chapter explains how to design the example experiment from the Experiment Setup menu.

This chapter covers:

- Define the experiment properties .......................................................... 75
- Define targets, samples and biological replicates ..................................... 76
- Assign targets, samples and biological groups ....................................... 78
- Set up the run method ............................................................................ 79
- Tips for designing your own experiment .................................................. 80
- For more information .............................................................................. 81

**Note**: To automatically export the analyzed data to a specified location, select the Auto Export task from the Export screen, before running the experiment. For more information on Auto Export, refer to Chapter 2 in Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments*.

### Define the experiment properties

Click **Experiment Setup > Experiment Properties** to create a new experiment in the QuantStudio™ 6 and 7 Flex Software. Enter:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Name</td>
<td>QS6_QuantStudio_384-Well_Comparative_Ct_Example</td>
</tr>
<tr>
<td>Barcode</td>
<td>Leave field empty</td>
</tr>
<tr>
<td>User Name</td>
<td>Example User</td>
</tr>
<tr>
<td>Comments</td>
<td>Comparative C&lt;sub&gt;T&lt;/sub&gt; [ΔΔC&lt;sub&gt;T&lt;/sub&gt;] example</td>
</tr>
<tr>
<td>Instrument type</td>
<td>QuantStudio™ 6 Flex System</td>
</tr>
<tr>
<td>Block</td>
<td>384-Well Block</td>
</tr>
<tr>
<td>Experiment Type</td>
<td>Comparative C&lt;sub&gt;T&lt;/sub&gt; [ΔΔC&lt;sub&gt;T&lt;/sub&gt;]</td>
</tr>
<tr>
<td>Reagents</td>
<td>TaqMan® Reagents</td>
</tr>
<tr>
<td>Ramp speed</td>
<td>Fast</td>
</tr>
<tr>
<td>Reagent information</td>
<td>NA</td>
</tr>
</tbody>
</table>

Save the experiment.
Define targets, samples and biological replicates

Click Define to access the Define screen. Enter:

1. Targets

<table>
<thead>
<tr>
<th>Target name</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTB</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>GAPDH</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>GH1</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>LPIN1</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>LIPC</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
</tbody>
</table>

2. Samples

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brain</td>
<td></td>
</tr>
<tr>
<td>Lung</td>
<td></td>
</tr>
<tr>
<td>Liver</td>
<td></td>
</tr>
<tr>
<td>Heart</td>
<td></td>
</tr>
</tbody>
</table>
3. Dye to be used as a Passive Reference
ROX

4. Custom Task Name
Not applicable

5. Analysis Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Sample</td>
<td>Brain</td>
</tr>
<tr>
<td>Endogenous Control</td>
<td>ACTB</td>
</tr>
</tbody>
</table>

Your Define screen should look like this:

Note: This example experiment does not define biological replicate groups. Leave Biological Replicate Groups blank.
Assign targets, samples and biological groups

Click Assign to access the Assign screen. Enter the targets and samples:

<table>
<thead>
<tr>
<th>Target name</th>
<th>Well number</th>
<th>Task</th>
<th>Sample name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTB</td>
<td>A1, A2, A3</td>
<td>Unknown</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>C1, C2, C3</td>
<td>Unknown</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>E1, E2, E3</td>
<td>Unknown</td>
<td>Lung</td>
</tr>
<tr>
<td></td>
<td>G1, G2, G3</td>
<td>Unknown</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>A24</td>
<td>Negative</td>
<td>None</td>
</tr>
<tr>
<td>GAPDH</td>
<td>A5, A6, A7</td>
<td>Unknown</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>C5, C6, C7</td>
<td>Unknown</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>E5, E6, E7</td>
<td>Unknown</td>
<td>Lung</td>
</tr>
<tr>
<td></td>
<td>G5, G6, G7</td>
<td>Unknown</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>C24</td>
<td>Negative</td>
<td>None</td>
</tr>
<tr>
<td>GH1</td>
<td>A9, A10, A11</td>
<td>Unknown</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>C9, C10, C11</td>
<td>Unknown</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>E9, E10, E11</td>
<td>Unknown</td>
<td>Lung</td>
</tr>
<tr>
<td></td>
<td>G9, G10, G11</td>
<td>Unknown</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>E24</td>
<td>Negative</td>
<td>None</td>
</tr>
<tr>
<td>LPIN1</td>
<td>A13, A14, A15</td>
<td>Unknown</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>C13, C14, C15</td>
<td>Unknown</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>E13, E14, E15</td>
<td>Unknown</td>
<td>Lung</td>
</tr>
<tr>
<td></td>
<td>G13, G14, G15</td>
<td>Unknown</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>G24</td>
<td>Negative</td>
<td>None</td>
</tr>
<tr>
<td>LIPC</td>
<td>A17, A18, A19</td>
<td>Unknown</td>
<td>Brain</td>
</tr>
<tr>
<td></td>
<td>C17, C18, C19</td>
<td>Unknown</td>
<td>Heart</td>
</tr>
<tr>
<td></td>
<td>E17, E18, E19</td>
<td>Unknown</td>
<td>Lung</td>
</tr>
<tr>
<td></td>
<td>G17, G18, G19</td>
<td>Unknown</td>
<td>Liver</td>
</tr>
<tr>
<td></td>
<td>I24 (Row I, Column 24)</td>
<td>Negative</td>
<td>None</td>
</tr>
</tbody>
</table>
Your Assign screen should look like this:

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- Reaction Volume Per Well: 10 µL
- Thermal Profile

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold Stage</td>
<td>Step 1</td>
<td>1.9°C/s</td>
<td>95°C</td>
<td>20 seconds</td>
</tr>
<tr>
<td>PCR Stage</td>
<td>Step 1</td>
<td>1.9°C/s</td>
<td>95°C</td>
<td>1 second</td>
</tr>
<tr>
<td>Number of Cycles: 40 Enable AutoDelta: Unchecked (default) Starting Cycle: Disabled when Enable AutoDelta is unchecked</td>
<td>Step 2</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>20 seconds</td>
</tr>
</tbody>
</table>
Your Run Method screen should look like this:

### Tips for designing your own experiment

Life Technologies recommends that you:

- **Identify each target assay with a unique name and color.** You can enter up to 100 characters in the Target Name field.

- **Identify each sample using a unique name and color.** You can enter up to 100 characters in the Sample Name field.

- **Select an endogenous control for each sample.** The endogenous control is a target that is present in all samples under investigation. It should be expressed equally in all sample types, regardless of treatment or tissue origin (examples of endogenous controls are β-actin, GAPDH, and 18S ribosomal RNA [18S rRNA]). The endogenous control is used to normalize the PCR results; the endogenous control corrects for variable sample mass, nucleic acid extraction efficiency, reverse transcription efficiency, and pipette calibration errors. Note that:
  - Each sample type (for example, each tissue in a study comparing multiple tissues) requires an endogenous control.
  - If samples are spread across multiple plates, each plate must have an endogenous control. Additionally, every plate must include an endogenous control for every sample type on the plate.

- **Select an endogenous control from your previously defined target assays.** Amplification results from the endogenous control are used to normalize the amplification results from the target for differences in the amount of template added to each reaction.

- **Select a reference sample from your previously defined samples.** Amplification results from the samples and from the reference sample are compared to determine relative expression.
For more information

<table>
<thead>
<tr>
<th>For more information on</th>
<th>Refer to</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumables</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em> Appendix A in Booklet 7, <em>QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes</em></td>
<td>4489822</td>
</tr>
<tr>
<td>Using the relative standard curve quantification method</td>
<td>Part 1 of this booklet</td>
<td>4489822</td>
</tr>
<tr>
<td>Selecting an endogenous control</td>
<td>Application Note Using TaqMan® Endogenous Control Assays to Select an Endogenous Control for Experimental Studies</td>
<td>127AP05-03</td>
</tr>
<tr>
<td>Reference samples (also known as calibrators) and endogenous controls</td>
<td><em>User Bulletin #2: Relative quantification of Gene Expression</em></td>
<td>4303859</td>
</tr>
<tr>
<td>Using alternative setup</td>
<td>Chapter 3 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Chapter 8  Design the Experiment
For more information
Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Comparative $C_T$ ($\Delta \Delta C_T$) example experiment.

This chapter covers:
- Assemble required materials .................................................. 83
- Prepare the template ................................................................. 83
- Prepare the sample dilutions ...................................................... 84
- Prepare the reaction mix ("cocktail mix") .................................. 84
- Prepare the reaction plate .......................................................... 85
- Tips for preparing reactions for your own experiments ................... 86
- For more information ............................................................... 87

Assemble required materials

- Items listed in Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments*.
- Samples - Total RNA isolated from liver, heart, brain, and lung tissues.
- Example experiment reaction mix components:
  - TaqMan® Fast Universal PCR Master Mix (2X)
  - ACTB Assay Mix (20X)
  - GAPDH Assay Mix (20X)
  - GH1 Assay Mix (20X)
  - LIPN1 Assay Mix (20X)
  - LIPC Assay Mix (20X)

*Note:* Fast Universal Master Mix is not recommended to be used with the 96-well (0.2 mL) reaction plates or reaction tubes and tube strips sealed with caps.

Prepare the template

Prepare the template for the PCR reactions using the High-Capacity cDNA Reverse Transcription Kit or one of the Invitrogen VILO kits to carry out the reverse transcription.

Example experiment settings

For the Comparative $C_T$ example experiment, the template for the PCR reactions is cDNA reverse-transcribed from total RNA samples using one of the Invitrogen VILO kits, SuperScript® VILO™ cDNA Synthesis Kit (Part no. 4453650).
Prepare the template

Use the Invitrogen VILO kits to reverse-transcribe cDNA from the total RNA samples. Follow the procedures in the Invitrogen VILO Kits Protocol (Pub. no. 100002284) to:

1. Prepare the RT master mix.
2. Prepare the cDNA reactions.
3. Perform reverse transcription on a thermal cycler.

Prepare the sample dilutions

For the Comparative $C_T$ example experiment, no more than 10% of your reaction should consist of the undiluted RT product.

1. Label a separate microcentrifuge tube for each diluted sample:
   - Liver
   - Heart
   - Brain
   - Lung

2. Add the required volume of water (diluent) to each empty tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample name</th>
<th>Diluent volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Liver</td>
<td>19</td>
</tr>
<tr>
<td>2</td>
<td>Heart</td>
<td>19</td>
</tr>
<tr>
<td>3</td>
<td>Brain</td>
<td>19</td>
</tr>
<tr>
<td>4</td>
<td>Lung</td>
<td>19</td>
</tr>
</tbody>
</table>

3. Add the required volume of cDNA sample stock (100 ng/µL) to each empty tube:

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample name</th>
<th>Volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Liver</td>
<td>1.0</td>
</tr>
<tr>
<td>2</td>
<td>Heart</td>
<td>1.0</td>
</tr>
<tr>
<td>3</td>
<td>Brain</td>
<td>1.0</td>
</tr>
<tr>
<td>4</td>
<td>Lung</td>
<td>1.0</td>
</tr>
</tbody>
</table>

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.
5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:
   - ACTB Reaction Mix
   - GAPDH Reaction Mix
   - GH1 Reaction Mix
• LPIN1 Reaction Mix
• LIPC Reaction Mix

2. For the ACTB assay, add the required volumes of each component to the ACTB Reaction Mix tube:

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume (µL) for 1 reaction</th>
<th>Volume (µL) for 13 reactions (plus 10% excess)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® Fast Universal PCR Master Mix (2X)</td>
<td>5.0</td>
<td>75.0</td>
</tr>
<tr>
<td>ACTB Assay Mix (20X)</td>
<td>0.5</td>
<td>7.5</td>
</tr>
<tr>
<td>Water</td>
<td>3.5</td>
<td>52.5</td>
</tr>
<tr>
<td>Total Reaction Mix Volume</td>
<td>9.0</td>
<td>135.0</td>
</tr>
</tbody>
</table>

3. Mix the reaction mix in each tube by gently pipetting up and down, then cap each tube.

4. Centrifuge the tubes briefly to remove air bubbles.

5. Place the reaction mixes on ice until you prepare the reaction plate.

6. Repeat steps 2 through 5 for the GAPDH, GH1, LPIN1, and LIPC assays.

Note: Do not add the sample at this time.

Prepare the reaction plate

Example experiment reaction plate components

The reaction plate for the Comparative C_T example experiment contains:
• A MicroAmp® Optical 384-Well Reaction Plate
• Reaction volume: 10µL/well
• The reaction plate contains:
  – 60 Unknown wells
  – 5 Negative control wells
  – 319 Empty wells
Chapter 9 Prepare the Reactions

Tips for preparing reactions for your own experiments

The following is an image of the plate layout for the example experiment:

To prepare the reaction plate components

1. Add 1 μL of each cDNA to the appropriate wells.
2. Pipet 1 μL of sterile water into the NTC wells.
3. Add 8 μL of the appropriate assay-specific cocktail to the wells.
4. Seal the reaction plate with optical adhesive film.
5. Centrifuge the reaction plate briefly to remove air bubbles.
6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the reaction plate again at a higher speed and for a longer period of time.
7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

Tips for preparing reactions for your own experiments

Tips for preparing templates

When you prepare your own Comparative C_T experiment, Life Technologies recommends the following templates:

- **Complementary DNA (cDNA)** – cDNA reverse-transcribed from total RNA samples.
- **Genomic DNA (gDNA)** – Purified gDNA already extracted from tissue or sample.

Tips for preparing the reaction mix

If your experiment includes more than one target assay, prepare the reaction mix for each target assay separately.
Tips for preparing
the reaction plate

When you prepare your own Comparative C_T experiment, make sure the arrangement of the PCR reactions matches the plate layout displayed in the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning the reaction plate components</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
<tr>
<td>Sealing the reaction plate</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Chapter 9 Prepare the Reactions

For more information
This chapter explains how to run the example experiment on the QuantStudio™ 6 or 7 Instrument.

This chapter covers:

- Start the run ............................................. 89
- Monitor the run ......................................... 89

**IMPORTANT!** Run the experiment at the same ambient temperature at which you calibrated the instrument. Extreme variations in ambient temperature can affect the heating and cooling of the instrument and influence experimental results.

**IMPORTANT!** Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 6 or 7 Instrument is in operation.

### Start the run

1. Open the Comparative C\textsubscript{T} example file that you created using instructions in Chapter 8.
2. Load the reaction plate into the instrument.
3. Start the run.

### Monitor the run

Monitor the example experiment run:

- From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software using the Run screen, while the experiment is in progress.
- From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software (to monitor an experiment started from another computer or from the QuantStudio™ 6 or 7 Instrument touchscreen).
- From the QuantStudio™ 6 or 7 Instrument touchscreen.
Chapter 10  Run the Experiment

Monitor the run

From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software

1. In the Instrument Console screen, select the instrument icon.
2. Click Manage Instrument or double-click on the instrument icon.
3. In the Manage Instrument screen, click Monitor Running Experiment to access the Run screen.

View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all the three plots available from the QuantStudio™ 6 and 7 Flex Software for potential problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab, then select the wells to view.

The following is an image of the Amplification Plot screen as it appears at the end of the example experiment.

View the Temperature Plot

Click Temperature Plot from the Run Experiment Menu.
The following is an image of the Temperature Plot screen as it appears during the example experiment.

**Note:** The Sample temperature displayed in the Current Temperatures group is an estimated value.

**View the Run Method**

Click **Run Method** from the Run Experiment Menu.

The following is an image of the Run Method screen as it appears in the example experiment.
View Run Data

Click **View Run Data** from the Run Experiment Menu.

The following is an image of the View Run Data screen as it appears in the example experiment:

![Run Data Report](image)

From the **QuantStudio™ 6 or 7 Instrument touchscreen**

You can also view the progress of the run from the QuantStudio™ 6 or 7 Instrument touchscreen.

The following are images of the Run Method screen on the QuantStudio™ 6 or 7 Instrument touchscreen:

**Experiment view**

![Experiment View](image)
Chapter 10  Run the Experiment

Monitor the run

Time View

Run Started: July 06 2013 - 05:48PM
Sample: 95.0 °C
Heated Cover [Set Point]: 105.0 °C [105.0 °C]
Stage / Step / Cycle: 1 / 2 / 1

01:31:52

Remaining Time  Elapsed Time

July 06 2013 - 05:48PM
Heated cover reached target temperature.
Chapter 10  Run the Experiment

Monitor the run
11

Review Results and Adjust Experiment Parameters

In Section 11.1 of this chapter you review the analyzed data using several of the analysis screens and publish the data. Section 11.2 of this chapter walks you through the process of modifying experiment parameters to troubleshoot problems with experiment results before rerunning an experiment.

This chapter covers:

- Section 11.1 Review Results ........................................ 97
- Analyze the example experiment ...................................... 97
- Assess the gene expression profile using the Gene Expression Plot ............................ 97
- Identify well problems using the Well Table .............................. 99
- Assess amplification results using the Amplification Plot ....................... 101
- Confirm accurate dye signal using the Multicomponent Plot .................... 108
- Determine signal accuracy using the Raw Data Plot .................... 110
- View the endogenous control profile using the QC Plot ...................... 112
- Review the flags in the QC Summary .................................. 113
- For more information .......................................................... 115
- Section 11.2 Adjust parameters for re-analysis of your own experiments ... 117
- Adjust analysis settings ...................................................... 117
- Improve CT precision by omitting wells ................................. 120
Section 11.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 10.
2. Click Analyze. The software analyzes the data using the default analysis settings.
   Note: You can also access the experiment to analyze from the Home screen.

Assess the gene expression profile using the Gene Expression Plot

The Gene Expression Plot screen displays the results of relative quantification calculations in the gene expression profile. There are two plots available:

- **RQ vs Target** – Groups the relative quantification (RQ) values by target. Each sample is plotted for each target. You can view the plot as the linear, log10, Ln, and log2 graph types. The Gene Expression plot when viewed as a linear graph type looks like this:
• **RQ vs Sample** – Groups the relative quantification (RQ) values by sample. Each target is plotted for each sample. You can view the plot as the following graph types: linear, log10, Ln, log2.

**Example experiment values**

Review each target in the Gene Expression Plot screen for the expression level (or fold change) of the target sample relative to the reference sample.

**View the Gene Expression Plot**

1. From the Experiment Menu pane, select **Analysis ▶ Gene Expression**.
   
   **Note:** If no data are displayed, click **Analyze**.

2. In the Gene Expression Plot screen, select:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>RQ vs Sample (default)</td>
</tr>
<tr>
<td>Graph Type</td>
<td>Log10</td>
</tr>
<tr>
<td>Orientation</td>
<td>Vertical Bars</td>
</tr>
</tbody>
</table>

3. Click **Show a legend for the plot** (default).
   
   **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.
In the example experiment, as shown below, the expression level of each target gene in liver, heart, and lung is displayed relative to its respective expression level in the reference sample (brain). Since the reference sample is compared to itself, the relative expression level is 1. When the result is displayed in the Log10 graph type, the expression level of the reference sample appears as 0 in the graph (log10 of 1 = 0).

Assessing the gene expression plot your own experiments

When you analyze your own Comparative C_T experiment, look for differences in gene expression (as a fold change) relative to the reference sample.

Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including:

- The sample name, target name, task, and dyes
- The calculated threshold cycle (C_T), normalized fluorescence (Rn), and quantity values
- Flags

Example experiment values and flags

Review the Well Table to evaluate the C_T precision of the replicate groups.

View the well table

1. From the Experiment Menu pane, select Analysis ➤ Amplification Plot, then click the Well Table tab.
2. From the Group By drop-down menu, select **Replicate**.

3. Look at the C_T SD column to evaluate the C_T precision of the replicate groups. In the example experiment, there are three outliers. You will omit these wells in the troubleshooting section (“Improve CT precision by omitting wells” on page 120).

**Note:** To show/hide columns in the Well Table, select/deselect the column name from the Show in Table drop-down menu.

**Assessing the well table in your own experiments**

When you analyze your own Comparative C_T experiment, look for standard deviation in the replicate groups (C_T SD values). If needed, omit outliers (see “Improve CT precision by omitting wells” on page 120).
Assess amplification results using the Amplification Plot

Amplification plots available for viewing

The Amplification Plot screen displays amplification of all samples in the selected wells. There are three plots available:

- **ΔRn vs Cycle** – ΔRn is the magnitude of normalized fluorescence signal generated by the reporter at each cycle during the PCR amplification. This plot displays ΔRn as a function of cycle number. You can use this plot to identify and examine irregular amplification and to view threshold and baseline values for the run.

- **Rn vs Cycle** – Rn is the fluorescence signal from the reporter dye normalized to the fluorescence signal from the passive reference. This plot displays Rn as a function of cycle number. You can use this plot to identify and examine irregular amplification.

- **C_T vs Well** – C_T is the PCR cycle number at which the fluorescence meets the threshold in the amplification plot. This plot displays C_T as a function of well position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

Purpose

The purpose of viewing the amplification plot for the example experiment is to identify:

- Correct baseline and threshold values
- Outliers

View the Amplification Plot

1. From the Experiment Menu pane, select Analysis ▶ Amplification Plot.
   
   Note: If no data are displayed, click Analyze.

2. Display the LP1N1 wells in the Amplification Plot screen:
   
   - Click the Plate Layout tab.
   - From the Select Wells drop-down menus, select Target, then LP1N1.
Chapter 11  Review Results and Adjust Experiment Parameters

Assess amplification results using the Amplification Plot

The following is an image of the Plate Layout screen:

3. In the Amplification Plot screen, enter:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>ΔRn vs Cycle (default)</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Well (default)</td>
</tr>
</tbody>
</table>

[This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.]

4. View the baseline values:
   a. From the Graph Type drop-down menu, select **Linear**.
   b. Select the **Baseline** check box to show the start cycle and end cycle.
c. Verify that the baseline is set correctly: The end cycle should be set a few cycles before the cycle number where significant fluorescent signal is detected. In the example experiment, the baseline is set correctly.

5. View the threshold values:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Type</td>
<td>Log</td>
</tr>
<tr>
<td>Target</td>
<td>LP1N1</td>
</tr>
</tbody>
</table>

a. Select the **Threshold** check box to show the threshold.
Review Results and Adjust Experiment Parameters

Assess amplification results using the Amplification Plot

Chapter 11

b. Verify that the threshold is set correctly. In the example experiment, the threshold is in the exponential phase.

6. Locate any outliers:

a. From the Plot Type drop-down menu, select $C_T$ vs Well.

b. Look for outliers from the amplification plot. In the example experiment, there are no outliers for LPIN1.
7. Repeat steps 2 through 6 for the GH1, TGFB1, LIPC, GAPDH, 18S, and ACTB wells. In the example experiment, there is one outlier for 18S. You will omit these wells in the troubleshooting section (“Improve CT precision by omitting wells” on page 120).

**Tips for analyzing your own experiments**

When you analyze your own Comparative C\text{T} experiment, look for:

- **Outliers**
- **A typical amplification plot** – The QuantStudio™ 6 and 7 Flex Software automatically calculates baseline and threshold values based on the assumption that the data exhibit a *typical* amplification plot. A typical amplification plot has four distinct sections:
  - Plateau phase
  - Linear phase
  - Exponential (geometric phase)
  - Baseline

  A typical amplification plot should look like this:

**IMPORTANT!** Experimental error (such as contamination or pipetting errors) can produce atypical amplification curves that can result in incorrect baseline and threshold value calculations by the QuantStudio™ 6 and 7 Flex Software. Therefore, Life Technologies recommends that you examine the Amplification Plot screen and review the assigned baseline and threshold values for each well after analysis completes.
- **Correct threshold values**

<table>
<thead>
<tr>
<th>Threshold Set Correctly</th>
<th><img src="image1.png" alt="Image" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>The threshold is set in the exponential phase of the amplification curve. Threshold settings above or below the optimum increase the standard deviation of the replicate groups.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Threshold Set Too Low</th>
<th><img src="image2.png" alt="Image" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>The threshold is set below the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar up into the exponential phase of the curve.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Threshold Set Too High</th>
<th><img src="image3.png" alt="Image" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>The threshold is set above the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar down into the exponential phase of the curve.</td>
<td></td>
</tr>
</tbody>
</table>
• Correct baseline values

**Baseline Set Correctly**
The amplification curve begins after the maximum baseline.

**Baseline Set Too Low**
The amplification curve begins too far to the right of the maximum baseline. Increase the End Cycle value.

**Baseline Set Too High**
The amplification curve begins before the maximum baseline. Decrease the End Cycle value.

If your experiment does not meet the guidelines above, troubleshoot as follows:
• Omit wells (see “Improve CT precision by omitting wells” on page 120).
  
  Or
  
  • Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on page 117).
Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

**Purpose**

In the Comparative $C_T$ example experiment, you review the Multicomponent Plot screen for:
- ROX™ dye (passive reference)
- FAM™ dye (reporter)
- Spikes, dips, and/or sudden changes
- Amplification in the negative control wells

**View the Multicomponent Plot**

1. From the Experiment Menu pane, select **Analysis → Multicomponent Plot**.
   **Note:** If no data are displayed, click **Analyze**.

2. Display the unknown and standard wells one at a time in the Multicomponent Plot screen:
   a. Click the **Plate Layout** tab.
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.
      **Note:** If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select **Dye**.

4. Click **Show a legend for the plot** (default).
   **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.
5. Check the FAM dye signals. In the example experiment, the FAM dye signal increases throughout the PCR process, indicating normal amplification.

6. Select the negative control wells one at a time and check for amplification. In the example experiment, there is no amplification in the negative control wells.
Tips for confirming dye accuracy in your own experiment

When you analyze your own Comparative Ct experiment, look for:

- **Passive reference** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.
- **Reporter dye** – The reporter dye fluorescence level should display a flat region corresponding to the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.
- **Irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.
- **Negative control wells** – There should not be any amplification in the negative control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter for the selected wells during each cycle of the real-time PCR.

About the example experiment

In the Comparative Ct example experiment, you review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data Plot

1. From the Experiment Menu pane, select Analysis ➔ Raw Data Plot.  
   **Note:** If no data are displayed, click Analyze.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.

3. Click ![Show a legend for the plot](default).  
   **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.  
   **Note:** The legend displays the color code for each row of the reaction plate (see the legend in the Raw Data Plot shown below).
4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example experiment, there is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.

The filters used for the example experiment are:

Tips for determining signal accuracy in your own experiment

When you analyze your own Comparative C_T experiment, look for the following in each filter:

- Characteristic signal growth
- No abrupt changes or dips
View the endogenous control profile using the QC Plot

In the Comparative C_T experiment, the QC Plot screen displays the Endogenous Control Profile plot for all the targets in the experiment. The QC Plot serves as a tool to help you choose the best endogenous control for that experiment. The endogenous control profile plot is a visual display of the C_T level of the endogenous control across the sample. You can view up to four endogenous controls at a time. The sample is plotted on the X-axis, and C_T is plotted on the Y-axis. The expression is viewed as a color and shape combination in the plot. Endogenous controls are also known as reference genes.

Example experiment settings

In the example experiment, you can view the endogenous control profile of ACTB, GAPDH, GH1, and LPIN1 the QC Plot screen.

View the QC Plot

1. From the Experiment Menu pane, select Analysis  QC Plot.
   Note: If no data are displayed, click Analyze.

2. In the QC Plot screen, click Target Table.
   a. In the Candidate Control column, select the check box of the target of the endogenous control profile to plot. In the example experiment, the endogenous controls selected are ACTB, GAPDH, GH1, and LPIN1.
   b. Select a color for each target, from the Color drop-down menu.
   c. Select a shape for each target, from the Shape drop-down menu.

3. Click the View Replicate Results Table.

4. Select the check box of the samples to plot. In the example experiment, all the four samples, Brain, Heart, Liver, and Lung are selected.

5. Click Show a legend for the plot (default).
   Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.
The following is an image of the QC Plot in the Comparative \( C_T \) example experiment:

![QC Plot Image]

Note: This example experiment does not define Biological Groups.

**Review the flags in the QC Summary**

The QC Summary screen displays a list of the QuantStudio™ 6 and 7 Flex Software flags, including the flag frequency and location for the open experiment.

Review the QC Summary screen in the Comparative \( C_T \) example experiment for any flags triggered by the experiment data. Wells G9, G10, and G11 have data that triggered the HIGHSD flag.

**View the QC Summary**

1. From the Experiment Menu pane, select **Analysis > QC Summary**.
   
   **Note:** If no data are displayed, click **Analyze**.

2. Review the Flags Summary.

   **Note:** A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment. If the frequency is >0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.

   In the example experiment, there are seven flagged wells.
3. In the Flag Details table, click each flag with a frequency >0 to display detailed information about the flag. In the example experiment. The HIGHSD flag appears three times, in the wells G9, G10, and G11, indicating high standard deviation in the replicate group.

**Note:** The HIGHSD flag appears because the C<sub>T</sub> values exceed the expected range due to low expression of the GH1 gene in the Liver sample.

4. *(Optional)* For those flags with frequency >0, click the troubleshooting link to view information on correcting the flag.

The following is an image of the QC Summary for the example experiment:

### Possible flags

The flags listed below may be triggered by the experiment data.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pre-processing flag</strong></td>
<td></td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td><strong>Primary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
</tbody>
</table>
## Section 11.1 Review Results

### For more information

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFAIL</td>
<td>$C_T$ algorithm failed</td>
</tr>
<tr>
<td>OUTLIERG</td>
<td>Outlier in replicate group</td>
</tr>
<tr>
<td>AMPNC</td>
<td>Amplification in negative control</td>
</tr>
<tr>
<td>HIGHSD</td>
<td>High standard deviation in replicate group</td>
</tr>
</tbody>
</table>

#### Secondary analysis flags

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFAIL</td>
<td>$C_T$ algorithm failed</td>
</tr>
<tr>
<td>OUTLIERG</td>
<td>Outlier in replicate group</td>
</tr>
<tr>
<td>AMPNC</td>
<td>Amplification in negative control</td>
</tr>
<tr>
<td>HIGHSD</td>
<td>High standard deviation in replicate group</td>
</tr>
</tbody>
</table>

### For more information on...

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing data</td>
<td>Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiment</td>
<td>4489822</td>
</tr>
</tbody>
</table>
Section 11.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle (C_T), flags, and advanced options.

If the default analysis settings in the QuantStudio™ 6 and 7 Flex Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.
2. Click Analysis ➔ Analysis Settings to open the Analysis Settings dialog box.
   In the example experiment, the default analysis settings are used for each tab:
   - C_T Settings
   - Flag Settings
   - Relative Quantification Settings
   - Advanced Settings

   The following is an image of the Analysis Settings dialog box for a Comparative C_T experiment:
3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” below).

   **Note:** You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.

4. Click **Apply Analysis Settings** to apply the current analysis settings.

   **Note:** You can go back to the default analysis settings, by clicking **Revert to Default Analysis Settings**.

### Adjust analysis settings

#### C_T Settings

- **Data Step Selection**
  
  Use this feature to select one stage/step combination for C_T analysis when there is more than one data collection point in the run method.

- **Algorithm Settings**
  
  Use the Baseline Threshold algorithm to determine the C_T values.
  
  The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for gene quantification.

- **Default C_T Settings**
  
  Use the default C_T settings feature to calculate C_T for the targets that do not have custom settings. To edit the default settings, click **Edit Default Settings**.

- **C_T Settings for Target**
  
  When you manually set the threshold and baseline, Life Technologies recommends:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Enter a value for the threshold so that the threshold is:</td>
</tr>
<tr>
<td></td>
<td>• Above the background.</td>
</tr>
<tr>
<td></td>
<td>• Below the plateau and linear regions of the amplification curve.</td>
</tr>
<tr>
<td></td>
<td>• Within the exponential phase of the amplification curve.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Select the Start Cycle and End Cycle values so that the baseline ends before significant fluorescent signal is detected.</td>
</tr>
</tbody>
</table>

   **Note:** This setting is applicable only to the Baseline Threshold algorithm.

   **Note:** Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.

#### Flag Settings

Use the Flag Settings tab to:

- Adjust the sensitivity so that more wells or fewer wells are flagged.
- Change the flags that are applied by the QuantStudio™ 6 and 7 Flex Software.

To adjust the flag settings
1. In the Use column, select the check boxes for flags to apply during analysis.

2. *(Optional)* If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.

   **Note:** If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.

   **Note:** After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments using the Standard Deviation calculations may change the result of CT SD. For some flags, analysis results calculated before the well is rejected are maintained.

4. Click **Apply Analysis Settings** in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.

   The following is an image of the Flag Settings tab:

   ![Flag Settings Tab](image)

   **Relative Quantification Settings**

   Use the Relative Quantification Settings tab to:
   - Change the type of analysis, singleplex or multiplex.
   - Change the reference sample and/or endogenous control.
• Reject Outliers with $\Delta C_T$ values less than or equal to the entered value.
  
  **Note:** The Outlier Rejection settings apply only to multiplex reactions.

• Select the algorithm to use to determine the relative quantification minimum and maximum values (error bars):
  - **Confidence Level** - Select to calculate the RQ minimum and maximum values based on the selected confidence level. Select the confidence level to use.
  - **Standard Deviations** - Select to calculate the RQ minimum and maximum values based on the selected number of standard deviations. Select the number of standard deviations to use.

**Advanced Settings**

Use the Advanced Settings tab to change baseline settings well-by-well.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.

2. Deselect the **Use C_T Settings Defined for Target** check box.

3. Define the custom baseline settings:
   - For automatic baseline calculations, select the **Automatic Baseline** check box.
   - To define the baseline, deselect the **Automatic Baseline** check box, then enter the baseline start cycle and baseline end cycle.

**Improve $C_T$ precision by omitting wells**

Experimental error may cause some wells to be amplified insufficiently or not at all. These wells typically produce $C_T$ values that differ significantly from the average for the associated replicate wells. If included in the calculations, these outliers can result in erroneous measurements; to ensure $C_T$ precision, omit the outliers from the analysis.

In the Comparative $C_T$ example experiment, there are seven outliers. To remove these wells from analysis:

1. From the Experiment Menu pane, select **Analysis › Amplification Plot**.
   
   **Note:** If no data are displayed, click **Analyze**.

2. In the Amplification Plot screen, select **$C_T$ vs. Well** from the Plot Type drop-down menu.

3. Select the **Well Table** tab.

4. In the Well Table, identify outliers:
   
   a. From the Group By drop-down menu, select **Replicate**.
### Section 11.2 Adjust parameters for re-analysis of your own experiments

**Improve Ct precision by omitting wells**

b. Look for outliers in the replicate group (make sure they are flagged). In the example experiment, wells G9, G10, and G11 have outliers.

c. Select the **Omit** check box next to outlying well(s).
5. Click **Analyze** to reanalyze the experiment data with the outlying well(s) removed from the analysis.

**Note:** You can also omit undesirable wells in an experiment from the Plate Layout screen. To omit a well from the Plate Layout screen, right-click the well and select **Omit**.
Export Analysis Results

1. Open the Comparative C_{\tau} example experiment file that you analyzed in Chapter 11.

2. In the Experiment Menu, click Export.

   **Note:** To export data automatically after analysis, select the Auto Export check box during experiment setup or before running the experiment. Auto export is unchecked for the example experiment.

3. Select QuantStudio™ 6 and 7 format.

   **Note:** Select 7900 Format if you want to export the Clipped Data.

4. Complete the Export dialog box as shown below:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export/</td>
<td>Results</td>
</tr>
<tr>
<td>Select Content</td>
<td></td>
</tr>
<tr>
<td>Export Data To</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>QS6_QuantStudio_384-Well_Comparative_Ct_Example_data</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td>C:\Applied Biosystems\QuantStudio 6 and 7 Flex Software\User Files\Export</td>
</tr>
</tbody>
</table>
Chapter 12  Export Analysis Results

Your Export screen should look like this:

Your exported file when opened in Notepad should look like this:

---

**QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Relative Standard Curve and Comparative C\_T Experiments**

124
Design and Analyze a Gene Expression Study

The QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software can combine the analysis of experiments that use the Relative Standard Curve or the Comparative $C_T$ ($\Delta \Delta C_T$) quantification methods into a Gene Expression study. A study provides a wider range for analyzing and comparing target behavior across multiple experiments.

Note: You can import different types of quantification experiments into a single Gene Expression study, but make sure the run method and experiment type are identical for all the experiments in that study. Also make sure that the experiments have been run on the same type of qPCR instrument.

Note: You can design an example study using the example experiments provided with the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software. This chapter explains how to design and analyze multiple Comparative $C_T$ experiments as a study. When you design a Gene Expression study, make sure that each experiment in that Gene Expression study has a unique name. Absence of a unique name, leads to failure of the run.

This chapter covers:

- About Gene Expression studies .................................................. 126
- About the example study ............................................................ 126
- Design a study ........................................................................... 127
- Analyze the example study ......................................................... 132
- View the analysis settings ............................................................ 134
- Assess amplification results using the Amplification Plot ............. 138
- Assess the gene expression profile using the Gene Expression Plot .... 140
- Confirm accurate dye signal using the Multicomponent Plot .......... 148
- View the QC Plots .................................................................... 149
- View the QC Summary ............................................................... 158
- Compare analysis settings .......................................................... 160
- Export the study ...................................................................... 165
- For more information ............................................................... 168
About Gene Expression studies

<table>
<thead>
<tr>
<th>In a Gene Expression study, you can...</th>
<th>You cannot...</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Specify the endogenous control[s] and reference sample for the study.</td>
<td>• Create, add, or modify samples.</td>
</tr>
<tr>
<td>• Set individual efficiency values for each target.</td>
<td>• Create, add, or modify targets.</td>
</tr>
<tr>
<td>• Select the control type when applicable.</td>
<td>• Change assay tasks.</td>
</tr>
<tr>
<td>• Set baseline and threshold values and confidence levels, or set the number of standard deviations for Comparative CT Min./Max.</td>
<td>You can perform these operations in individual experiments.</td>
</tr>
<tr>
<td>• Omit wells individually or together through their association with replicate groups (technical or biological).</td>
<td></td>
</tr>
</tbody>
</table>

About the example study

In the Comparative C<sub>T</sub> example study:

• Two reaction plates (experiments) are used.
• Experiments that you add to the study are two Comparative C<sub>T</sub> experiments that have already been analyzed.
• The cDNA was prepared from total RNA that was isolated from the following 4 samples:
  - Heart
  - Liver
  - Brain
  - Lung
• Five targets (assays) are used:
  - LIPC: Hs00165106_m1
  - GAPDH: Hs99999905_m1
  - ACTB: Hs99999903_m1
  - LP1N1: Hs00299515_m1
  - GH1: Hs00236859_m1
• The reference sample is Brain.
• The endogenous control is ACTB.
• Each experiment in the study was designed for singleplex PCR, where the target and endogenous control assays are run in separate wells.
• For each experiment in the study, reactions were set up for 2-step RT-PCR:
  - The cDNA was reverse-transcribed from total RNA samples using Invitrogen VILO Kit.
  - The reactions were prepared using TaqMan® Fast Universal PCR Master Mix (2X).
Design a study

Create a new study

To create a new study in the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software, from the Home screen, click **New Gene Expression Study**.

Set up the study in the Study Properties screen

1. In the Study Menu pane, select Setup > Study Properties
2. In the Study Properties pane, click the Study Name field, then enter QS6_384-Well_Comparative_Ct_with_Bioreplicates_Study_Example.
3. Click the Comments field, then enter Example Comparative Ct Study for the Comparative Ct Experiments.
4. In the Setup Experiments pane, click Add Experiment(s).
5. In the Open dialog box, browse to the QS6_384-Well_Comparative_Ct_Example_1.eds and QS6_384-Well_Comparative_Ct_Example_2.eds files at:
   C:\Program Files\Applied Biosystems\QuantStudio 6 and 7 Flex Software\examples\QS6Flex
   The QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software displays the details of the experiment in the Properties pane.
   Your Study Properties screen should look like this:

Filter the experiments in the study

To narrow your search for an experiment, define and apply a filter:
1. In the left-most drop-down menu, select an experiment attribute to query.
2. In the center drop-down menu, select an operator for the query.
3. In the right-most field, enter the condition to look for, then click Apply Filter.
After you apply a filter, click **Hide Filter/Show Filter** to hide or show the filter tool, or click **Remove Filter** to remove the filter.

**Define Replicates**

In the Define Replicates screen, create biological replicate groups and use them to associate samples for the analysis. Biological replicates allow you to assess the representative nature of your results as they relate to the population being studied. Including biological replicates can give insight into any natural variation that is in the population.

**Example study settings**

The Gene Expression example study contains four biological replicate groups. These are lung, heart, brain, and liver. Each biological groups consists eight replicates.

**To define replicates**

1. In the Study Menu pane, select **Setup › Define Replicates**.

2. Click **Add Biological Group** to open the Add Biological Replicate Group dialog box.

3. Define the biological replicate group:
   a. Click the **Biological Group Name** field, then enter Heart.
   b. In the Color field, select the color.
   c. Click the **Comments** field, then enter Example Biological Replicate Group for the Example Comparative Ct Study.

4. Add technical replicates:
   a. From the Select Plate drop-down menu, select **QuantStudio Comparative Ct Example 1.eds**.
   b. In the plate layout, select wells A1, A3, A5, A7, A9, A11, A13, A15, A17, and A19, then click **>>** to add the technical replicate wells that are associated with the selected well to the biological group.
   c. Click OK.
   d. Perform steps a through c to add the remaining technical replicate wells associated with the selected well to the biological group.
5. On the Set Up Biological Replicates screen, select the **Heart** biological group that you just added to the study. The QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software displays the details of the biological group in the Properties pane.

6. Click **Analyze**, then close the study:
   a. Select **File » Close**.
   b. At the prompt, click **Yes** to save the changes.
c. In the Save Study as dialog box, click Save to accept the default file name and location. The example study is saved and closed, and you are returned to the Home screen. You can also save the study you create at C:\Program Files\Applied Biosystems\QuantStudio 6 and 7 Flex Software\examples\QS6Flex.

**Edit a Biological Replicate Group**

1. Open the study of interest.
2. In the Study Menu pane, select Setup > Define Replicates.
3. Click Edit Biological Group to open the Edit Biological Replicate Group dialog box.
4. Edit the group information:
   a. From the Biological Group Name drop-down menu, select the group to edit.
   b. To change the group name, click Edit, enter a new name, then click OK.
   c. To change the color, select a color from the drop-down menu.
   d. (Optional) Enter comments.
5. From the Select Plate drop-down menu, select the experiment of interest.
6. Add samples to the biological group:
   a. In the Plate Layout, select the well(s) of the plate that contain samples to add to the biological group.
   b. Click ▶▶ to add the samples that are associated with the selected wells to the biological group.
7. Remove samples from the biological group:
   a. In the Technical Replicate Groups Added to Biological Replicate Group pane, select a sample. You can select only one sample at a time.
   b. Click ◀◀ to remove the sample from the biological group.
8. Repeat steps 5 through 7 for the other experiments in the study.
9. Click OK to save the changes and return to the study; click Cancel to exit the dialog box without saving the changes.

**Remove Biological Replicate Groups**

1. Open the study of interest.
2. In the Study Menu pane, select Setup > Define Replicates.
3. In the Define Replicates screen, select the group to remove, then click Delete Biological Group.
4. Click Yes to remove the group from the study; click No to keep the group in the study.
Chapter 13  Design and Analyze a Gene Expression Study

Tips for designing your own study

- Enter a study name that is descriptive and easy to remember. You can enter up to 100 characters in the Study Name field. The study name is used as the default file name. You can only use the alpha-numeric, period (.), hyphen (-), underscore (_), and spaces ( ) characters in the Experiment Name field.
- (Optional) Enter comments to describe the study. You can enter up to 1000 characters in the Comments field.
- Use the default user name, or enter a new user name, to identify the owner of the study. You can enter up to 100 characters in the User Name field.

**Note:** If security is enabled, the User Name field is automatically populated with the name you selected at log in.

- You can add an unlimited number of experiments (reaction plates) to the study. Click **Add Experiment(s)** or **Remove Selected Experiment(s)** to add or remove experiments to or from a study. Note the following:
  - Each experiment in the study must:
    - Have one or more common endogenous control(s). The endogenous control(s) must be present on each reaction plate within the study.
      **Note:** The endogenous control gene for a given sample must be run on the same plate as the target gene for a given sample in order for a study to be created.
    - Have identical thermal cycling parameters (the same number of steps and cycles). The QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software cannot combine in the same study experiments that use Fast and Standard thermal cycling conditions.
    - Have the same passive reference.
    - Have the same experiment type.
    - Have been run on the same instrument type.
  - As the default, the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software assigns the endogenous control and reference sample for a study based on the analysis settings of the first experiment that you added to the study.
  - If experiments that contain biological replicate groups are added to a study, the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software automatically merges the matching biological groups.
  - The QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software automatically analyzes a study after you add more than one experiment to it. Consequently, to ensure that the software uses the correct settings, Life Technologies recommends that you review the analysis settings of your study after adding multiple experiments.
- When adding experiments to the study, **Ctrl-click** multiple experiments in the Open dialog box to add them to the study.
- Select an experiment that has been added to the study to view its properties in the Properties pane.
- Filter the experiments added to the study to simplify the list for easier review. See “Filter the experiments in the study” on page 127.
• Enter a biological replicate group name that is descriptive and easy to remember. You can enter up to 100 characters in the Biological Group Name field. You can only use the alpha-numeric, full-stop (.), hyphen (-), underscore (_), and space ( ) characters in the Experiment Name field.
• (Optional) Enter comments to describe the biological replicate group. You can enter up to 1000 characters in the Comments field.
• You can add an unlimited number of technical replicates to a biological group.

IMPORTANT! A sample cannot belong to more than one biological group.

– Click-drag over the desired wells, or **Ctrl-click** or **Shift-click** in the plate layout to select multiple wells.
– Click the upper-left corner of the plate layout to select all wells.
• You can change the name of a biological replicate group, change its color identification and description, and add or remove technical replicates. See “Edit a Biological Replicate Group” on page 130.
• You can remove an existing biological replicate group. See “Remove Biological Replicate Groups” on page 130.

IMPORTANT! After you remove a biological replicate group from a study, you cannot restore it.

---

**Analyze the example study**

This section explains how to use the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software to analyze the Gene Expression example study. It also describes Life Technologies recommended best practices as you perform the analysis.

**Note:** The Comparative Ct Study Example.edm file illustrated in this chapter demonstrates the use of biological replicate groups. You can also create a study without the use of biological replicate groups.

---

**Access the example study**

Access the example study that you created on your computer.

C:\Program Files\Applied Biosystems\QuantStudio 6 and 7 Flex Software\examples\QS6_384 Well Comparative Ct with Bioreplicates Study Example.edm

---

**View the experiment data and well results**

The Experiment Data and Well Results Data panes appear in the Amplification Plot, Multicomponent Plot, and Multiple Plots View screens.

The Gene Expression screen displays the Replicate Results Data and the Well Results Data panes.
Only the Well Results Data pane appears in the QC Plots View screen.

- To display or hide columns in the Experiment Data pane– from the Show In Table drop-down menu, select or deselect one or more options: Experiments, # of Targets, # of Samples, Run Date.

- To display a subset of the study data in the plots– Select one or more rows in the Experiment Data pane or the Well Results Data pane, then select the **Hide unselected data from plot** check box appearing in the plot pane to display data only from the selected rows.

The Experiments Data pane lists each reaction plate (experiment) that is added to a study. The data that are displayed in the Well Results Data pane depend on which tab you select in the Experiment Data pane:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well Table tab</td>
<td>When you select one or more experiments in the Experiment Data pane, the well table displays the wells that make up the selected experiment(s).</td>
</tr>
</tbody>
</table>
View the analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle (C_T), flags, and relative quantification. If the default analysis settings in the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software are not suitable for your study, you can change the settings in the Analysis Settings dialog box, then reanalyze your study.

**Note:** In the Comparative C_T example study, the default analysis settings are used without changes.

To adjust the analysis settings

1. From the Study Menu pane, select **Analysis**.
2. Click **Analysis Settings** to open the Analysis Settings dialog box.
3. Select the **Relative Quantification Settings** tab, then view the default reference sample and endogenous control. In the example study, the default reference sample is brain and the default endogenous control is 18S.
4. Select the **C_T Settings** tab, then the **Flag Settings** tab. In the example study, the default analysis settings are used in each tab.
5. View and, if necessary, change the analysis settings. For more information on the changes to analysis settings, refer to “Tips for analyzing your own study” on page 135.

Note: You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.

6. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings by clicking Revert to Default Analysis Settings.

7. Click Analyze.

The following is an image of the Analysis Settings dialog box for a Comparative C_T Study:

![Analysis Settings Dialog Box](image)

### Tips for analyzing your own study

Unless you have already determined the optimal settings for your study, use the default analysis settings in the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software. If the default settings are not suitable for your study, change the settings as described below.

### C_T Settings

- **Data Step Selection**
  
  Use this feature to select multiple locations of analysis, in case several are chosen.

- **Algorithm Settings**
Use the Baseline Threshold algorithm to determine the $C_T$ values. The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for gene quantification.

- **Default $C_T$ Settings**
  Use the default $C_T$ settings feature to calculate $C_T$ for the targets that do not have custom settings. To edit the default settings, click **Edit Default Settings**.

- **$C_T$ Settings for Target**
  When you manually set the threshold and baseline, Life Technologies recommends:

  **Note:** This setting is applicable only to the Baseline-Threshold algorithm.

  **Note:** Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.

  **Flag Settings**

  Use the Flag settings tab to:
  - Adjust the sensitivity so that more wells or fewer wells are flagged.
  - Change the flags that are applied by the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software.

To adjust the flag settings

1. In the Use column, select the check boxes for flags to apply during analysis.
2. *(Optional)* If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.
   **Note:** If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.
3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.
   **Note:** After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HS in experiments using the Standard Deviation calculations may change the result of $C_T$ SD. For some flags, analysis results calculated before the well is rejected are maintained.
4. Click **Apply Analysis Settings** in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.
Relative Quantification Settings

Use the Relative Quantification Settings tab to:

- Change the reference sample and/or endogenous control. As the default, the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software assigns the endogenous control and reference sample for a study based on the analysis settings of the first experiment added to it. You can add multiple endogenous controls to a study.
- Correct the amplification efficiency. You can enter a percentage value between 1% and 150% for each target. When you set an assay to have a value that differs from 100% efficiency, the software uses the relative standard curve algorithm.
- (For multiplex reactions) Specify the ΔCₜ value at which to reject replicates (outlier rejection).
- Select the algorithm to use to determine the relative quantification minimum and maximum values (error bars):
  - **Confidence Level** - Select to calculate the RQ minimum and maximum values based on the selected confidence level. Select the confidence level to use.
  - **Standard Deviations** - Select to calculate the RQ minimum and maximum values based on the selected number of standard deviations. Select the number of standard deviations to use.
Assess amplification results using the Amplification Plot

In the comparative C_T example study, you review each target in the Amplification Plot screen for correct baseline and threshold values.

1. From the Study Menu pane, select Analysis ▶ Amplification Plot.
   
   **Note:** If no data are displayed, click Analyze.

2. In the Experiment Data pane, select all of the experiments (click and drag to select all rows in the table).

3. In the Amplification Plot pane, set the parameters for the plot:
   
   a. From the Plot Type drop-down menu, select ΔRn vs Cycle.
   b. From the Plot Color drop-down menu, select Well.
   c. Click Show a legend for the plot.
      
      **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.
   d. From the Target drop-down menu, select ACTB to highlight all ACTB wells in the study.

4. View the baseline values:
   
   a. From the Graph Type drop-down menu, select Linear.
   b. Select the Show Baseline check box to show the start cycle and end cycle.
   c. Verify that the baseline is set correctly: The end cycle should be set a few cycles before the cycle number where significant fluorescence is detected. In the example study, the baseline is set correctly.
      
      **Note:** The data shown in the screenshot below is of the example experiment. Results vary depending on the experiment setup.

5. View the threshold values:
a. From the Graph Type drop-down menu, select Log.
b. Deselect the Show Baseline check box, then select the Show Threshold check box to show the threshold.
c. Verify that the threshold is set correctly. In the example study, the threshold is in the exponential phase.

6. Repeat steps 3 through 5 for the remaining targets.

Tips for assessing amplification in your own study

Ensure that your study meets the following requirements:

- **A typical amplification plot** – See the amplification plot examples in the Chapter 5 and Chapter 11.
- **Correct baseline and threshold values** – See the threshold examples and the baseline examples in Chapter 5 and Chapter 11.

If your study does not meet these requirements, you can:

- Manually adjust the baseline and/or threshold. See “View the analysis settings” on page 134.
- Omit individual wells from the analysis. See “Omit wells from the analysis” on page 164.
Assess the gene expression profile using the Gene Expression Plot

The Gene Expression Plot screen displays the results of the relative quantification calculations in the gene expression profile. Three plots are available:

- **RQ vs Target** – Groups the relative quantification (RQ) values by target. Each sample is plotted for each target. You can view the plot as the following graph types: linear, log10, Ln, log2.
- **RQ vs Sample** – (displayed only when the Technical Replicates tab is selected in the Replicate Results Data pane) – Groups the relative quantification (RQ) values by sample. Each target is plotted for each sample. You can view the plot as the following graph types: linear, log10, Ln, log2.
- **RQ vs BioGroup** – (displayed only when the Biological Replicates tab is selected in the Replicate Results Data pane) – Groups the relative quantification (RQ) values by biological replicate group. Each target is plotted for each sample. You can view the plot as the following graph types: linear, log10, Ln, log2.

**About the example study**

In the Comparative C_T example study, you review each target in the Gene Expression Plot screen for the expression level (or fold change) of the target sample relative to the reference biological replicate group.

**View the Gene Expression Plot**

1. From the Study Menu pane, select Analysis ➤ Gene Expression.
2. In the Gene Expression Plot pane, set the parameters for the plot:
   a. In the Plot Type drop-down menu, select RQ vs BioGroup.
   b. In the Graph Type drop-down menu, select Log10.
   c. In the Orientation drop-down menu, select Vertical Bars.
   d. Click Show a legend for the plot.

   **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.
In the example study, the expression levels of multiple targets in the biological replicate group are displayed relative to the expression levels of the same targets in the reference biological replicate group (universal). Because the reference sample is compared to itself, the relative expression level is 1. When the result is displayed in the Log10 graph type, the expression level of the reference sample appears as 0 in the graph (log10 of 1 = 0).

3. Select multiple endogenous controls:
   a. In the Replicate Results Data pane, select the **Technical Replicates** tab.
b. From the Endo Controls drop-down menu, select GAPDH, GH1, and LIPC, then deselect ACTB.

Note: You can also select the endogenous controls in the Analysis Settings dialog box. See “View the analysis settings” on page 134.
4. Click **Analyze**. In the example study shown below, all samples for the endogenous controls GAPDH, ACTB, and LIPC have no values (with the exception of the CT Mean value), and the RQ values for the remaining samples change. For example, in the example study, the RQ value for the brain sample changes from 1.0 (with 18S as the endogenous control) to none with the new endogenous controls.

![Replicate Results Data](image)

**Tips for assessing the gene profile in your own study**

Look for:
- Differences in gene expression (as a fold change) relative to the reference sample.
- Standard deviation in the replicate groups (CT SD values).

If needed, you can omit outliers. See “Omit replicates from the analysis” on page 147.

**Note:** To display a subset of the study data in the Gene Expression Plot pane, select one or more rows in the Technical Replicates tab or the Biological Replicates tab, then select **Hide unselected data from plot** to display data only from the selected rows.
View the replicate results data and the well results data

The Replicate Results Data pane lists each reaction plate (experiment) that is added to a study. The results of the study are arranged by technical or biological replicate association.

The data that are displayed in the Well Results Data pane depend on which tab you select in the Replicate Results Data pane:

<table>
<thead>
<tr>
<th>Technical Replicates Tab</th>
<th>Biological Replicates Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>This tab arranges the results of the relative quantification analysis by technical replicate group. The ViiA™ 7 Software displays the results for each sample/target combination as a row in the table. You can view the members of a technical replicate group by selecting the appropriate row in the table. When a row is selected, the Well Results Data pane displays the wells that make up the selected technical replicate group.</td>
<td>This tab arranges the results of the relative quantification analysis by biological replicate group. The QuantStudio™ 6 and 7 Flex Software displays the results for each biological group as a row in the table (each row displays a biological sample with its target). You can view the members of a biological replicate group by selecting the appropriate row from the table. When a row is selected:</td>
</tr>
<tr>
<td>The table below provides definitions for the column headings that appear in the tables in the Technical Replicates and Biological Replicates tabs. Note: To show or hide columns in a table, select or deselect the column name from the Show In Table drop-down menu.</td>
<td>• The Biological Replicate Details table displays the technical replicate groups that make up the selected biological replicate group. • The Well Results Data pane displays the individual members of the technical replicate groups that make up the selected biological replicate group.</td>
</tr>
</tbody>
</table>

Column descriptions

The table below provides definitions for the column headings that appear in the tables in the Technical Replicates and Biological Replicates tabs.
### View the replicate results data and the well results data

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ΔC&lt;sub&gt;T&lt;/sub&gt;</td>
<td>The calculated ΔC&lt;sub&gt;T&lt;/sub&gt; value for the replicate group associated with the test sample.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The ΔC&lt;sub&gt;T&lt;/sub&gt; value is calculated only for multiplex experiments and is</td>
</tr>
<tr>
<td></td>
<td>calculated at the well level (that is, the individual technical replicate level) by</td>
</tr>
<tr>
<td></td>
<td>subtracting the target CT value from the endogenous control CT value.</td>
</tr>
<tr>
<td>ΔC&lt;sub&gt;T&lt;/sub&gt; Mean</td>
<td>The arithmetic average of the technical replicate CT values for the sample replicate group.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The ΔC&lt;sub&gt;T&lt;/sub&gt; Mean value is calculated at the reaction plate level and</td>
</tr>
<tr>
<td></td>
<td>represents the mean difference between the target CT values and the endogenous control CT values</td>
</tr>
<tr>
<td></td>
<td>for all the technical replicates for that sample that are present on the plate.</td>
</tr>
<tr>
<td>ΔC&lt;sub&gt;T&lt;/sub&gt; SE</td>
<td>The Standard Error of the mean associated with the reported Mean ΔC&lt;sub&gt;T&lt;/sub&gt; value.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The ΔC&lt;sub&gt;T&lt;/sub&gt; SE value is calculated differently for multiplex and singleplex</td>
</tr>
<tr>
<td></td>
<td>experiments. For multiplex experiments, the calculation is at the well level.</td>
</tr>
<tr>
<td></td>
<td>For singleplex experiments, the calculation combines the plate-level CT value variation</td>
</tr>
<tr>
<td></td>
<td>between the target and the endogenous control.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select the Standard Deviation option in the RQ Min/Max calculations on the</td>
</tr>
<tr>
<td></td>
<td>Relative Quantification Settings in the Analysis Settings dialog box, ΔC&lt;sub&gt;T&lt;/sub&gt; SD, that</td>
</tr>
<tr>
<td></td>
<td>is the Standard Deviation values are calculated by the QuantStudio™ 6 and 7 Flex Software.</td>
</tr>
<tr>
<td>ΔΔC&lt;sub&gt;T&lt;/sub&gt;</td>
<td>The calculated ΔΔC&lt;sub&gt;T&lt;/sub&gt; value for the replicate group associated with the reference</td>
</tr>
<tr>
<td></td>
<td>sample.</td>
</tr>
<tr>
<td># Replicates</td>
<td>The number of biological replicate groups in the study.</td>
</tr>
<tr>
<td>Biological Group</td>
<td>The name of the biological replicate group.</td>
</tr>
<tr>
<td>C&lt;sub&gt;T&lt;/sub&gt;</td>
<td>Threshold cycle; the PCR cycle number at which the fluorescence meets the threshold in the</td>
</tr>
<tr>
<td></td>
<td>amplification plot.</td>
</tr>
<tr>
<td>C&lt;sub&gt;T&lt;/sub&gt; Mean</td>
<td>The arithmetic average of the technical replicate CT values.</td>
</tr>
<tr>
<td>Experiment</td>
<td>The name of the experiment file (for example, heart.eds).</td>
</tr>
<tr>
<td>Flag</td>
<td>The number of QC flags that the well generated as listed in the ▲ symbol.</td>
</tr>
<tr>
<td>Omit (Replicate Results Data pane)</td>
<td>Indicates the omission status of the members of the associated technical or biological</td>
</tr>
<tr>
<td></td>
<td>replicate group(s):</td>
</tr>
<tr>
<td></td>
<td>• A check mark (√) indicates that all replicates have been removed from the analysis.</td>
</tr>
<tr>
<td></td>
<td>• A hyphen (–) indicates that one or more replicates have been removed from the analysis.</td>
</tr>
<tr>
<td>Omit (Well Results Data pane)</td>
<td>Indicates the omission status of the well. A check mark (√) indicates that the well has been</td>
</tr>
<tr>
<td></td>
<td>removed from the analysis.</td>
</tr>
<tr>
<td>RQ</td>
<td>The calculated relative level of gene expression for the replicate group that is associated with the test sample.</td>
</tr>
</tbody>
</table>
About the example study

In the Comparative C_T example study, you review the Replicate Results Data pane and the Well Results Data pane to evaluate the C_T precision of the replicate groups and view related RQ information.

View the results data

1. From the Study Menu pane, select Analysis > Gene Expression.
2. Click at the top left of the Replicate Results Data pane.
3. View the technical replicates:
   a. Click the Technical Replicates tab. The table displays the results by technical replicate group.
   b. In the Technical Replicates table, select the following groups:
      • Brain/GAPDH (row2)
      • Brain/LIPC (row 4)
      • Brain/LPIN1 (row 5)
      The Well Results Data pane displays all wells that make up the selected groups.
4. View the values in the Well Results Data pane:
   a. From the Group Results By drop-down menu, select Target.
b. View the C	extsubscript{T}, ΔC	extsubscript{T} Mean, and ΔC	extsubscript{T} SE values to evaluate the C	extsubscript{T} precision of the replicate groups. In the example study, the low ΔC	extsubscript{T} SE values indicate these replicates have good C	extsubscript{T} precision.

Tips for viewing replicate results in your own study

- Select the Technical Replicates tab or the Biological Replicates tab to organize and view the sample data according to the associated technical replicate group or biological replicate group.
- View all wells for a technical or biological replicate group by selecting the appropriate row in the table. When a row is selected, the Well Results Data pane displays the wells that make up the group. Ctrl-click to select multiple rows.
- Change the endogenous control by clicking Endo Control, then selecting a new target.
- Change the reference sample by clicking Ref Sample, then selecting a new sample.
- Add biological replicate groups by clicking Add BioGroup.
- Omit biological or technical replicates from the analysis. See “Omit replicates from the analysis” on page 147.

Note: The QuantStudio 384 Well Comparative Ct with Bioreplicates Study Example.edm file demonstrates the use of biological replicate groups. You can also create example study that does not use biological replicate groups.

Omit replicates from the analysis

To omit a technical or biological replicate from the analysis:

1. From the Study Menu pane, select Analysis ▶ Gene Expression.
2. Select the Technical Replicates or Biological Replicates tab according to the type of replicate that you want to omit.
3. In the replicate table, scroll to the biological or technical replicate of interest, then select the corresponding check box in the Omit column.
4. Click Analyze when you finish omitting wells.

**IMPORTANT!** You cannot omit all technical replicates that belong to a reference sample or a reference biological group, or that serve as the endogenous control for a study.

**Note:** You can also omit the biological replicates in the Biological Replicate Details table at the bottom of the Biological Replicates tab.

### Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye over the duration of the PCR run in a selected well of any experiment that is added to the study.

**About the example study**

In the comparative $C_T$ example study, you review the Multicomponent Plot screen for:

- ROX™ dye (passive reference)
- FAM™ dye (reporter)
- Spikes, dips, and/or sudden changes
- Amplification in the negative control wells

**View the Multicomponent Plot**

1. From the Study Menu pane, select **Analysis › Multicomponent Plot**.
2. In the Experiment Data pane, select the **QuantStudio Comparative Ct Example 1.eds** experiment.
3. Display the unknown wells one at a time in the Multicomponent Plot pane:
   a. Click the **Plate Layout** tab.
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot pane.
   **Note:** If you select multiple wells, the Multicomponent Plot pane displays the data for all selected wells simultaneously.
4. In the Multicomponent Plot pane, set the parameters for the plot:
   a. From the Plot Color drop-down menu, select **Dye**.
   b. Click **Show a legend for the plot**.
   **Note:** This is a toggle button. When the legend is displayed, the button changes to **Hide the plot legend**.
5. Check the FAM dye signal. In the example study, the FAM dye signal increases throughout the PCR process, which indicates normal amplification.
6. Check the ROX dye signal. In the example study, the ROX dye signal remains constant throughout the PCR process, which indicates typical data.
7. Repeat steps 2 through 6 for the remaining experiments in the study.

Tips for confirming dye-signal accuracy in your own studies

- **Passive reference** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.
- **Reporter dye** – The reporter dye fluorescence level should display a flat region corresponding to the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.
- **Irregularities in the fluorescence** – There should not be any spikes, dips, and/or sudden changes in the fluorescence.
- **Negative control wells** – There should not be any amplification in the negative control wells.

If your study does not meet the guidelines above, you can omit individual wells from the analysis. See “Omit wells from the analysis” on page 164.

**View the QC Plots**

The QC Plots screen displays the endogenous control and replicate analysis results for each reaction plate (experiment) added to the study. The following plots are derived from the experiments added to a study:

- Endogenous Control Profile
- Box Plot
- Technical Replicates Correlation
- Biological Replicates Correlation
The QC Plots screen displays the Endogenous Control Profile plot for the endogenous controls used in the experiments added to a gene expression study. The endogenous control profile plot displays how much of the endogenous control is expressed in a sample. The sample is plotted on the X-axis, and the C_T is plotted on the Y-axis. The expression is viewed as a color and shape combination in the plot.

In the example study, you view four potential endogenous controls expressed in four samples. The potential endogenous controls are:

- ACTB
- GH1
- LIPC
- LPIN1

The samples are brain, heart, lung, and liver.

1. From the Study Menu pane, select Analysis ▶ QC Plots.
2. In the QC Plots pane, click Endogenous Control Profile.
3. In the Candidate Endogenous Controls pane, select the check boxes of those Targets whose profile you want to view in the plot pane. In the example study, the Target ACTB is chosen to be the endogenous control because it is expressed at similar levels in three out of four of the given samples.
4. In the Replicate Results Data pane, view results by replicate group.
   a. Click the Technical Replicates tab. The table displays the results by technical replicate group.
   b. Click the Biological Replicates tab. The table displays the results by biological replicate group.

The Box Plot displays the C_T distribution of a particular Target in samples. You can see the individual C_T values/ raw data with this plot.
In the example study, you view the box plots of five targets in four different samples:

- LPIN1
- GAPDH
- LIPC
- GH1
- ACTB

The samples are Heart, Liver, Lung, and Brain.

1. In the QC Plots pane, click **Box Plots** to access the Replicate Results Data pane.
2. In the Replicate Results Data pane, click the **Technical Replicates** tab. The table displays the results by technical replicate group.
3. Click the **Biological Replicates** tab. The table displays the results by biological replicate group.
4. Click the Experiments tab to select the experiment whose Box plot to view.
5. View the values in the Well Results Data pane. View the $C_T$, $\Delta C_T$ Mean, and $\Delta C_T$ SE values to evaluate the $C_T$ precision of the replicate groups. In the example study, the low $\Delta C_T$ SE values indicate these replicates have good $C_T$ precision.

**View the Technical Replicates Correlation plot**

The Technical Replicates Correlation plot displays the correlation between the target genes in one or more samples.

The Technical Correlation Group plot is made of two components, the scatter plot and the heat map.
Scatter Plot

The scatter plot shows the distribution of ΔC_T of targets for different samples.

If a correlation (represented by R^2 or the coefficient of determination) exists among the targets in the samples, the targets appear on or along the line of reference. If the correlation is weak or not present, the targets appear scattered in the plot, away from the line of reference.

The line of reference is fixed in the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software.

If:
- \( R^2 \approx 1 \), then the correlation is strong
- \( R^2 < 1 \), then the correlation is weak
- \( R^2 = 0 \), then there is no correlation

Heat maps

The heat map shows the variation of coefficient determination for different scatter plots. Each cell of the heat map represents a different scatter plot, and therefore a different value for \( R^2 \). The cells inclined to red represent a lower \( R^2 \) value; the cells inclined to green represent a higher \( R^2 \) value.
In the example study, you view the scatter plots and heat maps of five targets in four different samples:

- LPIN1
- GAPDH
- LIPC
- GH1
- ACTB

The samples are Brain, Heart, Kidney and Lung.

1. In the QC Plots pane, click Technical Replicates Correlation to access the Heat Map.

2. In the Heat Map, click the cell with a correlation value, $R^2 \approx 1$. The corresponding scatter plot pane displays the scatter plot of the targets in that technical replicate group along the line of reference.
3. Click the cell with a correlation value, $R^2 =/= 0$. The corresponding scatter plot pane displays the scatter plot of the targets in that technical replicate group away from the line of reference.

View the Biological Group Correlation plot

The Biological Group Correlation plot displays the correlation between the target genes in one or more biological group samples. Biological groups provide a broader set of samples, with the same targets.

Note: If the experiments in your study do not use biological replicate groups, see “Define Replicates” on page 128 to create a new biological group.

The Biological Group Correlation plot is also made of two components, the scatter plot and the heat map.
Scatter Plot

The scatter plot shows the distribution of ΔC_T of targets for different biological groups. If a correlation (represented by R^2 or the coefficient of determination) exists among the targets in the biological groups, the targets appear on or along the line of reference. A weak correlation or no correlation is represented by the targets being scattered in the plot and away from the line of reference.

**Note:** The line of reference is fixed in the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software.

If:

- R^2 \approx 1, then the correlation is strong
- R^2 < 1, then the correlation is weak
- R^2 = 0, then there is no correlation
Heat maps

The heat map shows the variation of coefficient determination for different scatter plots. Each cell of the heat map represents a different scatter plot, and therefore a different value for $R^2$. The dull green cells represent a lower $R^2$ value; the bright green cells represent a higher $R^2$ value.

In the example study, you view the scatter plots and heat maps of eight targets across four biological groups:

- LPIN1
- GAPDH
- LIPC
- GH1
- ACTB

Technical replicate samples of Brain cDNA belong to the biological group Brain, those of Lung cDNA belong to biological group Lung, technical replicate samples of Liver cDNA belong to the biological group Liver, and those of Heart cDNA belong to the biological group Heart.

To view the Biological Group Correlation plot:

1. In the QC Plots pane, click **Biological Group Correlation** to access the heat map.
2. In the Heat Map, click the cell with a correlation value, $R^2 \approx 1$. The corresponding scatter plot pane displays the scatter plot of the targets in that biological replicate group along the line of reference.

3. Click the cell with a correlation value, $R^2 \approx 0$. The corresponding scatter plot pane displays the scatter plot of the targets in that biological replicate group away from the line of reference.

**Tips for viewing your own scatter plots and heat maps**

When you analyze your study, look for scatter plots and heat maps that display a correlation value that is $\approx 1$ for samples that come from the same source or tissue (technical or biological replicates). If the replicates do not correlate well, that could be a sign that there is a problem with a sample.

If your study does not meet the guidelines above, you can omit individual wells from the analysis. See “Omit wells from the analysis” on page 164.
View the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software flags, and it includes the flag frequency and location for any experiment that is added to a study.

About the example study

In the Comparative C_t example study, you review the QC Summary screen for any flags generated by the study data. In the example study, several wells produced data that generated flags.

View the QC Summary

1. From the Study Menu pane, select Analysis > QC Summary.

   Note: If no data are displayed, click Analyze.

2. In the Flags Summary table, look in the Frequency column to determine which flags appear in the study. In the example study, the EXPFAIL flag appears 10 times and the NOAMP flag appears once.

   Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the study.

3. For each flag that appears in the study, click the flag row to display details about the flag in the Flag Details table. In the example study, the NOAMP flag indicates no amplification and the EXPFAIL flag indicates that the exponential algorithm failed.

4. Consider removing the NOAMP well from the analysis. See “Omit wells from the analysis” on page 164.

Possible flags

For Comparative C_t studies, the flags listed below may be generated by the study data.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Name</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXPFAIL</td>
<td>No amplification</td>
<td>10</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
<td>1</td>
</tr>
<tr>
<td>BASELINE</td>
<td>Baseline algorithm failed</td>
<td>10</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
<td>0</td>
</tr>
<tr>
<td>NOISE</td>
<td>No signal in well</td>
<td>0</td>
</tr>
<tr>
<td>OUTLIER</td>
<td>Outlier in replicates group</td>
<td>0</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>No signal in well</td>
<td>0</td>
</tr>
<tr>
<td>NOAMP</td>
<td>Fluorescence is off scale</td>
<td>0</td>
</tr>
<tr>
<td>AMPFAIL</td>
<td>Amplification in negative cont</td>
<td>0</td>
</tr>
<tr>
<td>THRESH</td>
<td>Thresholding algorithm failed</td>
<td>0</td>
</tr>
</tbody>
</table>

Possible flags
If a flag does not appear in the study, its frequency is 0. If the frequency is >0, the flag appears somewhere in the study, and the associated well position is listed in the Wells column.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pre-processing flag</strong></td>
<td></td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td><strong>Primary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>C_T algorithm failed</td>
</tr>
<tr>
<td><strong>Secondary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>OUTLIERRG</td>
<td>Outlier in replicate group</td>
</tr>
<tr>
<td>AMPNC</td>
<td>Amplification in negative control</td>
</tr>
<tr>
<td>HIGHSD</td>
<td>High standard deviation in replicate group</td>
</tr>
</tbody>
</table>
Tips for using flags to evaluate your study

• In the Flag Summary table, click each flag that has a frequency >0 to display details about the flag in the Flag Details table. If needed, click the troubleshooting link in the Flag Details table to view information on correcting the flag.

  Note: In the Flag Details table, the numbers on each flag symbol indicate the number of flags generated for that well. For example, ▲ indicates that two flags have been generated for that well.

• You can change the flag settings. For more information, see “Flag Settings” on page 136:
  – Adjust the sensitivity so that more wells or fewer wells are flagged.
  – Change the flags that are applied by the QuantStudio™ 6 and 7 Flex Real-Time PCR Development Software.

• You can omit individual wells from the analysis. See “Omit wells from the analysis” on page 164.

Compare analysis settings

Use the Compare Settings screen to perform a side-by-side comparison of analysis settings for a comparative CT study. You can change one or more of the analysis settings, then compare the new results with the previous results. For example, you can compare the effects of:

• Using multiple endogenous controls versus a single endogenous control.
• Changing the amplification efficiency of a specific target versus keeping it at 100%.

About the example study

In the comparative CT example study, you change the endogenous control to LPIN1, then compare results.

Modify comparison criteria

1. From the Study Menu pane, select Analysis ▶ Compare Settings. When the Compare Settings screen is initially displayed (before you make any changes):
   • In the Settings Comparison pane, the green column is titled “Current Analysis Settings,” the white column is titled “Comparison Analysis Settings,” and the Use Comparison Analysis Settings button is under the green column.
   • In the Results Comparison pane, values in the white columns and values in the green columns are the same.
   • The Gene Expression Comparison plot is the same plot that is displayed in the Gene Expression screen (Analysis ▶ Gene Expression).
2. In the Settings Comparison pane, click **Edit** in the green column to open the Comparison Analysis Settings dialog box.

3. In the Comparison Analysis Settings dialog box, change the endogenous control:
   a. Select the **Relative Quantification Settings** tab.
   b. In the Endogenous Control(s) pane, select LIPN1 from the Endogenous Control drop-down menu.
c. Click Analyze to analyze the data and close the dialog box.

4. In the Settings Comparison pane, click Use Comparison Analysis Settings under the green column, then compare the results:

- In the Settings Comparison pane, the white column is titled “Comparison Analysis Settings,” the green column is titled “Current Analysis Settings,” and the Use Comparison Analysis Settings button is under the white column.

- In the Results Comparison pane, values in the white columns are based on the default analysis settings, and values in the green columns are based on the modified analysis settings. In the example experiment, changing the endogenous control to 18S affects the RQ values. To view the RQ values, scroll to the left. If desired, you can click and drag the RQ column headings so that they appear first in the table.

- The Gene Expression Comparison plot displays the default analysis settings (the values from the white columns).

Note: The Gene Expression Comparison plot has limited functions. For example, you cannot change to log scale and you cannot view by target.
Note: The default analysis settings are the settings automatically made by the software when the study is initially analyzed.

5. From the Study Menu pane, select Analysis ▶ Gene Expression to view the gene expression plot using the modified analysis settings.

   Note: In the Gene Expression screen you can view the modified data in log scale, by target, and so on. See “Assess the gene expression profile using the Gene Expression Plot” on page 140.

6. (Optional) View the data in the other analysis screens. All other analysis screens for the study display the data using the modified analysis settings.

7. Close the study.
   • Save your changes before closing the study.
   Or
   • Close the study without saving your changes. If you do not save your changes, the software reverts to the default analysis settings the next time you open the study.
Tips for managing your own comparison

- Edit the comparison analysis settings as desired. For information on editing the settings, see “View the analysis settings” on page 134.
- After making your first round of changes to the analysis settings, you can continue making changes using one of the following methods:
  - (Recommended) Revert to the saved analysis settings, then make new changes. To do this: In the Settings Comparison pane, click Use Comparative Analysis Settings (now under the white column) to revert to the saved analysis settings, then repeat steps 2 through 6 above. This method ensures that you do not lose the saved analysis settings.
  - Continually compare new settings with previous settings. To do this: In the Settings Comparison pane, alternate clicking Edit in the white and green columns, then repeat steps 3 through 6 above. This method does not allow you to return to your saved settings; subsequent comparisons are made with the previous analysis settings, building upon any changes that you have already made.

**IMPORTANT!** The default analysis settings are defined by the software. If you make changes to the analysis settings and save the study, the saved changes are lost when you revert to the default analysis settings.

1. In the Settings Comparison pane, click Edit next to the settings you want to revert to the default: Current Analysis Settings or Comparison Analysis Settings.

2. In the Analysis Settings dialog box, revert to defaults and reanalyze the data:
   a. Click Revert to Default Analysis Settings.
   b. At the prompt, click Yes.
   c. Click Analyze to analyze the data and close the dialog box.

3. In the Settings Comparison pane, click Use Comparison Analysis Settings. In the Results Comparison pane, values for the settings you selected to edit in step 1 (“Current Analysis Settings” or “Comparison Analysis Settings”) are generated according to the default analysis settings.

Omit wells from the analysis

You can use the Well Table to omit individual wells from the analysis. To omit a well:

1. From the Study Menu pane, select one of the following analysis screens:
   - Analysis ➤ Amplification Plot
   - Analysis ➤ Multicomponent Plot
   - Analysis ➤ Multiple Plots View

2. In the Experiment Data pane, select the experiment that contains the well to omit.
3. In the Well Results Data pane, click the **Well Table** tab, then select the check box in the Omit column for the well to omit.

**Note:** You cannot omit all technical replicates that belong to a reference sample or a reference biological group, or that serve as the endogenous control.

### Export the study

**Note:** If you are using RealTime StatMiner® Software to analyze the exported data, make sure you have assigned a sample to all the wells containing data in the individual experiments. If a sample is not assigned, the RealTime StatMiner® Software reports an error during import.

You can export the data within a study from the Analysis screen. To export a study:

1. On the Analysis screen, click **Export** to access the Export Properties tab.
2. Define export properties.
   a. Select the data to export. Options are:
      - Amplification Data
      - Results
      - Technical Analysis Result
      - BioGroup Analysis Result
      - QC Summary
   b. Select **One File** or **Separate Files** from the drop-down menu to export all data to one file or in separate files for each data type respectively.
   c. Enter the export file properties and file name.
   d. Select the file type from the **File Type** drop-down menu. You can choose from *.txt, *.xls, and *.xlsx.
   e. Enter the Export File Location. The default location is `C:\Applied Biosystems\QuantStudio 6 and 7 Flex Software\User Files\Export`.
   f. Select the Open file(s) when export is complete check box to automatically open the file when export is complete.

For the example study, enter:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export</td>
<td>Amplification Data</td>
</tr>
<tr>
<td>Select one file or separate files</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>Q56_384-Well_Comparative_Ct_with_Bioreplicates_Study_Example_data</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td><code>C:\Applied Biosystems\QuantStudio 6 and 7 Flex Software\User Files\Export</code></td>
</tr>
</tbody>
</table>
Chapter 13  Design and Analyze a Gene Expression Study

Export the study

The following is an image of the Export Data screen:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open file(s) when export is complete</td>
<td>Unchecked</td>
</tr>
<tr>
<td>Save current settings as the default</td>
<td>Unchecked</td>
</tr>
<tr>
<td>7900 Format</td>
<td>Unchecked</td>
</tr>
</tbody>
</table>

3. To change the export format, complete the tasks on the Customize Export tab.

   **Note:** To complete the tasks on the Customize Export tab you must have at least one type of data to export.

   a. Select the data from the Export Properties tab. The type of data that you selected in the Export Properties tab appears in the Customize field in the Customize Export tab.

   b. Select the data type content.

   c. Select the Tabs or Commas radio button to select the Field Separator (Delimiter).

   d. Select the Open file(s) when export is complete check box to automatically open the file when export is complete.

For the example study, enter:
4. Select the **Save current settings as the default** check box to save the export settings that you have modified. Alternatively, select the **7900 Format** check box to save the export settings in the 7900 format.

5. Click **Start Export**.
## For more information

<table>
<thead>
<tr>
<th>For more information on</th>
<th>Refer to</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculating Relative Quantification Values</td>
<td>User Bulletin #2: Relative Quantitation of Gene Expression.</td>
<td>4303859</td>
</tr>
</tbody>
</table>
| Consumables                                    | Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments  
Appendix A in Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes  | 4489822            |
| Publishing data                                | Chapter 2 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.                                                                                     | 4489822            |
A
adjusting parameters, re-analyzing own experiments 61, 117
Advanced Settings tab 64, 120
Algorithm Settings, Baseline Threshold 62, 118, 136
amplification efficiency, factors affecting
PCR inhibitors 41
standard quantities 41
standard replicates 41
amplification plot
amplification efficiency 21, 41, 66
assessing amplification results 42, 101, 138
reviewing baseline values 43, 102, 138
reviewing outliers 45, 104
reviewing threshold values 44, 103, 138
tips for analyzing own experiments 46, 105
tips for analyzing own study 139
viewing 32, 42, 90, 101
AMPNC flag 59, 115, 159
analysis settings
adjusting 61, 117
Advanced Settings 61, 117
comparing 160
C\textsubscript{T} Settings 61, 117
defining 17, 77
Flag Settings 61, 117
Relative Quantification Settings 61, 117
Standard Curve Settings 61
viewing 134
Analyze
Amplification Plot 42, 101
Gene Expression Plot 49, 97
Multicomponent Plot 53, 108
QC Plot 57, 112
QC Summary 58, 113
Raw Data Plot 55, 110
Standard Curve Plot 39
Study 132
Well Table 51, 99
Auto Export 67, 123
Automatic Baseline, advanced settings 64, 120
Automatic Threshold 62, 118, 136

B
BADROX flag 59, 114, 159
baseline values, correcting 47, 107
Biological Replicates and Technical Replicates, column headings
ΔΔC\textsubscript{T} 145
biological group correlation plot, viewing
Heat Map 156
Scatter Plot 155
biological replicate groups
adding 128
editing 130
removing 130
Biological Replicates tab 144
BLFAIL flag 59, 114, 159
box plots, viewing 150

C
cocktail mix 25, 84
comparative CT experiments
example experiment 73
overview 71
PCR options 72
required components, assemble 71
comparison criteria
modifying 160
tips for managing own study 164
correcting baseline and threshold values 139
C\textsubscript{T} settings
algorithm settings 62, 118, 135
data step, selecting 62, 118, 135
default 62, 118, 136
target 62, 118, 136
C\textsubscript{T} Settings tab 62, 118, 135
CTFAIL flag 59, 115, 159

defining samples 16, 76
defining targets 16, 76
designing experiment
assigning targets, samples, and biological groups 17, 78
defining and setting up standards 17
defining experiment properties 15, 75
defining targets, samples, and biological replicates 16, 76
setting up run method 19, 79
tips for designing own experiment 20, 80
dye accuracy
irregularities in the signal 55, 110, 149
negative control wells 55, 110, 149
passive reference 55, 110, 149
### Index

- **reporter dye** 55, 110, 149

### E
- endogenous control profile, viewing 150
- endogenous control, selecting 20, 80
- experiment properties, defining 15, 75
- EXPFAIL flag 59, 114, 159
- Export 67, 123

### F
- Flag Settings tab 62, 118, 136
- flags, QC
  - AMPNC 59, 115, 159
  - BADROX 59, 114, 159
  - BLFAIL 59, 114, 159
  - CTFAIL 59, 115, 159
  - EXPFAIL 59, 114, 159
  - HIGHSD 59, 115, 159
  - NOAMP 59, 114, 159
  - NOISE 59, 114, 159
  - NOSIGNAL 59, 114, 159
  - OFFSCALE 59, 114, 159
  - OUTLIERRG 59, 115, 159
  - SPIKE 59, 114, 159
  - THOLDFAIL 59, 114, 159
  - tips for evaluating own study 160

### G
- gene expression plot
  - assessing gene expression profile 49, 97, 140
  - assessing own experiments 51, 99
  - tips for assessing own study 143
  - viewing 50, 98, 140
- gene expression plots available
  - RQ vs BioGroup 140
  - RQ vs Sample 50, 98, 140
  - RQ vs Target 49, 97, 140
- gene expression study
  - about 126
  - designing and analyzing 125
  - example study 126

### H
- HIGHSD flag 59, 115, 159

### I
- improving C<sub>T</sub> precision, omitting wells 65, 120

### M
- multicomponent plot
  - confirming dye accuracy 53, 108, 148
  - tips for analyzing own experiment 55, 110
  - tips for analyzing own study 149
  - viewing 53, 108, 148

### N
- NOAMP flag 59, 114, 159
- NOISE flag 59, 114, 159
- NOSIGNAL flag 59, 114, 159

### O
- OFFSCALE flag 59, 114, 159
- OUTLIERRG flag 59, 115, 159

### P
- PCR options
  - 1-step PCR 13, 72
  - 2-step PCR 13, 72
  - Multiplex PCR 12, 72
  - Singleplex PCR 12, 72
- preparing reactions
  - reaction mix 25, 84
  - reaction plate 26, 85
  - required materials 23, 83
  - sample dilutions 24, 84
  - standard dilution series 24
  - template 23, 83
  - tips for your own experiment 28, 86
- preparing template
  - Complementary DNA 28
  - Genomic DNA 28
- Pre-processing flag
  - OFFSCALE 59, 114, 159
- Primary analysis flags
  - BADROX 59, 114, 159
  - BLFAIL 59, 114, 159
  - CTFAIL 59, 115, 159
  - EXPFAIL 59, 114, 159
  - NOAMP 59, 114, 159
  - NOISE 59, 114, 159
  - NOSIGNAL 59, 114, 159
SPIKE  59, 114, 159
THOLDFAIL  59, 114, 159
publishing data  60, 115, 168

Q
QC plots
  Biological Replicates Correlation  149
  Box Plot  149
  Endogenous Control Profile  149
  Technical Replicates Correlation  149
viewing  149
viewing endogenous control profile  57, 112
QC Summary
  reviewing flags  58, 113
  viewing  158

R
raw data plot
  determining signal accuracy  55, 110
tips for analyzing own experiments  56, 111
viewing  55, 110
reaction mix
  components  23, 83
  preparing reactions  25, 84
reactions, assembling materials for  23, 83
Relative Quantification Settings tab  63, 119, 137
relative standard curve experiments
  example experiment  13
overview  11
  PCR options  12
required components, assemble  12
relative target quantity  11
replicate results data and well results data,
viewing  144
replicate results, tips for viewing in own study  147
Replicates, defining  128
replicates, omitting  147
required components
  endogenous control  12, 72
  negative controls  12, 72
  reference sample  12, 71
replicates  12, 72
sample  12, 71
standard  12
  standard dilution series  12
results data, viewing  146
review results  39, 97
run
  monitoring  31, 89
starting  31, 89
run method
  reaction volume per well  19, 79
setting up  19, 79
thermal profile  19, 79
viewing  34, 91
Run screen
  Amplification Plot  32, 90
  Run Method  34, 91
  Temperature Plot  33, 90
  View Run Data  34, 92

S
sample dilutions, preparing reactions  24, 84
samples, defining  16, 76
scatter plots and heat maps, tips for viewing  157
Secondary analysis flags
  AMPNC  59, 115, 159
  HIGHSD  59, 115, 159
  OUTLIERRG  59, 115, 159
SPIKE flag  59, 114, 159
standard curve  20
standard curve plot
  tips for analyzing own experiment  41
  viewing and assessing  39
Standard Curve Settings tab  64
standard curve values
  amplification efficiency  39
  correlation coefficient  39
  C_T values  39
standard dilution series, preparing reactions  24
standards, defining and setting up  17
study
  creating  127
  exporting  165

T
targets and samples, assigning  78
targets, defining  16, 76
targets, samples, and biological groups
  assigning  17, 78
defining  16, 76
Technical Replicates and Biological Replicates, column headings
  # Replicates  145
Index

Biological Group 145
Cₜ 145
Cₜ Mean 145
DCT 145
ΔCₜ Mean 145
ΔΔCₜ SE 145
Experiment 145
Flag 145
Omit (Replicate Results Data) 145
Omit (Well Results Data) 145
RQ 145
RQ Max 146
RQ Min 146
Sample 146
Target 146
Well 146

technical replicates correlation plot, viewing
   Heat Map 152
   Scatter Plot 152
Technical Replicates tab 144
temperature plot, viewing 90
template, preparing reactions 23, 83
THOLDFAIL flag 59, 114, 159
threshold cycle 41
threshold values, correcting 47, 106
tips
   analyzing own study 135
   designing own study 131
tips for your own experiment, preparing reactions 28, 86
touchscreen, running the experiment from
   Experiment View 35, 92
   Time View 35, 93

V
viewing replicate results data 144
viewing well results data 144

W
well table
   assessing own experiments 52, 100
   identifying well problems 51, 99
   viewing 51, 99
wells, omitting from analysis 164
# Contents

## CHAPTER 1  About Genotyping Experiments  

About data collection  ........................................... 5
About TaqMan® SNP Genotyping assays  ........................ 5
About TaqMan® MGB probes  .................................. 6
5′ nuclease assay  ............................................. 6
Minimizing non-specific fluorescence  .......................... 7
Reading and analyzing the plates  ............................... 7
About the example experiment ................................ 8

## CHAPTER 2  Design the Experiment  

Define the experiment properties  ................................ 11
Define SNPs and samples  ....................................... 12
Assign markers, samples, and controls  ......................... 14
Set up the run method  .......................................... 16
For more information  ........................................... 17

## CHAPTER 3  Prepare the Reactions  

Assemble required materials  .................................... 19
Prepare the sample dilutions  .................................... 19
Prepare the reaction mix (“cocktail mix”)  ....................... 20
Prepare the reaction plate  ........................................ 20
  Example experiment reaction plate components ............... 20
  To prepare the reaction plate: dried gDNA ................... 21
  To prepare the reaction plate: wet gDNA ..................... 22
Tips for preparing reactions for your own experiments ....... 22
Tips for preparing samples  ....................................... 22
Tips for preparing the reaction mix  ............................ 22
Tips for preparing the reaction plate  ............................ 22
For more information  ........................................... 22

## CHAPTER 4  Run the Experiment  

Start the run  ..................................................... 23
Monitor the run  .................................................. 23
  From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software  ...................... 24
  From the QuantStudio™ 6 or 7 Instrument touchscreen .... 26

## CHAPTER 5  Review Results and Adjust Experiment Parameters  

Section 5.1 Review Results  ...................................... 31
Analyze the example experiment  .............................. 31
View clusters in the Allelic Discrimination Plot ........................................ 31
To view and assess the allelic discrimination plot ................................... 31
Troubleshoot clustering on the Allelic Discrimination Plot .................... 33
Confirm setup accuracy using Plate Layout .............................................. 34
Example experiment plate layout values ................................................. 34
View the layout ....................................................................................... 34
Tips for troubleshooting plate setup in your own experiment ....................... 36
Assess amplification results using the Amplification Plot ......................... 36
About amplification plots ......................................................................... 37
View the $\Delta Rn$ vs. Cycle plot ............................................................... 37
Identify well problems using the Well Table .......................................... 39
Example experiment values and flags ...................................................... 39
View the well table ................................................................................. 39
Identify quality control (QC) problems .................................................. 41
Tips for analyzing your own experiments ................................................. 42
Confirm accurate dye signal using the Multicomponent Plot ...................... 42
Purpose ................................................................................................. 43
View the Multicomponent Plot .............................................................. 43
Tips for confirming dye accuracy in your own experiment ......................... 44
Determine signal accuracy using the Raw Data Plot ............................... 44
Purpose ................................................................................................. 44
View the Raw Data Plot ......................................................................... 45
Tips for determining signal accuracy in your own experiment ..................... 46
Review the flags in the QC Summary ..................................................... 46
View the QC Summary .......................................................................... 46
Possible flags ......................................................................................... 47
For more information .............................................................................. 47

Section 5.2 Adjust parameters for re-analysis of your own experiments ....... 49
Adjust analysis settings .......................................................................... 49
View the analysis settings ....................................................................... 49
Adjust analysis settings .......................................................................... 50
For more information .............................................................................. 53

■ CHAPTER 6 Export Analysis Results ................................................. 55

Index ....................................................................................................... 57
About Genotyping Experiments

This chapter covers:

- About data collection ................................................................. 5
- 5′ nuclease assay ................................................................. 6
- Minimizing non-specific fluorescence ...................................... 7
- Reading and analyzing the plates ......................................... 7
- About the example experiment ........................................... 8

IMPORTANT! First-time users of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software please read Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments and Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes of this binder thoroughly. The booklet provides information and general instructions that are applicable to all the experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ 6 and 7 Flex Real-Time PCR System Software by pressing F1, clicking Help in the toolbar, or selecting Help > QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Help.

About data collection

Genotyping experiments are performed to detect single nucleotide polymorphism (SNP) variants of a target nucleic acid sequence in samples. The PCR reactions contain primers designed to amplify the sequence containing the SNP and reagents to detect two different alleles.

You can collect the results of a genotyping experiment in two different ways: At the end of the experiment, or continuously during the experiment. Data collection at the end of the experiment is called end-point data collection. Data collection during the experiment run is considered real-time PCR. The real-time data helps further data analysis.

In end-point data collection, the normalized intensity of the reporter dye, or Rn, is the data collected. Some end-point experiments also include pre-PCR (data collected before the amplification process) data collection. The software calculates the delta Rn (ΔRn) value per the following formula:

\[ \Delta Rn = Rn \text{ (post-PCR read)} - Rn \text{ (pre-PCR read)} \]

where Rn = normalized readings.
About TaqMan®
SNP Genotyping assays
A Genotyping assay detects variants of a single nucleic acid sequence, without quantifying the target. The presence of two probes in each reaction allows Genotyping of the two possible variants at the single nucleotide polymorphism (SNP) site in a target sequence.

Each TaqMan® SNP Genotyping Assay consists of a single, ready-to-use tube containing:
- Two sequence-specific primers for amplifying the polymorphism of interest
- Two allele-specific TaqMan® MGB probes for detecting the alleles for the specific polymorphism of interest

About TaqMan®
MGB probes
Each allele-specific TaqMan® MGB probe has:
- A reporter dye at its 5’ end:
  - VIC® dye is linked to the 5’ end of the Allele 1 probe.
  - FAM™ dye is linked to the 5’ end of the Allele 2 probe.
- The Allele 1 VIC® dye-labeled probe corresponds to the first nucleotide inside the square brackets of the context sequence in the assay information file (AIF) shipped with each order. The Allele 2 FAM™ dye-labeled probe corresponds to the second nucleotide inside the square brackets of the context sequence in the AIF. For the context sequence ATCGATT[G/T]ATCC, the VIC® dye-labeled probe binds to the G allele, and the FAM™ dye-labeled probe to the T allele.
- A minor groove binder (MGB), which increases the melting temperature (T_m) for a given probe length and allows the design of shorter probes. The use of shorter probes results in greater differences in T_m values between matched and mismatched probes, and more robust genotyping.
- A non-fluorescent quencher (NFQ) at its 3’ end, which allows for detection of the reporter dye fluorescence with greater sensitivity than with a fluorescent quencher.

5’ nuclease assay
The figure below is a schematic depiction of the 5’ nuclease assay. During PCR:
- Each TaqMan® MGB probe anneals specifically to its complementary sequence between the forward and reverse primer sites.
- When the oligonucleotide probe is intact, the proximity of the quencher dye to the reporter dye quenches the reporter signal.
- AmpliTaq Gold® DNA polymerase extends the primers bound to the genomic DNA template.
Minimizing non-specific fluorescence

In TaqMan® assays, fluorescence from nonspecifically bound probes is reduced, because nucleotide mismatches between a probe and a sequence reduce the chances that the probe will be cleaved. The probe’s short length means that a one-base-pair mismatch will have a larger negative effect on the binding. The mismatched probe will not bind tightly to the allele; the AmpliTaq Gold® DNA polymerase will likely displace the probe without cleaving the dye.

Reading and analyzing the plates

The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software genotypes the DNA samples from the reaction plate simultaneously. First, the software normalizes the fluorescence of the reporter dyes to the fluorescence of the passive reference dye in each well. Next, the software plots the normalized intensities (Rn) of the reporter dyes.
in each sample well on an Allelic Discrimination Plot, which contrasts the reporter dye intensities of the allele-specific probes. Finally, the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software algorithmically clusters the sample data, and assigns a genotype call to the samples of each cluster according to its position on the plot.

**Note:** The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software clustering algorithm does not call genotypes when only one genotype is present in an experiment.

The clustering of datapoints can vary along the horizontal axis (Allele 1), vertical axis (Allele 2), or diagonal (Allele 1/Allele 2). This variation results from differences in the extent of reporter dye fluorescent intensity after PCR amplification. The table below shows the correlation between fluorescence signals and sequences in a sample.

<table>
<thead>
<tr>
<th><strong>A substantial increase in...</strong></th>
<th><strong>Indicates...</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>VIC® dye-labeled probe fluorescence only</td>
<td>Homozygosity for Allele 1</td>
</tr>
<tr>
<td>FAM™ dye-labeled probe fluorescence only</td>
<td>Homozygosity for Allele 2</td>
</tr>
<tr>
<td>Both VIC® and FAM™ dye-labeled probes fluorescence</td>
<td>Allele 1-Allele 2 heterozygosity</td>
</tr>
</tbody>
</table>

**About the example experiment**

To illustrate how to perform Genotyping experiments, this guide leads you through the process of designing and performing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with a QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

The objective of the example Genotyping experiment is to investigate SNP rs8039, where possible genotypes are AA, AC, and CC. In the example, two unknown genomic DNA (gDNA) samples were genotyped using TaqMan® Drug Metabolism Genotyping Assay ID C__11711420_30. The reactions were set up so that the PCR...
primers and probes that target both alleles of SNP rs8039 were present in the same well. The PCR was performed using the TaqMan® Genotyping Master Mix and run according to the protocol that is described in the *Performing a TaqMan® Drug Metabolism Genotyping Assay.*
Chapter 1  About Genotyping Experiments

About the example experiment
Design the Experiment

This chapter explains how to design the example experiment from the Experiment Setup menu.

This chapter covers:

- Define the experiment properties ........................................... 11
- Define SNPs and samples .................................................... 12
- Assign markers, samples, and controls ................................. 14
- Set up the run method ......................................................... 16
- For more information ......................................................... 17

Note: To automatically export the analyzed data to a specified location, select the Auto Export task from the Export screen, before running the experiment. For more information on Auto Export, refer to Chapter 2 in Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments*.

Define the experiment properties

Click **Experiment Setup ➤ Experiment Properties** to create a new experiment in the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software. Enter:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Name</td>
<td>QuantStudio_384-Well_SNAP_Genotyping_Example</td>
</tr>
<tr>
<td>Barcode</td>
<td>Leave field empty</td>
</tr>
<tr>
<td>User Name</td>
<td>Example User</td>
</tr>
<tr>
<td>Comments</td>
<td>Genotyping example</td>
</tr>
<tr>
<td>Instrument type</td>
<td>QuantStudio™ 6 Flex System</td>
</tr>
<tr>
<td>Block</td>
<td>384-Well Block</td>
</tr>
<tr>
<td>Experiment Type</td>
<td>Genotyping</td>
</tr>
<tr>
<td>Reagents</td>
<td>TaqMan® Reagents</td>
</tr>
<tr>
<td>Ramp speed</td>
<td>Standard</td>
</tr>
<tr>
<td>Reagent information</td>
<td>NA</td>
</tr>
</tbody>
</table>

Select all three data-collection check boxes: Pre-PCR, Amplification, and Post-PCR collection methods:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-PCR Read</td>
<td>Checked</td>
</tr>
<tr>
<td>Amplification</td>
<td>Checked</td>
</tr>
</tbody>
</table>
Define SNPs and samples

Click **Define** to access the Define screen. Enter:

1. **SNP Assays**

<table>
<thead>
<tr>
<th>SNP assay name</th>
<th>NCBI SNP reference</th>
<th>Context sequence</th>
<th>Allele 1</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Allele 2</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNP Assay 1</td>
<td></td>
<td></td>
<td>Allele1</td>
<td>VIC</td>
<td>NFQ-MGB</td>
<td>Allele2</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>SNP Assay 2</td>
<td></td>
<td></td>
<td>Allele1</td>
<td>VIC</td>
<td>NFQ-MGB</td>
<td>Allele2</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The NCBI SNP reference and Context sequence fields are optional fields and are used for reference. They are not required to run an experiment.

2. **Samples**

<table>
<thead>
<tr>
<th>Sample name</th>
<th>Color</th>
<th>Sample name</th>
<th>Color</th>
<th>Sample name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample 1</td>
<td></td>
<td>Sample 11</td>
<td></td>
<td>Sample 21</td>
<td></td>
</tr>
</tbody>
</table>
3. Dye to be used as a Passive Reference
ROX

4. Custom Task Name
Not applicable

Your Define screen should look like this:

Note: This example experiment does not define biological replicate groups. Leave Biological Replicate Groups blank.
Assign markers, samples, and controls

Click Assign to access the Assign screen. Enter the SNP assays and samples:

- SNP Assay 1

<table>
<thead>
<tr>
<th>Target name</th>
<th>Well number</th>
<th>Task</th>
<th>Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNP Assay 1</td>
<td>A3, A7, A11</td>
<td>Unknown</td>
<td>Sample 3</td>
</tr>
<tr>
<td></td>
<td>C1, C5, C9</td>
<td>Unknown</td>
<td>Sample 4</td>
</tr>
<tr>
<td></td>
<td>C3, C7, C11</td>
<td>Unknown</td>
<td>Sample 5</td>
</tr>
<tr>
<td></td>
<td>E1, E5, E9</td>
<td>Unknown</td>
<td>Sample 6</td>
</tr>
<tr>
<td></td>
<td>E3, E7, E11</td>
<td>Unknown</td>
<td>Sample 7</td>
</tr>
<tr>
<td></td>
<td>G1, G5, G9</td>
<td>Unknown</td>
<td>Sample 8</td>
</tr>
<tr>
<td></td>
<td>G3, G7, G11</td>
<td>Unknown</td>
<td>Sample 9</td>
</tr>
<tr>
<td></td>
<td>I1, I5, I9</td>
<td>Unknown</td>
<td>Sample 10</td>
</tr>
<tr>
<td></td>
<td>I3, I7, I11</td>
<td>Unknown</td>
<td>Sample 11</td>
</tr>
<tr>
<td></td>
<td>K1, K5, K9</td>
<td>Unknown</td>
<td>Sample 12</td>
</tr>
<tr>
<td></td>
<td>K3, K7, K11</td>
<td>Unknown</td>
<td>Sample 13</td>
</tr>
<tr>
<td></td>
<td>M1, M5, M9</td>
<td>1/1</td>
<td>Sample 14</td>
</tr>
<tr>
<td></td>
<td>M3, M7, M11</td>
<td>Unknown</td>
<td>Sample 15</td>
</tr>
<tr>
<td></td>
<td>O1, O5, O9</td>
<td>1/2</td>
<td>Sample 16</td>
</tr>
<tr>
<td></td>
<td>O3, O7, O11</td>
<td>2/2</td>
<td>Sample 17</td>
</tr>
<tr>
<td>SNP Assay 1</td>
<td>A1, A5, A9</td>
<td>Negative</td>
<td>NTC</td>
</tr>
</tbody>
</table>
- **SNP Assay 2**

<table>
<thead>
<tr>
<th>Target name</th>
<th>Well number</th>
<th>Task</th>
<th>Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNP Assay 2</td>
<td>A15, A19, A23</td>
<td>Unknown</td>
<td>Sample 1</td>
</tr>
<tr>
<td></td>
<td>C13, C17, C21</td>
<td>Unknown</td>
<td>Sample 2</td>
</tr>
<tr>
<td></td>
<td>C15, C19, C23</td>
<td>Unknown</td>
<td>Sample 18</td>
</tr>
<tr>
<td></td>
<td>E13, E17, E21</td>
<td>Unknown</td>
<td>Sample 19</td>
</tr>
<tr>
<td></td>
<td>E15, E19, E23</td>
<td>Unknown</td>
<td>Sample 20</td>
</tr>
<tr>
<td></td>
<td>G13, G17, G21</td>
<td>Unknown</td>
<td>Sample 21</td>
</tr>
<tr>
<td></td>
<td>G15, G19, G23</td>
<td>Unknown</td>
<td>Sample 22</td>
</tr>
<tr>
<td></td>
<td>I13, I17, I21</td>
<td>Unknown</td>
<td>Sample 23</td>
</tr>
<tr>
<td></td>
<td>I15, I19, I23</td>
<td>Unknown</td>
<td>Sample 24</td>
</tr>
<tr>
<td></td>
<td>K13, K17, K21</td>
<td>2/2</td>
<td>Sample 25</td>
</tr>
<tr>
<td></td>
<td>K15, K19, K23</td>
<td>Unknown</td>
<td>Sample 26</td>
</tr>
<tr>
<td></td>
<td>M13, M17, M21</td>
<td>1/2</td>
<td>Sample 27</td>
</tr>
<tr>
<td></td>
<td>M15, M19, M23</td>
<td>Unknown</td>
<td>Sample 28</td>
</tr>
<tr>
<td></td>
<td>O13, O17, O21</td>
<td>1/1</td>
<td>Sample 29</td>
</tr>
<tr>
<td></td>
<td>O15, O19, O23</td>
<td>Unknown</td>
<td>Sample 30</td>
</tr>
<tr>
<td>SNP Assay 2</td>
<td>A13, A17, A21</td>
<td>Negative</td>
<td>NTC</td>
</tr>
</tbody>
</table>
Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- Reaction Volume Per Well: 10 µL
- Thermal Profile

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Read Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>60 °C</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Hold Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>10 minutes</td>
</tr>
<tr>
<td>PCR Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>15 seconds</td>
</tr>
<tr>
<td></td>
<td>Step 2</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>1 minute</td>
</tr>
<tr>
<td>Post-Read Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>30 seconds</td>
</tr>
</tbody>
</table>
Your Run Method screen should look like this:

![Run Method Screen](image)

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumables</td>
<td>Chapter 1 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em> Appendix A in Booklet 7, <em>QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes</em></td>
<td>4489822</td>
</tr>
<tr>
<td>Data collection</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
<tr>
<td>Amplification efficiency</td>
<td><em>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</em></td>
<td>127AP05-03</td>
</tr>
<tr>
<td>Using Alternative Setup</td>
<td>Chapter 3 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Chapter 2 Design the Experiment

For more information
Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Genotyping example experiment.

This chapter covers:
- Assemble required materials .............................................. 19
- Prepare the sample dilutions .............................................. 19
- Prepare the reaction mix (“cocktail mix”). .......................... 20
- Prepare the reaction plate .............................................. 20
  Example experiment reaction plate components ............... 20
  To prepare the reaction plate: dried gDNA ....................... 21
  To prepare the reaction plate: wet gDNA ......................... 22
- Tips for preparing reactions for your own experiments ........ 22
  Tips for preparing samples ........................................ 22
  Tips for preparing the reaction mix ................................ 22
  Tips for preparing the reaction plate ............................. 22
- For more information .................................................. 22

Assemble required materials

- Items listed in Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments*
- Samples - Sample 1 - Sample 30
- Example experiment reaction mix components:
  - TaqMan® Genotyping Master Mix (2X)
  - SNP 1 Assay Mix (20X)
  - SNP 2 Assay Mix (20X)

*Note:* Fast Universal Master Mix is not recommended to be used with the 96-well (0.2 mL) reaction plates or reaction tubes and tube strips sealed with caps.

Prepare the sample dilutions

For the example experiment, two targets are assigned to 36 wells each. Each well contains 20 ng of Coriell DNA diluted from 100 ng/µL of stock.

To prepare the sample dilutions:
1. Label a separate microcentrifuge tube for each sample to be diluted.
2. Add 5µL of sample stock to each empty tube.
3. Add 45µL of sterile water (diluent) to each tube, such that each working stock tube has a final concentration of 10 ng/µL.
4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.
5. Place the diluted samples on ice until you prepare the reaction plate.

**Prepare the reaction mix (“cocktail mix”)**

1. Label an appropriately sized tube for each reaction mix:
   - SNP 1 Reaction Mix
   - SNP 2 Reaction Mix

2. For SNP Assay 1, prepare a cocktail by adding the required volumes of each component to the SNP 1 reaction tube, as detailed below.

<table>
<thead>
<tr>
<th>Reaction component</th>
<th>Reaction volume</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Per well (µL)</td>
</tr>
<tr>
<td></td>
<td>Dry</td>
</tr>
<tr>
<td>TaqMan® Genotyping Master Mix (2X)</td>
<td>10.0</td>
</tr>
<tr>
<td>SNP Assay Mix (20X)</td>
<td>1.0</td>
</tr>
<tr>
<td>H₂O, DNase-free</td>
<td>9.0</td>
</tr>
<tr>
<td>Total Reaction Mix Volume</td>
<td>20.00</td>
</tr>
</tbody>
</table>

3. Gently pipet the reaction mix up and down, then cap the tube.
4. Centrifuge the tube briefly.
5. Place the reaction mixes on ice until you prepare the reaction plate.
6. Repeat step 2 through 5 for the SNP 2 assay.
   **Note:** Do not add the sample at this time.

**Prepare the reaction plate**

**Example reaction plate components**

- The reaction plate for the Genotyping example experiment contains:
  - A MicroAmp® Optical 384-Well Reaction Plate
  - Reaction volume: 10 µL/well
  - 72 Unknown wells
Chapter 3  Prepare the Reactions

Prepare the reaction plate

The following is an image of the plate layout:

To prepare the reaction plate: dried gDNA

1. Pipet 2.0 µL of the appropriate sample (20 ng of purified genomic DNA) into each well of the reaction plate.
   All wells belonging to the same Genotyping assay must contain approximately the same quantity of sample or control.
   Note: While preparing the reaction plate for your own Genotyping experiment, add between 1 and 20 ng of purified DNA per reaction.

2. Dry down the samples by evaporation at room temperature in a dark, amplicon-free location. (Cover the reaction plate with a lint-free tissue while drying.)

3. Transfer 20 µL of reaction mix to each well.

   IMPORTANT! Make sure that no cross-contamination occurs from well to well.

4. Seal the reaction plate with adhesive film.

5. Vortex the reaction plate for 3 to 5 sec.

6. Briefly centrifuge the reaction plate.

7. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the plate again at a higher speed and for a longer period of time.
To prepare the reaction plate: wet gDNA

1. Add 2 µL of DNA to the appropriate wells.
2. Add 2 µL of water to wells containing the NTCs.
3. Transfer 18 µL of reaction mix to the appropriate wells.
4. Seal the reaction plate with optical adhesive film.
5. Vortex the reaction plate for 3 to 5 seconds, then briefly centrifuge it.
6. Centrifuge the reaction plate briefly.
7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

Tips for preparing reactions for your own experiments

Tips for preparing samples

When you prepare the samples for your own experiment:

- Use DNAse-free water to dilute the samples.
- Use the same quantity of DNA per well for each experiment.

Tips for preparing the reaction mix

When you prepare the reaction mix for your own experiment, make sure you prepare the reactions for each SNP separately.

Prior to use:

- Mix the master mix thoroughly by swirling the bottle.
- Resuspend the assay mix by vortexing, then centrifuge the tube briefly.
- Thaw frozen samples by placing them on ice. When thawed, resuspend the samples by vortexing, then centrifuge the tubes briefly.

Tips for preparing the reaction plate

When you prepare the reaction plate for your own experiment:

- Make sure the reaction locations match the plate layout in the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.
- Load 1 to 20 ng of purified genomic DNA per reaction
- All wells belonging to the same Genotyping assay must contain approximately the same quantity of sample or control.
- Multiple assays may be run on one reaction plate, but must be analyzed separately.

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning the reaction plate</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
<tr>
<td>components</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sealing the reaction plate</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
This chapter explains how to run the example experiment on the QuantStudio™ 6 or 7 Instrument.

This chapter covers:

- Start the run ................................................................. 23
- Monitor the run .............................................................. 23

**IMPORTANT!** Run the experiment at the same ambient temperature at which you calibrated the instrument. Extreme variations in ambient temperature can affect the heating and cooling of the instrument and influence experimental results.

**IMPORTANT!** Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 6 or 7 Instrument is in operation.

**Start the run**

1. Open the Genotyping example file that you created using instructions in Chapter 2.
2. Load the reaction plate into the instrument.
3. Start the run.
   
   **Note:** To collect real-time data during a run, click the 📊 button on the Run Method screen in the Experiment Setup menu.

**Monitor the run**

Monitor the example experiment run:

- From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software using the Run screen, while the experiment is in progress.
- From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software (to monitor an experiment started from another computer or from the QuantStudio™ 6 or 7 Instrument touchscreen).
- From the QuantStudio™ 6 or 7 Instrument touchscreen.
Chapter 4  Run the Experiment
Monitor the run

From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software

1. In the Instrument Console screen, select the instrument icon.
2. Click Manage Instrument or double-click on the instrument icon.
3. On the Manage Instrument screen, click Monitor Running Instrument to access the Run screen.

View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all the three plots available from the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software for potential problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab, then select the wells to view.

The following is an image of the Amplification Plot screen as it appears at the end of the example experiment.
View the Temperature Plot

Click **Temperature Plot** from the Run Experiment Menu.

The following is an image of the Temperature Plot screen as it appears during the example experiment.

![Temperature Plot](image-url)

**Note:** The sample temperature displayed in the Current Temperatures group is a calculated value.

View the Run Method

Click **Run Method** from the Run Experiment Menu.

The following is an image of the Run Method screen as it appears in the example experiment.

![Run Method](image-url)
View run data

Click View Run Data from the Run Experiment Menu.

The following is an image of the View Run Data screen as it appears in the example experiment.

From the QuantStudio™ 6 or 7 Instrument touchscreen

You can also view the progress of the run from the QuantStudio™ 6 or 7 Instrument touchscreen.

The following are images of the Run Method screen on the QuantStudio™ 6 or 7 Instrument touchscreen:

Experiment View
Time View

Run Started: July 05 2013 - 05:48PM
Sample: 95.0 °C
Heated Cover (Set Point): 105.0 °C (105.0 °C)
Stage / Step / Cycle: 1 / 2 / 1

01:31:52

Remaining Time
Elapsed Time

Heated cover reached target temperature.
In Section 5.1 of this chapter you review the analyzed data using several of the analysis screens and publish the data. Section 5.2 of this chapter walks you through the process of modifying experiment parameters to troubleshoot problems with experiment results before rerunning an experiment.

This chapter covers:

**Section 5.1 Review Results** ....................................................... 31

- Analyze the example experiment ............................................. 31
- View clusters in the Allelic Discrimination Plot ......................... 31
- Confirm setup accuracy using Plate Layout ............................... 34
- Assess amplification results using the Amplification Plot .............. 36
- Identify well problems using the Well Table .............................. 39
- Confirm accurate dye signal using the Multicomponent Plot ........ 42
- Determine signal accuracy using the Raw Data Plot .................. 44
- Review the flags in the QC Summary ........................................ 46
- For more information ............................................................. 47

**Section 5.2 Adjust parameters for re-analysis of your own experiments** ........ 49

- Adjust analysis settings ......................................................... 49
- For more information ............................................................. 53
Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.
2. Click Analyze. The software analyzes the data using the default analysis settings.
   Note: You can also access the experiment to analyze from the Home screen.

View clusters in the Allelic Discrimination Plot

The Allelic Discrimination Plot contrasts the normalized reporter dye fluorescence (Rn) for the allele-specific probes of the SNP assay.

View the allelic discrimination plot to identify:
- Clusters for the three possible genotypes (Allele 1 homozygous, Allele 2 homozygous, and Allele 1/2 heterozygous).
- A cluster for the negative controls.

Note: Including controls helps to improve the clustering algorithm, particularly in situations where a limited number of samples are run.

To view and assess the allelic discrimination plot

1. From the Experiment menu pane, select Analysis ▶ Allelic Discrimination Plot.
2. Click the Plate Layout tab, then click any empty well to select it.
   Note: In the Allelic Discrimination Plot, the software highlights all wells that are selected in the Plate Layout tab. If the plot displays a single color for all wells, then all wells in the plate layout are selected.
3. In the allelic discrimination plot, select SNP Assay 1 from the SNP Assay menu, then enable Autocaller.

The Allelic Discrimination Plot displays allele symbols for each sample evaluated for the selected SNP. The samples are grouped on the plot as follows:

<table>
<thead>
<tr>
<th>Genotype</th>
<th>Symbol</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Homozygous for Allele 1 of the selected SNP assay.</td>
<td>● (red)</td>
<td>X-axis of the plot</td>
</tr>
<tr>
<td>Homozygous for Allele 2 of the selected SNP assay.</td>
<td>● (blue)</td>
<td>Y-axis of the plot</td>
</tr>
<tr>
<td>Heterozygous for both alleles of the selected SNP assay (Allele 1 and Allele 2).</td>
<td>● (green)</td>
<td>Midway between the homozygote clusters</td>
</tr>
<tr>
<td>A negative control.</td>
<td>■ (black)</td>
<td>Bottom-left corner of the plot</td>
</tr>
<tr>
<td>Undetermined.</td>
<td>● (black)</td>
<td>Anywhere on plot</td>
</tr>
</tbody>
</table>
Chapter 5 Review Results and Adjust Experiment Parameters

View clusters in the Allelic Discrimination Plot

Note: If the Autocaller is not enabled, the Allelic Discrimination Plot displays a crossmark (X – Undetermined) for each sample.

4. Review each cluster in the plot:
   a. Click and drag a box around the cluster to select the associated wells in the plate layout and well table.
   b. Confirm that the expected wells are selected in the well table.
      For example, if you select the cluster at the bottom-left corner of the plot, only the negative controls should be selected. The presence of an unknown among the negative controls may indicate that the sample failed to amplify.
   c. Repeat steps a and b for all other clusters in the plot.
   d. The table below describes the elements of the Allelic Discrimination Plot.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNP Assay dropdown menu</td>
<td>Determines the SNP assay data that the QuantStudio™ 6 and 7 Flex Software displays in the plot.</td>
</tr>
<tr>
<td>Plot Type dropdown menu</td>
<td>Determines the type of plot (Cartesian or Polar) that the QuantStudio™ 6 and 7 Flex Software uses to display the data.</td>
</tr>
<tr>
<td>Apply Call dropdown menu</td>
<td>When a datapoint is selected, this menu allows you to assign an allele call to the datapoint within the scatterplot.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Contains tools for manipulating the scatterplot:</td>
</tr>
<tr>
<td></td>
<td>• ![Selection tool] – Selection tool.</td>
</tr>
<tr>
<td></td>
<td>• ![Repositioning tool] – Repositioning tool.</td>
</tr>
<tr>
<td></td>
<td>• ![Zoom in] – Zooms in.</td>
</tr>
<tr>
<td></td>
<td>• ![Zoom out] – Zooms out.</td>
</tr>
<tr>
<td>Legend</td>
<td>Explains the symbols in the scatterplot.</td>
</tr>
<tr>
<td>Options</td>
<td>The Reveal Traces option allows you to trace the clusters throughout the PCR process.</td>
</tr>
<tr>
<td></td>
<td>This option is not activated for the example experiment.</td>
</tr>
<tr>
<td></td>
<td>To activate the feature, see “Adjust analysis settings” on page 50.</td>
</tr>
</tbody>
</table>
The following is an image of the Allelic Discrimination plot for the example experiment:

**Troubleshoot clustering on the Allelic Discrimination Plot**

**Do all controls have the correct genotype?**

In the example experiment and in your own experiments, confirm that data points cluster as expected.

**Clustering in positive controls**

1. From the well table, select the wells containing a positive control to highlight the corresponding data points (symbols) in the Allelic Discrimination Plot.

2. Check that the data points for the positive controls cluster along the expected axis of the plot. For example, if you select the Positive Control Allele 1/Allele 1, then the controls should cluster along the X-axis.

3. Repeat steps 1 and 2 for the wells containing the other positive controls.

**Failed amplification in the unknown samples**

1. Select the data points of the cluster in the lower left corner of the Allelic Discrimination Plot to select the corresponding wells in the well table.

2. Check that the selected wells in the well table are negative controls, and not unknown samples.

**Samples clustered with negative control**
Samples that clustered with the negative controls may:
- Contain no DNA
- Contain PCR inhibitors
- Be homozygous for a sequence deletion

Confirm the results of these samples by retesting them.

Are outliers present?

If the Allelic Discrimination Plot contains clusters other than the three representative genotype clusters (heterozygous, homozygous allele 1, and homozygous allele 2), then those can be classified as outliers.

Confirm the results of the associated samples by retesting them.

Note: The results displays are synchronized. For example, selecting a well in the plate layout selects the corresponding data in the well table and Allelic Discrimination Plot.

Confirm setup accuracy using Plate Layout

Review the experiment results in the Plate Layout. The plate layout displays the assay-specific setup and analysis properties for the experiment in a well format corresponding to the type of reaction plate used for the run.

Example experiment plate layout values

For the example experiment, confirm that the QuantStudio™ 6 and 7 Flex Software called:
- 54 samples as Allele 1 homozygous (●)
- 12 samples as Allele 2 homozygous (●)
- 24 samples as heterozygous (●)
- 0 samples as undetermined (X)

Confirm that no wells of the reaction plate triggered QC flags (▲). The example experiment does not display any flags.

View the layout

1. Click the icon beside the Allelic Discrimination Plot to maximize the plate layout.

2. Click Show in Wells, then select or deselect a parameter that you want the wells to display. Repeat this step until the plate layout contains all of the desired parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Name</td>
<td>The name of the sample applied to the well.</td>
</tr>
</tbody>
</table>
## Section 5.1 Review Results

### Confirm setup accuracy using Plate Layout

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Task</strong></td>
<td>The task assigned to the well:</td>
</tr>
<tr>
<td>U</td>
<td>Unknown</td>
</tr>
<tr>
<td>N</td>
<td>Negative Control</td>
</tr>
<tr>
<td>1</td>
<td>Positive Control - Allele 1</td>
</tr>
<tr>
<td>2</td>
<td>Positive Control - Allele 2</td>
</tr>
<tr>
<td>7</td>
<td>Positive Control - Allele 1/2</td>
</tr>
<tr>
<td><strong>SNP Assay Name</strong></td>
<td>The name of the SNP evaluated by the well.</td>
</tr>
<tr>
<td><strong>Assay ID</strong></td>
<td>The Assay ID number of the SNP evaluated by the well.</td>
</tr>
<tr>
<td><strong>Allele 1 / Allele 2</strong></td>
<td>The name of the associated allele for the SNP evaluated by the well</td>
</tr>
<tr>
<td><strong>Allele 1 Dyes / Allele 2 Dyes</strong></td>
<td>The name of the reporter and quencher dyes of the associated allele for the SNP evaluated by the well</td>
</tr>
<tr>
<td><strong>SNP Assay Color</strong></td>
<td>The color of the SNP evaluated by the well.</td>
</tr>
<tr>
<td><strong>Sample Color / Task Color</strong></td>
<td>The color of the sample or task applied to the well.</td>
</tr>
<tr>
<td><strong>Genotype Call</strong></td>
<td>The allele call assigned to the sample:</td>
</tr>
<tr>
<td>•●</td>
<td>Homozygous 1/1</td>
</tr>
<tr>
<td>•●</td>
<td>Homozygous 2/2</td>
</tr>
<tr>
<td>•</td>
<td>Heterozygous 1/2</td>
</tr>
<tr>
<td>•■</td>
<td>Negative Control</td>
</tr>
<tr>
<td>•X</td>
<td>Undetermined</td>
</tr>
<tr>
<td><strong>Flag</strong></td>
<td>The number of QC flags the well triggered as listed in the ▲ symbol.</td>
</tr>
</tbody>
</table>
The following is an image of the plate layout of the example Genotyping experiment.

**Tips for troubleshooting plate setup in your own experiment**

You can adjust your view of the plate layout:
- Note the location of any samples that trigger QC flags (▲). Understanding the position of errors can aid in diagnosing any failures that may occur.
- You can select the entire reaction plate, areas of the reaction plate, or specific wells:
  - Click the upper left corner of the reaction plate to select all 384 wells.
  - Left-click the mouse and drag across the area to select it.
  - Select Sample, SNP Assay, or Task from the Select Wells menu in the Plate Layout tab to select wells of a specific type using the well-selection criteria.
- Use the ▼ (Zoom In), ▲ (Zoom Out), and □ (Fit Plate) buttons to magnify or compress the view of the wells shown.
- Use the ▶ arrow tabs to expand the plate layout to cover the entire screen.

**Assess amplification results using the Amplification Plot**

**IMPORTANT!** Amplification plots are not used to make SNP calls. Examine the plots to help with troubleshooting and quality control.

If you collected real-time data for your experiment, review the amplification data to further understand the flags triggered by the experiment data.
Section 5.1 Review Results

Assess amplification results using the Amplification Plot

About amplification plots

The Amplification Plot screen displays amplification of all samples in the selected wells. Use the amplification plots to confirm the results of the experiment:

- **ΔRn vs. Cycle** – ΔRn is the difference in normalized fluorescence signal generated by the reporter between the pre-PCR read and the post-PCR read. This plot displays ΔRn as a function of cycle number. You can use this plot to identify and examine irregular amplification and to view threshold and baseline values for the run.
  
  Note: Viewing the ΔRn vs. Cycle plot is discussed in this booklet as an example of how to view the plot.

- **Rn vs. Cycle** – Rn is the fluorescence signal from the reporter dye normalized to the fluorescence signal from the passive reference. This plot displays Rn as a function of cycle number. You can use this plot to identify and examine irregular amplification.

- **C\text{\textsubscript{T}} vs. Well** – C\text{\textsubscript{T}} is the PCR cycle number at which the fluorescence meets the threshold in the amplification plot. This plot displays C\text{\textsubscript{T}} as a function of well position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

View the ΔRn vs. Cycle plot

1. From the Experiment Menu pane, select Analysis ➤ Amplification Plot.
   
   Note: If no data are displayed, click Analyze.

2. Select the plot type and format:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>ΔRn vs. Cycle</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Target</td>
</tr>
<tr>
<td></td>
<td>Check (default)</td>
</tr>
</tbody>
</table>

   (This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.)

![Amplification Plot](image-url)
3. View the baseline values:
   a. From the Graph Type drop-down menu, select Linear.
   b. Select Baseline to show the start cycle and end cycle.

4. View the threshold values:
   a. From the Graph Type drop-down menu, select Log.
   b. From the Target drop-down menu, select SNP Assay 1-Allele 2.
c. Select the Threshold check box to show the threshold.

Identify well problems using the Well Table

Review the details of the experiment results in the Well Table and identify any flagged wells. The Well Table displays the assay-specific setup and analysis properties for the experiment in a tabular format.

Example experiment values and flags

For the example experiment, look for wells that triggered QC flags (▲). The example experiment has no flags.

View the well table

1. Select the Well Table tab.
2. Click the Flag column header to sort the data so that the wells that triggered flags appear at the top of the table.
3. Confirm the integrity of the controls:
   a. From the Group By menu, select Task to organize the table rows by their function on the reaction plate.
   b. Confirm that each of the controls do not display flags (▲).
   c. Click the icon to collapse the negative and positive controls.
The following is an image of the well table of the example Genotyping experiment.

The following table gives the names and description of the columns in the well table:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>The position of the well on the reaction plate.</td>
</tr>
<tr>
<td>Omit</td>
<td>A check mark indicates that the well has been removed from the analysis.</td>
</tr>
<tr>
<td>Flag</td>
<td>A △ indicates that the well triggered the number of flags listed inside the symbol.</td>
</tr>
<tr>
<td>Sample Name</td>
<td>The name of the sample.</td>
</tr>
<tr>
<td>SNP Assay Name</td>
<td>The name of the SNP assay evaluated by the well.</td>
</tr>
<tr>
<td>Assay ID</td>
<td>The Assay ID number of the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Task</td>
<td>The task assigned to the well (Unknown, Negative Control, or Positive Control).</td>
</tr>
<tr>
<td>Allele 1 / 2</td>
<td>The name of the associated allele for the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Allele 1 / 2 Dyes</td>
<td>The name of the reporter and quencher dyes of the associated allele for the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Allele 1 / 2 Rn</td>
<td>Normalized signal ( R_{n} ) of the reporter dye of the associated allele for the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Pass Ref</td>
<td>The signal of the passive reference dye for the well.</td>
</tr>
</tbody>
</table>
Identify quality control (QC) problems

The Well Table displays columns for QC flags that are triggered by the experimental data. If the experiment data does not trigger a QC flag, then the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software does not display a corresponding column for the flag.

A (▲) in one of the following columns indicates that the associated well triggered the flag.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call</td>
<td>The allele call assigned to the sample, where possible calls are:</td>
</tr>
<tr>
<td></td>
<td>• Homozygous 1/1 - Homozygous for allele 1</td>
</tr>
<tr>
<td></td>
<td>• Homozygous 2/2 - Homozygous for allele 2</td>
</tr>
<tr>
<td></td>
<td>• Heterozygous 1/2 - Heterozygous</td>
</tr>
<tr>
<td></td>
<td>• ■ Negative Control</td>
</tr>
<tr>
<td></td>
<td>• ✕ Undetermined</td>
</tr>
<tr>
<td>Quality(%)</td>
<td>The quality value calculated for the genotype call.</td>
</tr>
<tr>
<td>Method</td>
<td>The method used to assign the call to the sample [Auto if assigned by the</td>
</tr>
<tr>
<td></td>
<td>QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, or Manual if</td>
</tr>
<tr>
<td></td>
<td>applied by a user].</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments entered for the associated sample well.</td>
</tr>
<tr>
<td>Allele 1 / 2 C\textsubscript{T}</td>
<td>Threshold cycle (C\textsubscript{T}) of the sample for the associated allele for the SNP evaluated by the well.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BADROX</td>
<td>The well produced a passive reference signal greater than the limit defined</td>
</tr>
<tr>
<td></td>
<td>in the analysis settings.</td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>The well produced a level of fluorescence greater than the QuantStudio™ 6</td>
</tr>
<tr>
<td></td>
<td>or 7 Instrument can measure.</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>The well did not produce a detectable level of fluorescence.</td>
</tr>
<tr>
<td>CLUSTER#</td>
<td>For the SNP evaluated by the well, the number of clusters generated from</td>
</tr>
<tr>
<td></td>
<td>the experiment data is greater than the limit defined in the analysis</td>
</tr>
<tr>
<td></td>
<td>settings.</td>
</tr>
<tr>
<td>PCFAIL</td>
<td>The positive control did not produce an R\textsubscript{n} for the associated</td>
</tr>
<tr>
<td></td>
<td>allele greater than the limit defined in the analysis settings indicating</td>
</tr>
<tr>
<td></td>
<td>that the control may have failed to amplify.</td>
</tr>
<tr>
<td>SMCLUSTER</td>
<td>The number of data points in the associated cluster is less than the limit</td>
</tr>
<tr>
<td></td>
<td>defined in the analysis settings.</td>
</tr>
<tr>
<td>AMPNC</td>
<td>The negative control has produced an R\textsubscript{n} greater than the</td>
</tr>
<tr>
<td></td>
<td>limit defined in the analysis settings indicating possible amplification.</td>
</tr>
<tr>
<td>NOAMP</td>
<td>The well did not produce an R\textsubscript{n} for either allele that is</td>
</tr>
<tr>
<td></td>
<td>greater than the limit defined in the analysis settings indicating that the</td>
</tr>
<tr>
<td></td>
<td>well may have failed to amplify.</td>
</tr>
<tr>
<td>NOISE</td>
<td>The background fluorescence [noise] produced by the well is greater than</td>
</tr>
<tr>
<td></td>
<td>the other wells on the reaction plate by a factor greater than the limit</td>
</tr>
<tr>
<td></td>
<td>defined in the analysis settings.</td>
</tr>
</tbody>
</table>
Chapter 5  Review Results and Adjust Experiment Parameters

Confirm accurate dye signal using the Multicomponent Plot

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPIKE</td>
<td>The amplification plot for the well contains one or more data points inconsistent with the other points in the plot.</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>The software cannot identify the exponential region of the amplification plot for the well.</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>The software cannot calculate the best fit baseline for the data for the well.</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>The software cannot calculate a threshold for the associated well.</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>The software cannot calculate a threshold cycle ( C_T ) for the associated well.</td>
</tr>
</tbody>
</table>

Tips for analyzing your own experiments

Confirm the integrity of positive controls

When you analyze the example experiment or your own experiment, if you are using positive controls, confirm the integrity of the positive controls:

1. From the Group By menu, select Task to organize the table rows by their function on the reaction plate.
2. Confirm that the positive controls do not display flags (▲) and that their normalized reporter dye fluorescence \( R_n \) is appropriate for the genotype (for example, if evaluating the Positive Control Allele 1/Allele 1, you would expect to see significant increase in \( R_n \) for the Allele 1 probe and very little for the Allele 2 probe).

Adjust the Well Table

- Review the data for the Unknown samples. For each row that displays (▲) in the Flag column, note the data and the flag(s) triggered by the associated well.
- Select areas of the table or wells of a specified type by:
  - Left-clicking the mouse and dragging across the area you want to select an area of the table.
  - Selecting Sample, SNP Assay, or Task from the Select Wells menu in the Well Table tab to select wells of a specific type using the well-selection tool.
- Group the rows of the plate layout by selecting an option from the Group By menu. You can then collapse or expand the lists either by clicking the +/- icon next to individual lists, or by clicking Collapse All or Expand All.
- Omit a well from the analysis by selecting the Omit check box for that well. To include the well in the analysis, deselect the Omit check box.

Note: You must reanalyze the experiment each time you omit or include a well.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.
Section 5.1 Review Results

Confirm accurate dye signal using the Multicomponent Plot

Purpose

In the example experiment, you review the Multicomponent Plot screen for:

- ROX™ dye (passive reference)
- FAM™ dye (reporter)
- VIC® dye (reporter)
- Spikes, dips, and/or sudden changes
- Amplification in the negative control wells

View the Multicomponent Plot

1. From the Experiment Menu pane, select Analysis ➤ Multicomponent Plot.
   
   Note: If no data are displayed, click Analyze.

2. Display the unknown wells in the plate layout to display the corresponding data in the Multicomponent Plot screen:
   
   a. Click the Plate Layout tab.
   
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.

   Note: If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click Show a legend for the plot (default).

   Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal remains constant throughout the PCR process; a constant ROX dye signal indicates typical data.
6. Check the FAM dye signal. In the example experiment, the FAM dye signal increases throughout the PCR process; increase in FAM dye signal indicates normal amplification.

7. Select the negative control wells one at a time and check for amplification. Wells with the negative control should not show amplification. The example experiment does not have negative controls.

Tips for confirming dye accuracy in your own experiment

When you analyze your own Genotyping experiment, look for:

- **Passive Reference** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.

- **Reporter Dye** – The reporter dye fluorescence level should display a flat region corresponding to the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.

- **Irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.

- **Negative Control wells** – There should not be any amplification in the negative control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter for the selected wells during each cycle of the real-time PCR.

Purpose

In the Genotyping example experiment, you review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.
View the Raw Data Plot

1. From the Experiment Menu pane, select **Analysis** > **Raw Data Plot**. 
   **Note:** If no data are displayed, click **Analyze**.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.

3. Click **Show a legend for the plot** (default). The legend displays the color code for each row of the reaction plate (see the legend in the Raw Data Plot shown below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 42. In the example experiment, there is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.

The filters are:
Tips for determining signal accuracy in your own experiment

When you analyze your own Genotyping experiment, look for the following in each filter:

- Characteristic signal growth
- No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software flags, including the flag frequency and location for the open experiment.

For Genotyping experiments, flag appearance is triggered by experiment data or the assay. If a flag has been triggered by the assay, the Plate Layout does not display the flag icon. The flag details appear in the QC Summary.

In the example experiment, there are no flags.

View the QC Summary

1. From the Experiment Menu pane, select Analysis > QC Summary.
   
   Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.
   
   Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment. If the frequency is >0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed information about the flag.

4. (Optional) For those flags with frequency >0, click each flag with a frequency >0 to display detailed information about the flag.
## Possible flags

The flags listed below may be triggered by the experiment data or the assay.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pre-processing flag</strong></td>
<td></td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td><strong>Primary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>$C_T$ algorithm failed</td>
</tr>
<tr>
<td><strong>Secondary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>AMPNC</td>
<td>Amplification in negative control</td>
</tr>
<tr>
<td>CLUSTER#</td>
<td>Number of clusters outside expected range</td>
</tr>
<tr>
<td>PCFAIL</td>
<td>Positive Control failed</td>
</tr>
<tr>
<td>SMCLUSTER#</td>
<td>Small number of samples in clusters</td>
</tr>
</tbody>
</table>

### For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing data</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Chapter 5 Review Results and Adjust Experiment Parameters

For more information
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the call, threshold cycle (C_T), flags, and advanced options.

You can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.
2. Click Analysis ➤ Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:

- Call Settings
- C_T Settings
- Flag Settings
- Advanced Settings

The following is an image of the Analysis Settings dialog box for a Genotyping experiment:
3. View and, if necessary, change the analysis (see “Adjust analysis settings” below).

**Note:** You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments*.

4. Click **Apply Analysis Settings** to apply the current analysis settings.

**Note:** You can go back to the default analysis settings, by clicking **Revert to Default Analysis Settings**.

### Adjust analysis settings

#### Call Settings

Use the Call Settings tab to:

- Change the default data analysis settings. You can select from:
  - Analyze data from Post-PCR Read only - Select if you do not want to use data from the pre-PCR read to determine genotype calls.
  - Analyze data from Pre-PCR Read and Post-PCR Read - If you included the pre-PCR read in the run, select if you want to use data from the pre-PCR read to determine genotype calls.
  - Analyze Real-Time Rn Data - If you included amplification in the run, select if you want to use the normalized reporter (Rn) data from the cycling stage to determine genotype calls.
  - Analyze data from Rn - Avg (Rna to Rnb) - If you included amplification in the run, select if you want to use the subtracted median of the normalized reporter (Rn) data from the cycling stage to determine genotype calls, where Rna to Rnb refers to all the cycles from the Start Cycle Number to the End Cycle Number. The average subtraction provides improved data accuracy.

  **Note:** To activate the Reveal Traces feature on the Allelic Discrimination Plot screen, select either **Analyze Real-Time Rn Data** or **Analyze data from Rn - Avg (Rna - Rnb)**.

- Edit the default call settings. Click **Edit Default Settings**, then specify the default settings:
  - **Autocaller Enabled** - Select for the software to make genotype calls using the autocaller algorithm.
  - **Keep Manual Calls from Previous Analysis** - If the autocaller is enabled, select to maintain manual calls after reanalysis
  - **Quality Value** - Enter a value to use to make genotype calls. If the confidence value is less than the call setting, the call is undetermined.

- Use custom call settings for a SNP assay.
  - Select one or more SNP assays in the table, then deselect the **Default Settings** check box.
  - **Define the custom call settings**.

### CT Settings

- **Data Step Selection**

  Use this feature to select one stage/step combination for CT analysis when there is more than one data collection point in the run method.

- **Algorithm Settings**
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

Use the Baseline Threshold algorithm to determine the $C_T$ values.
The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for gene quantification.

- Default $C_T$ Settings
  Use the default $C_T$ settings feature to calculate $C_T$ for the alleles that do not have custom settings. To edit the default settings, click Edit Default Settings.

- $C_T$ Settings for Target
  When you manually set the threshold and baseline, Life Technologies recommends:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Enter a value for the threshold so that the threshold is:</td>
</tr>
<tr>
<td></td>
<td>• Above the background.</td>
</tr>
<tr>
<td></td>
<td>• Below the plateau and linear regions of the amplification curve.</td>
</tr>
<tr>
<td></td>
<td>• Within the exponential phase of the amplification curve.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Select the Start Cycle and End Cycle values so that the baseline ends before significant fluorescent signal is detected.</td>
</tr>
</tbody>
</table>

**Note:** This setting is applicable only to the Baseline Threshold algorithm.

**Note:** Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.

Flag Settings

Use the Flag Settings tab to:

- Adjust the sensitivity so that more wells or fewer wells are flagged.
- Change the flags that are applied by the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

To adjust the flag settings:

1. In the Use column, select the check boxes for flags to apply during analysis.

2. *(Optional)* If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.
   **Note:** If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.
   **Note:** After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments using the Standard Deviation calculations may change the result of $C_T$ SD. For some flags, analysis results calculated before the well is rejected are maintained.
4. Click **Apply Analysis Settings** in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.

The following is an image of the Flag Settings tab:

![Flag Settings Tab](image)

**Advanced Settings**

Use the Advanced Settings tab to change baseline settings well-by-well.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.
2. Deselect the **Use \(C_T\) Settings Defined for Target** check box.
3. Define the custom baseline settings:
   - For automatic baseline calculations, select the **Automatic Baseline** check box.
   - To define the baseline, deselect the **Automatic Baseline** check box, then enter the baseline start cycle and baseline end cycle.
## For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification efficiency</td>
<td><em>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note.</em></td>
<td>127AP05-03</td>
</tr>
</tbody>
</table>
Chapter 5  Review Results and Adjust Experiment Parameters
For more information
Export Analysis Results

1. Open the Genotyping example experiment file that you analyzed in Chapter 5.
2. In the Experiment Menu, click Export.
   
   **Note**: To export data automatically after analysis, select the Auto Export check box during experiment setup or before running the experiment. Auto export is unchecked for the example experiment.
3. Select QuantStudio™ 6 and 7 format.
4. Complete the Export dialog box as shown below:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export/ Select Content</td>
<td>Results</td>
</tr>
<tr>
<td>Export Data To</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>QuantStudio_384-Well_SNP_Genotyping_Example_data</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td>C:\Applied Biosystems\QuantStudio 6 and 7 Flex Software\User Files\Export</td>
</tr>
</tbody>
</table>

Your Export screen should look like this:
Your exported file when opened in Notepad should look like this:

<table>
<thead>
<tr>
<th>Block type</th>
<th>384-well Block</th>
<th>Calibration background performed on</th>
<th>08-23-2010</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration HMM MULTIOCTOR performed on</td>
<td>03-03-2010</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration normalization FW-BOX performed on</td>
<td>07-22-2010</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration normalization VIC-ROX performed on</td>
<td>07-22-2010</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye ABI is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye ABIQ is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye ABQ is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye ATTO 703 is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye DYN3 is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye DYN1 is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye DYN4 is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye FAM is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye JUN is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye JUNQ is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye MUSTANTG is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye RAP is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye Q705 is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye SYBR is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye VIC is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Pure Dye VICQ is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration uniformity is expired</td>
<td>YES</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

56 QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Genotyping Experiments
## Index

### Numerics

- 5’ Nuclease Assay 6

### A

- adjusting analysis settings 50
- adjusting parameters, re-analyzing own experiments 49
- Advanced Settings tab 52
- Algorithm Settings, Baseline Threshold 51
- allele-specific probes 8, 31
- allelic discrimination plot troubleshooting 33
  - viewing and assessing 31
- amplification plot
  - amplification efficiency 17, 53
  - assessing amplification results 36
  - reviewing baseline values 38
  - reviewing threshold values 38
  - viewing 24
- AMPNC flag 41
- analysis settings
  - Advanced Settings 49
  - Call Settings 49
  - Cₜ Settings 49
  - Flag Settings 49
- Analyze
  - Allelic Discrimination Plot 31
  - Amplification Plot 36
  - Multicomponent Plot 42
  - QC Summary 46
  - Raw Data Plot 44
- Auto Export 55
- Autocaller 31
- Automatic Baseline, advanced settings 52
- Automatic Threshold 51

### B

- BADROX flag 41, 47
- baseline settings
  - end cycle 52
  - start cycle 52
- BLFAIL flag 42

### C

- Call Settings tab 50
- CLUSTER# flag 41

### clusters

- troubleshooting 33
  - viewing 8, 31
- cocktail mix 20

### Cₜ settings

- algorithm settings 50
- data step, selecting 50
- default 51
- target 51
- Cₜ Settings tab 50
- CTFAIL flag 42

### D

- data collection, about 5
- designing experiment
  - assigning markers and samples 14
  - defining experiment properties 11
  - defining SNPs and samples 12
  - setting up run method 16
- DNAs-free water 22
- dye accuracy
  - irregularities in the signal 44
  - negative control wells 44
  - passive reference 44
  - reporter dye 6, 44

### E

- example experiment 8
- experiment properties, defining 11
- EXPFAIL flag 42

### F

- Flag Settings tab 51
- flags, QC
  - AMPNC 41
  - BADROX 41
  - BLFAIL 42
  - CLUSTER# 41
  - CTFAIL 42
  - EXPFAIL 42
  - NOAMP 41
  - NOISE 41
  - NOSIGNAL 41
  - OFFSCALE 41
  - PCFAIL 41
  - SMCLUSTER 41
  - SPIKE 42
Index

THOLDFAIL 42
fluorescence signal 37

G
gDNA
dried 21
wet 22
genotype
heterozygous 31
homozygous 31
genotype calls 50

I
irregular amplification 37

M
markers and samples, assigning 14
minor groove 6
multicomponent plot
confirming dye accuracy 42
tips for analyzing own experiment 44
viewing 43

N
NOAMP flag 41, 47
NOISE flag 41
non-specific fluorescence, minimizing 7
normalized reporter (Rn) data 50
normalized reporter dye fluorescence 31
NOSIGNAL flag 41, 47

O
OFFSCALE flag 41
oligonucleotide probe 6
optical filter 44
outliers 34

P
PCFAIL flag 41
plate layout parameters 34
    Allele 1 / Allele 2 35
    Allele 1 Dyes / Allele 2 Dyes 35
    Assay ID 35
    confirming setup accuracy 34
    Flag 35
    Genotype Call 35
    Sample Color / Task Color 35
    Sample Name 34
    SNP Assay Color 35
    SNP Assay Name 35
    Task 35
plates, reading and analyzing 7
Post-PCR read, analyzing data 50
preparing reactions
    reaction mix 20
    reaction plate 20
    required materials 19
    sample dilutions 19
tips for your own experiments 22
Pre-PCR read, analyzing data 50
Pre-processing flag
    OFFSCALE 47
Primary analysis flags
    BLFAIL 47
    CTFAIL 47
    EXPFAIL 47
    NOISE 47
    THOLDFAIL 47
primers 5

Q
QC flags
    reviewing QC summary 46
troubleshooting 36
well table 39

R
raw data plot
    confirming signal accuracy 44
tips for analyzing own experiment 46
    viewing 45
reaction mix
    components 19
    preparing reactions 20
reaction plate
    dried gDNA 21
    preparing reactions 20
    wet gDNA 22
reactions, assembling materials for 19
real-time data
    analyzing data 50
running experiment 23
reporter dye 6
reporter signal 6
required materials, preparing reactions 19
reveal traces, call settings 50
review results 31
Rna to Rnb 50
run
  monitoring 23
  starting 23
run method
  reaction volume per well 16
  setting up 16
  thermal profile 16
  viewing 26
Run screen
  Amplification Plot 24
  Run Method 25
  Temperature Plot 25
  View Run Data 26

S
sample dilutions, preparing reactions 19
samples, defining 12
scatterplot 32
Secondary analysis flags
  AMPNC 47
  CLUSTER# 47
  PCFAIL 47
  SMCLUSTER# 47
signal accuracy 44
single nucleotide polymorphism. See SNP 5
SMCLUSTER flag 41
SNP 5
SNPs and samples, defining 12
SPIKE flag 42, 47
spikes 44

T
TaqMan® MGB probes 6
TaqMan® SNP Genotyping assays 5
temperature plot, viewing 25
THOLDFAIL flag 42
touchscreen, running the experiment from
  Experiment View 26
  Time View 27

troubleshooting, plate setup 36

W
well table
  identifying well problems 39
tips for analyzing own experiments 42
viewing 39
well table columns 40
  Allele 1 / 2 40
  Allele 1 / 2 CT 41
  Allele 1 / 2 Dyes 40
  Allele 1 / 2 Rn 40
  Assay ID 40
  Call 41
  Comments 41
  Flag 40
  Method 41
  Omit 40
  Pass Ref 40
  Quality(%) 41
  Sample Name 40
  SNP Assay Name 40
  Task 40
  Well 40

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Genotyping Experiments
Contents

Purpose ................................................................. 30
View the Amplification Plot ......................................... 30
Tips for viewing amplification plots in your own experiments ......................................................... 32
View the Well Table .................................................. 33
Purpose ................................................................. 33
To view the Well Table ................................................ 34
Tips for analyzing your own experiments .......................................................... 36
Confirm accurate dye signal using the Multicomponent Plot ............................................................ 36
Purpose ................................................................. 36
View the Multicomponent Plot ........................................ 36
Tips for confirming dye accuracy in your own experiment .......................................................... 38
Determine signal accuracy using the Raw Data Plot .......................................................... 38
Purpose ................................................................. 38
View the Raw Data Plot ................................................ 38
Tips for determining signal accuracy in your own experiments .......................................................... 40
Review the flags in the QC Summary ............................................. 40
View the QC Summary .................................................. 40
Possible flags ............................................................ 41
For more information .......................................................... 42

Section 5.2 Adjust parameters for re-analysis of your own experiments ............................... 43
Adjust analysis settings .................................................. 43
View the analysis settings ............................................. 43
Adjust analysis settings .................................................. 44
For more information .......................................................... 46

CHAPTER 6 Exporting Analysis Results .................................. 47

Index ................................................................. 49
This chapter covers:

- About data collection ................................................................. 5
- Setting up PCR reactions ............................................................ 6
- About the instrument run ............................................................. 6
- About the analysis ................................................................. 7
- About the example experiment ................................................. 7

IMPORTANT! First-time users of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software please read Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments* and Booklet 7, *QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes* of this binder thoroughly. The booklet provides information and general instructions that are applicable to all the experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ 6 and 7 Flex Real-Time PCR System Software by pressing F1, clicking in the toolbar, or selecting Help → *QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Help*.

**About data collection**

Presence/Absence experiments are end-point experiments that are performed to detect a target nucleic acid sequence in a sample.

You can collect the experiment data at the end of the run or continuously in real time.

**End-point PCR Data**

The QuantStudio™ 6 and 7 Instruments collect data at an end-point, that is after the process has completed.

The data collected is the normalized intensity of the reporter dye, or Rn.

Note: Some end-point experiments also include pre-PCR (data collected before the amplification process) datapoints. If so, the software calculates the delta Rn (ΔRn) value per the following formula:

\[ \Delta Rn = Rn \text{(post-PCR read)} - Rn \text{(pre-PCR read)} \]

where Rn = normalized readings.

**Real-Time PCR Data**

The QuantStudio™ 6 and 7 Instruments provide the option of collecting real-time data, during the PCR process.

Note: Real-time data collection is used only for troubleshooting, and not for Presence/Absence analysis.
Setting up PCR reactions

With Presence/Absence experiments, you prepare PCR reactions that contain primers and probes to amplify the target and a reagent to detect amplification of the target. You can set up the PCR reactions for the Presence/Absence experiments two different ways.

Note: The example experiment uses IPC setup for setting up the PCR reactions.

IPC setup

Use an internal positive control (IPC) to monitor the PCR progress and ensure that a negative result is not caused by failed PCR in the sample. PCR reactions contain two primer/probe sets: One to detect the unknown target (unknown target primer set and TaqMan® probe to detect the unknown target) and one to detect the IPC (IPC primer set and a VIC dye-labeled TaqMan® probe to detect the IPC template). With this setup, there are three well types:

- **Unknown-IPC wells** contain sample template and IPC template; the presence of the target is not known.
- **Negative control-IPC wells** contain IPC template and water or buffer instead of sample template in the PCR reaction. Only the IPC template should amplify in negative control-IPC wells because the reaction contains no sample template. Also called IPC+.
- **Negative control-blocked IPC wells** do not contain sample template in the PCR reaction. Amplification is prevented by a blocking agent. As a result, no amplification should occur in negative control-blocked IPC wells because the reaction contains no sample template and amplification of the IPC is blocked. Negative control-blocked IPC is called *no amplification control (NAC)*.

If the run method includes amplification, real-time data are plotted in an amplification plot.

No IPC, singleplex setup

Omit the IPC from your Presence/Absence experiment. PCR reactions contain one primer/probe set. PCR reactions do not contain the IPC. With this setup, there are two well types:

- **Unknown wells** – Wells contain sample template; the presence of the target is not known.
- **Negative controls** – Wells contain water or buffer instead of sample template.

About the instrument run

With Presence/Absence experiments, the instrument runs can include:

- **Pre-PCR read** – Perform the pre-PCR read on the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software before PCR amplification to collect baseline fluorescence data.
- **Amplification** – Perform amplification on the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software to collect fluorescence data during PCR amplification. If you do not include amplification in the run method, perform amplification on another instrument.
- **Post-PCR read** – To determine the results for Presence/Absence experiments, perform the post-PCR read on the instrument after PCR amplification to collect endpoint fluorescence data.
Fluorescence data collected during the instrument run are stored in an experiment data file (.eds).

### About the analysis

Data from the instrument run are used to determine Presence/Absence calls. Results are plotted in a Presence/Absence plot. If the experiment includes amplification, results are plotted in an amplification plot.

- **Pre-PCR read** – If included, the data collected from the pre-PCR read can be used to normalize data collected from the post-PCR read.
- **Amplification** – If included, the data collected from the amplification can be used to troubleshoot.
- **Post-PCR read** – The data collected from the post-PCR read are used to make Presence/Absence calls:
  - **Presence** – The target amplified above the target's threshold. The target is present in the sample.
  - **Absence** – The target did not amplify above the target's threshold. The target is absent in the sample.
  - **Unconfirmed** – The data collected is below the target threshold, and the intensity of IPC is below the IPC threshold.

With the IPC setup, the data collected form the post-PCR read are used to make the following calls:

- **IPC Failed** – The IPC target did not amplify in the IPC wells and/or the IPC target amplified in the blocked IPC wells.
- **IPC Succeeded** – The IPC target amplified in the IPC wells and the IPC target did not amplify in the blocked IPC wells.

### About the example experiment

To illustrate how to perform Presence/Absence experiments, this guide leads you through the process of designing and performing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with a QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

The objective of the Presence/Absence example experiment is to determine if a pathogen is present or absent in each batch of ground beef.

In the Presence/Absence example experiment:

- DNA is extracted from samples using the PrepMan® Ultra Sample Preparation Reagent (Part no. 4318930). The DNA is extracted from each of the four samples of ground beef or from the bacteria found in the ground beef.
- The target is a pathogen.
- The experiment is designed for duplex PCR, where each reaction contains two primer/probe sets. One set detects the pathogen sequence, TGFB (primer set and FAM™ dye-labeled probe to detect the TGFB sequence). The other primer/probe set detects the IPC primer set and VIC® dye-labeled TaqMan® probe detects the IPC template.
Chapter 1  About Presence/ Absence Experiments

About the example experiment
Design the Experiment

This chapter explains how to design the example experiment from the Experiment Setup menu.

This chapter covers:

■ Define the experiment properties ........................................ 9
■ Define targets and samples ............................................. 10
■ Assign targets and samples .............................................. 11
■ Set up the run method ................................................... 12
■ For more information .................................................... 13

**Note:** To automatically export the analyzed data to a specified location, select the Auto Export task from the Export screen, before running the experiment. For more information on Auto Export, refer to Chapter 2 in Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments*.

**Define the experiment properties**

Click **Experiment Setup ▶ Experiment Properties** to create a new experiment in the QuantStudio™ 6 and 7 Flex Software. Enter:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Name</td>
<td>QuantStudio_384-Well_Presence-Absence_Example</td>
</tr>
<tr>
<td>Barcode</td>
<td>Leave field empty</td>
</tr>
<tr>
<td>User Name</td>
<td>Example User</td>
</tr>
<tr>
<td>Comments</td>
<td>Presence/Absence example</td>
</tr>
<tr>
<td>Instrument type</td>
<td>QuantStudio™ 6 Flex System</td>
</tr>
<tr>
<td>Block</td>
<td>384-Well Block</td>
</tr>
<tr>
<td>Experiment Type</td>
<td>Presence/ Absence</td>
</tr>
<tr>
<td>Reagents</td>
<td>TaqMan® Reagents</td>
</tr>
<tr>
<td>Ramp speed</td>
<td>Standard</td>
</tr>
<tr>
<td>Reagent information</td>
<td>NA</td>
</tr>
</tbody>
</table>

Select all three data-collection check boxes: Pre-PCR, Amplification, and Post-PCR collection methods:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-PCR Read</td>
<td>Checked</td>
</tr>
</tbody>
</table>
Chapter 2  Design the Experiment

Define targets and samples

Save the experiment.

Your Experiment Properties screen should look like this:

---

## Define targets and samples

Click **Define** to access the Define screen. Enter:

1. **Targets**

<table>
<thead>
<tr>
<th>Target Name</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>TGFB</td>
<td>FAM</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
<tr>
<td>IPC</td>
<td>VIC</td>
<td>NFQ-MGB</td>
<td></td>
</tr>
</tbody>
</table>

2. **Samples**

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTC</td>
<td></td>
</tr>
<tr>
<td>NAC</td>
<td></td>
</tr>
<tr>
<td>Sample (+)</td>
<td></td>
</tr>
<tr>
<td>Sample (-)</td>
<td></td>
</tr>
</tbody>
</table>
3. Dye to be used as a Passive Reference
   ROX

4. Custom Task Name
   Not applicable

Your Define screen should look like this:

---

**Assign targets and samples**

Click **Assign** to access the Assign screen. Enter the targets and samples:

<table>
<thead>
<tr>
<th>Target Name</th>
<th>Well Number</th>
<th>Task</th>
<th>Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>TGFB</td>
<td>A1 - P3 (Columns 1 - 3)</td>
<td>Negative IPC</td>
<td>NTC</td>
</tr>
<tr>
<td>IPC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TGFB</td>
<td>A4 - P12 (Columns 4 - 12)</td>
<td>Unknown IPC</td>
<td>Sample (-)</td>
</tr>
<tr>
<td>IPC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TGFB</td>
<td>A13 - P15 (Columns 13 - 15)</td>
<td>NTC Blocked IPC</td>
<td>NAC</td>
</tr>
<tr>
<td>IPC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TGFB</td>
<td>A16 - P24 (Columns 16 - 24)</td>
<td>Unknown IPC</td>
<td>Sample (+)</td>
</tr>
<tr>
<td>IPC</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Your Assign screen should look like this:

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- Reaction Volume Per Well: 20 µL
- Thermal Profile

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Read Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Hold Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>10 minutes</td>
</tr>
<tr>
<td>PCR Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>15 seconds</td>
</tr>
<tr>
<td></td>
<td>Step 2</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>1 minute</td>
</tr>
<tr>
<td>Post-Read Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>30 seconds</td>
</tr>
</tbody>
</table>
Your Run Method screen should look like this:

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumables</td>
<td>Chapter 3 in Booklet 1, <em>Getting Started with QuantaStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em> Appendix A in Booklet 7, <em>QuantaStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes</em></td>
<td>4489822</td>
</tr>
<tr>
<td>Data collection</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantaStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
<tr>
<td>Amplification efficiency</td>
<td><em>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</em></td>
<td>127AP05-03</td>
</tr>
<tr>
<td>Using Alternative Setup</td>
<td>Chapter 3 in Booklet 1, <em>Getting Started with QuantaStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Presence/Absence example experiment.

This chapter covers:

- Assemble required materials .......................................................... 15
- Prepare the reaction mix ("cocktail mix") ......................................... 15
- Prepare the reaction plate .............................................................. 17
- For more information ................................................................. 18

Assemble required materials

- Items listed in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments
- Samples - DNA extracted from ground beef (100 ng/µL)
- Example experiment reaction mix components:
  - TaqMan® Universal PCR Master Mix
  - 10X IPC Mix
  - 50X IPC DNA
  - 20X Primer/Probe Mix

Note: Fast Universal Master Mix is not recommended to be used with the 96-well (0.2 mL) reaction plates or reaction tubes and tube strips sealed with caps.

Prepare the reaction mix ("cocktail mix")

For the Presence/Absence example experiment, four cocktail mixes are used; one each for:

- Sample (+)
- Sample (-)
- NTC/IPC+
- NAC/IPC-

The following tables list the universal assay conditions (volume and final concentration) for using the TaqMan® Universal PCR Master Mix for the four cocktail mixes.
## Prepare the Reactions

### Prepare the reaction mix ("cocktail mix")

<table>
<thead>
<tr>
<th>Cocktail Mix</th>
<th>Reaction component</th>
<th>Volume for 1 reaction (µL)</th>
<th>Volume for 160 reactions (144 wells + 10% excess) (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cocktail Mix 1 for Sample (+)</td>
<td>TaqMan® Universal PCR Master Mix (2.0×)</td>
<td>12.50</td>
<td>2000.0</td>
</tr>
<tr>
<td></td>
<td>10X IPC Mix</td>
<td>2.50</td>
<td>400.0</td>
</tr>
<tr>
<td></td>
<td>50X IPC DNA</td>
<td>0.50</td>
<td>80.0</td>
</tr>
<tr>
<td></td>
<td>20X Primer/ Probe Mix</td>
<td>1.25</td>
<td>200.0</td>
</tr>
<tr>
<td></td>
<td>Water/ Buffer</td>
<td>5.75</td>
<td>920.0</td>
</tr>
<tr>
<td></td>
<td>Diluted unknown 1</td>
<td>2.5</td>
<td>400.0</td>
</tr>
<tr>
<td></td>
<td>Total reaction mix volume</td>
<td>25.0</td>
<td>4000.0</td>
</tr>
<tr>
<td>Cocktail Mix 2 for Sample (-)</td>
<td>TaqMan® Universal PCR Master Mix (2.0×)</td>
<td>12.50</td>
<td>2000.0</td>
</tr>
<tr>
<td></td>
<td>10X IPC Mix</td>
<td>2.50</td>
<td>400.0</td>
</tr>
<tr>
<td></td>
<td>50X IPC DNA</td>
<td>0.50</td>
<td>80.0</td>
</tr>
<tr>
<td></td>
<td>20X Primer/ Probe Mix</td>
<td>1.25</td>
<td>200.0</td>
</tr>
<tr>
<td></td>
<td>Water/ Buffer</td>
<td>5.75</td>
<td>920.0</td>
</tr>
<tr>
<td></td>
<td>Diluted unknown 2</td>
<td>2.5</td>
<td>400.0</td>
</tr>
<tr>
<td>Cocktail Mix 3 for NTC/ IPC+</td>
<td>TaqMan® Universal PCR Master Mix (2.0×)</td>
<td>12.50</td>
<td>662.5</td>
</tr>
<tr>
<td></td>
<td>10X IPC Mix</td>
<td>2.50</td>
<td>132.5</td>
</tr>
<tr>
<td></td>
<td>50X IPC DNA</td>
<td>0.50</td>
<td>26.5</td>
</tr>
<tr>
<td></td>
<td>20X Primer/ Probe Mix</td>
<td>1.25</td>
<td>66.25</td>
</tr>
<tr>
<td></td>
<td>Water/ Buffer</td>
<td>8.25</td>
<td>304.75</td>
</tr>
<tr>
<td></td>
<td>Total reaction mix volume</td>
<td>25.0</td>
<td>1325.0</td>
</tr>
<tr>
<td>Cocktail Mix 4 for NAC/ IPC-</td>
<td>TaqMan® Universal PCR Master Mix (2.0×)</td>
<td>12.50</td>
<td>662.5</td>
</tr>
<tr>
<td></td>
<td>10X IPC Mix</td>
<td>2.50</td>
<td>132.5</td>
</tr>
<tr>
<td></td>
<td>50X IPC DNA</td>
<td>0.50</td>
<td>26.5</td>
</tr>
<tr>
<td></td>
<td>20X Primer/ Probe Mix</td>
<td>1.25</td>
<td>66.25</td>
</tr>
<tr>
<td></td>
<td>IPC Block</td>
<td>5.75</td>
<td>132.5</td>
</tr>
<tr>
<td></td>
<td>Water/ Buffer</td>
<td>5.75</td>
<td>304.75</td>
</tr>
<tr>
<td></td>
<td>Total reaction mix volume</td>
<td>25.0</td>
<td>1325.0</td>
</tr>
</tbody>
</table>

To prepare the reaction mix for each of the four types:

1. Label four appropriately sized tubes for the reaction mixes: **Sample (+), Sample (-), NTC, NAC.**
2. Add the required volumes of each cocktail mix component to the tube.
3. Mix the cocktail thoroughly by gently pipetting up and down several times, then cap the tube.

4. Centrifuge the tube briefly to remove air bubbles.

5. Place the cocktail mix on ice until you prepare the reaction plate.

   Note: You can separately add the sample to the reaction plate, as opposed to preparing individual reaction mixes for each sample.

Prepare the reaction plate

The reaction plate for the Presence/Absence example experiment contains:

- A MicroAmp® Optical 384-Well Reaction Plate
- Reaction volume of 20 μL/well
- 144 Sample (+) wells
- 144 Sample (-) wells
- 48 NTC/IPC+
- 48 NAC/IPC-

The following is an image of the plate layout:

To prepare the reaction plate:
1. Add 25 µL of Cocktail mix 1 to wells A16–P24.
2. Add 25 µL of Cocktail mix 2 to wells A4–P12.
3. Add 25 µL of Cocktail mix 3 to wells A13–P15.
5. Seal the reaction plate with optical adhesive film.
6. Centrifuge the reaction plate briefly to remove air bubbles.
7. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the reaction plate again at a higher speed and for a longer period of time.
8. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning the reaction plate components</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
<tr>
<td>Sealing the reaction plate</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Run the Experiment

This chapter explains how to run the example experiment on the QuantStudio™ 6 or 7 Instrument.

This chapter covers:
- Start the run ................................................................. 19
- Monitor the run ............................................................. 19

IMPORTANT! Run the experiment at the same ambient temperature at which you calibrated the instrument. Extreme variations in ambient temperature can affect the heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 6 or 7 Instrument is in operation.

Start the run

1. Open the Presence/Absence example file that you created using instructions in Chapter 2.
2. Load the reaction plate into the instrument.
3. Start the run.

Monitor the run

Monitor the example experiment run:
- From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software using the Run screen, while the experiment is in progress.
- From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software (to monitor an experiment started from another computer or from the QuantStudio™ 6 or 7 Instrument touchscreen).
- From the QuantStudio™ 6 or 7 Instrument touchscreen.
1. In the Instrument Console screen, select the instrument icon.

2. Click Manage Instrument or double-click on the instrument icon.

3. On the Manage Instrument screen, click Monitor Running Instrument to access the Run screen.

View the Amplification Plot

You can view the progress of the run in real time. During the run, periodically view all the three plots available from the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software for potential problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab, then select the wells to view.

The following is an image of the Amplification Plot screen as it appears at the end of the example experiment.

View the Temperature Plot

Click Temperature Plot from the Run Experiment Menu.
The following is an image of the Temperature Plot screen as it appears during the example experiment.

**Note:** The Sample temperature displayed in the Current Temperatures group is an estimated value.

**View the Run Method**

Click **Run Method** from the Run Experiment Menu.

The following is an image of the Run Method screen as it appears in the example experiment.

**View run data**

Click **View Run Data** from the Run Experiment Menu.
Chapter 4  Run the Experiment
Monitor the run

The following is an image of the View Run Data screen as it appears in the example experiment.

From the QuantStudio™ 6 or 7 Instrument touchscreen

You can also view the progress of the run from the QuantStudio™ 6 or 7 Instrument touchscreen.

The following are images of the Run Method screen on the QuantStudio™ 6 or 7 Instrument touchscreen:

Experiment View
Chapter 4  Run the Experiment

Monitor the run

Time View

Run Started: July 06 2013 - 05:48PM
Reaction Volume: 20 μL

Sample: 95.0 °C
Heated Cover [Set Point]: 105.0 °C [105.0 °C]
Stage / Step / Cycle: 1 / 2 / 1

01:31:52

Remaining Time  Elapsed Time

Heated cover reached target temperature.
Chapter 4  Run the Experiment

Monitor the run
5

Review Results and Adjust Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis screens and publish the data. Section 5.2 of this chapter walks you through the process of modifying experiment parameters to troubleshoot problems with experiment results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ................................................................. 27
- Analyze the example experiment ................................................. 27
- View the Presence/Absence Plot .................................................. 27
- Assess amplification results using the Amplification Plot ............. 29
- View the Well Table ................................................................. 33
- Confirm accurate dye signal using the Multicomponent Plot .......... 36
- Determine signal accuracy using the Raw Data Plot .................... 38
- Review the flags in the QC Summary ............................................. 40
- For more information .............................................................. 42

Section 5.2 Adjust parameters for re-analysis of your own experiments. .... 43
- Adjust analysis settings .......................................................... 43
- For more information .............................................................. 46
Section 5.1 Review Results

Analyze the example experiment

1. Open the Presence/Absence example experiment file that you ran in Chapter 4.
2. Click Analyze. The software analyzes the data using the default analysis settings.
   Note: You can also access the experiment to analyze from the Home screen.

View the Presence/Absence Plot

The Presence/Absence Plot displays the intensity of the fluorescence for each well position. There are four Presence/Absence plot views available:

- All Calls
- Presence calls only
- Absence calls only
- Unconfirmed calls

For each view you can choose to:

- Show IPC
- Show Controls

Purpose

The purpose of viewing the Presence/Absence Plot for the example experiment is to confirm that:

- The target is absent in samples NTC and Sample (-).
- The target is present in Sample (+).
- There are no unconfirmed wells.
- The IPC succeeded in all wells.
- There is no amplification in NAC wells.

To view and assess the Presence/Absence Plot

From the Experiment menu pane, select Analysis ▶ Presence/Absence Plot.

Note: If no data are displayed, click Analyze.

1. Display all 384 wells in the Presence/Absence Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.
2. Enter the Plot Settings:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Reporter</td>
<td>TGFB</td>
</tr>
<tr>
<td>Control Reporter</td>
<td>IPC</td>
</tr>
<tr>
<td>Show Calls</td>
<td>All Calls</td>
</tr>
</tbody>
</table>
3. Click the **Show IPC** check box to view the fluorescence intensity of the IPC target in the Unknown-IPC wells.

4. Click the **Show Controls** check box to view the fluorescence intensity of the IPC target in the Negative Control-IPC wells and the Negative Control-Blocked IPC wells.

5. To view the fluorescence intensity of:
   - Presence calls—select **Presence** from the Show Calls drop-down menu.
   - Absence calls—select **Absence** from the Show Calls drop-down menu.
   - Unconfirmed calls—select **Unconfirmed** from the Show Calls drop-down menu.

   **Note:** The Presence/Absence example experiment does not contain any unconfirmed calls.

The following is an image of the Presence/Absence Plot for the example experiment:
• **The IPC threshold** is calculated from the Negative Control- Blocked IPC reactions.

• **The Target Threshold** is calculated from the Negative Control- IPC reactions. If the target’s intensity is:
  - Above the target threshold, the call is present (regardless of the intensity of the IPC).
  - Below the target threshold, and the IPC’s intensity is above the IPC threshold, the call is absent.
  - Below the target threshold, and the IPC’s intensity is below the IPC threshold, the call is unconfirmed.

• **Target Calls**:  
  - Presence  
  - Absence  
  - Unconfirmed

• **IPC Calls**:  
  - IPC Succeeded  
  - IPC Failed

• **Control Well Calls**:  
  - Negative Control - IPC  
  - Negative Control - Blocked IPC

**Assess amplification results using the Amplification Plot**

**IMPORTANT!** Amplification plots are not used to make presence/absence calls. Examine the plots to help with troubleshooting and quality control.

**Amplification plots available for viewing**

The Amplification Plot displays amplification of all samples in the selected wells. There are three amplification plot views available:

• **ΔRn vs Cycle** – ΔRn is the difference in normalized fluorescence signal generated by the reporter between the pre-PCR read and the post-PCR read. This plot displays ΔRn as a function of cycle number. You can use this plot to identify and examine irregular amplification and to view threshold and baseline values for the run.

• **Rn vs Cycle** – Rn is the fluorescence signal from the reporter dye normalized to the fluorescence signal from the passive reference. This plot displays Rn as a function of cycle number. You can use this plot to identify and examine irregular amplification.

• **C<sub>T</sub> vs Well** – C<sub>T</sub> is the PCR cycle number at which the fluorescence meets the threshold in the amplification plot. This plot displays C<sub>T</sub> as a function of well position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.
Purpose

The purpose of viewing the amplification plot for the example experiment is to review the target to identify:

- Correct baseline and threshold values
- Irregular amplification
- Outliers

View the Amplification Plot

1. From the Experiment menu pane, select Analysis › Amplification Plot.  
   **Note:** If no data are displayed, click Analyze.

2. Display all 384 wells in the amplification plot by clicking the upper left corner of the plate layout in the Plate Layout tab.

3. Expand the Plate Layout tab by clicking the left facing arrow that is left of the tab.

4. In the Amplification Plot screen, enter:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Type</td>
<td>ΔRn vs Cycle</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Well</td>
</tr>
</tbody>
</table>

   (This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.)

5. View the baseline values:
   a. From the Graph Type drop-down menu, select Linear.
   b. Select the Baseline check box to show the start cycle and end cycle.
   c. Verify that the baseline is set correctly: The end cycle should be set a few cycles before the cycle number where significant fluorescent signal is detected. In the example experiment, the baseline is set correctly.
Section 5.1 Review Results
Assess amplification results using the Amplification Plot

Your screen should look like this:

6. View the threshold values:
   a. From the Graph Type drop-down menu, select **Log**.
   b. Select the **Threshold** check box to show the threshold.
   c. Verify that the threshold is set correctly.

Your screen should look like this:
7. Locate any outliers:
   a. From the Plot Type drop-down menu, select $C_T$ vs Well.
   b. Look for outliers from the amplification plot. In the example experiment, there are no outliers for IPC.

Your screen should look like this:

Tips for viewing amplification plots in your own experiments

When you analyze your own Presence/Absence experiment, look for:

- **Outliers**

- **A typical amplification plot** – The QuantStudio™ 6 and 7 Flex Software automatically calculates baseline and threshold values based on the assumption that the data exhibit a *typical* amplification plot. A typical amplification plot has four distinct sections:
  - Plateau phase
  - Linear phase
  - Exponential (geometric phase)
  - Baseline
A following is an image of a typical amplification plot:

**IMPORTANT!** Experimental error (such as contamination or pipetting errors) can produce atypical amplification curves that can result in incorrect baseline and threshold value calculations by the QuantStudio™ 6 and 7 Flex Software. Life Technologies recommends that you examine the Amplification Plot screen and review the assigned baseline and threshold values for each well after analysis.

**View the Well Table**

The well table displays results data for each well in the reaction plate, including:

- The well number, sample name, target name, task, and dyes
- The calculated values: ΔRn, ΔRn mean, and ΔRn SD
  
  **Note:** ΔRn, ΔRn mean, and ΔRn SD are calculated only when the analysis call settings specify to analyze data from the pre-PCR read and the post-PCR read.

- Target and IPC thresholds, Call, Comments
- Flags

**Purpose**

In the Presence/Absence example experiment, you review the well table for:

- Call
- ΔRn
- Flag
Chapter 5 Review Results and Adjust Experiment Parameters

View the Well Table

To view the Well Table

1. From the Experiment Menu pane, select **Analysis ➤ Amplification Plot**, then select the **Well Table** tab.

   **Note:** If no data are displayed, click **Analyze**.

2. Use the Group By drop-down menu to group wells by a specific category. For the example experiment, group the wells by flag, call, and ΔRn value.

   **Note:** You can select only one category at a time.

   a. From the Group By drop-down menu, select **Flag**:
      - 144 wells are listed under Flagged.
      - 240 wells are listed under Unflagged.

   b. From the Group By drop-down menu, select **Call**. Wells are listed in the order:
      - Absence
      - Blocked IPC Control
      - IPC Succeeded
Section 5.1 Review Results

View the Well Table

- Negative Control
- Presence

... From the Group By drop-down menu, select None. In the table, click the column heading ΔRn. Wells are listed in order of increasing ΔRn. Click the column heading again to reverse the sort order.
Tips for analyzing your own experiments

When you analyze your own Presence/Absence experiment, group the wells by:

- **Flag** – The software groups the flagged and unflagged wells. A flag indicates that the software has found an error in the flagged well. For a description of the QuantStudio™ 6 and 7 Flex Software flags, see “Review the flags in the QC Summary” on page 40.

- **Call** – The software groups the wells by call: Negative Control, Blocked-IPC, Presence, Absence, Unconfirmed, IPC Succeeded, and IPC Failed.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

**Purpose**

In the Presence/Absence example experiment, you review the Multicomponent Plot screen for:

- ROX™ dye (passive reference)
- FAM™ dye (reporter)
- VIC® dye (reporter)
- Spikes, dips, and/or sudden changes
- Amplification in the negative control wells

**View the Multicomponent Plot**

1. From the Experiment Menu pane, select **Analysis ▸ Multicomponent Plot**.
   
   **Note:** If no data are displayed, click **Analyze**.

2. Display the wells **one at a time** in the Multicomponent Plot screen:
   
   a. Click the **Plate Layout** tab.
   
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.
   
   **Note:** If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select **Dye**.

4. Click **Show a legend for the plot** (default).
   
   **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal remains constant throughout the PCR process; a constant ROX dye signal indicates typical data.
6. Check the VIC dye signal. In the example experiment the VIC dye signal should not amplify for NC-Blocked IPC wells or if the IPC call for the Unknown-IPC well is IPC Failed.

7. Check the FAM dye signal. In the example experiment, for the Sample (+), the FAM dye signal increases throughout the PCR process; increase in FAM dye signal indicates normal amplification.
8. Select the negative control (NAC) wells one at time and check for amplification. In the example experiment, there is no amplification in the negative control wells.

Tips for confirming dye accuracy in your own experiment

When you analyze your own Presence/Absence experiment, look for:

- **Passive reference (ROX)** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.
- **Reporter dye (FAM)** – The reporter dye fluorescence level should display a flat region corresponding to the baseline. If target is present in the sample (a Presence call is made), the baseline will be followed by a rapid rise in fluorescence as the amplification proceeds.
- **Irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.
- **Negative control wells** – There should not be any amplification in the negative control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter for the selected wells during each cycle of the real-time PCR.

**Purpose**

In the Presence/Absence example experiment, review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

**View the Raw Data Plot**

1. From the Experiment Menu pane, select **Analysis ▸ Raw Data Plot**.

   **Note:** If no data are displayed, click **Analyze**.
2. Click **Show a legend for the plot** (default). The legend displays the color code for each row of the reaction plate (see the legend in the Raw Data Plot shown below).

3. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.

4. Select wells corresponding to a replicate group:
   - Sample (-) wells: From the Select Wells with drop-down menus, select Sample (-).
   - Sample (+) wells: From the Select Wells with drop-down menus, select Sample (+).
   - Negative control-IPC wells: Select wells A1 - P1, A2 - P2, and A3 - P3.
   - Negative control-blocked IPC wells: Select wells A13 - P13, A14 -P14, and A15 - P15.

5. Click and drag the Show Cycle pointer from cycle 1 to cycle 42. In the example experiment, there is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.
Chapter 5  Review Results and Adjust Experiment Parameters

Review the flags in the QC Summary

The filters used for the example experiment are:

<table>
<thead>
<tr>
<th>PCR Filter</th>
<th>m1(520±15)</th>
<th>m2(550±11)</th>
<th>m3(586±10)</th>
<th>m4(623±14)</th>
<th>m5(662±14)</th>
<th>m6(711±12)</th>
</tr>
</thead>
<tbody>
<tr>
<td>x1(470±15)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x2(500±10)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x3(550±11)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x4(590±10)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x5(640±10)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x6(662±10)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Melt Curve Filter</th>
<th>m1(520±15)</th>
<th>m2(550±11)</th>
<th>m3(586±10)</th>
<th>m4(623±14)</th>
<th>m5(662±14)</th>
<th>m6(711±12)</th>
</tr>
</thead>
<tbody>
<tr>
<td>x1(470±15)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x2(500±10)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x3(550±11)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x4(590±10)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x5(640±10)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x6(662±10)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Emission Filter</th>
<th>m1(520±15)</th>
<th>m2(550±11)</th>
<th>m3(586±10)</th>
<th>m4(623±14)</th>
<th>m5(662±14)</th>
<th>m6(711±12)</th>
</tr>
</thead>
<tbody>
<tr>
<td>x1(470±15)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x2(500±10)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x3(550±11)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x4(590±10)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x5(640±10)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x6(662±10)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Tips for determining signal accuracy in your own experiments

- Characteristic signal growth
- No abrupt changes or dips

When you analyze your own Presence/Absence experiment, look for the following in each filter:

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 6 and 7 Flex Software flags, including the flag frequency and location for the open experiment. In the example experiment, 144 flags have been triggered.

Note: The flags triggered in the example experiment are seen in the Sample (-) wells. The flags, NOAMP and EXPFAIL indicate that the wells containing the Sample (-) did not amplify and that the software could not identify the exponential region of the amplification plot (as amplification did not take place). The occurrence of these flags in the example experiment is valid because it indicates the absence of the target in the sample.

View the QC Summary

1. From the Experiment Menu pane, select Analysis ▶ QC Summary.

   Note: If no data are displayed, click Analyze.
2. Review the Flags Summary

**Note:** A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment. If the frequency is >0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.

In the example experiment, there are 144 flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed information about the flag. In the example experiment:

- The NOAMP flag appears 144 times, in the wells A4 - P4, A5 - P5, A6 - P6, A7 - P7, A8 - P8, A9 - P9, A10 - P10, A11 - P11, and A12 - P12.
- The EXPFAIL flag appears 144 times, in the same wells as the NOAMP flag, that is, A4 - P4, A5 - P5, A6 - P6, A7 - P7, A8 - P8, A9 - P9, A10 - P10, A11 - P11, and A12 - P12.

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view information on correcting the flag.

**Possible flags**

For Presence/Absence experiments, the flags listed below may be triggered by the experiment data.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BADROX</td>
<td>Pre-processing flag</td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td>NOAMP</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>BTFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>THLCPFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
</tbody>
</table>

**Possible flags**

For Presence/Absence experiments, the flags listed below may be triggered by the experiment data.
### Flag Description

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>$C_T$ algorithm failed</td>
</tr>
</tbody>
</table>

**Secondary analysis flags**

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMPNC</td>
<td>Amplification in negative control</td>
</tr>
</tbody>
</table>

**Note**: If the experiment does not include amplification, then the only flags are BADROX, NOSIGNAL, and OFFSCALE.

### For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing data</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experimentss</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the call, threshold cycle (C_T), flags, and advanced options.

If the default analysis settings in the QuantStudio™ 6 and 7 Flex Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.
2. Click Analysis ➤ Analysis Settings to open the Analysis Settings dialog box.
   In the example experiment, the default analysis settings are used for each tab:
   - Call Settings
   - C_T Settings
   - Flag Settings
   - Advanced Settings
   The following is an image of the Analysis Settings dialog box for a Presence/Absence experiment:
3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” below).
   
   **Note:** You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments*.

4. Click **Apply Analysis Settings** to apply the current analysis settings.
   
   **Note:** You can go back to the default analysis settings, by clicking **Revert to Default Analysis Settings**.

**Adjust analysis settings**

**Call Settings**

Use the Call Settings tab to:

- Change the default data analysis settings. You can select from:
  - Analyze data from Post-PCR Read only
  - Analyze data from Pre-PCR Read and Post-PCR Read
- Edit the default call settings.
  - Click **Edit Default Settings**, then select the confidence value to use to make presence/absence calls. If the confidence value is less than the call setting, the call is unconfirmed.
  - Click **Save Changes**.
- Use custom call settings for a target.
  - Select one or more targets in the table, then deselect the **Default Settings** check box.
  - Select the confidence value to use to make presence/absence calls for the selected target(s).

**C_T Settings**

- **Data Step Selection**
  Use this feature to select one stage/step combination for C_T analysis when there is more than one data collection point in the run method.
- **Algorithm Settings**
  Use the Baseline Threshold algorithm to determine the C_T values.
  The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for gene quantification.
- **Default C_T Settings**
  Use the default C_T settings feature to calculate C_T for the targets that do not have custom settings. To edit the default settings, click **Edit Default Settings**.
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

• **CT Settings for Target**
  When you manually set the threshold and baseline, Life Technologies recommends:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Enter a value for the threshold so that the threshold is:</td>
</tr>
<tr>
<td></td>
<td>• Above the background.</td>
</tr>
<tr>
<td></td>
<td>• Below the plateau and linear regions of the amplification curve.</td>
</tr>
<tr>
<td></td>
<td>• Within the exponential phase of the amplification curve.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Select the Start Cycle and End Cycle values so that the baseline ends</td>
</tr>
<tr>
<td></td>
<td>before significant fluorescent signal is detected.</td>
</tr>
</tbody>
</table>

**Note:** This setting is applicable only to the Baseline Threshold algorithm.

**Note:** Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.

**Flag Settings**

Use the Flag Settings tab to:

- Adjust the sensitivity so that more wells or fewer wells are flagged.
- Change the flags that are applied by the QuantStudio™ 6 and 7 Flex Software.

To adjust the flag settings:

1. In the Use column, select the check boxes for flags to apply during analysis.

2. *(Optional)* If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.

   **Note:** If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.

   **Note:** After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments using the Standard Deviation calculations may change the result of CT SD. For some flags, analysis results calculated before the well is rejected are maintained.

4. Click **Apply Analysis Settings** in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.
Chapter 5 Review Results and Adjust Experiment Parameters

For more information

The following is an image of the Flag Settings tab:

Advanced Settings

Use the Advanced Settings tab to change baseline settings well-by-well.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.
2. Deselect the **Use C_T Settings Defined for Target** check box.
3. Define the custom baseline settings:
   - For automatic baseline calculations, select the **Automatic Baseline** check box.
   - To define the baseline, deselect the **Automatic Baseline** check box, then enter the baseline start cycle and baseline end cycle.

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification efficiency</td>
<td><strong>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note.</strong></td>
<td>127AP05-03</td>
</tr>
</tbody>
</table>
## Exporting Analysis Results

1. Open the Presence/Absence example experiment file that you analyzed in Chapter 5.

2. In the Experiment Menu, click **Export**.

   **Note:** To export data automatically after analysis, select the **Auto Export** check box during experiment setup or before running the experiment. Auto export is unchecked for the example experiment.

3. Select **QuantStudio™ 6 and 7** format.

4. Complete the Export dialog box as shown below:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export/ Select Content</td>
<td>Results</td>
</tr>
<tr>
<td>Export Data To</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>QuantStudio_384-Well_Presence-Absence_Example_data</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td>C:\Applied Biosystems\QuantStudio 6 and 7 Flex Software\User Files\Export</td>
</tr>
</tbody>
</table>

   Your Export screen should look like this:

   ![Export Screen Screenshot]

---

**QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence Experiments**
Your exported file when opened in Notepad should look like this:
A
adjusting analysis settings 43
adjusting parameters, re-analyzing own experiments 43
Advanced settings tab 46
Algorithm Settings, Baseline Threshold 44
ambient temperature 19
amplification 6
amplification plot
amplification efficiency 13, 46
assessing amplification results 29
reviewing baseline values 30
reviewing outliers 32
reviewing threshold values 31
tips for analyzing own experiment 32
viewing 20, 30
AMPNC flag 42
analysis data
amplification 7
post-PCR read 7
pre-PCR read 7
analysis settings 43
Advanced Settings 43
Call Settings 43
C<sub>T</sub> Settings 43
Flag Settings 43
Analyze
Amplification Plot 29
Multicomponent Plot 36
Presence/Absence Plot 27
QC Summary 40
Raw Data Plot 38
Well Table 33
Auto Export 47
Automatic Baseline, advanced settings 46
Automatic Threshold 45
B
BADROX flag 41
BLFAIL flag 42
Blocked IPC 29
Blocked IPC Control 34
C
Call Settings tab 44
cocktail mix 15, 16
C<sub>T</sub> settings 44
algorithm settings 44
data step, selecting 44
default 44
tab 44	
target 45
cycle number 30
D
data collection, type
end-point PCR data 5
real-time PCR data 5
designing experiment
assigning targets and samples 11
defining experiment properties 9
defining targets and samples 10
setting up run method 12
dye accuracy
irregularities in the signal 38
negative control wells 38
passive reference 38
reporter dye 38
E
end-point PCR data 5
example experiment 7
experiment properties, defining 9
EXPFAIL flag 42
Export 47
F
Flag Settings tab 45
flags, QC
AMPNC 42
BADROX 41
BLFAIL 42
CTFAIL 42
EXPFAIL 42
NOAMP 41
NOISE 42
NOSIGNAL 42
OFFSCALE 41
SPIKE 42
THOLDFAIL 42
Index

I
instrument run
   amplification 6
   post-PCR read 6
   pre-PCR read 6
IPC
   failed 7
   succeeded 7
IPC setup, well type
   negative control-blocked IPC wells 6
   negative control-IPC wells 6
   unknown-IPC wells 6
irregular amplification 29

M
multicomponent plot
   confirming dye signal 36
   tips for analyzing own experiment 38
   viewing 36

N
negative control-blocked IPC wells 6
negative control-IPC wells 6
negative controls 6
no IPC 6
   well type, negative controls 6
   well type, unknown wells 6
NOAMP flag 41
NOISE flag 42
NOSIGNAL flag 42

O
OFFSCALE flag 41
outliers 29

P
passive reference 29
PCR reactions, type
   IPC setup 6
   no IPC, singleplex setup 6
post-PCR read 6, 29
post-PCR read analysis data
   absence 7
   presence 7
   unconfirmed 7
preparing reactions
   reaction mix 15
   reaction plate 17
   required materials 15
pre-PCR read 6, 29
Pre-processing flag
   OFFSCALE 41
presence/absence calls 29
Presence/Absence experiments
   analysis, about 7
   instrument run, about 6
   overview 5
   PCR reactions, setting up 6
presence/absence plot
   tips for viewing own experiment 29
   viewing and assessing 27
   views, absence calls only 27
   views, all calls 27
   views, presence calls only 27
   views, unconfirmed calls 27
Primary analysis flags
   BADROX 41
   BLFAIL 42
   CTFAIL 42
   EXPFAIL 42
   NOAMP 41
   NOISE 42
   NOSIGNAL 42
   SPIKE 42
   THOLDFAIL 42

Q
QC Summary, reviewing flags 40

R
raw data plot
   determining signal accuracy 38
   tips for analyzing own experiment 40
   viewing 38
reaction mix
   components 15
   preparing reactions 15
reactions, assembling materials for 15
real-time PCR data 5
replicate group 39
review results 27
run

Quinstudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Presence/Absence Experiments
monitoring 19
starting 19
run method
  reaction volume per well 12
  setting up 12
  thermal profile 12
  viewing 21
Run screen
  Amplification Plot 20
  Run Method 21
  Temperature Plot 20
  View Run Data 21

S
samples, defining 10
Secondary analysis flags
  AMPNC 42
  setting up PCR reactions 6
  show controls 27
  show IPC 27
  singleplex setup 6
  SPIKE flag 42

T
targets and samples, assigning 11
targets, defining 10
temperature plot, viewing 20
THOLDFAIL flag 42
tips for viewing presence/absence plot
  control well calls 29
  IPC calls 29
  IPC threshold 29
  target calls 29
  target threshold 29
touchscreen, running the experiment from
  Experiment View 22
  Time View 23

U
unconfirmed calls 28
unknown wells 6
unknown-IPC wells 6

W
well table
  tips for analyzing own experiment 36
For Research Use Only. Not for use in diagnostic procedures.
CHAPTER 1  About Melt Curve Experiments ............................... 5
  Overview ........................................................................... 5
  About the Melt Curve reactions ........................................ 5
  About the example experiment ......................................... 6

CHAPTER 2  Design the Experiment ................................. 7
  Define the experiment properties ..................................... 7
  Define targets and samples .............................................. 8
  Assign targets and samples ............................................. 9
  Set up the run method ..................................................... 10
    Set the thermal profile ................................................ 10
    Edit the ramp increment .............................................. 10
  For more information ................................................... 11

CHAPTER 3  Prepare the Reactions .............................. 13
  Assemble required materials ......................................... 13
  Prepare the sample dilutions .......................................... 13
  Prepare the reaction mix ("cocktail mix") ......................... 14
    Procedure ..................................................................... 14
    Calculations ............................................................... 14
  Prepare the reaction plate .............................................. 14
  For more information ................................................... 15

CHAPTER 4  Run the Experiment ................................. 17
  Start the run ................................................................... 17
  Monitor the run ............................................................. 17
  From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software .............................................. 18
  From the QuantStudio™ 6 or 7 Instrument touchscreen .......... 20

CHAPTER 5  Review Results and Adjust Experiment Parameters .. 23
  Section 5.1 Review Results ............................................. 25
    Analyze the example experiment .................................. 25
    View the Melt Curve Plot ............................................ 25
      Purpose ........................................................................ 25
      To view and assess the Melt Curve ............................... 25
      Tips for viewing melt curves in your own experiments ..... 26
    Identify well problems using the Well Table .................. 27
      Example experiment values and flags .......................... 27
      View the well table .................................................... 27
## Tips for viewing well tables your own experiments

- Confirm accurate dye signal using the Multicomponent Plot
- Purpose
- View the Multicomponent Plot
- Tips for confirming dye accuracy in your own experiment
- Determine signal accuracy using the Raw Data Plot
- About the example experiment
- View the Raw Data Plot
- Tips for determining signal accuracy in your own experiments
- Review the flags in the QC Summary
- View the QC Summary
- Possible flags
- For more information

### Section 5.2 Adjust parameters for re-analysis of your own experiments

- Adjust analysis settings
- View the analysis settings
- Adjust analysis settings
- For more information

#### CHAPTER 6 Export Experiment Results

- Index
About Melt Curve Experiments

This chapter covers:

- Overview ................................................................. 5
- About the Melt Curve reactions .............................. 5
- About the example experiment ............................. 6

**IMPORTANT!** First-time users of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, please read Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments* and Booklet 7, *QuantStudio™ 6 and 7 Flex Real-Time PCR System Software - Appendixes* of this binder thoroughly. The booklet provides information and general instructions that are applicable to all the experiments described in this binder.

**Note:** For more information about any of the topics discussed in this guide, access the Help from within QuantStudio™ 6 and 7 Flex Real-Time PCR System Software by pressing F1, clicking Help in the toolbar, or selecting Help → QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Help.

**Overview**

A Melt Curve, also known as dissociation curve, is a plot of data collected during the Melt Curve stage of an experiment. Melt Curve experiments are performed to determine the melting temperature (Tm) of a target nucleic acid sequence or to identify nonspecific PCR amplification.

Melting temperature (Tm) is the temperature at which 50% of the target DNA is double-stranded and 50% is dissociated into single-stranded DNA.

The melting temperature and non-specific PCR amplification can be identified as peaks in the melt curve stage of an experiment.

**About the Melt Curve reactions**

With Melt Curve experiments, the reactions consist of completed PCR reactions that contain amplified products and SYBR® Green dye to detect double-stranded DNA.

The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software detects the number of fluorescence peaks, determines the melting temperature (Tm) for each peak, and plots the results in a melt curve.

The fluorescence data collected during the QuantStudio™ 6 or 7 Instrument run are stored in an experiment data file (*.eds).
There are two types of reactions in a Melt Curve experiment:

- **Unknowns** - Wells containing PCR product with unknown melting temperature(s).
- **Negative controls** - Wells containing buffer or water instead of sample. Negative controls should contain no double-stranded DNA.

**About the example experiment**

To illustrate how to perform Melt Curve experiments, this guide leads you through the process of designing and performing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with a QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

The objective of the example Melt Curve experiment is to investigate the melting temperature of Target 1, and verify that no extraneous peaks appear. The SYBR Green reagent is used to detect the melting temperature stage.

**Note:** The example experiment performs a melt curve analysis on PCR products from a PCR performed on the QuantStudio™ 6 or 7 Instrument or on another thermal cycler.
Define the experiment properties

Click **Experiment Setup  ▶ Experiment Properties** to create a new experiment in the QuantStudio™ 6 and 7 Flex Software. Enter:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Name</td>
<td>QuantStudio_384-Well_SYBR_Green_Melt_Example</td>
</tr>
<tr>
<td>Barcode</td>
<td>Leave field empty</td>
</tr>
<tr>
<td>User Name</td>
<td>Example User</td>
</tr>
<tr>
<td>Comments</td>
<td>Melt Curve example</td>
</tr>
<tr>
<td>Instrument type</td>
<td>QuantStudio™ 6 Flex System</td>
</tr>
<tr>
<td>Block</td>
<td>384-Well Block</td>
</tr>
<tr>
<td>Experiment Type</td>
<td>Melt Curve</td>
</tr>
<tr>
<td>Reagents</td>
<td>SYBR® Green Reagents</td>
</tr>
<tr>
<td>Ramp speed</td>
<td>Standard</td>
</tr>
<tr>
<td>Include PCR</td>
<td>Unchecked</td>
</tr>
<tr>
<td>Reagent information</td>
<td>NA</td>
</tr>
</tbody>
</table>

Save the experiment.
Your Experiment Properties screen should look like this:

**Define targets and samples**

Click Define to access the Define screen. Enter:

1. **Targets**

<table>
<thead>
<tr>
<th>Target Name</th>
<th>Reporter</th>
<th>Quencher</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target 1</td>
<td>SYBR</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

2. **Samples**

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample 1</td>
<td></td>
</tr>
</tbody>
</table>

3. Dye to be used as a Passive Reference
   ROX

4. Custom Task Name
   Not applicable
Assign targets and samples

Click Assign to access the Assign screen. Enter the targets and samples:

<table>
<thead>
<tr>
<th>Target Name</th>
<th>Sample</th>
<th>Well Number</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYBR</td>
<td>Sample 1</td>
<td>A1 - P24 (Columns 1 - 24)</td>
<td>Unknown</td>
</tr>
</tbody>
</table>

Your Assign screen should look like this:
Set up the run method

Set the thermal profile

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View tab. Enter:

- Reaction Volume Per Well: 20 µL
- Thermal Profile

<table>
<thead>
<tr>
<th>Stage</th>
<th>Step</th>
<th>Ramp rate</th>
<th>Temperature</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Melt Curve Stage</td>
<td>Step 1</td>
<td>1.6°C/s</td>
<td>95°C</td>
<td>15 seconds</td>
</tr>
<tr>
<td></td>
<td>Step 2</td>
<td>1.6°C/s</td>
<td>60°C</td>
<td>1 minute</td>
</tr>
<tr>
<td></td>
<td>Step 3 (Dissociation)</td>
<td>0.05°C/s</td>
<td>95°C</td>
<td>15 seconds</td>
</tr>
</tbody>
</table>

Edit the ramp increment

Edit the ramp increment for a melt curve (dissociation) step.

1. Select a melt curve ramp increment method:
   - **Step and Hold** – Increases or decreases the ramp temperature in 0.1°C increments over the time (duration) for the melt curve ramp.
   - **Continuous (default)** – Increases or decreases the ramp rate in 0.005°C per second increments.

2. If you selected the Step and Hold ramp increment method, edit the melt curve ramp time:
   - To increase or decrease the time in 1-minute or 1-second increments, click the **Step and Hold** field, select the minutes or seconds, then use the up or down arrow keys or click the up or down buttons in the field until you reach the desired time.
   - To enter the desired time, click the **Step and Hold** field, select the minutes or seconds, then enter the desired time.

3. Edit the melt curve ramp increment:
   - To increase or decrease the ramp increment, click the melt curve (dissociation) ramp increment in the thermal profile, then use the up or down arrow keys or click the up or down buttons in the field until you reach the desired value.
   - To enter the desired ramp increment, click the melt curve (dissociation) ramp increment in the thermal profile, select the value in the field, then enter the desired value.

**Note:** To view the maximum and minimum allowed values, place the cursor over melt curve (dissociation) ramp increment in the thermal profile and wait for the tooltip to pop up.
Your Run Method screen should look like this:

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to</th>
<th>Publication number</th>
</tr>
</thead>
</table>
| Consumables               | Chapter 1 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments  
Appendix A in Booklet 7, QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments - Appendixes                                | 4489822            |
| Using Alternative Setup   | Chapter 3 in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments                                                                                | 4489822            |
Prepare the Reactions

This chapter explains how to prepare the reactions for running a PCR prior to running a Melt Curve.

To perform a Melt Curve experiment without running a PCR, use the reaction plate containing the PCR product.

Note: The example experiment performs a melt curve analysis on PCR products from a PCR performed on the QuantStudio™ 6 or 7 Instrument or on another thermal cycler.

This chapter covers:

■ Assemble required materials .................................................. 13
■ Prepare the sample dilutions .................................................. 13
■ Prepare the reaction mix (“cocktail mix”). ................................. 14
■ Prepare the reaction plate ...................................................... 14
■ For more information. ........................................................... 15

Assemble required materials

- Items listed in Booklet 1, Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments
- Sample 1
- Example experiment reaction mix components:
  - Power SYBR® Master Mix
  - Target - Assay Mix Forward primer (10 µM)
  - Target - Assay Mix Reverse primer (10 µM)

Prepare the sample dilutions

The stock concentration of each sample is 100 ng/µL. After you dilute the sample according to the Sample Dilutions Calculations table, the sample will have a concentration of 10 ng/µL. Add 2 µL to each reaction.

<table>
<thead>
<tr>
<th>Sample name</th>
<th>Stock concentration (ng/µL)</th>
<th>Sample volume (µL)</th>
<th>Diluent volume (µL)</th>
<th>Total volume of diluted sample (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample 1</td>
<td>100.0</td>
<td>2</td>
<td>18</td>
<td>20</td>
</tr>
</tbody>
</table>
Chapter 3  Prepare the Reactions

Prepare the reaction mix (‘cocktail mix’)  

The following table lists the universal assay conditions [volume and final concentration for using the Power SYBR Master Mix (2X)].

<table>
<thead>
<tr>
<th>Reaction Component</th>
<th>Volume for 1 reaction (µL)</th>
<th>Volume for 384 reactions + 10% excess (µL) = 424 reactions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power SYBR®Green PCR Master Mix (2X)</td>
<td>10</td>
<td>4240</td>
</tr>
<tr>
<td>Forward primer (10 µM)</td>
<td>0.1</td>
<td>42.4</td>
</tr>
<tr>
<td>Reverse primer (10 µM)</td>
<td>0.1</td>
<td>42.4</td>
</tr>
<tr>
<td>Water</td>
<td>7.8</td>
<td>3307.2</td>
</tr>
<tr>
<td>Total reaction mix volume</td>
<td>18</td>
<td>7632</td>
</tr>
</tbody>
</table>

Procedure  
1. Label an appropriately sized tube for the reaction mix: Power SYBR Reaction Mix.  
2. Add the required volume of each cocktail mix component to the tube.  
3. Mix the cocktail thoroughly by gently pipetting up and down several times, then cap the tube.  
4. Centrifuge the tube briefly to remove air bubbles.  
5. Place the cocktail mix on ice until you prepare the reaction plate.

Calculations  
Determine the quantity of primer to be added to the reaction mix by performing the following calculation:

\[
\text{Concentration (initial) } \times \text{ Volume (primer stock) } \times \text{ Concentration (final) } \times \text{ Volume (final reaction) } = \text{ total volume for 1 reaction} \\
(10 \, \mu\text{M}) \times (V1) = (0.05 \, \mu\text{M}) (20 \, \mu\text{L}) \\
V1 = (0.05 \times 20) / 10 = 0.1
\]

Prepare the reaction plate  
1. Add reaction mix and sample to a tube.  
   a. To an appropriately sized tube, add the volumes of reaction mix and sample listed below.

<table>
<thead>
<tr>
<th>Tube</th>
<th>Unknown reaction</th>
<th>Reaction mix</th>
<th>Reaction mix volume (µL)</th>
<th>Sample</th>
<th>Sample volume (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Target 1</td>
<td>Power SYBR reaction mix</td>
<td>7632</td>
<td>Sample 1</td>
<td>848</td>
</tr>
</tbody>
</table>
b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

2. Pipet 20 µL of the unknown (sample) reaction to each well in the reaction plate.

3. Seal the reaction plate with optical adhesive film.

4. Centrifuge the reaction plate briefly to remove air bubbles.

5. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the reaction plate again at a higher speed and for a longer period of time.

6. Until you are ready to perform the PCR run, place the reaction plate at 4°C, in the dark.

7. Run the PCR.

8. After the PCR is completed, use the same reaction plate containing the PCR product to run the Melt Curve as described in Chapter 4.

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning the reaction plate components</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
<tr>
<td>Sealing the reaction plate</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Chapter 3  Prepare the Reactions
For more information
Run the Experiment

This chapter explains how run the example experiment on the QuantStudio™ 6 or 7 Instrument.

This chapter covers:
- Start the run.......................... 17
- Monitor the run......................... 17

**IMPORTANT!** Run the experiment at the same ambient temperature at which you calibrated the instrument. Extreme variations in ambient temperature can affect the heating and cooling of the instrument and influence experimental results.

**IMPORTANT!** Do not attempt to open the access door during the run. The door is locked while the QuantStudio™ 6 or 7 Instrument is in operation.

### Start the run

1. Open the Melt Curve example file that you created using instructions in Chapter 2.

   **IMPORTANT!** The example experiment includes the melt curve analysis of a PCR product from PCR on the QuantStudio™ 6 or 7 Instrument, or another thermal cycler. To run a Melt Curve on the example file you created in Chapter 2, ensure that PCR has already been performed on the reaction plate you load into the instrument. Absence of the PCR product will lead to no results in the Dissociation Step of the Melt Curve Stage.

2. Load the reaction plate, containing the PCR product, into the instrument.

3. Start the run.

### Monitor the run

Monitor the example experiment run:
- From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software using the Run screen, while the experiment is in progress.
- From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software (to monitor an experiment started from another computer or from the QuantStudio™ 6 or 7 Instrument touchscreen).
- From the QuantStudio™ 6 or 7 Instrument touchscreen.
From the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software

1. In the Instrument Console screen, select the instrument icon.
2. Click Manage Instrument or double-click on the instrument icon.
3. On the Manage Instrument screen, click Monitor Running Instrument to access the Run screen.

View the Melt Curve

You can view the progress of the run in real time. During the run, periodically view all the three plots available from the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software for potential problems.

Click Melt Curve from the Run Experiment Menu, select the Plate Layout tab, then select the wells to view.

The following is an image of the Melt Curve as it appears at the end of the example experiment.
View the Temperature Plot

Click **Temperature Plot** from the Run Experiment Menu.

The following is an image of the Temperature Plot screen as it appears during the example experiment.

**Note:** The Sample temperature displayed in the Current Temperatures group is an estimated value.

View the Run Method

Click **Run Method** from the Run Experiment Menu.

The following is an image of the Run Method screen as it appears in the example experiment.
View run data

Click View Run Data from the Run Experiment Menu.

The following is an image of the View Run Data screen as it appears in the example experiment.

From the QuantStudio™ 6 or 7 Instrument touchscreen

You can also view the progress of the run from the QuantStudio™ 6 or 7 Instrument touchscreen.

The following are images of the Run Method screen on the QuantStudio™ 6 or 7 Instrument touchscreen:
Chapter 4 Run the Experiment

Monitor the run

Time View

Run Started: July 06 2013 - 05:48PM
Reaction Volume: 20 μL
Sample: 95.0 °C
Heated Cover (Set Point): 105.0 °C [105.0 °C]
Stage / Step / Cycle: 1 / 2 / 1

01:31:52

Remaining Time
Elapsed Time

Heated cover reached target temperature.
In Section 5.1 of this chapter you review the analyzed data using several of the analysis screens and publish the data. Section 5.2 of this chapter walks you through the process of modifying experiment parameters to troubleshoot problems with experiment results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ................................................................. 25
- Analyze the example experiment ................................................. 25
- View the Melt Curve Plot ............................................................. 25
- Identify well problems using the Well Table ................................. 27
- Confirm accurate dye signal using the Multicomponent Plot ........... 29
- Determine signal accuracy using the Raw Data Plot ....................... 30
- Review the flags in the QC Summary ............................................. 32
- For more information................................................................. 33

Section 5.2 Adjust parameters for re-analysis of your own experiments .... 35
- Adjust analysis settings ............................................................... 35
- For more information................................................................. 38
Chapter 5 Review Results and Adjust Experiment Parameters
Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.
2. Click Analyze. The software analyzes the data using the default analysis settings.
   Note: You can also access the experiment to analyze from the Home screen.

View the Melt Curve Plot

View the Melt Curve Plot as the Derivative Reporter (-Rn) versus the Temperature Plot generated by the target.

The Melt Curve screen displays the melt curve of the targets in the selected wells. Use the Melt Curve plots to confirm the results of the experiment:

- Normalized Reporter (Rn) vs. Temperature – This plot displays the fluorescence signal from the reporter dye normalized to the fluorescence signal of the passive reference. You can use this plot to see the change in Rn with change in the temperature. You cannot use this plot to determine the Tm of the target.
- Derivative Reporter (-Rn) vs. Temperature – This plot displays the derivative reporter signal in the y-axis. The peaks in the plot indicate significant decrease in SYBR® Green signal, and therefore the Tm of the target.

Purpose

The purpose of viewing the Melt Curve Plot for the example experiment is to review the melting temperature of the target.

To view and assess the Melt Curve

1. From the Experiment menu pane, select Analysis » Melt Curve Plot.
   Note: If no data are displayed, click Analyze.
2. Enter the Plot Settings:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot</td>
<td>Derivative Reporter</td>
</tr>
<tr>
<td>Target</td>
<td>All</td>
</tr>
<tr>
<td>Plot Color</td>
<td>Target</td>
</tr>
<tr>
<td></td>
<td>[This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.] Check (default)</td>
</tr>
</tbody>
</table>
The following is an image of the Melt Curve for the example experiment:

**Tips for viewing melt curves in your own experiments**

When you analyze your own Melt Curve experiment, look for wells with multiple peaks, indicating non-specific amplifications or primer dimer formation.

If your experiment does not amplify properly or indicates non-specific amplification, troubleshoot by manually adjusting the Melt Curve settings (see “Adjust analysis settings” on page 35).
Identify well problems using the Well Table

Review the details of the experiment results in the well table and identify any flagged wells. The well table displays the assay-specific setup and analysis properties for the experiment in a tabular format.

Example experiment values and flags

For the example experiment, confirm that no wells of the reaction plate triggered QC flags.

View the well table

1. Select the Well Table tab.
2. Click the Flag column header to sort the data so that the wells that triggered flags appear at the top of the table.
3. Confirm the integrity of the controls:
   a. From the Group By menu, select Task to organize the table rows by their function on the reaction plate.
   b. Confirm that each of the controls do not display flags.

The following is an image of the well table of the example Melt Curve experiment.

The following table gives the description of each column in the well table.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>The position of the well on the reaction plate.</td>
</tr>
<tr>
<td>Omit</td>
<td>A check mark indicates that the well has been removed from the analysis.</td>
</tr>
</tbody>
</table>
Chapter 5  Review Results and Adjust Experiment Parameters

Identify well problems using the Well Table

Tips for viewing well tables your own experiments

When you analyze your own experiment:

- Review the data for the Unknown samples. For each row that displays ▲ in the Flag column, note the data and the flag(s) triggered by the associated well.

- Select areas of the table or wells of a specified type by:
  - Left-clicking the mouse and dragging across the area you want to select an area of the table.
  - Selecting Sample, Target, or Task from the Select Items menu in the Well Table tab, then selecting the sample, target, or task name from the second Select Items menu to select wells of a specific type using the well-selection tool.

- Group the rows of the plate layout by selecting an option from the Group By menu. You can then collapse or expand the lists either by clicking the +/- icon next to individual lists, or by clicking ▼ Collapse All or ▼ Expand All.

- Omit a well from the analysis by selecting the Omit check box for that well. To include the well in the analysis, deselect the Omit check box.

Note:  You must reanalyze the experiment each time you omit or include a well.
Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

**Purpose**

In the Melt Curve example experiment, you review the Multicomponent Plot screen for:

- ROX™ dye (passive reference)
- SYBR® dye (reporter)
- Spikes, dips, and/or sudden changes

**View the Multicomponent Plot**

1. From the Experiment Menu pane, select **Analysis › Multicomponent Plot**.
   
   **Note**: If no data are displayed, click **Analyze**.

2. Display the unknown wells in the plate layout to display the corresponding data in the Multicomponent Plot screen:
   
   a. Click the **Plate Layout** tab.
   
   b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen.

   **Note**: If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select **Dye**.

4. Click **Show a legend for the plot** (default).
   
   **Note**: This is a toggle button. When the legend is displayed, the button changes to **Hide the plot legend**.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal remains constant throughout the PCR process; a constant ROX dye signal indicates typical data.

6. Check the SYBR® dye signal. In the example experiment, because the PCR run has already been completed, the SYBR® dye signal shows gradual decrease throughout the run and a sudden dip in the fluorescence at one point; the sudden drop in the SYBR® dye signal indicates the melting temperature of the target.
Chapter 5  
Review Results and Adjust Experiment Parameters

Determine signal accuracy using the Raw Data Plot

When you analyze your own Melt Curve experiment, look for:

- **Passive reference** – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.

- **Reporter dye** – The reporter dye fluorescence level should display a flat region corresponding to the baseline, followed by a rapid rise in fluorescence as the amplification proceeds. If the Melt Curve is being performed post-PCR, then there should be a gradual decrease in fluorescence and a sudden dip indicating the melting temperature of the target.

- **Irregularities in the signal** – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.

### Tips for confirming dye accuracy in your own experiment

1. From the Experiment Menu pane, select **Analysis ‣ Raw Data Plot**.
   
   **Note:** If no data are displayed, click **Analyze**.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.
3. Click ![Show a legend for the plot](default). The legend displays the color code for each row of the reaction plate (see the legend in the Raw Data Plot shown below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 130. In the example experiment, the signal from filter 1, which corresponds to the SYBR® dye filter, is stable throughout.

**Note:** The readings shown below are from the example experiment. Actual results will vary with individual experiment setup.

**Note:** The cycle number in the Melt Curve represents the number of data collection points for that experiment.

The following is an image of the Raw Data plot for the example experiment:

![Raw Data Plot](image)

The filters used for the example experiment are:

<table>
<thead>
<tr>
<th>Emission Filter</th>
<th>Excitation Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>x1470a2050</td>
<td>r1520a2050</td>
</tr>
<tr>
<td>x2720a2050</td>
<td>r2550a2050</td>
</tr>
<tr>
<td>x3550a2050</td>
<td>r1482a1497</td>
</tr>
<tr>
<td>x590a2152</td>
<td>r571a2152</td>
</tr>
</tbody>
</table>

---

**QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide for Melt Curve Experiments**
Tips for determining signal accuracy in your own experiments

When you analyze your own Melt Curve experiment, look for the following in each filter:

- Characteristic signal growth
- No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the QuantStudio™ 6 and 7 Flex Software flags, including the flag frequency and location for the open experiment.

View the QC Summary

1. From the Experiment Menu pane, select Analysis ➤ QC Summary.

   **Note:** If no data are displayed, click Analyze.

2. Review the Flags Summary.

   **Note:** A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment. If the frequency is >0, the flag appears somewhere in the experiment; the well position is listed in the Wells column.

   In the example experiment, there are no flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed information about the flag. In the example experiment, the Frequency column displays 0 for the three flags NOSIGNAL, OFFSCALE, and MTP.

4. *(Optional)* For those flags with frequency >0, click the troubleshooting link to view information on correcting the flag.

   The following is an image of the QC Summary for the example experiment:

Possible flags

For Melt Curve experiments that do not include amplification, the flags listed below may be triggered by the experiment data.
### Flag Description

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pre-processing flag</strong></td>
<td></td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td><strong>Primary analysis flag</strong></td>
<td></td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td><strong>Secondary analysis flag</strong></td>
<td></td>
</tr>
<tr>
<td>MTP</td>
<td>Multiple Tm peaks</td>
</tr>
</tbody>
</table>

For Melt Curve experiments that include amplification, the flags listed below may be triggered by the experiment data.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pre-processing flag</strong></td>
<td></td>
</tr>
<tr>
<td>OFFSCALE</td>
<td>Fluorescence is offscale</td>
</tr>
<tr>
<td><strong>Primary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>BADROX</td>
<td>Bad passive reference signal</td>
</tr>
<tr>
<td>NOAMP</td>
<td>No amplification</td>
</tr>
<tr>
<td>NOISE</td>
<td>Noise higher than others in plate</td>
</tr>
<tr>
<td>SPIKE</td>
<td>Noise spikes</td>
</tr>
<tr>
<td>NOSIGNAL</td>
<td>No signal in well</td>
</tr>
<tr>
<td>EXPFAIL</td>
<td>Exponential algorithm failed</td>
</tr>
<tr>
<td>BLFAIL</td>
<td>Baseline algorithm failed</td>
</tr>
<tr>
<td>THOLDFAIL</td>
<td>Thresholding algorithm failed</td>
</tr>
<tr>
<td>CTFAIL</td>
<td>$C_T$ algorithm failed</td>
</tr>
<tr>
<td><strong>Secondary analysis flags</strong></td>
<td></td>
</tr>
<tr>
<td>MTP</td>
<td>Multiple Tm peaks</td>
</tr>
<tr>
<td>OUTLIERRG</td>
<td>Outlier in replicate group</td>
</tr>
<tr>
<td>AMPNC</td>
<td>Amplification in negative control</td>
</tr>
<tr>
<td>HIGHSD</td>
<td>High standard deviation in replicate group</td>
</tr>
</tbody>
</table>

**For more information**

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to...</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishing data</td>
<td>Chapter 2 in Booklet 1, <em>Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments</em></td>
<td>4489822</td>
</tr>
</tbody>
</table>
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the Melt Curve and flags.

If the default analysis settings in the QuantStudio™ 6 and 7 Flex Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.
2. Click Analysis ▶ Analysis Settings to open the Analysis Settings dialog box.
   In the example experiment, the default analysis settings are used for each tab:
   - Melt Curve Settings
   - CΤ Settings
   - Flag Settings
   - Advanced Settings

   Note: The CΤ Settings and Advanced Settings tabs appear in the Analysis Settings dialog box only if the Melt Curve experiment you are performing includes the PCR process.

   Note: Select the Include PCR check box on the Experiment Properties screen to include amplification in your Melt Curve experiment.

The following is an image of the Analysis Settings dialog box for a Melt Curve experiment:
3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” below).

**Note:** You can save the changes to the analysis settings to the Analysis Settings Library for later use. For more information, see About the Analysis Settings Library in Booklet 1, *Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.*

4. Click **Apply Analysis Settings** to apply the current analysis settings.

**Note:** You can go back to the default analysis settings, by clicking **Revert to Default Analysis Settings**.

---

**Adjust analysis settings**

You may change the following settings:

**Melt Curve Settings**

Use this tab to:

- Enable or disable multi-peak calling.
  - Select the **Enable the Multi-Peak Calling** check box if you expect to amplify more than 1 PCR product and you want to determine the Tm for more than one peak.
  - Deselect the **Enable the Multi-Peak Calling** check box if you expect to amplify 1 PCR product and you do not want to determine the Tm for more than one peak.

- Enter a value (in percentage) for the peak level relative to the dominant peak.
  Specify a fractional level value as the peak detection threshold. The detected peaks are measured relative to the height of the tallest peak, which has a perfect fractional level 100%. The default value is initially set at 10%.
  For example, if you set a fractional level detection threshold value at 40, then only peaks above 40% of the tallest peak are reported and the peaks at lower height are regarded as noise.

**C<T>Settings**

- **Data Step Selection**
  Use this feature to select one stage/step combination for C<T> analysis when there is more than one data collection point in the run method.

- **Algorithm Settings**
  Use the Baseline Threshold algorithm to determine the C<T> values.
  The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline component and sets a fluorescent threshold in the exponential region for gene quantification.

- **Default C<T>Settings**
  Use the default C<T> settings feature to calculate C<T> for the targets that do not have custom settings. To edit the default settings, click **Edit Default Settings**.
Section 5.2 Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

- **C<sub>T</sub> Settings for Target**
  When you manually set the threshold and baseline, Life Technologies recommends:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Enter a value for the threshold so that the threshold is:</td>
</tr>
<tr>
<td></td>
<td>• Above the background.</td>
</tr>
<tr>
<td></td>
<td>• Below the plateau and linear regions of the amplification curve.</td>
</tr>
<tr>
<td></td>
<td>• Within the exponential phase of the amplification curve.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Select the Start Cycle and End Cycle values so that the baseline ends before significant fluorescent signal is detected.</td>
</tr>
</tbody>
</table>

**Note:** This setting is applicable only to the Baseline Threshold algorithm.

**Note:** Selecting Automatic Threshold implies selection of automatic setting of the baseline. However, if Automatic Threshold is deselected, then you can choose between setting the baseline either automatically or manually.

**Flag Settings**

Use the Flag Settings tab to:

- Adjust the sensitivity so that more wells or fewer wells are flagged.
- Change the flags that are applied by the QuantStudio™ 6 and 7 Flex Software.

To adjust the flag settings:

1. In the Use column, select the check boxes for flags to apply during analysis.
2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying the flag.
   - **Note:** If you choose to adjust the setting for applying a flag, make minor adjustments as you evaluate the appropriate setting.
3. In the Reject Well column, select the check boxes if you want the software to reject wells with the flag.
   - **Note:** After you have rejected the flagged wells, analysis results depend on factors such as the experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments using the Standard Deviation calculations may change the result of C<sub>T</sub> SD. For some flags, analysis results calculated before the well is rejected are maintained.
4. Click **Apply Analysis Settings** in the Analysis Settings dialog box. If the run status is complete, the data are reanalyzed.
The following is an image of the Flag Settings tab:

Advanced Settings

Use the Advanced Settings tab to change baseline settings well-by-well.

To use custom baseline settings for a well-target combination:

1. Select one or more well-target combinations in the table.
2. Deselect the **Use C_T Settings Defined for Target** check box.
3. Define the custom baseline settings:
   - For automatic baseline calculations, select the **Automatic Baseline** check box.
   - To define the baseline, deselect the **Automatic Baseline** check box, then enter the baseline start cycle and baseline end cycle.

For more information

<table>
<thead>
<tr>
<th>For more information on...</th>
<th>Refer to</th>
<th>Publication number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification efficiency</td>
<td><em>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note.</em></td>
<td>127AP05-03</td>
</tr>
</tbody>
</table>
Export Experiment Results

1. Open the Melt Curve example experiment file that you analyzed in Chapter 5.

2. In the Experiment Menu, click Export.
   
   **Note:** To export data automatically after analysis, select the Auto Export check box during experiment setup or before running the experiment. Auto export is unchecked for the example experiment.

3. Select QuantStudio™ 6 and 7 format.

4. Complete the Export dialog box as shown below:

<table>
<thead>
<tr>
<th>Field or Selection</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Data to export/Select Content</td>
<td>Results</td>
</tr>
<tr>
<td>Export Data To</td>
<td>One File</td>
</tr>
<tr>
<td>Export File Name</td>
<td>QuantStudio_384-Well_SYBR_Green_Melt_Example_data</td>
</tr>
<tr>
<td>File Type</td>
<td>*.txt</td>
</tr>
<tr>
<td>Export File Location</td>
<td>C:\AppliedBiosystems\QuantStudio 6 and 7 Flex Software\User Files\Export</td>
</tr>
</tbody>
</table>

Your Export screen should look like this:
Your exported file when opened in Notepad should look like this:

![Image of Notepad window showing exported data]

<table>
<thead>
<tr>
<th>Sample Target</th>
<th>Well</th>
<th>Well Position</th>
<th>Sample Name</th>
<th>Sample Color</th>
<th>Stigroup Name</th>
<th>Stigroup Color</th>
<th>Target Name</th>
<th>Target Color</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1 A1</td>
<td>Sample 1</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 1</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 A2</td>
<td>Sample 2</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 2</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 A3</td>
<td>Sample 3</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 3</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 A4</td>
<td>Sample 4</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 4</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 A5</td>
<td>Sample 5</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 5</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 A6</td>
<td>Sample 6</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 6</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7 A7</td>
<td>Sample 7</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 7</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 A8</td>
<td>Sample 8</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 8</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9 A9</td>
<td>Sample 9</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 9</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10 A10</td>
<td>Sample 10</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 10</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11 A11</td>
<td>Sample 11</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 11</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>12 A12</td>
<td>Sample 12</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 12</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>13 A13</td>
<td>Sample 13</td>
<td>&quot;R6G(0.375, 0.0)&quot;</td>
<td>Target 13</td>
<td>&quot;R6G(0.0, 0.75)&quot;</td>
<td>UNKOWN SYBR</td>
<td>None</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>
Index

A
adjusting analysis settings adjusting 35
adjusting parameters, re-analyzing own experiments 35
Advanced Settings tab 38
Algorithm Settings, Baseline Threshold 36
amplification efficiency 38
amplification, include PCR 35
amplified products 5
AMPNC flag 33
analysis settings 35, 36
Advanced Settings 35
CT Settings 35
Flag Settings 35
Melt Curve Settings 35
Analyze 25
Melt Curve Plot 25
Multicomponent Plot 29
QC Summary 32
Raw Data Plot 30
Auto Export 7, 39
Automatic Baseline 38
Automatic Threshold 37

B
BADROX flag 33
BLFAIL flag 33

C
cocktail mix 14
CT settings
algorithm settings 36
data step, selecting 36
default 36
target 37
CT Settings tab 36
CTFAIL flag 33

D
designing experiment
assigning targets and samples 9
defining experiment properties 7
defining targets and samples 8
setting up run method 10
dissociation curve 5
dye accuracy
irregularities in the signal 30
passive reference 30
reporter dye 30

E
Enable the Multi-Peak Calling 36
example experiment 6
experiment properties, defining 7
EXPFAIL flag 33
Export 39
extraneous peaks 6

F
Flag Settings tab 37
flags, QC
AMPNC 33
BADROX 33
BLFAIL 33
CTFAIL 33
EXPFAIL 33
HIGHSD 33
MTP 33
NOAMP 33
NOISE 33
NOSIGNAL 33
OFFSCALE 33
OUTLIERRG 33
SPIKE 33
THOLDFAIL 33
fluorescence peaks 5

H
HIGHSD flag 33

I
include amplification, Pre-processing flag
OFFSCALE 33
include amplification, Primary analysis flags
BADROX 33
BLFAIL 33
CTFAIL 33
EXPFAIL 33
NOAMP 33
NOISE 33
NOSIGNAL 33
SPIKE 33
Index

THOLDFAIL 33
include amplification, Secondary analysis flags
AMPNC 33
HIGHSD 33
MPT 33
OUTLIERRG 33

M
melt curve experiments
melt curve reactions 5
overview 5
Melt Curve Plot 18, 25
assessing 25
Derivative Reporter 25
Normalized Reporter 25
reactions type, negative controls 6
reactions type, unknowns 6
tips for analyzing own experiment 26
viewing 18, 25
Melt Curve Settings tab 36
melt curve stage 6
Melting temperature (Tm) 5
MTP flag 33
multicomponent plot
confirming dye accuracy 29
tips for analyzing own experiment 30
viewing 29

N
no PCR, Pre-processing flag
OFFSCALE 33
no PCR, Primary analysis flags
NOSIGNAL 33
no PCR, Secondary analysis flags
MPT 33
NOAMP flag 33
NOISE flag 33
NOSIGNAL flag 33
reaction mix 14
reaction plate 14
required materials 13
sample dilutions 13

Q
QC Summary 32
QC Summary, reviewing flags 32

R
ramp increment 10
editing 10
method, continuous (default) 10
method, step and hold 10
Raw Data Plot 30
raw data plot
determining signal accuracy 30
tips for analyzing own experiments 32
viewing 30
reaction mix
components 13
preparing reactions 14
reactions, assembling materials for 13
review results 25
run
monitoring 17
starting 17
run method
reaction volume per well 10
setting up 10
thermal profile 10
viewing 19
Run Screen
Melt Curve Plot 18
Run Method 19
Temperature Plot 19
View Run Data 20
Run screen 18

S
sample dilutions, preparing reactions 13
Sample temperature 19
samples, defining 8
single-stranded DNA 5
SPIKE flag 33

P
preparing reactions
**T**

- target DNA 5
- targets and samples
  - assigning 9
  - defining 8
- targets, defining 8
- temperature plot, viewing 19
- thermal profile, setting up 10
- THOLDFAIL flag 33
- touchscreen, running the experiment from
  - Experiment View 20
  - Time View 21
- troubleshooting
  - multiple peaks 26
  - non-specific amplification 26

**W**

- well table
  - identifying well problems 27
  - tips for viewing own experiments 28
  - viewing 27
- well table, column
  - Dyes 28
  - Flag 28
  - Omit 27
  - Sample Name 28
  - Target Name 28
  - Task 28
  - Tm1 28
  - Tm2 28
  - Tm3 28
  - Well 27
For Research Use Only. Not for use in diagnostic procedures.
Contents

APPENDIX A Ordering Information ........................................... 5
How to order from the Life Technologies website .................................. 6
Reagents and consumables .................................................................... 7
Calibration reagents and consumables .................................................. 7
Experiment consumables ..................................................................... 9
QuantStudio™ 6 or 7 Instrument accessories ......................................... 10
Experiment reagents .......................................................................... 11
General-use materials and consumables .............................................. 12

APPENDIX B Supplemental Information ............................................. 13
(Optional) Libraries for designing your own experiments ....................... 13
Dye library ....................................................................................... 13
Target, Sample, Control, and SNP Assay libraries ................................ 14
Run Method library ........................................................................... 14
Analysis Settings Library .................................................................... 15
Instrument Console ........................................................................... 17
Left panel ......................................................................................... 18
Right panel ....................................................................................... 18
Status icons ....................................................................................... 19
About the reagents ............................................................................ 20
TaqMan® Reagents ............................................................................ 20
SYBR® Green reagents ....................................................................... 20

Documentation and Support ................................................................. 23
Related documentation ....................................................................... 23
Other related documents ..................................................................... 24
Documents related to Standard Curve experiments ............................... 24
Documents related to Relative Standard Curve and Comparative C<sub>T</sub> experiments ......................................................... 24
Documents related to Genotyping experiments .................................... 24
Documents related to Presence/Absence experiments ......................... 25
How to obtain support ........................................................................ 25
Obtaining information from the Help system ...................................... 25
Limited Product Warranty ................................................................... 26

Glossary ............................................................................................ 27

Index ................................................................................................. 43
Ordering Information

This appendix covers:

- How to order from the Life Technologies website ........................................ 6
- Reagents and consumables ................................................................. 7
  Calibration reagents and consumables ............................................ 7
  Experiment consumables ............................................................. 9
  QuantStudio™ 6 or 7 Instrument accessories ................................. 10
  Experiment reagents ................................................................. 11
- General-use materials and consumables ................................. 12
How to order from the Life Technologies website

You can order materials accessories directly from the Life Technologies store over the internet.

**Note:** Product availability and pricing may vary according to your region or country. Online ordering through the Life Technologies store is not available in all countries. Contact your local Life Technologies representative for help.

To order through the website:

- Confirm that your computer has an Internet connection.
- We recommend the following browsers and Adobe® Acrobat® Reader® Software versions to use the Life Technologies website:

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Microsoft® Internet Explorer®</th>
<th>Apple® Safari®</th>
<th>Mozilla® Firefox®</th>
<th>Adobe® Acrobat® Reader®</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft® Windows®</td>
<td>v6.x or later</td>
<td>None†</td>
<td>v2.x or later</td>
<td>v4.0 or later</td>
</tr>
<tr>
<td>Macintosh®</td>
<td>None†</td>
<td>v2.0.4 or later</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

† Browser not available for this platform.

**Note:** Confirm that cookies and Javascript® are turned on for the website to function correctly.

To purchase reagents, accessories, and calibration kits:

1. Go to [www.lifetechnologies.com](http://www.lifetechnologies.com)
2. Under “I Want to Buy,” select the product of interest.
Reagents and consumables

The reagents and consumables listed below are required for calibrating and for performing experiments with the QuantStudio™ 6 and 7 Flex Software.

**Note:** For reagent or consumable shelf-life expiration date, see the package label.

### Calibration reagents and consumables

The following table shows the reagents and consumables required to calibrate and verify the performance of the QuantStudio™ 6 and 7 Instruments when run with the QuantStudio™ 6 and 7 Flex Software.

#### 384-well sample block

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
<th>Shelf-life at environmental temperature</th>
<th>Storage conditions (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>384-Well Spectral Calibration Plate with FAM™ Dye</td>
<td>4432271</td>
<td>Use the consumable by the expiration date mentioned on the package</td>
<td>−15°C to −25°C</td>
</tr>
<tr>
<td>384-Well Spectral Calibration Plate with VIC® Dye</td>
<td>4432278</td>
<td></td>
<td></td>
</tr>
<tr>
<td>384-Well Spectral Calibration Plate with ROX™ Dye</td>
<td>4432284</td>
<td></td>
<td></td>
</tr>
<tr>
<td>384-Well Spectral Calibration Plate with SYBR® Green Dye</td>
<td>4432290</td>
<td></td>
<td></td>
</tr>
<tr>
<td>384-Well Spectral Calibration Plate with TAMRA™ Dye</td>
<td>4432296</td>
<td></td>
<td></td>
</tr>
<tr>
<td>384-Well Spectral Calibration Plate with NED™ Dye</td>
<td>4432302</td>
<td></td>
<td></td>
</tr>
<tr>
<td>384-Well Region of Interest (ROI) and Background Plates</td>
<td>4432320</td>
<td></td>
<td></td>
</tr>
<tr>
<td>384-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes</td>
<td>4432308</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan® RNase P Fast 384-Well Instrument Verification Plate</td>
<td>4455280</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### 96-well [0.2 mL] sample block

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
<th>Shelf-life at environmental temperature</th>
<th>Storage conditions (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-Well Spectral Calibration Plate with FAM™ Dye</td>
<td>4432327</td>
<td>Use the consumable by the expiration date mentioned on the package</td>
<td>−15°C to −25°C</td>
</tr>
<tr>
<td>96-Well Spectral Calibration Plate with VIC® Dye</td>
<td>4432334</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Spectral Calibration Plate with ROX™ Dye</td>
<td>4432340</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Spectral Calibration Plate with SYBR® Green Dye</td>
<td>4432346</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Spectral Calibration Plate with TAMRA™ Dye</td>
<td>4432352</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Spectral Calibration Plate with NED™ Dye</td>
<td>4432358</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan® RNase P 96-Well Instrument Verification Plate</td>
<td>4432382</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Region of Interest (ROI) and Background Plates</td>
<td>4432364</td>
<td></td>
<td></td>
</tr>
<tr>
<td>96-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes</td>
<td>4432370</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Fast 96-well (0.1 mL) sample block

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
<th>Shelf-life at environmental temperature</th>
<th>Storage conditions (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast 96-Well Spectral Calibration Plate with FAM™ Dye</td>
<td>4432389</td>
<td>Use the consumable by the expiration date mentioned on the package</td>
<td>–15°C to –25°C</td>
</tr>
<tr>
<td>Fast 96-Well Spectral Calibration Plate with VIC® Dye</td>
<td>4432396</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast 96-Well Spectral Calibration Plate with ROX™ Dye</td>
<td>4432402</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast 96-Well Spectral Calibration Plate with SYBR® Green Dye</td>
<td>4432408</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast 96-Well Spectral Calibration Plate with TAMRA™ Dye</td>
<td>4432414</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast 96-Well Spectral Calibration Plate with NED™ Dye</td>
<td>4432420</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast 96-Well Region of Interest (ROI) and Background Plates</td>
<td>4432426</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast 96-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes</td>
<td>4432432</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan® RNase P Fast 96-Well Instrument Verification Plate</td>
<td>4351979</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Array card sample block

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
<th>Shelf-life at environmental temperature</th>
<th>Storage conditions (°C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array Card Spectral Dye Calibration Kit</td>
<td>4432376</td>
<td>Use the consumable by the expiration date mentioned on the package</td>
<td>–15°C to –25°C</td>
</tr>
<tr>
<td>Array Card RNase P Instrument Verification Kit</td>
<td>4432464</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** To prepare calibration plates, refer to the instrument user guide.

**Note:** The Array card sample block is applicable only to the QuantStudio™ 7 Flex System.
The following table shows the consumables required to perform experiments with the QuantStudio™ 6 and 7 Flex Software.

**96-well (0.2 mL) sample block**

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroAmp® Optical 8-Cap Strip</td>
<td>300 strips</td>
</tr>
<tr>
<td>MicroAmp® Optical 8-Tube Strip (0.2 mL)</td>
<td>125 strips</td>
</tr>
<tr>
<td>MicroAmp® Optical Tube without cap (0.2 mL)</td>
<td>2000 tubes</td>
</tr>
<tr>
<td>MicroAmp® 96-Well Tray/Retainer Set [Blue] (for 0.2 mL)</td>
<td>10 pairs</td>
</tr>
<tr>
<td>MicroAmp® Optical 96-Well Reaction Plate (0.2 mL)</td>
<td>10 plates</td>
</tr>
<tr>
<td>MicroAmp® Optical 96-Well Reaction Plate with Barcode (0.2 mL)</td>
<td>10 plates</td>
</tr>
</tbody>
</table>

**Fast 96-well (0.1 mL) sample block**

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroAmp® Fast 8-Tube Strip (0.1 mL)</td>
<td>125 strips</td>
</tr>
<tr>
<td>MicroAmp® Fast Reaction Tube with cap (0.1 mL)</td>
<td>1000 tubes</td>
</tr>
<tr>
<td>MicroAmp® 96-Well Tray [Black] (for 0.1 mL)</td>
<td>10 plates</td>
</tr>
<tr>
<td>MicroAmp® Fast Optical 96-Well Reaction Plate (0.1 mL)</td>
<td>10 plates</td>
</tr>
<tr>
<td>MicroAmp® Fast Optical 96-Well Reaction Plate with Barcode (0.1 mL)</td>
<td>10 plates</td>
</tr>
</tbody>
</table>

**Array card sample block**

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array Card</td>
<td>4-pack</td>
</tr>
<tr>
<td></td>
<td>1-pack</td>
</tr>
</tbody>
</table>

**Note:** The Array card sample block is applicable only to the QuantStudio™ 7 Flex System.

**Miscellaneous**

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroAmp® Multi-Removal Tool</td>
<td>1 tool</td>
</tr>
<tr>
<td>MicroAmp® Cap Installing Tool (Handle)</td>
<td>1 tool</td>
</tr>
</tbody>
</table>
QuantStudio™ 6 or 7 Instrument accessories

The accessories listed in the following table are for the QuantStudio™ 6 or 7 Instrument when run with the QuantStudio™ 6 and 7 Flex Software.

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>384-Well Plate/Array Card Heated Cover</td>
<td>4453555</td>
</tr>
<tr>
<td>384-Well Plate Sample Block</td>
<td>4453553</td>
</tr>
<tr>
<td>96-Well Plate Heated Cover</td>
<td>4453560</td>
</tr>
<tr>
<td>96-Well Plate Sample Block</td>
<td>4453556</td>
</tr>
<tr>
<td>Fast 96-Well Plate Heated Cover</td>
<td>4459838</td>
</tr>
<tr>
<td>Fast 96-Well Plate Sample Block</td>
<td>4453559</td>
</tr>
<tr>
<td>Array Card Buckets/Clip Set</td>
<td></td>
</tr>
<tr>
<td>1st Generation</td>
<td>4337762</td>
</tr>
<tr>
<td>2nd Generation</td>
<td>4442571</td>
</tr>
<tr>
<td>Array Card Sample Block</td>
<td>4453554</td>
</tr>
<tr>
<td>Array Card Staker/ Sealer</td>
<td>4331770</td>
</tr>
<tr>
<td>Handheld Barcode Scanner</td>
<td>4453271</td>
</tr>
</tbody>
</table>
## Experiment reagents

The following table lists the reagents that can be ordered for performing experiments with the QuantStudio™ 6 and 7 Flex Software.

<table>
<thead>
<tr>
<th>To perform</th>
<th>Recommended reagent kits</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse Transcription</td>
<td>SuperScript® VILO™ cDNA Synthesis Kit</td>
<td>4453650</td>
</tr>
<tr>
<td>TaqMan® PCR</td>
<td>TaqMan® Fast Advanced Master Mix</td>
<td>4444557</td>
</tr>
<tr>
<td></td>
<td>TaqMan® GTXpress™ Master Mix</td>
<td>4401892</td>
</tr>
<tr>
<td></td>
<td>TaqMan® Fast Virus 1-Step Master Mix</td>
<td>4444432</td>
</tr>
<tr>
<td></td>
<td>TaqMan® Gene Expression Master Mix</td>
<td>4369016</td>
</tr>
<tr>
<td></td>
<td>TaqMan® Genotyping Master Mix</td>
<td>4371355</td>
</tr>
<tr>
<td></td>
<td>TaqMan® Universal Master Mix II, with UNG</td>
<td>4440038</td>
</tr>
<tr>
<td>SYBR® Green PCR</td>
<td>Fast SYBR® Green Master Mix</td>
<td>4385612</td>
</tr>
<tr>
<td></td>
<td>Power SYBR® Green PCR Master Mix</td>
<td>4367659</td>
</tr>
<tr>
<td></td>
<td>Power SYBR® Green RNA-to-CT™ 1-Step Kit</td>
<td>4389986</td>
</tr>
</tbody>
</table>
General-use materials and consumables

The following general-use materials and consumables are required to calibrate, maintain, and perform experiments with the QuantStudio™ 6 and 7 Flex Software. Unless indicated otherwise, all materials shown below are available from major laboratory suppliers (MLS). The materials are applicable to all sample blocks.

<table>
<thead>
<tr>
<th>Material/Consumable</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bleach, 10% solution</td>
<td>MLS</td>
</tr>
<tr>
<td>Lint-free lab tissues</td>
<td>MLS</td>
</tr>
<tr>
<td>Cotton or nylon swabs and lint-free cloths</td>
<td>MLS</td>
</tr>
<tr>
<td>Centrifuge with buckets appropriate for your consumable type</td>
<td>MLS</td>
</tr>
<tr>
<td>Ethanol, 95% solution</td>
<td>MLS</td>
</tr>
<tr>
<td>Glasses, safety</td>
<td>MLS</td>
</tr>
<tr>
<td>Gloves, powder-free</td>
<td>MLS</td>
</tr>
<tr>
<td>Permanent marker or pen</td>
<td>MLS</td>
</tr>
<tr>
<td>Pipettors: 100-µL and 200-µL (with pipette tips)</td>
<td>MLS</td>
</tr>
<tr>
<td>Screwdriver, flathead</td>
<td>MLS</td>
</tr>
<tr>
<td>Optical clear adhesive film for PCR</td>
<td>MLS</td>
</tr>
<tr>
<td>Deionized water</td>
<td>MLS</td>
</tr>
</tbody>
</table>
Supplemental Information

This appendix covers:

- (Optional) Libraries for designing your own experiments ......................... 13
  Dye library ........................................................................................................... 13
  Target, Sample, Control, and SNP Assay libraries ......................................... 14
  Run Method library ............................................................................................. 14
  Analysis Settings Library ....................................................................................... 15
- Instrument Console .............................................................................................. 17
  Left panel .............................................................................................................. 18
  Right panel ........................................................................................................... 18
  Status icons .......................................................................................................... 19
- About the reagents ............................................................................................... 20
  TaqMan® Reagents ............................................................................................... 20
  SYBR® Green reagents ......................................................................................... 20

(Optional) Libraries for designing your own experiments

The QuantStudio™ 6 and 7 Flex Software allows you to save information to libraries, so you can easily use the information again when setting up an experiment. The libraries include:

- Dye Library
- Targets Library
- Samples Library
- Control Library
- SNP Assay Library (only available for Genotyping experiments)
- Run Method Library
- Analysis settings Library

Dye library

You can access the Dye library from the Tools menu to add new custom dyes, edit existing dyes, and delete dyes.

To add a new dye to the Dye Library:

1. Go to Tools ➤ Dye Library...
2. Click New at the bottom of the Dye Library dialog box.
3. In the New Dye dialog box, enter the name and wavelength (optional) of the custom dye in the respective fields.

**IMPORTANT!** Ensure that you perform a custom dye calibration with the new dye before you run an experiment using this dye.

4. Select the Type of dye: **Reporter**, **Quencher**, or **Both**.
   The new dye gets added to the Dye Library.

5. Click **OK**.

6. To edit or delete any of the dyes in the Dye Library, select the dye and click **Edit** or **Delete** respectively.

7. Click **Close** to exit the Dye Library.

**Target, Sample, Control, and SNP Assay libraries**
You can access the Targets, Samples, and SNP Assay libraries from the Tools menu to add, edit, delete, and import or export items. You can also access a library by clicking **Import from Library** in the Define screen when you are setting up an experiment.

**Run Method library**
You can use the Run Method library from the Run Method screen to:
- Save a new run method for later use.
- To select an existing run method for an experiment.
Appendix B  Supplemental Information
(Optional) Libraries for designing your own experiments

To add a run method to the Run Method Library:

1. Click **Save Run Method** in the toolbar of the Graphical View tab on the Run Method screen.

2. Enter a name and description (optional) for the run method, then click **Save**.

To select a run method from the Run Method Library:

1. Click **Open Run Method** on the Run Method screen.

2. Select one from the saved run methods.

3. Click **OK**.

Analysis Settings Library

Analysis Settings are different for each experiment type. If the default analysis settings in the QuantStudio™ 6 and 7 Flex Software are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.

You can save the changed analysis settings to the Analysis Settings Library so that you can use them in other experiments.

To access the Analysis Settings Library, go to **Tools** → **Analysis Settings Library**. The Analysis Settings Library dialog box looks like this:

![Analysis Settings Library](image)

**Note:** In the Analysis Settings Library dialog box you can apply a filter to reduce the number of settings protocols displayed.

To change the analysis settings and to save them to the Analysis Settings Library:

1. From the Experiment Menu pane, select **Analysis**.

2. On the Analysis screen, click **Analysis Settings** to open the Analysis Settings dialog box.

3. Change the analysis settings according to your requirement.
4. Click **Save to Library** to save the changes you have made to the Analysis Settings Library.

**Note:** You can import the analysis settings you have previously saved to the Analysis Settings Library, by clicking **Load from Library** in the Analysis Settings dialog box.

**Changing default analysis settings in Preferences**

*(Optional)* For real-time data collection, you can change the default analysis settings in the Preferences for the following:

- Automatic analysis
- Automatic save
- Baseline settings

To change the default analysis settings:

1. Go to **Tools ➤ Preferences**.
2. Click the Experiment tab. Select the Auto Analysis and Auto Save check boxes for the QuantStudio™ 6 and 7 Flex Software to automatically analyze and save experiment results.
   
   You can also edit the following default baseline settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Cycle Number</td>
<td>3 (default)</td>
</tr>
<tr>
<td>End Cycle Number</td>
<td>15 (default)</td>
</tr>
</tbody>
</table>

**Note:** By default, the Auto Analysis and Auto Save check boxes are selected.
Instrument Console

The Instrument Console displays all the QuantStudio™ 6 and 7 Instruments discovered on a network.
Left panel

The features on the left panel of the Instrument Console allow:

- Instrument access: Open and close the QuantStudio™ 6 or 7 Instrument door from the QuantStudio™ 6 and 7 Flex Software user interface.

- Group management:
  
  - Create, rename, and delete groups and assign instruments to the groups.
  
  - Add and remove instruments to and from My Instruments.

  **Note:** To add instruments, select the icon of the QuantStudio™ 6 or 7 Instrument that you want to add to the My Instruments list. Then click **Add to My Instruments.** Similarly, click **Remove from My Instruments** to remove an instrument from the My Instruments list. You can also drag and drop the instrument icon into My Instruments or into the group created by you.

  - Display instrument groups from the Display Group drop-down menu. according to their activity. Select the status from the Filtered By drop-down menu. For more information on the status of an instrument, see Monitor the experiment, in Chapter 1, Booklet 1 Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.

- Instrument management:

  - Monitor experiments (check the run status or monitor a temperature plot or amplification plot during a run). For more information on monitoring experiments, see Monitor the experiment, in Chapter 1, Booklet 1 Getting Started with QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Experiments.

  - Maintain instruments (check the calibration status of instruments and perform different calibrations). For more information on instrument maintenance, refer to the instrument user guide.

  - Manage files (upload setup files; download completed experiments; and create, rename, and delete experiment files and plate setup folders).

  **Note:** Completed experiments are downloaded into the default folder Completed Experiments.

  **Note:** To manage files, click **Manage Instrument.**

  Use the File Manager to create, rename or delete folders for holding setup files for starting a run or completed experiments for analysis.

  To move setup files from one folder to the other, click **Move** and select the setup folder you want to shift the setup file into.

  **IMPORTANT!** To Manage and Monitor, you must move instruments from On the Network to My Instruments or a custom group. You can start a run and calibrate instruments present only in the My Instruments group or the custom group(s) that you created.

Right panel

The right panel of the Instrument Console displays:

- The name of the instrument whose instrument icon is selected.

- The run status of the selected instrument.

- The group the instrument belongs to.

- The calibration status, maintenance reminders and instrument properties of the selected instrument.
The calibration status is indicated by the □ icon. The icon appears in the Status column of the Calibration Status table after the last reminder date before the calibration expires.

Status icons

You can monitor the instrument status and view calibration and other information in the Instrument Console.

The status of an instrument is represented by an icon in the top-right corner of the thumbnail representation of the instrument on the Instrument Console. An instrument displays the status when you place the instrument icon under My Instruments or under the Group(s) that you created.

QuantStudio™ 6 or 7 Instrument status icon

To monitor the instrument status:

1. On the Home tab ( ), select Instrument Console. If you do not see an instrument, click Refresh in the instrument console toolbar.

2. If needed, move the instrument from the On the Network group to a group which can be monitored:
   a. Click the instrument of interest, then click Assign to Group in the instrument console toolbar.

   b. Select the My Instruments or a personal group in the drop-down list. The instrument is now monitored.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Instrument status</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Ready Icon](Q56_0008 READY)</td>
<td>Ready</td>
</tr>
<tr>
<td>![No Icon](no icon)</td>
<td>Available on the network but cannot be monitored because that instrument is not under My Instruments or a group you created.</td>
</tr>
<tr>
<td><img src="run_in_process" alt="Run in process Icon" /></td>
<td>Run in process (The time remaining for the run is shown to the left of the icon.)</td>
</tr>
<tr>
<td><img src="unavailable" alt="Unavailable Icon" /></td>
<td>Unavailable</td>
</tr>
<tr>
<td><img src="incompatible_firmware_version" alt="Incompatible firmware version Icon" /></td>
<td>Incompatible firmware version</td>
</tr>
<tr>
<td><img src="no_longer_connected_to_the_network" alt="No longer connected to the network Icon" /></td>
<td>No longer connected to the network</td>
</tr>
<tr>
<td><img src="error_occurred_during_run" alt="Error occurred during run Icon" /></td>
<td>Error occurred during run</td>
</tr>
</tbody>
</table>
About the reagents

TaqMan® Reagents

Description
TaqMan® reagents use a fluorogenic probe to enable detection of a specific PCR product as it accumulates during PCR cycles.

Advantages
- Increased signal specificity with the addition of a fluorogenic probe.
- Multiplex capability.
- Optional preformulated assays, optimized to run under universal thermal cycling conditions, are available.
- Can be used for either 1- or 2-step RT-PCR.

Limitations
Require synthesis of a unique fluorogenic probe.

TaqMan® Reagents detection process

SYBR® Green reagents

Description
SYBR Green reagents use SYBR® Green I dye, a double-stranded DNA binding dye, to detect PCR products as they accumulate during PCR cycles.

Advantages
- Economical (no probe needed).
- Allow for melt curve analysis to measure the Tm of all PCR products.
- Can be used for either 1- or 2-step RT-PCR.
Limitations

Bind nonspecifically to all double-stranded DNA sequences. To avoid erroneous information signals, check for nonspecific product formation using melt curve or gel analysis.

SYBR® Green detection process

Step 1: Reaction setup
The SYBR® Green I dye fluoresces when bound to double-stranded DNA.

Step 2: Denaturation
When the DNA is denatured into single-stranded DNA, the SYBR® Green I dye is released and the fluorescence is drastically reduced.

Step 3: Polymerization
During extension, primers anneal and PCR product is generated.

Step 4: Polymerization completed
SYBR® Green I dye binds to the double-stranded product, resulting in a net increase in fluorescence detected by the instrument.
Appendix B  Supplemental Information

About the reagents
## Related documentation

The following related documents are shipped with the instrument:

<table>
<thead>
<tr>
<th>Document</th>
<th>Pub. no.</th>
<th>Description</th>
</tr>
</thead>
</table>
| **QuantStudio™ 6 and 7 flex Real-Time PCR System**         | 4489822  | Contains seven individual booklets that explain how to perform the six different experiments on the QuantStudio™ 6 and 7 flex Real-Time PCR System Software. The experiments include Standard Curve, Relative Standard Curve and Comparative C>T, Genotyping, Presence/ Absence and Melt Curve. Each Getting Started Guide booklet functions as both:  
  • A tutorial, using example experiment data provided with the QuantStudio™ 6 and 7 flex Real-Time PCR System Software.  
  • A guide for your own experiments.  
  Intended for laboratory staff and principal investigators who perform experiments using the QuantStudio™ 6 and 7 flex Real-Time PCR System Software. |
| **QuantStudio™ 6 and 7 Flex Real-Time PCR Systems**        | 4489821  | Explains how to use and maintain the QuantStudio™ 6 and 7 Flex Real-Time PCR Systems  
  Intended for laboratory staff responsible for the use and maintenance of the QuantStudio™ 6 and 7 Instruments.                                                                                                                                                                                                                         |
| **QuantStudio™ 6 and 7 Flex Real-Time PCR Systems**        | 4489824  | Explains how to prepare your site to receive and install the QuantStudio™ 6 and 7 Instruments  
  Intended for personnel who schedule, manage, and perform the tasks required to prepare your site for installation of the QuantStudio™ 6 and 7 Instruments.                                                                                                                                                                         |
| **QuantStudio™ 6 and 7 Flex Real-Time PCR System**         | 4489825  | Provides IT administrative personnel with sufficient information to integrate the instrument and software with a LIS/LIMS.  
  Intended to be used with the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting Started Guide.                                                                                                                                                                                                                       |
### Other related documents

#### Documents related to Standard Curve experiments

<table>
<thead>
<tr>
<th>Document</th>
<th>Pub. no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</td>
<td>127AP05</td>
</tr>
<tr>
<td>Custom TaqMan® Gene Expression Assays Protocol</td>
<td>4334429</td>
</tr>
<tr>
<td>Primer Express® Software Version 3.0 Getting Started Guide</td>
<td>4362460</td>
</tr>
<tr>
<td>TaqMan® Gene Expression Assays Protocol</td>
<td>4333458</td>
</tr>
<tr>
<td>User Bulletin #2: Relative Quantitation of Gene Expression</td>
<td>4303859</td>
</tr>
</tbody>
</table>

#### Documents related to Relative Standard Curve and Comparative CT experiments

<table>
<thead>
<tr>
<th>Document</th>
<th>Pub. no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</td>
<td>127AP05</td>
</tr>
<tr>
<td>Applied Biosystems® High-Capacity cDNA Reverse Transcription Kits Protocol</td>
<td>4375575</td>
</tr>
<tr>
<td>Custom TaqMan® Gene Expression Assays Protocol</td>
<td>4334429</td>
</tr>
<tr>
<td>Primer Express® Software Version 3.0 Getting Started Guide</td>
<td>4362460</td>
</tr>
<tr>
<td>TaqMan® Gene Expression Assays Protocol</td>
<td>4333458</td>
</tr>
<tr>
<td>User Bulletin #2: Relative Quantitation of Gene Expression</td>
<td>4303859</td>
</tr>
</tbody>
</table>

**Note:** For additional documentation, see “How to obtain support” on page 25.
Documents related to Genotyping experiments

<table>
<thead>
<tr>
<th>Document</th>
<th>Pub. no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allelic Discrimination Pre-Developed TaqMan® Assay Reagents Quick Reference Card</td>
<td>4312212</td>
</tr>
<tr>
<td>Custom TaqMan® Genomic Assays Protocol</td>
<td>4367671</td>
</tr>
<tr>
<td>Custom TaqMan® SNP Genotyping Assays Protocol</td>
<td>4334431</td>
</tr>
<tr>
<td>Ordering TaqMan® SNP Genotyping Assays Quick Reference Card</td>
<td>4374204</td>
</tr>
<tr>
<td>Pre-Developed TaqMan® Assay Reagents Allelic Discrimination Protocol</td>
<td>4312214</td>
</tr>
<tr>
<td>TaqMan® Drug Metabolism Genotyping Assays Protocol</td>
<td>4362038</td>
</tr>
<tr>
<td>TaqMan® SNP Genotyping Assays Protocol</td>
<td>4332856</td>
</tr>
</tbody>
</table>

Documents related to Presence/Absence experiments

<table>
<thead>
<tr>
<th>Document</th>
<th>Pub. no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal Swabs Protocol</td>
<td>4343586</td>
</tr>
<tr>
<td>NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue Protocol</td>
<td>4333959</td>
</tr>
<tr>
<td>PrepMan® Ultra Sample Preparation Reagent Protocol</td>
<td>4318925</td>
</tr>
</tbody>
</table>

How to obtain support

For the latest services and support information for all locations, go to:

www.lifetechnologies.com/support

At the Life Technologies web site, you can:

- Access worldwide telephone and fax numbers to contact Life Technologies Technical Support and Sales facilities.
- Search through frequently asked questions (FAQs).
- Submit a question directly to Technical Support.
- Order Life Technologies user documents, SDSs, certificates of analysis, and other related documents.
- Download PDF documents.
- Obtain information about customer training.
- Download software updates and patches.

Obtaining information from the Help system

The QuantStudio™ 6 and 7 flex Real-Time PCR System Software has a Help system that describes how to use each feature of the user interface. Access the Help system by doing one of the following:

- Click 🕵️ in the toolbar of the QuantStudio™ 6 and 7 flex Real-Time PCR System Software window.
- Select Help ➤ QuantStudio™ 6 and 7 flex Real-Time PCR System Software Help.
- Press F1.
You can use the Help system to find topics of interest by:

- Reviewing the table of contents
- Searching for a specific topic

**Limited Product Warranty**

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the Life Technologies’ General Terms and Conditions of Sale found on Life Technologies’ website at [www.lifetechnologies.com/termsandconditions](http://www.lifetechnologies.com/termsandconditions). If you have any questions, please contact Life Technologies at [www.lifetechnologies.com/support](http://www.lifetechnologies.com/support).
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIF</td>
<td>See assay information file (AIF).</td>
</tr>
<tr>
<td>AIX</td>
<td>XML version of the assay information file.</td>
</tr>
<tr>
<td></td>
<td>See also assay information file (AIF).</td>
</tr>
<tr>
<td>allele</td>
<td>In a diploid organism, one of two DNA sequences found at the same locus (for example, a particular gene), but located on homologous chromosomes. Two corresponding alleles may have the identical sequence, or they may differ somewhat, often at one or more single-base sites (SNPs).</td>
</tr>
<tr>
<td>aligned melt curve plot</td>
<td>Plot of the re-scaled melt curve.</td>
</tr>
<tr>
<td>allelic discrimination plot</td>
<td>Display of genotyping data collected during the post-PCR read. The allelic discrimination plot is a graph of the normalized reporter signal from the allele 1 probe, plotted against the normalized reporter signal from the allele 2 probe.</td>
</tr>
<tr>
<td>amplicon</td>
<td>A segment of DNA amplified during PCR.</td>
</tr>
<tr>
<td>amplification</td>
<td>Part of the instrument run in which PCR amplifies the target. Fluorescence data collected during amplification are displayed in an amplification plot, and the data are used to calculate results. <strong>Note:</strong> Only quantitative real-time PCR experiments, not end-point experiments, take amplification data into account.</td>
</tr>
<tr>
<td>amplification efficiency (EFF%)</td>
<td>Calculation of the efficiency of the PCR amplification in an experiment. EFF% is calculated using the slope of the regression line in the standard curve. A slope close to −3.32 indicates optimal, 100% PCR amplification efficiency.</td>
</tr>
</tbody>
</table>
| amplification plot | Display of data collected during the cycling stage of PCR amplification. The amplification plot can be viewed as:  
  - Baseline-corrected normalized reporter (ΔRn) vs. cycle  
  - Normalized reporter (Rn) vs. cycle  
  - Threshold cycle (C_T) vs. well |
| amplification stage | Part of the instrument run in which PCR amplifies the target. The amplification stage, called a cycling stage in the thermal profile, consists of denaturing, primer annealing, and extension steps that are repeated. Fluorescence data collected during the extension stage are displayed in an amplification plot, and the data are used to calculate results. With TaqMan® chemistry, the last two steps of a PCR stage are typically combined. See also cycling stage. |
**Analysis Settings Library**

In the software, a collection of analysis settings to use in experiments. You can save settings and reuse them. You cannot edit or import settings into the library.

**assay**

In a PCR reaction mix, two target-specific primers or two primers and a probe used to amplify a target.

**Assay ID**

Identifier assigned by Life Technologies to TaqMan® assays.

**assay information file (AIF)**

Tab-delimited data file on a CD shipped with each assay order. The AIF contains technical details about all assays in the shipment. It includes information about assay concentrations; reporters and quenchers used; part and lot numbers; and assay, vial, and plate ID numbers. The file name includes the number from the barcode on the plate.

**assay mix**

PCR reaction component in Applied Biosystems® TaqMan® assays. The assay mix contains primers designed to amplify a target and a TaqMan® probe designed to detect amplification of the target.

**AutoDelta**

In the run method, a setting to increase or decrease the temperature and/or time for a step with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a cycling stage, the settings are indicated by an icon in the thermal profile:

- AutoDelta on: ▲
- AutoDelta off: ▲

**automatic baseline**

An analysis setting in which the software calculates the baseline start and end cycles for the amplification plot.

See also baseline.

**automatic threshold**

An analysis setting in which the software calculates the baseline start and end cycles and the threshold in the amplification plot. The software uses the baseline and threshold to calculate the threshold cycle (C_T).

See also threshold cycle (C_T).

**background calibration**

Type of calibration in which the instrument performs reads of a background plate, averages the spectra recorded during the run, and extracts the resulting spectral component to a calibration file. The software then uses the calibration file during subsequent runs to remove the background fluorescence from the run data.

**baseline**

In the amplification plot, a cycle-to-cycle range that defines background fluorescence. This range can be set manually on an assay-by-assay basis, or automatically to set each individual well.

**baseline-corrected normalized reporter (ΔRn)**

The magnitude of normalized fluorescence signal generated by the reporter. In experiments that contain data from real-time PCR, the magnitude of normalized fluorescence signal generated by the reporter at each cycle during the PCR amplification. In the ΔRn vs Cycle amplification plot, ΔRn is calculated at each cycle as:

\[ ΔRn \text{ (cycle)} = Rn \text{ (cycle)} - Rn \text{ (baseline)} \]

where \( Rn \) = normalized reporter
In genotyping experiments and presence/absence experiments, the difference in normalized fluorescence signal generated by the reporter between the pre-PCR read and the post-PCR read. In the allelic discrimination plot (genotyping experiments) and the presence/absence plot (presence/absence experiments), $\Delta Rn$ is calculated as:

$$\Delta Rn = Rn \text{ (post-PCR read)} - Rn \text{ (pre-PCR read)}$$

where $Rn = \text{normalized reporter}$.

See also normalized reporter ($Rn$).

**baseline threshold algorithm**
Expression estimation algorithm ($C_T$) which subtracts a baseline component and sets a fluorescent threshold in the exponential region for gene quantification.

**biological replicates**
Reactions that contain identical components and volumes, but evaluate separate samples of the same biological source (for example, samples from three different mice of the same strain, or separate extractions of the same cell line or tissue sample).

When an experiments uses biological replicate groups in a gene expression study, the values displayed in the Biological Replicates tab are calculated by combining the results of the separate biological samples and treating this collection as a single population (that is, as one sample). For $\Delta C_T$ computations (normalizing by the endogenous control) in a singleplex experiment, the software treats separate biological samples as unpaired data when computing variability estimates of the single biological replicate. Individual contributions of the separate biological samples to the single biological replicate results are observed in the Technical Replicates tab.

See also technical replicates.

**blocked IPC**
In presence/absence experiments, a reaction that contains IPC blocking agent, which blocks amplification of the internal positive control (IPC). In QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, also the name of the task for the IPC target in wells that contain IPC blocking agent. See also negative control-blocked IPC wells.

**calibrator**
See reference sample.

**chemistry**
See reagents.

**comparative $C_T$ ($\Delta\Delta C_T$) method**
Method for determining relative target quantity in samples. The software measures amplification of the target and of the endogenous control in samples and in a reference sample. Measurements are normalized using the endogenous control. The software determines the relative quantity of target in each sample by comparing normalized target quantity in each sample to normalized target quantity in the reference sample.

$C_T$
See threshold cycle ($C_T$).

$C_T$ algorithm
Algorithm used to determine the threshold cycle. The software provides the Baseline Threshold $C_T$ algorithm.

**cycle threshold**
See threshold cycle ($C_T$).

**cycling stage**
In the thermal profile, a stage that is repeated. A cycling stage is also called an amplification stage. See also amplification stage.

$C_q$
See quantification cycle ($C_q$).
Glossary

**data collection**  
During the instrument run, a process in which an instrument detects fluorescence data from each well of the reaction plate. The instrument transforms the signal to electronic data and saves the data in the experiment file. In the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, a data collection point is indicated by an icon in the thermal profile:
- Data collection on:  
- Data collection off:

**delta Rn (ΔRn)**  
See baseline-corrected normalized reporter (ΔRn).

**derivative reporter (–Rn’)**  
The rate of change in fluorescence as a function of temperature. Rn’ is used to plot a melting curve. Significant decrease of the fluorescent signal generates a positive peak on the derivative view of the melting curve.

**diluent**  
A reagent used to dilute a sample or standard before it is added to the PCR reaction.

**dilution factor**  
See serial factor.

**dye calibration**  
Type of calibration in which the software collects spectral data from a series of dye standards and stores the spectral information for the dye standards in a pure spectra calibration file. This file is used during experiment runs to characterize and distinguish the individual contribution of each dye in the total fluorescence collected by the instrument.

**EFF%**  
See amplification efficiency (EFF%).

**efficiency correction**  
In Comparative CT experiments, a feature that allows you to manually enter previously-determined amplification efficiencies for each experiment, following the experimental run. The real-time software mathematically compensates for differences in efficiency between each target assay and the endogenous control when calculating sample-to-sample relative quantities. This method can be employed as a substitute for the Relative Standard Curve Method.

**endogenous control**  
A gene that is used to normalize template differences and sample-to-sample or run-to-run variation.

**endpoint read**  
See post-PCR read.

**error**  
The standard error of the slope of the regression line in the standard curve.

The error can be used to calculate a confidence interval (CI) for the slope. Because the amplification efficiency (EFF%) is calculated from the slope, knowing the error allows a CI for the amplification efficiency to be calculated.

**experiment**  
Refers to the entire process of performing a run, including setup, run, and analysis. You can perform the following types of experiments:
- Quantification - Standard curve
- Quantification - Relative standard curve
- Quantification - Comparative CT (ΔΔC_T)
**Glossary**

- **Melt Curve**
- **Genotyping**
- **Presence/Absence**

**experiment name**
Entered during experiment setup, the name that is used to identify the experiment.

**Experiment Setup**
A software feature that allows you to set up an experiment according to your experiment design. Experiment Setup provides you with maximum flexibility in the design and setup of your experiment.

**experiment type**
The type of experiment to perform:
- **Standard curve**
- **Comparative \( C_T (\Delta \Delta C_T) \)**
- **Relative standard curve**
- **Genotyping**
- **Presence/Absence**
- **Melt curve**

The experiment type that you select affects setup, run, and analysis.

**export**
A software feature that allows you to export experiment setup files, experiment results, instrument information, and security and auditing settings to spreadsheet, presentation, or text files. You can edit the default location of the exported file.

**filter**
Dye excitation and emission filter combination that you select for an experiment. The QuantStudio™ 6 and 7 Instruments include a five-color filter set and six-color filter set, respectively, that support FAM™, SYBR® Green, VIC®, JOE™, NED™, Cy®3, TAMRA™, ROX™, and Texas Red® dyes.

**flag**
A quality control (QC) indicator which, when applied by the software to a well during analysis, indicates a possible issue with that reaction. For example, a flag may be issued if no amplification is detected in a well. Flags indicating potential problems are displayed in the Quality Control tab of the plate layout, well table, and QC Summary screens.

**forward primer**
Oligonucleotide that flanks the 5′ end of the amplicon. The reverse primer and the forward primer are used together in PCR reactions to amplify the target.

**genotyping experiment**
An experiment used to identify known mutations in a DNA sample. With this experiment type, you can determine if a DNA sample is:
- **Homzygous** (samples having only allele 1). Also called wild type homozygote.
- **Homzygous** (samples having only allele 2). Also called variant homozygote.
- **Heterozygous** (samples having both allele 1 and allele 2).

**heterozygote**
Samples having both allele 1 and allele 2.

See also genotyping experiment.
Glossary

holding stage  In the thermal profile, the stage that holds the temperature constant for a defined period of time. A stage that includes one or more steps. You can add a holding stage to the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a reaction.

homozygote  Samples having only allele 1 or only allele 2. See also genotyping experiment.

housekeeping gene  A gene that is involved in basic cellular functions and that may be constitutively expressed. Housekeeping genes may be candidates for use as endogenous controls; however, their constancy should always be validated experimentally.

See also endogenous control.

import  A software feature that allows you to import plate setup information or security settings before an experiment run. You can also import information into some libraries in the software.

Instrument Console  A software feature that allows you to view information about instruments on the network. In the Instrument Console, you can monitor the status of any instrument on the network; view calibration, maintenance, and instrument properties for a selected instrument; and open and close the instrument drawer.

Instrument Manager  A software feature that allows you to view information about instrument available on the network. In the Instrument Manager, you can monitor the status of an instrument; monitor amplification plots and temperature plots in real time; view the calibration status, perform calibrations and manage files on the instrument, including downloading completed experiments to your computer.

internal positive control (IPC)  In presence/absence experiments, a short synthetic DNA template that is added to PCR reactions. The IPC can be used to distinguish between true negative results (the target is absent in the samples) and negative results caused by PCR inhibitors, incorrect assay setup, or reagent or instrument failure.

inventoried assays  TaqMan® Gene Expression Assays and TaqMan® SNP Genotyping Assays that have been previously manufactured, passed quality control specifications, and stored in inventory.

IPC  See internal positive control (IPC).

IPC blocking agent  Reagent added to PCR reactions to block amplification of the internal positive control (IPC).

IPC+  See negative control-IPC wells.

made-to-order assays  TaqMan® Gene Expression Assays that are manufactured at the time of order. Only assays that pass manufacturing quality control specifications are shipped.

manual baseline  An analysis setting for the Baseline Threshold algorithm. You enter the baseline start and end cycles for the amplification plot.

See also baseline.
manual threshold
An analysis setting for the Baseline Threshold algorithm. You enter the threshold value and select whether to use automatic baseline or manual baseline values. The software uses the baseline and the threshold values to calculate the threshold cycle (C_T).

melt curve
A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate the melting temperature (T_m) of the target, or they can identify nonspecific PCR amplification. In the software, you can view the melt curve as normalized reporter (R_n) vs. temperature or as derivative reporter (–R_n’) vs. temperature. In a high resolution melting experiment, you can view the melt curve as fluorescence vs. temperature. Also called dissociation curve.

melt curve characteristics
The melt curve shape and the difference in melting temperature (T_m) values.

melt curve stage
In the thermal profile, a stage with a temperature increment to generate a melt curve.

melt curve plot
The default view of the melting curve. It plots the negative derivative data (–R_n’) vs. temperature.

melting temperature (T_m)
The temperature at which 50% of the DNA is double-stranded and 50% of the DNA is dissociated into single-stranded DNA. In a melt curve experiment, the melt curve plot displays the melting temperature.

multicomponent plot
A plot of the complete spectral contribution of each dye for the selected well(s) over the duration of the PCR run.

negative control (NC)
The task for targets or SNP assays in wells that contain water or buffer instead of sample. No amplification of the target should occur in negative control wells. Previously called no template control (NTC).

negative control-blocked IPC wells
In presence/absence experiments, wells that contain IPC blocking agent instead of sample in the PCR reaction. No amplification should occur in negative control-blocked IPC wells because the reaction contains no sample and amplification of the IPC is blocked. Previously called no amplification control (NAC).

negative control-IPC wells
In presence/absence experiments, wells that contain IPC template and buffer or water instead of sample. Only the IPC template should amplify in negative control-IPC wells because the reaction contains no sample. Previously called IPC+.

no amplification control (NAC)
See negative control-blocked IPC wells.

no template control (NTC)
See negative control (NC).

nonfluorescent quencher-minor groove binder (NFQ-MGB)
Molecules that are attached to the 3’ end of TaqMan® probes. When the probe is intact, the nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence signal. Because the NFQ does not fluoresce, it produces lower background signals, resulting in improved precision in quantification. The minor groove binder (MGB) increases the melting temperature (T_m) of the probe without increasing its length, allowing for the design of shorter probes.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>normalization calibration</td>
<td>Type of calibration in which the software collects data from the normalization standards, then stores it in a normalization calibration file. This file is used in comparisons of data from multiple instruments within a study.</td>
</tr>
<tr>
<td>normalized quantity</td>
<td>Either the C\textsubscript{T} Avg. of the target gene minus the C\textsubscript{T} Avg. of the endogenous control (Comparative C\textsubscript{T} experiments), or the Q Avg. of the target divided by the Q Avg. of the endogenous control (Relative Standard Curve experiments).</td>
</tr>
<tr>
<td>normalized quantity mean</td>
<td>The relative standard curve equivalent of the ΔC\textsubscript{T} mean value found in Comparative C\textsubscript{T} experiments (computed as the geometric mean).</td>
</tr>
<tr>
<td>normalized quantity SE</td>
<td>The relative standard curve equivalent of the ΔC\textsubscript{T} SE value found in Comparative C\textsubscript{T} experiments (computed as the geometric standard error of the mean).</td>
</tr>
<tr>
<td>normalized reporter (Rn)</td>
<td>Fluorescence signal from the reporter dye normalized to the fluorescence signal of the passive reference dye (usually ROX\textsuperscript{TM} dye on Life Technologies instruments).</td>
</tr>
<tr>
<td>omit well</td>
<td>An action that you perform before reanalysis to omit one or more wells from analysis. Because no algorithms are applied to omitted wells, omitted wells contain no results. You can add wells back in to the analysis; no information is permanently discarded.</td>
</tr>
<tr>
<td>outlier</td>
<td>A measurement (such as a C\textsubscript{T}) that deviates significantly from the measurement of the other replicates for that same sample.</td>
</tr>
<tr>
<td>passive reference</td>
<td>A dye that produces fluorescence signal independent of PCR amplification, and that is added to each reaction at a constant concentration. Because the passive reference signal should be consistent across all wells, it is used to normalize the reporter dye signal to account for non-PCR related fluorescence fluctuations caused by minor well-to-well differences in volume. Normalization to the passive reference signal generally results in data with noticeably high precision among technical replicates.</td>
</tr>
<tr>
<td>plate layout</td>
<td>An illustration of the grid of wells and assigned content in the reaction plate. The number of rows and columns in the grid depends on the sample block that you use. In the software, you can use the plate layout as a selection tool to assign well contents, to view well assignments, and to view results. The plate layout can be printed, included in a report, exported, and saved as a slide for a presentation.</td>
</tr>
<tr>
<td>plate setup file</td>
<td>A file (.txt, .csv, .xml, or .sds) that contains setup information such as the well number, sample name, sample color, target name, dyes, and other reaction plate contents.</td>
</tr>
<tr>
<td>point</td>
<td>One standard in a standard curve. The standard quantity for each point in a standard curve is calculated based on the starting quantity and serial factor.</td>
</tr>
<tr>
<td>positive control</td>
<td>In genotyping and presence/absence experiments, a DNA sample with a known genotype, homozygous or heterozygous. In the software, the task for the SNP assay in wells that contain a sample with a known genotype.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>post-PCR read</td>
<td>In genotyping and presence/absence experiments, the part of the instrument run that occurs after amplification. In genotyping experiments, fluorescence data collected during the post-PCR read are displayed in the allelic discrimination plot and used to make allele calls. In presence/absence experiments, fluorescence data collected during the post-PCR read are displayed in the presence/absence plot and used to make detection calls. Also called endpoint read.</td>
</tr>
<tr>
<td>pre-PCR read</td>
<td>In genotyping and presence/absence experiments, the part of the instrument run that occurs before amplification. The pre-PCR read is optional but recommended. Fluorescence data collected during the pre-PCR read can be used to normalize fluorescence data collected during the post-PCR read.</td>
</tr>
<tr>
<td>primer mix</td>
<td>PCR reaction component that contains the forward primer and reverse primer designed to amplify the target.</td>
</tr>
<tr>
<td>primer/probe mix</td>
<td>PCR reaction component that contains the primers designed to amplify the target and a TaqMan® probe designed to detect amplification of the target.</td>
</tr>
<tr>
<td>pure dye</td>
<td>Fluorescent compound used to calibrate the instrument.</td>
</tr>
<tr>
<td>See system dye</td>
<td></td>
</tr>
<tr>
<td>quantification cycle</td>
<td>The fractional PCR cycle used for quantification, according to the Real-time PCR Data Markup Language (RDML) data standard. C_T is the algorithm-specific calculations of C_q.</td>
</tr>
<tr>
<td>method</td>
<td>In quantification experiments, the method used to determine the quantity of target in the samples.</td>
</tr>
<tr>
<td>quantity</td>
<td>In quantification experiments, the amount of target in the samples. Absolute quantity can refer to copy number, mass, molarity, or viral load. Relative quantity refers to the fold-difference between normalized quantity of target in the sample and normalized quantity of target in the reference sample.</td>
</tr>
<tr>
<td>quencher</td>
<td>A molecule attached to the 3’ end of TaqMan® probes to prevent the reporter from emitting fluorescence signal while the probe is intact. With TaqMan® reagents, a nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the quencher.</td>
</tr>
<tr>
<td>QuickStart</td>
<td>A feature that allows you to run an experiment without entering plate setup information, if your instrument and computer are in the same network. QuickStart requires an experiment template file.</td>
</tr>
<tr>
<td>R² value</td>
<td>Regression coefficient calculated from the regression line in the standard curve. An important quality value, the R² value indicates the closeness of fit between the standard curve regression line and the individual C_T data points from the standard reactions. A value of 1.00 indicates a perfect fit between the regression line and the data points.</td>
</tr>
<tr>
<td>ramp</td>
<td>The step at which the temperature changes during the instrument run. The ramp rate is defined as °C per second. In the graphical view of the thermal profile, the ramp rate is indicated by a diagonal line.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ramp speed</td>
<td>Speed at which the temperature ramp occurs during the instrument run. Available ramp speeds include fast and standard.</td>
</tr>
<tr>
<td>Raw data plot</td>
<td>A plot of raw fluorescent signal as detected through each emission filter, used to view raw data for individual wells and at individual cycles.</td>
</tr>
<tr>
<td>reaction mix</td>
<td>A solution that contains all components to run the PCR reaction, except for the template (sample, standard, or control). Also called a “PCR cocktail”.</td>
</tr>
<tr>
<td>reagents</td>
<td>The PCR reaction components used to amplify the target and to detect amplification.</td>
</tr>
<tr>
<td>real-time PCR</td>
<td>Process of collecting fluorescence data during PCR. Data from the real-time PCR are used to calculate results for quantification experiments or to troubleshoot results for genotyping or presence/absence experiments.</td>
</tr>
<tr>
<td>Real-time PCR Data Markup Language (RDML)</td>
<td>A reporting format that is compliant with the Minimum Information for Publication for Quantitative Real Time Experiments (MIQE) guidelines.</td>
</tr>
<tr>
<td>reference sample</td>
<td>In relative standard curve and Comparative C&lt;sub&gt;T&lt;/sub&gt; (ΔΔC&lt;sub&gt;T&lt;/sub&gt;) experiments, the sample used as the basis for relative quantification results. Also called the calibrator.</td>
</tr>
<tr>
<td>refSNP ID</td>
<td>The reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National Center for Biotechnology Information (NCBI). The refSNP ID can be used to search the Life Technologies Store for an Applied Biosystems® SNP Genotyping Assay. Also called an rs number.</td>
</tr>
<tr>
<td>region of interest (ROI) calibration</td>
<td>Type of calibration in which the software maps the positions of the wells on the sample block of the instrument. The software uses the ROI calibration data to associate increases in fluorescence during a run with specific wells of the plate. A calibration image for each individual filter must be generated to account for minor differences in the optical path.</td>
</tr>
<tr>
<td>regression coefficients</td>
<td>Values calculated from the regression line in standard curves, including the R&lt;sup&gt;2&lt;/sup&gt; value, slope, and y-intercept. You can use the regression coefficients to evaluate the quality of results from the standards. See also standard curve.</td>
</tr>
<tr>
<td>regression line</td>
<td>In standard curve and relative standard curve experiments, the best-fit line from the standard curve. Regression line formula: C&lt;sub&gt;T&lt;/sub&gt; = m [log (Qty)] + b where m is the slope, b is the y-intercept, and Qty is the standard quantity. See also regression coefficients.</td>
</tr>
<tr>
<td>reject well</td>
<td>An action that the software performs during analysis to remove one or more wells from further analysis if a specific flag is applied to the well.</td>
</tr>
</tbody>
</table>
**relative standard curve method**
An experimental method to determine relative quantities. This method compensates for target and endogenous control efficiency differences within each run. In all experiments, unknown samples and dilution series of template (such as cDNA) are amplified. Following a run, the instrument software interpolates relative quantities for each unknown sample from the appropriate dilution curve, then normalizes the data for each sample (or set of replicates) as follows: target \( Q_{\text{Avg}} \) \( \div \) endogenous control \( Q_{\text{Avg}} \).

**replicate group**
A user-defined biological grouping. A replicate group may be a set of identical reactions in an experiment.

**replicates**
Total number of identical reactions containing identical components and identical volumes.

**reporter**
A fluorescent dye used to detect amplification. With TaqMan® reagents, the reporter dye is attached to the 5’ end. With SYBR® Green reagents, the reporter dye is SYBR® Green dye. SYBR® dyes are DNA-binding dyes.

**reverse primer**
An oligonucleotide that flanks the 3’ end of the amplicon. The reverse primer and the forward primer are used together in PCR reactions to amplify the target.

**reverse transcriptase**
An enzyme that converts RNA to cDNA.

**Rn**
See normalized reporter (Rn).

**ROX™ dye**
A dye supplied by Life Technologies, which is used as a passive reference in some experiments.

**rs number**
See refSNP ID.

**run method**
Definition of the reaction volume and the thermal profile for the instrument run. The run method specifies the temperature, time, ramp, and data collection points for all steps and stages of the instrument run.

**sample**
The biological tissue or specimen that you are testing for a target gene.

**sample definition file**
A tab-delimited file (*.txt or *.csv) that contains the following setup information: well number, sample name, and custom sample properties.

**Sample Library**
In the software, an editable collection of sample names to use in experiments. The samples in the library contain the sample name and the sample color. The samples in the library may also contain comments about the sample.

**sample/SNP assay reaction**
In genotyping experiments, the combination of the sample to test and the SNP assay to perform in one PCR reaction. Each PCR reaction can contain only one sample and one SNP assay.

**sample/target reaction**
In quantification experiments, the combination of the sample to test and the target to detect and quantify in one PCR reaction.
Glossary

security, auditing and eSignature

An optional software module that provides:

- **System Security** – Controls user access to the software. Provides a default Administrator user account. You can define additional user accounts and permissions.

- **Auditing** – Tracks changes made to library items, actions performed by users, and changes to the Security and Audit settings. The software automatically audits some actions silently. You can select other items for auditing and specify the audit mode. Provides reports for audited library items, Security and Audit changes, and actions.

- **Electronic Signature (eSignature)** – Controls whether users are permitted, prompted, or required to provide a user name and password when accessing certain software features. You can select which features are controlled and the number of signatures required for access. When authorized persons use this feature, they are creating a legally binding signature.

serial factor

In the software, a numeric value that defines the sequence of quantities in the standard curve. The serial factor and the starting quantity are used to calculate the standard quantity for each point in the standard curve. For example, if the standard curve is defined with a serial factor of 1:10 or \(10^\bullet\), the difference between any 2 adjacent points in the curve is 10-fold.

slope

Regression coefficient calculated from the regression line in the standard curve. The slope indicates the PCR amplification efficiency for the assay. A slope of \(-3.32\) indicates 100% amplification efficiency.

See also amplification efficiency (EFF%) and regression line.

SNP

Single nucleotide polymorphism. The SNP can consist of a base difference or an insertion or deletion of one base.

SNP assay

Used in genotyping experiments, a PCR reaction that contains primers to amplify the SNP and two probes to detect different alleles.

SNP Assay Library

In the software, an editable collection of SNP assays to add to genotyping experiments. The SNP assays in the library contain the SNP assay name; SNP assay color; and for each allele, the allele name or base(s), reporter, quencher, and allele colors. The SNP assays in the library may also contain the assay ID and comments about the SNP assay.

stage

In the thermal profile, a group of one or more steps. Examples: PCR stage, cycling stage (also called amplification stage), and hold stage.

standard

A sample that you dilute and amplify along with unknown samples. This dilution series can contain known starting quantities of the target of interest (absolute standard curve) or it can be of known dilution factor (relative standard curve). Following the run, the software interpolates the C\(_T\) values of the unknowns to this curve, yielding either specific quantities of the target (for absolute curves) or relative quantities (for relative dilution curves).

See also standard curve.
standard curve

In standard curve and relative standard curve experiments:

- The best-fit line in a plot of the Cₜ values from the standard reactions plotted against standard quantities. See also regression line.
- A set of standards containing a range of known quantities. Results from the standard curve reactions are used to generate the standard curve. The standard curve is defined by the number of points in the dilution series, the number of standard replicates, the starting quantity, and the serial factor.

standard curve method

Method for determining absolute target quantity in samples. With the standard curve method, the software measures amplification of the target in samples and in a standard dilution series. Data from the standard dilution series are used to generate the standard curve. Using the standard curve, the software interpolates the absolute quantity of target in the samples.

See also standard and standard curve.

standard dilution series

In standard curve and relative standard curve experiments, a set of standards containing a range of known quantities. The standard dilution series is prepared by serially diluting standards. For example, the standard stock is used to prepare the first dilution point, the first dilution point is used to prepare the second dilution point, and so on. In the software, the volumes needed to prepare a standard dilution series are calculated by the number of dilution points, the number of standard replicates, the starting quantity, the serial factor, and the standard concentration in the stock. See also standard curve.

standard quantity

In the PCR reaction, a known quantity. In standard curve experiments, the quantity of target in the standard. In the software, the units for standard quantity can be for mass, copy number, viral load, or other units for measuring the quantity of target. Standard quantity can also refer to dilution factor.

starting quantity

When defining a standard curve in the software, the highest quantity.

step

A component of the thermal profile. For each step in the thermal profile, you can set the ramp rate (ramp increment for melt curve steps), hold temperature, and hold time (duration). You can turn data collection on or off for the ramp or the hold parts of the step. For cycling stages, a step is also defined by the AutoDelta status.

SYBR® Green reagents

PCR reaction components that consist of two primers designed to amplify the target and SYBR® Green dye to facilitate detection of the PCR product.

system dye

Dye supplied by Life Technologies. Before you use system dyes in your experiments, make sure the system dye calibration is current in the Instrument Console.

The system dyes are:

- FAM™ dye
- JOE™ dye
- ROX™ dye
- NED™ dye
- SYBR® Green dye
- TAMRA™ dye
### Glossary

- **VIC® dye**
- **Cy®3 dye**
- **Texas Red® dye**

**TaqMan® reagents**  
PCR reaction components that consist of primers designed to amplify the target and a TaqMan® probe designed to detect amplification of the target.

**target**  
The nucleic acid sequence to amplify and detect.

**target color**  
In the software, a color assigned to a target to identify the target in the plate layout and analysis plots.

**Target Library**  
In the software, an editable collection of targets to use in experiments. Targets in the library contain the target name, reporter, quencher, and target color. The targets in the library may also contain comments about the target.

**task**  
In the software, the type of reaction performed in the well for the target or SNP assay.  
**Available tasks:**
- Unknown
- Negative Control
- Standard (standard curve and relative standard curve experiments)
- Positive control (genotyping experiments)
- IPC (presence/absence experiments)
- Blocked IPC (presence/absence experiments)

**technical replicates**  
Wells containing identical reaction components, including sample; important for evaluating precision.

**temperature plot**  
In the software, a display of temperatures for the instrument cover and instrument block during the instrument run.

**template**  
The type of nucleic acid to add to the PCR reaction.

**template file**  
A user-created file that contains experiment setup information (experiment type, sample names, target name, and thermal conditions) to be used as a starting point for new experiment setup. Template files have an .edt extension.

**thermal profile**  
Part of the run method that specifies the temperature, time, ramp, and data collection points for all steps and stages of the instrument run.

**threshold**  
- In amplification plots, the level of fluorescence above the baseline and within the exponential growth region. For the Baseline Threshold algorithm, the threshold can be determined automatically (see automatic threshold) or can be set manually (see manual threshold).
- In presence/absence experiments, the level of fluorescence above which the software assigns a presence call.
threshold cycle (C_T)  The PCR cycle number at which the fluorescence meets the threshold in the amplification plot.

T_m  See melting temperature (T_m).

touchscreen  Instrument display that you touch to control the instrument.

uniformity calibration  Type of calibration in which the software measures sample block uniformity. The calibration generates data that compensate for the physical effects of the QuantStudio™ 6 and 7 Instruments’ filters on data collected during an experiment.

unknown  In the software, the task for the target or SNP assay in wells that contain the sample being tested. In quantification experiments, the task for the target in wells that contain a sample with unknown target quantities. In genotyping experiments, the task for the SNP assay in wells that contain a sample with an unknown genotype. In presence/absence experiments, the task for the target in wells that contain a sample in which the presence of the target is not known. In melt curve experiments, the task for the target in wells that contain a sample with an unknown melt curve profile.

unknown-IPC wells  In presence/absence experiments, wells that contain a sample and internal positive control (IPC).

variant  A sample (or group of samples) with a unique melt curve (that is, the melt curve is different from the melt curves of other samples or controls used in the experiment). The software determines melt curve differences by the melting temperature (Tm) and the shape of the melt curve.

y-intercept  In the standard curve, the value of y where the regression line crosses the y-axis. The y-intercept indicates the expected threshold cycle (C_T) for a sample with quantity equal to 1.
A
AIF 27
AIX 27
aligned melt curve plot 27
allele 27
allelic discrimination plot 27
amplicon 27
amplification 27
amplification efficiency (EFF%) 27
amplification plot 27
amplification stage 27
analysis options, setting 15, 16
Analysis Protocol Library 28
analysis settings library 15
assay 28
Assay ID 28
assay index file 27
assay information file (AIF) 28
AutoDelta 28
automatic baseline 28
automatic threshold 28

B
background calibration 28
baseline 28
baseline-corrected normalized reporter (DRn) 28
biological replicate 29
blocked IPC 29

C
calibration 19
Calibration and verification consumables 384-well 7
96-well (0.2 mL) 7
array card 8
Fast 96-well (0.1 mL) 8
calibrator 29
comparative CT method 29
console, instrument 17
Ct algorithm 29
cycle threshold 29
cycling stage 29

data collection 30

default analysis settings
   Automatic analysis 16
   Automatic save 16
   Baseline settings 16
delta Rn 30
derivative reporter (–Rn’) 30
diluent 30
dye calibration 30
dye library 13

E
efficiency correction 30
endogenous control 30
endpoint read 30
error 30
experiment
   consumables 9
   reagents 11
experiment name 31
experiment type 31
expiration date 7
export 31

F
filter 31
flag 31
fluorogenic probe 20
forward primer 31

G
genotyping experiment 31

H
Help system 25
heterozygote 31
holding stage 32
homozygote 32
housekeeping gene 32

I
import 32
Instrument Console 32
Instrument Manager 32
internal positive control (IPC) 32
inventoried assays 32
IPC blocking agent 32

L
libraries, using in your own experiments
Analysis settings library 13
Control library 13
Dye library 13
Run Method library 13
Samples library 13
SNP Assay library 13
Targets library 13

M
made-to-order assays 32
manual baseline 32
manual C T 33
melt curve 33
melt curve plot 33
melting temperature (Tm) 33
multicomponent plot 33

N
negative control (NC) 33
negative control-blocked IPC wells 33
negative control-IPC wells 33
no amplification control (NAC) 33
no template control 33
nonfluorescent quencher-minor groove binder 33
normalization calibration 34
normalized quantity 34
normalized quantity mean 34
normalized quantity SE 34
normalized reporter (Rn) 34
NTC 33

O
omit well 34
order
from the website 6
how to 6
outlier 34

P
package label 7
passive reference 34
plate layout 34
plate setup file 34
positive control 34
post-PCR read 35
pre-PCR read 35
primer mix 35
primer/probe mix 35
pure dye 35

Q
quantification method 35
quantity 35
quencher 35
QuickStart 35

R
ramp 35
ramp speed 36
raw data plot 36
RDML 36
reaction mix 36
reagents 36
reagents, about 20
reagents, selecting
SYBR® Green Reagents 20
TaqMan® Reagents 20
real-time PCR 36
reference sample 36
refSNP ID 36
region of interest (ROI) calibration 36
regression coefficient 35
regression line 36
reject well 36
relative standard curve method 37
replicate group 37
replicates 37
reporter 37
reverse primer 37
reverse transcriptase 37
ROX™ dye 37
run method 37
run method library 14
S
sample 37
sample definition file 37
Sample Library 37
sample/SNP assay reaction 37
sample/target reaction 37
security and auditing 38
serial factor 38
slope 38
SNP 38
SNP assay 38
SNP Assay Library 38
stage 38
standard 38
standard curve 39
standard curve method 39
standard quantity 39
starting quantity 39
step 39
sybr green reagents
  advantages 20
  description 20
  limitations 21
  reagent detection process 21
SYBR® markers
  SYBR® Green dye 39
  SYBR® Green I Reagents 11
system dye 39

T
taqman reagents
  advantages 20
  description 20
  limitations 20
  reagent detection process 20
TaqMan® markers
  TaqMan® reagents 11, 40
target 40
target color 40
Target Library 40
task 40
technical replicate 40
Temperature Plot 40
template 40
template file 40
threshold 40

threshold cycle (CT) 41
Tm 41
training, information on 25

U
uniformity calibration 41
unknown 41
unknown-IPC wells 41

V
variant 41

Y
y-intercept 41